
Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Denna guide beskriver hur man använder och konfigurerar ILME-FR7 / ILME-FR7K Interchangeable Lens Digital
Camera.

Se denna bruksanvisning och driftsanvisningarna för relaterade enheter enligt behov.

Översikt

Typiska användningstillämpningar

Systemkonfiguration

Styra en enda enhet med den medföljande infraröda fjärrkontrollen

Styra en enda enhet med en surfplatta eller dator

Styra en enda enhet med den externa fjärrkontrollen

Styra flera enheter med den externa fjärrkontrollen

Delarnas plats och funktioner

Vy framifrån

Vy från baksidan

Anslutningsblock

Sidovy

Vy ovanifrån

Vy underifrån

Linsstöd

Platser och funktioner för delar i den infraröda fjärrkontrollen (medföljer)

Web App-skärmen

Översikt Web App-skärmen

Struktur för skärmarnas gemensamma område

Struktur för skärmen för livedrift

Struktur för uppspelningsskärmen

Struktur för inställningsskärmen
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Förberedelse

Kameramenyn

Kameraskärmen

Montera enheten

Montera upprätt på en fast plats

Montera upprätt på en högt belägen, fast plats

Montera i ett tak

Fästa/ta bort en lins

Säkerhetsföreskrifter när man kopplar/kopplar bort en lins

Kontrollera linsbrytarna

Säkerhetsföreskrifter när man använder en zoomlins

Fästa en lins

Ta bort en lins

Ansluta kablar

Ansluta en enhet till en nätverksenhet via trådbunden anslutning

Ansluta strömförsörjning

Använda AC-ström

Använda PoE++-strömförsörjning

Återställa pan/tilt

Konfigurera före du filmar

Starta enheten med hjälp av Web App

Gå till Web App från en webbläsare

Starta enheten

Konfigurera grundläggande användning

Förbereda minneskort

Stödda minneskort

Föra in minneskort

Mata ut ett minneskort
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Filmning

Formatera (initiera) minneskort

Kontrollera kvarvarande inspelningstid

Återställa minneskort

Grundläggande användning

Starta/stoppa inspelning

Växla mellan minneskort

Kontrollera ljudet

Specificera tidsdata

Granska inspelningen (Rec Review)

Justera bildinramning

Skärm för bildinramningsjustering

Justera filmningsriktning

Justera filmningsriktning med hjälp av Web App

Ställa in hastigheten för pan/tilt-drift

Ställa in acceleration för pan-tilt-användning

Justera filmningsriktning med den medföljande infraröda fjärrkontrollen

Justera zoomen

Ställa in zoomtyp

Justera zoomen med hjälp av Web App

Ställa in hastigheten för zoomdrift

Justera zoomen med den medföljande infraröda fjärrkontrollen

Spara/återställa kamerans panorering/lutning/zoomposition (förinställd position)

Kalibrera en E-monterad lins

Spara/återställa inställningar för pan/tilt, zoomposition och fokusinställningar med Web App

Döpa om förinställningspositioner med hjälp av Web App

Ersätta den sparade förinställda positionen med en ny position med Web App

Radera en sparad förinställd position med hjälp av Web App

Synkronisera pan/tilt och zoom/fokus när man återställer en förinställningsposition
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Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition

Spara/återställa pan/tilt- och zoompositionen med den medföljande infraröda fjärrkontrollen

Spara/spela upp bildinramningsfunktioner (PTZ-spårning)

Spela in kamerabildinramningar med hjälp av Web App

Spela upp kamerabildinramningar med hjälp av Web App

Radera bildinramningsfunktioner lagrade på kameran med hjälp av Web App

Spara bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen

Spela upp bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen

Justera fokuset

Skärm för fokusjustering

Justera fokus manuellt (manuellt fokus)

Justera manuellt med hjälp av Web App

Justera manuellt med den medföljande infraröda fjärrkontrollen

Fokusera genom att specificera en fokusposition (punktfokus)

Använda autofokus tillfälligt (push-autofokus (AF))

Använda autofokus med en bild (push-autofokus (AF-S))

Justera fokus automatiskt (autofokus)

Justera automatiskt med hjälp av Web App

Justera automatiskt med den medföljande infraröda fjärrkontrollen

Ställa in autofokusområde/position (fokusområde)

Ändra fokusområdet snabbt (fokusinställning)

Flytta fokusområdesramen med pekfunktionen (beröringsfokusområde)

Justera autofokusåtgärden (AF-övergångshastighet, känslighet för växling av AF-föremål)

Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App

Fokusera manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen

Använda manuellt fokus tillfälligt under autofokus (manuellt fokus med push)

Fokusering med ansikts- och ögondetektering (Face/Eye Detection AF)

Spåra ett specificerat motiv (Realtime Tracking AF)

Justera ljusstyrka
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Praktiska funktioner

Skärm för ljusstyrkejustering

Ställa in grundläggande känslighet

Ställa in målnivå för automatisk ljusstyrkejustering

Justera bländaren

Justera bländaren automatiskt

Justera bländaren manuellt

Justera förstärkning

Justera förstärkningen automatiskt

Justera förstärkningen manuellt

Justera slutaren

Justera slutaren automatiskt

Justera slutaren manuellt

Justera belysningsnivå (ND-filter)

Om ND-filtret

Justera i förinställt läge

Justera automatiskt i variabelt läge

Justera manuellt i variabelt läge

Justera till naturliga färger (vitbalans)

Skärm för justering av vitbalans

Justera vitbalansen automatiskt

Justera vitbalansen manuellt

Köra automatisk vitbalans

Konfigurera ljudet till inspelning

Ljudkonfigurationsskärm

Välj ljudingångsenhet

Justera ljudinspelningsnivån automatiskt

Justera ljudinspelningsnivån manuellt

Använda direktmenyn

5



Tilldelningsbara knappar

Slow & Quick Motion

Spela in video växelvis (Interval Rec)

Ta cachade bilder (Picture Cache Rec)

Inspelning till minneskort A och B samtidigt (2-öppningar Simul Rec)

Videosignalmonitor

Videoklippflaggor

Andningskompensation

Proxyinspelning

Översikt för proxyinspelning

Spela in en proxy

Filma med önskat utseende

Översikt för utseende

Välja ett utseende

Importera ett önskat grundutseende

Anpassa ett utseende

Spara ett utseende

Radera ett grundutseende

Filma med utseendejustering i efterproduktion

Filma med utseendejustering i efterproduktion

Tillämpa en LUT till HDMI-utgång och strömning

Ändra en LUT

Ändra fördelningen av mörka och ljusa områden i inspelad bild

RAW-inspelning

Spela in RAW-video

Spela in RAW-video i Slow & Quick Motion-läge

Justera Bokeh (Bokeh Control-funktionen)

Växlar bokeh control-funktionen till On/Off
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Network-funktioner

Miniatyrbildskärm

Kamerameny och detaljerade inställningar

Justera graden av bokeh

Spara och ladda konfigurationsdata

Spara och ladda konfigurationsdata Översikt

Spara en ALL-fil

Ladda en ALL-fil

Överföra filer

Om filöverföring

Registrera en filöverföringsdestination

Välj en fil och ladda upp

Ladda upp en proxyfil i ett minneskort från miniatyrbildskärmen

Ladda upp en ursprungsfil i ett minneskort från miniatyrbildskärmen

Kontrollera filöverföringsstatus

Ladda upp med Secure FTP

Konfigurera strömning

Om strömning

Ställa in strömningsformat

Ställa in video-codec för strömning

Ställa in ljud-codec för strömning

Starta/stoppa strömning

Miniatyrbildskärm

Spela videoklipp och annan klippanvändning

Spela upp inspelade videoklipp

Använda inspelade videoklipp

Konfigurera kameramenyn

Använda kameramenyn

Använda kameramenyn
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Ange en teckensträng

User-meny

User

Edit User-meny

Edit User

Shooting-meny

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project-meny

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec
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SDI/HDMI Rec Control

Assignable Button

Paint/Look-meny

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

Pan-tilt-meny

P/T Acceleration

TC/Media-meny

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring-menyn

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio-meny

9



Audio Input

Audio Output

Thumbnail-menyn

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical-menyn

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network-meny

Wired LAN

File Transfer

Maintenance-meny

Language

Clock Set

Hours Meter

Shooting-menyinställning och standardvärden

ISO/Gain-inställningar och standardvärden
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Webbmeny och detaljerade inställningar

AGC Limit-inställningar och standardvärden

Bildkvalitetsinställningar som sparas för varje filmningsläge

Konfigurera web-menyn

Använda web-menyn

Shooting-meny

Focus

Project-meny

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look-meny

Base Look

Pan-tilt-meny

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring-menyn

Output Format

Output Display

Audio-meny

Audio Input
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Audio Output

Technical-menyn

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network-meny

Camera Name

User

Wired LAN

File Transfer

FTP Server 1 till 3

SSL

Referer Check

Brute Force Attack Protection

Stream-meny

Stream

Video Stream

Audio Stream

Maintenance-meny

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log
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Anslutning av extern enhet

Bilaga

Service

EULA

Software

Ansluta externa monitorer och inspelningsenheter

Ansluta en RCP/MSU (tillval)

Ansluta med en RCP/MSU

En-till-en-anslutning mellan enheten och en RCP

Använda enheten i en multikameramiljö med en MSU/kamerans fjärrkontrollprogramvara

Lista över funktioner som stöds

Användning med en RM-IP500-fjärrkontroll (tillval)

Om användning med en RM-IP500-fjärrkontroll (tillval)

Ansluta en RM-IP500-fjärrkontroll

Synkronisera med en extern enhet

Om att synkronisera med en extern enhet

Synkronisera videosignalens fas (Genlock)

Låsa tidskoden till andra enheter

Ansluta en extern mikrofon eller extern ljudenhet

Hantera/redigera videoklipp med en dator

Utgång för en optisk fibersignal

Ansluta en tally-signal

Mata ut spårningsdata (free-d)

Ansluta en linskontroll

Justera zoomen med hjälp av en linskontroll

Försiktighetsåtgärder vid användning

Utgångsformat och begränsningar

Felsökning

Fel-/varningsmeddelanden
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5-041-958-63(1) Copyright 2022 Sony Corporation

Lista på menyobjekt

Förinställningspositioner för sparade objekt

Blockdiagram

Uppdatera programvara för E-monterad lins

Fästa locket till linsfrigöringsknappen

Licenser

Specifikationer

Varumärken
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Systemkonfiguration

Denna enhet kan kombineras med kringutrustning för att skapa flera olika systemkonfigurationer.

E-monterad lins1.

LA-EA3/LA-EA4 A-monteringsadapter2.

Infraröd fjärrkontroll (medföljer)3.

CFexpress Type A-minneskort / SDXC-minneskort4.

CFexpress Type A-kortläsare / SD-kortläsare5.

ECM-680S, ECM-678*, ECM-674* Mikrofon6.
EC-0.5X3F5M 3-pin → 5-pin XLR-adapterkabel krävs.*

AC-adapter (medföljer)7.

Videomonitor8.

RM-IP500-fjärrkontroll9.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styra en enda enhet med den medföljande infraröda fjärrkontrollen

Du kan styra en enda enhet på distans med den medföljande infraröda fjärrkontrollen.

 Videosignal
 Signalflöde

5-041-958-63(1) Copyright 2022 Sony Corporation

Infraröd fjärrkontroll (medföljer)1.

Videomonitor2.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styra en enda enhet med en surfplatta eller dator

Du kan ansluta en surfplatta eller dator till enheten och därefter styra enheten med en webbläsare.

 Videosignal
 Fjärrkontrollsignal

  Signalflöde

5-041-958-63(1) Copyright 2022 Sony Corporation

Videomonitor1.

Surfplatta2.

Dator3.

Åtkomstpunkt4.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styra en enda enhet med den externa fjärrkontrollen

Du kan styra enheten på distans med en fjärrkontroll.

 Videosignal
 Fjärrkontrollsignal

  Signalflöde

5-041-958-63(1) Copyright 2022 Sony Corporation

Videomonitor1.

RM-IP500-fjärrkontroll2.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Styra flera enheter med den externa fjärrkontrollen

Du kan styra upp till 100 enheter på distans med en enda fjärrkontroll.

 Videosignal
 Fjärrkontrollsignal
 Tally/kontaktsignal

  Signalflöde

5-041-958-63(1) Copyright 2022 Sony Corporation

Videomonitor1.

Videobrytare2.

Ethernet-nav3.

RM-IP500-fjärrkontroll4.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vy framifrån

Detta ämne beskriver plats och funktion för delar på enhetens framsida.

Tips

Denna beskrivning avser illustrationen av en enhet utan någon fäst lins.

Kamerahuvudet

OBS!

Utsätt inte kamerahuvudet för kraftiga slag.

1.

Inspelningslampa
När konfigurerat som en inspelningslampa, tänds lampan i rött när man spelar in till ett minneskort. Lampan blinkar
när kvarvarande fritt utrymme i inspelningsmedia är lågt eller när ett fel uppstår.

2.
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För information se ”Fel-/varningsmeddelanden.”

När konfigurerat som en tally-lampa, tänds lampan i rött eller grönt enligt den externa tally-signalen.

För mer info se ”Ansluta en tally-signal”.
Bildsensor

OBS!

Vidrör inte direkt med dina händer.

3.

Linsfrigöringsknapp
Tryck för att ta bort linsen.

För mer info se ”Ta bort en lins.”

4.

Linssignalkontakter

OBS!

Vidrör inte direkt med dina händer.

5.

POWER-lampa6.

NETWORK-lampa
Enhetens tillstånd indikeras av kombinationen av displayfärg och tändningsstatus (tänds, blinkar, tänds inte) för
POWER-lampan och NETWORK-lampan.

7.

POWER-
lampa

NETWORK-
lampa Enhetsstatus

Tänds grön*1
Tänds grön Strömsatt (nätverk anslutet)

Tänds inte Strömsatt (nätverk inte anslutet)

Blinkar grön Tänds inte Strömsättningsprocessen pågår

Tänds orange Tänds inte Standbyläge för ström

Blinkar gul Tänds inte Programuppdatering pågår

Blinkar
långsamt i
orange*2

Blinkar
långsamt i
grönt*2

Enheten kan inte användas normalt. Mer info finns i systemloggen. Om
problemet kvarstår även efter att du satt enheten i standby-läge eller stängt av
strömmen och sedan slagit på den igen, kontakta då din Sony-
servicerepresentant.

Blinkar
snabbt i
orange*3

Blinkar snabbt i
grönt*3

Ett fel uppstod med enheten. Kontakta din Sony-servicerepresentant.

Blinkar grönt när ett kommando tas emot från den medföljande infraröda fjärrkontrollen.*1

Blinkar långsamt: Blinkar en gång per sekund*2

Blinkar snabbt: Blinkar fyra gånger per sekund*3

Infraröd fjärrkontrollsensor
Tar emot styrsignalen från den medföljande infraröda fjärrkontrollen.

8.

Luftinlopp9.
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Relaterade avsnitt

Fel-/varningsmeddelanden

Ansluta en tally-signal

Ta bort en lins

5-041-958-63(1) Copyright 2022 Sony Corporation

OBS!

Täck inte luftflödet. Om du gör det kan det orsaka fel.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Vy från baksidan

Detta ämne beskriver plats och funktion för delar på enhetens baksida.

Relaterade avsnitt
Sidovy

5-041-958-63(1) Copyright 2022 Sony Corporation

Kamerahuvudets låsspak
Låser kamerahuvudets framåt-/bakåtrörelse.

OBS!

Alltid ställd i låst läge när du inte byter lins.

När enheten transporteras ska linsen alltid tas bort och enheten ställas i låst position.

Stäng av enhetens ström och lås kamerahuvudet horisontalt med pan/tilt-låsspaken innan du använder låsspaken för att
undvika skada på grund av klämda fingrar. För information om pan/tilt låsspak, se ”Pan/tilt låsspak” i ”Sidovy.”

1.

Skjutbas2.

24



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Anslutningsblock

Detta ämne beskriver plats och funktion för delar i enhetens anslutningsblock.

 anslutning (till jord)
Anslut till jord genom att ansluta till jordkontakten i ett strömuttag eller till en jordningsstång.

1.

DC-IN-kontakt (standard DC-jack)
Anslut till en AC-adapter.

OBS!

Använd inte en AC-adapter utöver den som har tillhandahållits. Om du ansluter en annan adapter kan det orsaka brand eller
fel.

2.

 LAN (nätverk)-kontakt (RJ-45)
Anslut en nätverkskabel (kategori 5e eller högre) för kommunikation och PoE++*-strömförsörjning.

Speed LED-status
Indikerar nätverksanslutningens hastighet.

3.

PoE++: Power over Ethernet Plus Plus. Överensstämmer med IEEE802.3bt (Type 4 Class 8). Du finner mer information om att ansluta i
strömförsörjningsenhetens bruksanvisning.

*
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Link/ACT LED-status
Indikerar nätverksanslutningens status.

OBS!

När du ansluter den här produkten till internet, anslut den via ett system som ger en skyddsfunktion, som en router eller
brandvägg. Om den ansluts utan sådant skydd kan säkerhetsproblem uppstå.

Visning Anslutningshastighet

Tänds inte
10 Mbps anslutning

100 Mbps anslutning

Tänds orange 1 000 Mbps anslutning

Visning Anslutningsstatus

 Tänds inte Ingen länk

Blinkar grön Upprättad länk, data aktiva

Tänds grön Aktiv länk

TC IN-kontakt
För in en extern referenstidskodssignal.

För information, se ”Låsa tidskoden till andra enheter.”

4.

HDMI-kontakt
Med denna går video från enheten ut som en HDMI-signal.

För information se, ”HDMI-kontakt (Type A-kontakt)” i ”Ansluta externa monitorer och inspelningsenheter.”

5.

Monteringsskruv till HDMI-kabelhållarplatta
För att förhindra att HDMI-kabeln tas bort, fäst den medföljande HDMI-kabelhållarplattan med den medföljande
monteringsskruven (M2.6×6), och fäst HDMI-kabeln med ett vanligt buntband.

För information om att fästa HDMI-kabelhållarplattan, se ”Ansluta kablar.”

6.

OPTION-kontakt
Använd för att ansluta en tally-signal från en extern enhet eller en linskontroll.

För information, se ”Ansluta en tally-signal” och ”Ansluta en linskontroll”.

7.

Sladdklämma
Använd för att säkra AC-adaptersladden.

8.

RESET-brytare
Tryck ned i minst 5 sekunder med en pennspets eller liknande enhet för att återställa enhetens inställningar till
fabriksstandardvärden.
Du kan välja om du endast vill återställa nätverksanslutningsinställningar eller alla inställningar med SETUP-brytare
1.

9.

OPTICAL utmatningskontakt
Matar ut en SDI-signal konverterad till optiskt format när en SFP+-modul (tillval) är ansluten.

För mer info se ”Utgång för en optisk fibersignal.”

10.

26



SETUP-brytare

Konfigurerar följande inställningar.
Brytare 1: Ställer in vilka inställningar som återställs när RESET-brytaren trycks ned.

Brytare 2: Ställer in huruvida +48 V strömförsörjningen (fantommatningen) är på eller av när en ljudingångsenhet
ansluts. Inställningen tillämpas omgående.
Funktionen aktiveras när [Audio] > [Audio Input] > [AUDIO IN Select] är inställt till [MIC] i kameramenyn.

OBS!

Om man ställer brytare 2 på ON och ansluter en mikrofon som inte är kompatibel med en källa på +48 V kan det skada den
anslutna enheten. Kontrollera inställningen innan du ansluter enheten.

Brytare 3: Aktivera VISCA over IP-kommunikation. Inställningarna tillämpas när kameran slås på.
Ställ i positionen ON för att använda enheten när ansluten till en fjärrkontroll (RM-IP500).

OBS!

Om administratörens lösenord inte har konfigurerats, inaktiveras VISCA over IP-kommunikation, oavsett brytarinställningen.
För information om administratörlösenord, se ”Starta enheten.”

Brytare 4: Ändrar hastigheten för pan/tilt-driften som skickas från den infraröda fjärrkontrollen. Inställningen tillämpas
omgående.

11.

Inställning Beskrivning

OFF
(standard)

Återställer endast inställningar för nätverksanslutningen. Nätverksinställningar,
säkerhetsinställningar och användarinformation (användarnamn och lösenord) till enheten kommer
återställas.

ON Återställer alla inställningar till fabriksinställningar.

Inställning Beskrivning

OFF
(standard)

Tillför in +48 V-ström (fantommatad ström). Konfigurera denna inställning när du använder en
extern ljudenhet (till exempel en mixer), dynamisk mikrofon eller mikrofon med inbyggt batteri.

ON
Mata +48 V-ström (fantommatad ström) till en mikrofon kompatibel med fantommatning till AUDIO
IN-kontakten (CH-1 eller CH-2).

Inställning Beskrivning

OFF (standard) Kommer inte svara på VISCA over IP-kommando.

ON Acceptera VISCA over IP-kommando.
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Relaterade avsnitt

Låsa tidskoden till andra enheter

Ansluta externa monitorer och inspelningsenheter

Ansluta kablar

Ansluta en tally-signal

Ansluta en linskontroll

Utgång för en optisk fibersignal

Starta enheten

Synkronisera videosignalens fas (Genlock)

Ansluta en extern mikrofon eller extern ljudenhet
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Inställning Beskrivning

OFF (standard) Körs i normal hastighet.

ON Körs i maximal hastighet.

SDI OUT-kontakt
Med denna går video från enheten ut som en 12G/6G/3G/HD-SDI-signal.
Enheten kan även konfigureras för RAW-signalutgång.

För information se, ”SDI OUT-kontakt (BNC-typ)” i ”Ansluta externa monitorer och inspelningsenheter.”

12.

 Infraröd fjärrkontrollsensor (rear)
Infraröd sensor för den medföljande infraröda fjärrkontrollen.

13.

Fläkt/luftutlopp
Sänder värme från inuti enheten.

OBS!

Täck inte luftutloppet. Om du gör det kan det orsaka fel.

Notera att området i närheten av luftutloppet kan bli varmt.

14.

GENLOCK-kontakt
Använd en ingång som en extern synkroniseringssignal.

För information, se ”Synkronisera videosignalens fas (Genlock).”

15.

AUDIO IN-kontakt (XLR-typ 5-stifts kontakt)
Använd för ingång för signalen från en extern mikrofon eller ljudenhet.
Den fungerar som en AUDIO IN CH-1-kontakt eller AUDIO IN CH-2-kontakt.

För information se, ”Ansluta en extern mikrofon eller extern ljudenhet.”

16.
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Sidovy

Detta ämne beskriver plats och funktion för delar på enhetens sida.

Tips

Denna beskrivning avser illustrationen av en enhet utan någon fäst lins.

Pan/tilt låsspak
Låser enhetens pan/tilt-funktion. Använd i följande fall.

När du transporterar eller förpackar enheten.
När du fäster eller tar bort en lins. För information, se ”Fästa en lins” eller ”Ta bort en lins.”
När du använder en lins som inte stöder pan/tilt-drift (till exempel linserna Sony SEL100400GM / SEL200600G /
SEL400F28GM / SEL600F40GM).
När enheten transporteras ska linsen alltid tas bort och enheten ställas i låst position.

Tips

1.
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Relaterade avsnitt
Fästa en lins

Ta bort en lins

Föra in minneskort

Gå till Web App från en webbläsare

5-041-958-63(1) Copyright 2022 Sony Corporation

Pan/tilt-rörelsen kan fixeras i följande vinklar.

Skjutbas2.

Skruvhål för externa enheter (4 platser)
För M3-skruvar med upp till 6 mm längd.

OBS!

Använd inte skruvar som är längre än 6 mm. Om du gör det kan det orsaka fel.

3.

Åtkomstindikator A4.

Åtkomstindikator B
Indikatorn tänds eller blinkar när inspelningsmedia är insatt.

För information, se ”Föra in minneskort.”

5.

CFexpress Type A/SD-kortöppning (A)6.

CFexpress Typ A/SD-kortöppning (B)
Använd för att föra in inspelningsmedia.

För information, se ”Föra in minneskort.”

7.

QR-kod för nätverksanslutning
Använd när du konfigurerar de inledande inställningarna.

För information, se ”Gå till Web App från en webbläsare.”

8.
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Vy ovanifrån

Detta ämne beskriver plats och funktion för delar på enhetens översida.

Tips

Denna beskrivning avser illustrationen av en enhet utan någon fäst lins.
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Skruvhål för externa enheter (2 platser)
Kompatibel med 1/4-20 UNC-skruvar för ett stativ.
Maximal längd 6 mm.

1.

ɸ (bildmärke)
Bildmärket sitter på samma plan som bildsensorn.
För att korrekt mäta avståndet mellan enheten och föremålet, kan du använda detta bildmärke som referenspunkt.

2.
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Vy underifrån

Detta ämne beskriver plats och funktion för delar på enhetens undersida.

Tips

Denna beskrivning avser illustrationen av en enhet utan någon fäst lins.

Monteringsskruvhål för takfäste (6 platser, 5,5 mm effektivt gängdjup)
När du monterar enheten i ett tak eller på en hylla på en högt belägen plats, fäst då enhetens fäste (tillval) i enhetens
bas med de sex skruvarna avsedda för detta i de avsedda hålen.

För information om att montera, se ”Montera upprätt på en högt belägen, fast plats” och ”Montera i ett tak.”

1.

Stativmonteringsskruvar (2 platser)
Används när man monterar enheten på ett kamerastativ (tillval 1/4-20 UNC-skruvar på upp till 5,5 mm i längd).

OBS!

2.
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Relaterade avsnitt

Montera upprätt på en högt belägen, fast plats

Montera i ett tak

5-041-958-63(1) Copyright 2022 Sony Corporation

Använd inte skruvar som är längre än 5,5 mm. Om du gör det kan det orsaka fel.
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Linsstöd

Detta ämne beskriver plats och funktion för delar i enhetens linsstöd.

Tips

Denna beskrivning avser illustrationen av en enhet utan någon fäst lins.

Linsstödstång (2)
Stöder linsen.
Kan även användas för att montera allmänna Ø15 stångtillbehör.

1.
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Linsens stödenhet
Linsstödet kan skjutas framåt/bakåt enligt linsen och därefter säkras.

2.

Skruv till linsens stödsockel
Fäst på linsens stödsockel. Du kan justera skruven upp/ned för att matcha höjden för linsens stödsockel.

3.

Linsens stödklämspak (2 platser)
Säkrar framåt-/bakåtpositionen för linsens stödenhet.

4.

Klämspak till linsens stödsockel
Säkrar den vertikala positionen för skruven till linsens stödsockel.

Tips

Om en klämspak är i en position där den inte går att vrida, frigör då klämspaken och rotera den till en vinkel som underlättar
driften. När i önskat läge, stäng klämspaken.

A: Klämspak till linsens stödsockel
B: Linsens stödklämspak

OBS!

För att förhindra att linsens stödenhet stör pan/tilt-driften, ska du flytta linsens stödenhet uppåt mot kamerahuvudet när du
inte använder den och flytta skruven till linsens stödsockel till dess högsta position (närmast linsen).

5.
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Platser och funktioner för delar i den infraröda fjärrkontrollen (medföljer)

Detta ämne beskriver platser och funktioner för delar i den infraröda fjärrkontrollen (medföljer).

Knappen REC● (START/STOP-inspelning)
Tryck för att starta eller stoppa inspelning.

1.

MENU-knapp
Tryck för att visa eller dölja kameramenyn.

2.

GUI-kontrollknappar
Tryck för att utföra åtgärder i kameramenyn, i meddelandedialoger som omfattar knappar och andra
skärmvisningsfunktioner.

3.

CANC./BACK-knapp
Tryck för att avbryta en inställning eller för att återgå till föregående skärm i enhetens kamerameny.

4.
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Infraröd fjärrkontroll, batteri

Den infraröda fjärrkontrollen kräver två AA (LR6) -batterier.
För in batterierna i den infraröda fjärrkontrollen så som det visas i följande diagram.

Kontrollknappar för pan och tilt
Tryck på pilknapparna för att styra kamerans pan/tilt. Tryck på HOME-knappen för att återföra kamerans riktning till
framåt.

5.

Kontrollknappar för förinställningsposition
Tryck och håll ned PRESET-knappen och tryck på en av knapparna 1 till 3 för att lagra kamerariktning, zoom och
fokusjusteringsstatus i den nedtryckta nummerknappen.
Tryck på en nummerknapp med lagrade inställningar för att återkalla sparad status.

6.

Fokuskontrollknappar
Använd för att justera fokuset.
För att justera fokuset automatiskt, trycker du på AF-knappen.
För att justera fokuset manuellt, tryck på MF-knappen och därefter på antingen knappen F (Far) för att fokusera på
föremål långt bort eller N (Near) för att fokusera på föremål som ligger nära.

7.

Tilldelningsbara knapparna 1 till 3
Utför de funktioner som är tilldelade de tilldelningsbara knapparna i kameramenyn.
Om du tilldelar [Direct Menu]-funktionen till en tilldelningsbar knapp, kan du justera exponering, vitbalans och andra
inställningar med hjälp av GUI-kontrollknapparna.

För information om tilldelning med kameramenyn, se ”Tilldelningsbara knappar.”

För mer information om direktmenyn, se ”Använda direktmenyn.”

8.

 (ström)-knapp
Tryck för att slå på enheten eller för att växla strömförsörjningen till standby-läge.

9.

THUMBNAIL-knapp
Visar miniatyrbildskärmen som visar inspelade videoklipp på enhetens minneskort.

För information om miniatyrbildskärmen, se ”Miniatyrbildskärm.”

Du kan välja videoklipp och styra uppspelning på miniatyrbildskärmen med hjälp av GUI-kontrollknapparna.

För information om att välja videoklipp och styra uppspelning, se ”Spela upp inspelade videoklipp” och ”Använda
inspelade videoklipp.”

10.

SLOT SEL-knapp minneskortsöppning (A)/(B)
När två minneskort sitter i, tryck då på knappen för att växla mellan minneskorten för inspelning.
Tryck på knappen medan miniatyrbildsskärmen visas för att växla mellan minneskorten som ska visas.

11.

P/T RESET (pan/tilt-återställning) knapp
Återställa pan/tilt-funktioner. Tryck på knappen när POWER-lampan och NETWORK-lampan blinkar samtidigt eller
när [Execute Pan-Tilt Reset] visas i kontrollpanelen för bildinramningsjustering i Web App.

12.

Zoomkontrollknappar
För att zooma in trycker du på knappen T (telephoto).
För att zooma ut trycker du på knappen W (wide).

13.
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OBS!

Använd endast mangan- eller alkaliska batterier, då andra typer kan gå sönder.

Kassera använda batterier enligt lagar och förordningar i det lokala landet eller regionen.

Relaterade avsnitt

Tilldelningsbara knappar

Använda direktmenyn

Miniatyrbildskärm

Spela upp inspelade videoklipp

Använda inspelade videoklipp

5-041-958-63(1) Copyright 2022 Sony Corporation
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Översikt Web App-skärmen

Genom att ansluta en surfplatta eller dator kan du använda funktionerna pan/tilt, zoom, inspelning, uppspelning och
konfigurera enheten från en webbläsare (nedan kallas denna funktion ”Web App”).

För information om att lansera Web App, se ”Gå till Web App från en webbläsare.”

OBS!

Web App stödjer inte kamerans ljudutgång.

Web App startar och följande skärm för livedrift visas.

Skärm för livedrift

För information om skärmen för livedrift, se ”Struktur för skärmen för livedrift.”
Knappar och ikoner som är gemensamma för skärmen för livedrift och uppspelning visas högst upp på skärmen.

För information om gemensamma områden för skärmar, se ”Struktur för skärmarnas gemensamma område.”
Du kan växla mellan skärmarna genom att trycka på skärmens växlingsflik i det gemensamma området.
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Skärm för uppspelning

Tryck på fliken [Playback] för att visa skärmen för uppspelning.

För information om skärmen för uppspelning, se ”Struktur för uppspelningsskärmen.”

Inställningsskärm

Tryck på fliken [Settings] för att visa inställningsskärmen (nedan kallad web-menyn).
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OBS!

I web-menyn tillämpas inte inställningarna förrän du trycker på knappen [OK]. Om du ändrar inställningar på en sida som har en
[OK]-knapp, se då till att trycka på knappen [OK].

För information om inställningsskärmen, se ”Struktur för inställningsskärmen.”
I denna hjälpguide kallas inställningsskärmen för Web App för web-menyn.

Relaterade avsnitt
Gå till Web App från en webbläsare

Struktur för skärmen för livedrift

Struktur för skärmarnas gemensamma område

Struktur för uppspelningsskärmen

Struktur för inställningsskärmen
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Struktur för skärmarnas gemensamma område

Detta ämne beskriver strukturen för skärmarnas gemensamma område.

Kameranamn
Visar kamerans namn.
Du kan ändra namnet med [Network] > [Camera Name] i web-menyn.
Bakgrundsfärgen ändras i enlighet med den externa tally-signalen.

1.

Strömbrytare
När enheten är påslagen, visas [Power ON]. Tryck på strömbrytaren och välj [Power Standby] för att ställa enhetens
strömförsörjning till standby-läge.
När [Power Standby] visas kan du trycka på brytaren och välja [Power ON] för att starta enhetens strömförsörjning.

2.

Användningsskärmens växlingsflikar
Tryck på en flik för att visa motsvarande driftsskärm.
[Live]-fliken: Visar skärmen för livedrift.
[Playback]-fliken: Visar skärmen för uppspelning.
[Settings]-fliken: Visar skärmen för inställningar (web-meny).

3.

Notifieringsmärke
När ett meddelande anländer ändras indikeringen så som visas nedan.

 (Notifieringar på)
Vidta nödvändig åtgärd i enlighet med meddelandet som visas i kamerans bildruta.

OBS!

Meddelanden visas inte när [Monitoring] > [Output Display] > [HDMI/Stream] är inställt till [Off] i web-menyn. Inställt på [On]
för att kontrollera innehållet i meddelanden.

4.

 (Kamerastatus)-knapp
Tryck på knappen för att visa kamerans inspelade bildsignalsinformation, linsinformation samt kontrollens status
(tillval) på en separat skärm.

5.
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När ett meddelande om linskontroll (tillval) visas ändras indikeringen enligt nedan.

Brytare för skärmlås
 (Drift upplåst): Ställ brytaren till vänster position för att kontrollera driften av skärmen för livedrift och

uppspelningsskärmen.
 (Drift låst): Ställ brytaren till höger position för att låsa driften av skärmen för livedrift och uppspelningsskärmen

för att förhindra oavsiktlig användning.

6.
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Struktur för skärmen för livedrift

Detta ämne beskriver strukturen för skärmen för livedrift.

Kontrollpanelen för förinställningsposition
Visar den registrerade positionen för en förinställning med hjälp av en miniatyrbild. Vidrör miniatyrbilden två gånger
för att återgå till positionen sparad i förinställningen.

För mer information om förinställningsposition, se ”Spara/återställa inställningar för pan/tilt, zoomposition och
fokusinställningar med Web App.”
För mer information om PTZ-spårning, se i avsnittet ”Spela in kamerabildinramningar med hjälp av Web App”.

1.

Kamerans bildruta
Visar kamerans nuvarande bild och enhetens status.
Den visar samma bild som HDMI-utgången.
Följande status visas ovanför bilden. En röd eller grön ram visas också runt bilden enligt mottagen extern tally-signal.

2.
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[Display]-knapp
Tryck på denna knapp för att visa kamerainformation på bilden.
Tryck på nytt medan kamerainformationen visas för att dölja kamerainformationen.

Utöver markörerna visas autofokus-relaterade indikatorer och meddelande enligt deras status, och de kan inte döljas
genom att trycka på knappen [Display].

För information om kamerainformation som visas, se ”Kameraskärmen.”

Stoppknapp för realtidsspårning med AF
Tryck på knappen för att sluta spåra ett motiv.

No. Visning Beskrivning

2-1 Fokuslägesindikator Se ”Fokuslägesindikator” i ”Kameraskärmen.”

2-2
Inspelningsläge, öppning A/B, Interval Rec-
indikator för intervallinspelning

Se ”Inspelningsläge, öppning A/B, Interval Rec-indikator
för intervallinspelning” i ”Kameraskärmen.”

2-3 Strömningsstatusindikator
Visas under strömning (när [Stream Setting] är inställt på
[RTMP] eller [SRT-Caller] endast)

2-4 Statusindikator för RAW-bildformat
Visar utgångsstatus för RAW-signalen. För mer
information om RAW, se ”Spela in RAW-video.”

2-5 Indikator för kvarvarande mediakapacitet Se ”Indikator kvarvarande mediakapacitet” i
”Kameraskärmen.”

2-6 Zoompositionsindikator
Se ”Zoompositionsindikator” i ”Kameraskärmen.”
När en linskontroll (tillval) ansluts, visas . Om ett fel
uppstår på linskontrollen (tillval), visas .

2-7 AE-läge/AE-nivåindikator Se ”AE-läge/AE-nivåindikator” i ”Kameraskärmen.”
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För information, se ”Spåra ett specificerat motiv (Realtime Tracking AF).”
START/STOP-knapp för inspelning
Tryck på knappen för att starta inspelning. Under inspelning tänds knappen START/STOP i rött.
Tryck under inspelning för att stoppa inspelningen.
Du kan ställa in Hold-brytaren till Hold-läget för att förhindra felaktig drift för START/STOP-inspelningsknappen.

3.

Kamerans grundläggande konfigurationspanel
Visar inställningar för grundläggande funktioner som krävs för filmning. Tryck på en knapp för att visa motsvarande
konfigurationsskärm för varje funktion i kamerans grundläggande justeringspanel nedan (5).

4-1 [FPS]
4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Du finner mer information i beskrivningen av varje funktion.

4.

Funktion Referens

FPS ”Slow & Quick Motion”

ISO/Gain
”Ställa in grundläggande känslighet,” ”Justera förstärkningen automatiskt” och ”Justera
förstärkningen manuellt” i ”Justera förstärkningen”

Exposure
Index

”Ställa in grundläggande känslighet” och ”Ändra fördelningen av mörka och ljusa områden i
inspelad bild”

Shutter ”Justera slutaren automatiskt” och ”Justera slutaren manuellt” i ”Justera slutaren”

Iris ”Justera bländaren automatiskt” och ”Justera bländaren manuellt” i ”Justera bländaren”

ND Filter ”Om ND-filtret” i ”Justera belysningsnivå (ND-filter)”

Scene File ”Översikt för utseende” och andra ämnen i ”Filma med önskat utseende”

Base
Look/LUT

”Filma med utseendejustering i efterproduktion”

White
Balance

”Skärm för justering av vitbalans”

Tilldelningsbara knappar/Kamerans justeringspanel för grundläggande konfiguration5.
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Visar tilldelningsbara knappar under normal drift. Tryck på knapparna på kamerans grundläggande
konfigurationspanel (objekt 4) för att visa motsvarande konfigurationsobjekt. Tryck på knappen [X] eller tryck på
kamerans konfigurationspanel igen för att återgå till den tilldelningsbara knappen.

För information om tilldelningsbara knappar, se ”Tilldelningsbara knappar.”
I beskrivningen av varje funktion finner du information om kamerans justeringspanel för grundläggande
konfiguration.

Kontrollpanelen för bildinramningsjustering/GUI-kontrollpanelen
Växla mellan kontrollpanelen för bildinramningsjustering/GUI-kontrollpanelen med flikarna högst upp.
Du kan trycka på knappen  (Stäng) längst upp till höger på skärmen för att dölja kontrollpanelen för att förhindra
oavsiktlig användning. Om kontrollpanelen inte visas, tryck då på knappen  (Öppna) för att visa den.
Använd kontrollpanelen för bildinramningsjustering för att justera bildinramning. Tryck på fliken 
(Panorering/lutning/zoom) för att visa kontrollpanelen för bildinramningsjustering.

För information om användning, se ”Justera bildinramning.”

Tips

Joystickdelen för kontrollpanelen för bildinramningsjustering visas som visat nedan när pan/tilt-drift är inaktiverat och när
pan/tilt-start krävs.

När pan/tilt-drift är låst med pan/tilt-låsspaken

När pan/tilt-drift inte har startats

6.
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När pan/tilt-drift måste återställas

När pan/tilt-drift inte är inaktiverat

När pan/tilt-driften inte är startat eller behöver återställas, kan du snabbt komma åt  (Panorering/lutning-återställning)-
knappen i kamerakontrollpanelen genom att trycka på meddelandet som visas under joysticken.

Använd GUI-kontrollpanelen för att använda kameramenyn, uppspelningsklipp och andra funktioner. Tryck på fliken
 (Kam UI) för att visa GUI-kontrollpanelen.

För information om användning, se ”Använda kameramenyn” och ”Spela upp inspelade videoklipp.”
Kamerakontrollpanelen
Använd för att konfigurera de funktioner som krävs för att använda kameran.
Växla mellan skärmarna för att visa med flikarna högst upp.
Du kan trycka på knappen  (Stäng) längst upp till höger på skärmen för att dölja kontrollpanelen för att förhindra
oavsiktlig användning. Om kontrollpanelen inte visas, tryck då på knappen  (Öppna) för att visa den.

7.
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Du finner mer information i beskrivningen av varje funktion.

  (Main)-fliken
Visar konfigurationsobjekten för vanligen använda funktioner.
Funktioner för skjutreglage högst upp och ned kan ändras genom att trycka på knappen [▼] och välja från listan som
visas. Följande funktioner kan väljas.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Zoom Speed
Pan-Tilt Speed

  (Focus)-fliken
Visar konfigurationsobjekten relaterade till fokus.

  (Audio)-fliken

Visar konfigurationsobjekten relaterade till ljud.

Visas enligt menyinställningar.*
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 (Stream)-fliken
Visar konfigurationsobjekten relaterade till strömning.
Objekten som visas kommer variera enligt inställning för strömningsformat.
När inställt på [RTMP] eller [SRT-Caller], kan strömningen startas/stoppas på denna skärm.

För information se ”Om strömning” och andra ämnen i ”Konfigurera strömning.”
Felinformation visas om ett anslutningsfel inträffar. För mer information om felinformation, se
”Fel-/varningsmeddelanden.”

 (Others)-fliken
Visar konfigurationsobjekten relaterade till andra funktioner.
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Relaterade avsnitt

Spara/återställa inställningar för pan/tilt, zoomposition och fokusinställningar med Web App

Spela in kamerabildinramningar med hjälp av Web App

Kameraskärmen

Spela in RAW-video

Spåra ett specificerat motiv (Realtime Tracking AF)

Slow & Quick Motion

Ställa in grundläggande känslighet

Justera förstärkningen automatiskt

Justera förstärkningen manuellt

Ändra fördelningen av mörka och ljusa områden i inspelad bild

Justera slutaren automatiskt

Justera slutaren manuellt

Justera bländaren automatiskt

Justera bländaren manuellt

Om ND-filtret

Översikt för utseende

Filma med utseendejustering i efterproduktion

Skärm för justering av vitbalans

Tilldelningsbara knappar

Spela upp inspelade videoklipp

Använda kameramenyn

Om strömning

Fel-/varningsmeddelanden

5-041-958-63(1) Copyright 2022 Sony Corporation

Genom att trycka på knappen [Full Screen Display] öppnas en ny flik i webbläsaren och kamerans bildruta visas i
helskärm.
Endast bildvisning sker; touch AF och andra funktioner är inte tillgängliga.

OBS!

Skärmen för livedrift på originalfliken fortsätter att fungera. Det rekommenderas att du stänger fliken för att minska antalet
samtidiga anslutningar om ingen drift krävs.

Tryck på knappen  (Initiera linskontroll) för att initiera linskontrollen (tillval från tredje part). Den här
knappen aktiveras endast när [Technical] > [Lens Controller] > [Zoom] > [Setting] är inställt till [On] i webmenyn.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur för uppspelningsskärmen

Detta ämne beskriver strukturen för uppspelningsskärmen.

Kamerans bildruta
Visar uppspelningsbilden och relaterad information. När uppspelning stoppas, visas kamerabildskärmen.

1.
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1-1 Filmningsdatum och tid
1-2 Uppspelningsstatusindikator
1-3 Indikator för uppspelningsformat (bildstorlek)
1-4 Indikator för uppspelningsformat (codec)
1-5 Visning videoklippnamn
1-6 Videoklippnummer/totalt antal videoklipp
1-7 Visning LUT-namn
1-8 Strömningsstatusindikator
1-9 Indikator för uppspelningsformat (bildfrekvens och skanningsmetod)
1-10 Inspelningsutseendeindikator

Kontrollpanelen för uppspelning

Visar uppspelningskontrollknapparna.

[Display]-knapp
Tryck på brytaren mellan skärmvisningen på bilden.
[Thumbnail]-knapp
Visar videoklipp som spelas in på minneskortet på kamerans bildruta som miniatyrbilder.

2.

Knapp Funktion

 (Spela/Paus)-knapp Spela upp ett videoklipp. Under uppspelning, pausas videoklippet.

 (Framåtspolning)-knappen, 
(Bakåtspolning)-knappen

Spelar upp ett videoklipp i hög hastighet. När knappen är nedtryckt
ändras uppspelningshastigheten i tre steg.

 (Nästa)-knappen, 
(Föregående)-knappen

Hoppar till början av klippet eller föregående/nästa klipp.

 (Stopp)-knappen Stoppar uppspelning.
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Relaterade avsnitt

Miniatyrbildskärm

Tilldelningsbara knappar

Spela upp inspelade videoklipp

5-041-958-63(1) Copyright 2022 Sony Corporation

Om du trycker på [Thumbnail]-knappen under visning av miniatyrbildskärmen, stängs den och återgår till
kamerabilden.

För information om miniatyrbildskärmen, se ”Miniatyrbildskärm.”

[Slot Select]-knapp
Växlar mellan måluppspelningsmedia.

Tilldelningsbara knappar
Visar vilka tilldelningsbara knappar som är tilldelade till funktioner i enheten.

För information om tilldelningsbara knappar, se ”Tilldelningsbara knappar.”

3.

GUI-kontrollpanelen
Använd GUI-kontrollpanelen för att använda kameramenyn, uppspelningsklipp och andra funktioner.

För information om användning, se ”Använda kameramenyn” och ”Spela upp inspelade videoklipp.”

4.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Struktur för inställningsskärmen

Använd inställningsskärmen för att konfigurera enhetens olika konfigurationsobjekt, bland annat de inledande
inställningarna, nätverksinställningar, inspelnings-/uppspelningsinställningar med hjälp av web-menyn.

OBS!

I web-menyn tillämpas inte som allmän regel inställningarna förrän du trycker på knappen [OK]. Om du ändrar inställningar på en
sida som har en [OK]-knapp, se då till att trycka på knappen [OK].

För information om inställningsskärmen, se ”Webbmeny och detaljerade inställningar.”

5-041-958-63(1) Copyright 2022 Sony Corporation
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameramenyn

Tryck på [Menu]-knappen i GUI-kontrollpanelen på skärmen för livedrift eller uppspelningsskärmen för att visa
kameramenyn i kamerans bildruta.

Du kan konfigurera inställningarna som krävs för att filma eller spela upp med kameramenyn.
Tryck på [Menu]-knappen medan kameramenyn visas för att dölja menyn.
Kameramenyn används med GUI-kontrollpanelen.

För information om kameramenyn, se ”Kamerameny och detaljerade inställningar.”

OBS!

När [Monitoring] > [Output Display] > [HDMI/Stream] är inställt på Off i web-menyn (inaktiveras informationsöverlägg på skärmen),
kameramenyn visas inte längre i kamerans bildruta. Men tänk på att menydriften i GUI-kontrollpanelen fortfarande är aktiv. För att
undvika oavsiktlig användning, var försiktig med att inte utföra några åtgärder med GUI-kontrollpanelen när [HDMI/Stream] är
inställt på Off.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Kameraskärmen

Du kan visa status och inställningar för enheten på kamerans utgångsbild. Ställ in utgångar för vilka skärmen är aktiverad
med [Monitoring] > [Output Display] i web-menyn.
Du kan/dölja denna information med [Display]-knappen. Till och med när den är dold, kommer den synas när du utför
direktmenyåtgärder.
Du kan visa/dölja objekt enskilt med [Monitoring] > [Display On/Off] i kameramenyn.

Information som visas på skärmen när du filmar

Uppladdningsindikator/indikator för kvarvarande filer

För mer information om filöverföring, se ”Om filöverföring” och andra ämnen i ”Överföra filer.”

1.

Fokusområdesindikator
Visar fokusområde för autofokus.

För information om autofokus, se ”Justera automatiskt med hjälp av Web App” och andra ämnen i ”Justera fokus
automatiskt (autofokus).”

2.

Inspelningsläge, öppning A/B, Interval Rec-indikator för intervallinspelning

För information om Interval Rec, se ”Spela in video växelvis (Interval Rec).”

3.

Visning Innebörd

●Rec Inspelning

Stby Inspelning standby

Indikator för fältdjup4.

Indikator för bildskanningsläge5.
57



Ett  (missmatchning) märke visas om det finns missmatchning mellan bildcirkelstorleken för linsen och den faktiska
inställningen för bildstorlek i bildskanningsläget.
När Imager Scan Mode ställs in på FF, visas ett ”C”-märke i lägen med smalare visningsvinkel (beskuren).
Beskärning förekommer i följande lägen.

När inspelningsformatet är 3840×2160 och S&Q Motion är bildfrekvensen 100 fps eller 120 fps
När [Codec] är inställt på RAW eller RAW & XAVC-I och RAW-formatet är 3840×2160
För information om bildskanningsläge, se ”Konfigurera grundläggande användning” i ”Konfigurera grundläggande
användning.”

Statusindikator för RAW-bildformat
Visar utgångsstatus för RAW-signalen.

För mer information om RAW, se ”Spela in RAW-video.”

6.

Indikator för bildfrekvens när man filmar i Slow & Quick Motion

För mer information om Slow & Quick Motion, se ”Slow & Quick Motion.”

7.

Fokuspositionsindikator

Visar fokuspositionen.

8.

Fokuslägesindikator

Ansikts-/ögondetektering AF

För information om ansikts-/ögondetektering AF, se ”Fokusering med ansikts- och ögondetektering (Face/Eye
Detection AF).”

9.

Visning Innebörd

Focus Hold Focus Hold-läge

MF MF-läge

AF AF-läge

 (Läget realtidsspårning med AF) Läget realtidsspårning med AF

Visning Innebörd

 (Ansikts-/ögondetektering AF) Indikerar att ansikts/ögondetektering AF är aktiv

 (endast ansikten/ögon AF) Indikerar att endast ansikten/ögon AF är aktivt

 (sparat spårningsansikte) Indikerar att spårningsansiktet har sparats

 (AF pausad) Anger att AF har pausats*

Visas när det inte finns något sparat spårningsansikte och ett ansikte inte detekteras, eller när det finns ett sparat spårningsansikte men
målspårningsansiktet inte detekteras.

*

Zoompositionsindikator
Visar zoomposition i intervallet 0 (vidvinkel) till 99 (telefoto) (om en lins som stöder zoompositionsvisning är fäst).
Du kan även ändra indikatorn till en fältvisning eller fokallängdsvisning med inställningen [Technical] > [Lens] > [Zoom
Position Display] i kameramenyn.
Följande objekt läggs till displayen när Clear Image Zoom aktiveras.

10.
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För information om zoom, se ”Ställa in zoomtyp” och andra ämnen i ”Justera zoomen.”

Visning Innebörd

 (Clear Image Zoom är aktiverad) Clear Image Zoom aktiveras

Förstoringsvärde När man använder Clear Image Zoom

Indikator för bildstabiliseringsläge11.

SDI-utgång/HDMI-utgång Rec Control-statusindikator
Visar utgångsstatus för REC-kontrollsignalen.

För information, se ”Ansluta externa monitorer och inspelningsenheter.”

12.

Fokusindikator

För information se ”Använda autofokus med en bild (push-autofokus (AF-S))” i ”Justera fokuset.”

13.

Indikator för kvarvarande mediakapacitet
En  (skydda) ikon visas om minneskortet är skrivskyddat.

14.

Indikator för vitbalansläge15.

Visning Innebörd

 (ATW) Autoläge

 (ATW Hold) Autoläge pausat

W:P Förinställt läge

W:A Läget minne A

Indikator för tidskods externa lås/visning tidsdata
Visar ”EXT-LK” när låst till tidskoden för en extern enhet.

För information se ”Specificera tidsdata.”

16.

ND-filterindikator

För information om ND-filter, se ”Justera belysningsnivå (ND-filter).”
För information om bokeh control, se ”Justera Bokeh (Bokeh Control-funktionen).”

17.

Visning Innebörd

 (A) Autoläge

 (B) Bokeh control-läge

Indikator för scenfil

För information om scenfiler, se ”Översikt för utseende” och andra ämnen i ”Filma med önskat utseende”.

18.

Bländarindikator
Visar bländarposition (F-värde) (om en lins som stöder visning av bländarinställning är fäst).

19.
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För information om bländaren, se ”Justera bländaren automatiskt” och ”Justera bländaren manuellt.”
Indikator för videonivåvarning20.

Förstärkningsindikator
Visar EI-värde i Cine EI/Cine EI Quick-läge.

För information om förstärkning, se ”Justera förstärkningen automatiskt” och ”Justera förstärkningen manuellt.”
För information om Cine EI/Cine EI Quick-läge, se ”Konfigurera filmningsläge” i ”Konfigurera grundläggande
användning.”

21.

Visning Innebörd

 (A) Autoläge

L Förinställt L-läge

 (Tillfälligt justeringsläge) Tillfälligt justeringsläge

 (B) Bokeh control-läge

Visning videoklippnamn
Visar namnet på videoklippet som spelas in eller som ska spelas in härnäst.
Om den blinkar stämmer inte det sista videoklippet på inspelningsmediet överens med inställningarna för [Camera ID]
eller [Reel Number]. Du finner mer information i beskrivningen [Clip Name Format] > [Auto Naming].

22.

Slutarindikator

För information om slutaren, se ”Justera slutaren automatiskt” och ”Justera slutaren manuellt.”

23.

AE-läge/AE-nivåindikator

För information om automatisk exponering (AE), se ”Ställa in målnivå för automatisk ljusstyrkejustering.”

24.

Indikator stämningsläge
Visar den horisontala nivån med ökningar på ±1° upp till ±15°.

25.

Ljudnivåmätare
Visar ljudnivån för varje kanal.

26.

Videosignalmonitor
Visar en vågform, vektorskåp eller histogram.
Den orange linjen anger det inställda värdet för ljusstyrkenivåmarkören.
I Loggfilmningslägena visas monitorns mål-LUT-typ ovanför displayen.

För information, se ”Videosignalmonitor.”
För information om Log-filmningslägena, se ”Konfigurera filmningsläge” i ”Konfigurera grundläggande
användning.”

27.

Base Sensitivity-indikator/Base ISO-indikator
I läget Custom visar den grundkänsligheten med [ISO/Gain / Exposure Index]-knappen i kamerans grundläggande
konfigurationspanel eller [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] i kameramenyn.
I Log-filmningslägena visar den Base ISO-känslighet inställd med knappen [ISO/Gain / Exposure Index] i kamerans
grundläggande konfigurationspanel eller [Shooting] > [ISO/Gain/EI] > [Base ISO] i kameramenyn.

För information om grundläggande känslighet, se ”Välja grundläggande känslighet.”
För information om Log-filmningslägena, se ”Konfigurera filmningsläge” i ”Konfigurera grundläggande
användning.”

28.

60



Information som visas på skärmen när du spelar upp

Följande information läggs över uppspelningsbilden.

Monitoring look-indikator
I Lo-filmningsläget visar det monitorns LUT-inställning.

För information om LUT-inställning, se ”Filma med utseendejustering i efterproduktion” och relaterade ämnen.
För information om Log-filmningslägena, se ”Konfigurera filmningsläge” i ”Konfigurera grundläggande
användning.”

29.

Grundutseende/inspelningsutseendeindikator
Visar inställning för Base Look.
I Log-filmningslägena visas videosignalen för att spela in på minneskort.

För information om grundutseende, se ”Översikt för utseende” i ”Filma med önskat utseende.”
För information om Log-filmningslägena, se ”Konfigurera filmningsläge” i ”Konfigurera grundläggande
användning.”

30.

Proxystatusindikator31.

Indikator för inspelningsformat (codec)
Visar namnet på inspelningsformatet på minneskorten.
Ställ in Inspelningsformat (codec) med [Project] > [Rec Format] > [Codec] i web- eller kameramenyn.

32.

Indikator för inspelningsformat (bildfrekvens och skanningsmetod)33.

Indikator för inspelningsformat (bildstorlek)
Visar bildstorlek för inspelning på minneskorten.
Ställ in inspelningsformat (bildstorlek) med [Project] > [Rec Format] > [Codec] i web- eller kameramenyn.

34.

Tally-indikator
Visar en röd eller grön ram runt bilden enligt mottagen extern tally-signal.

35.

Uppladdningsindikator/indikator för kvarvarande filer1.

Videoklippnummer2.
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Relaterade avsnitt

Om filöverföring

Justera automatiskt med hjälp av Web App

Spela in video växelvis (Interval Rec)

Konfigurera grundläggande användning

Spela in RAW-video

Slow & Quick Motion

Fokusering med ansikts- och ögondetektering (Face/Eye Detection AF)

Ställa in zoomtyp

Ansluta externa monitorer och inspelningsenheter

Använda autofokus med en bild (push-autofokus (AF-S))

Specificera tidsdata

Översikt för utseende

Justera bländaren automatiskt

Justera bländaren manuellt

Justera förstärkningen automatiskt

Justera förstärkningen manuellt

Justera slutaren automatiskt

Justera slutaren manuellt

Ställa in målnivå för automatisk ljusstyrkejustering

Videosignalmonitor

Filma med utseendejustering i efterproduktion

Clip Name Format

5-041-958-63(1) Copyright 2022 Sony Corporation

Indikator för uppspelningsstatus3.

Indikator för uppspelningsformat (bildfrekvens och skanningsmetod)4.

Indikator för uppspelningsformat (bildstorlek)5.

Indikator för uppspelningsformat (codec)6.

Mediaindikator
En  (skydda) ikon visas om minneskortet är skrivskyddat.

7.

Tidsdatavisning8.

Visning videoklippnamn9.

Gammavisningsassistans-indikator10.

Ljudnivåmätare
Visar ljuduppspelningsnivå.

11.

Grundutseende/inspelningsutseendeindikator12.

Tally-indikator13.
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Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Montera upprätt på en fast plats

Detta ämne beskriver hur man monterar enheten på en bänkskiva eller stativ.

Installationsanmärkning
För att skydda linsen och linsens anslutningsblock, ska du behålla locket och skyddet till enheten tills du har fäst
linsen.
För att undvika linshaveri ska du inte hålla i linsdelar när du arbetar.
För att undvika enhetshaveri ska du inte hålla i kamerahuvudet när du arbetar.

Kontrollera monteringsutrymmet.

När du monterar på en bänkskiva
Montera denna enhet på en plan yta och beakta det utrymme som krävs för att vrida linser och kablaget på
enhetens baksida.

OBS!

Montera på en stabil plats som inte är utsatt för vibration. Platser utsatta för vibration kan orsaka vibration i bilden.

Om enheten måste monteras på en lutad yta, håll den inom ±15° horisontalt, och vidta åtgärder för förhindra enheten från
att falla ned.

När du monterar på ett stativ
Fästa stativet eller stativets monteringsskruv på botten.
Använd en monteringsskruv till stativet med följande utskjutning från monteringsytan och dra åt med en
skruvmejsel.

A: Stativets monteringsskruvar 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Utskjutning (4,5 mm till 5,5 mm)

1
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Nästa, fäst linsen. Se ”Fästa en lins,” ha i åtanke information i ”Säkerhetsföreskrifter när man kopplar/kopplar bort en
lins,” ”Kontrollera linsbrytarna,” och ”Säkerhetsföreskrifter när man använder en zoomlins.”

Relaterade avsnitt

Säkerhetsföreskrifter när man kopplar/kopplar bort en lins

Kontrollera linsbrytarna

Säkerhetsföreskrifter när man använder en zoomlins

Fästa en lins

5-041-958-63(1) Copyright 2022 Sony Corporation

Använd inte stativskruvar för att montera enheten på en högt belägen plats.

OBS!

Välj ett stativ som inte välter även när linsen vrider på sig.
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Montera upprätt på en högt belägen, fast plats

Detta ämne beskriver hur man monterar enheten upprätt på en högt belägen plats med takfästet (CIB-PCM1 (tillval)).

För att montera enheten på en högt belägen plats, anlita ett proffs.
När du monterar på en högt belägen plats, se då till att monteringsytan och monteringsmaterialet (tillbehör
undantaget) klarar av 200 kg eller mer och montera enheten enligt beskrivningen i denna hjälpguide. Om
monteringen inte är stadig nog, kan enheten ramla ned och orsaka allvarlig skada.
Fäst den medföljande fallskyddsvajern i CIB-PCM1 takfäste (tillval) för att undvika att enheten ramlar ned.
När enheten har monterats på en högt belägen plats, kontrollera då en gång om året att monteringen inte har lossnat.
Förkorta inspektionsintervallet enligt användningsförhållanden.

Installationsanmärkning
För att skydda linsen och linsens anslutningsblock, ska du behålla linslocket och skyddet på tills linsen är fäst.
För att undvika linshaveri ska du inte hålla i linsdelar när du arbetar.
För att undvika enhetshaveri ska du inte hålla i kamerahuvudet när du arbetar.

Kontrollera tillbehören till montering på en högt belägen plats samt monteringsutrymme.

CIB-PCM1 takfästekitt (tillval)
Innan du startar ska du kontrollera att du har följande delar.

Fäste till enheten (1)
Takfäste (1)
Linsfrigöringsknappskydd (1)
Fallskyddsvajer (1)
+PSW M3×8-skruvar (9)
+PSW M4×8 skruvar i rostfritt stål för fallskyddsvajer (1)

OBS!

1

65



Fallskyddsvajern är utformad för att stödja enheten när den hängs upp. Tillämpa inte någon belastning på den utöver
enhetens belastning.

Monteringsutrymme
Se följande ritning när du ska fastställa monteringsplats och riktning, och beakta det utrymme som krävs för att vrida
linser och kablaget på enhetens baksida.

A: Kamerahuvudets rörelseräckvidd (t.ex. SEL70200GM2 (med SEL20TC fäst): Ø370)
B: Takfäste (hål på monteringsytans sida (Ø150))
C: Hål monteringsinriktning

OBS!

Montera på en stabil plats som inte är utsatt för vibration. Platser utsatta för vibration kan orsaka vibration i bilden.

Om enheten måste monteras på en lutad yta, håll den inom ±15° horisontalt, och vidta åtgärder för förhindra enheten från
att falla ned.

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.2
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OBS!

Om kamerahuvudets pan/tilt inte låses när låsspaken är i läget LOCK, flytta då kamerahuvudet manuellt tills det låses i
position.

Fäst enhetens fäste i botten av enheten med de sex medföljande skruvarna (M3×8).3
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Använd de medföljande skruvarna. Användning av andra skruvar än de medföljande skruvarna kan skada enhetens
insida.

Fäst fallskyddsvajern i enhetens fäste.4
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A: Vajer som medföljer 
B: Phillips-skruv som medföljer (M4×8)
C: Metallögla till vajer

Använd den medföljande skruven. Användning av annan skruv än den medföljande skruven minskar effektiviteten
för vajerns funktion.

Fäst takfästet i ytan, till exempel en hylla, där enheten ska monteras.5
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A: Vägg 
B: △ märke (kameras framåtriktning)
C: Hål för anslutningskablar
D: Hylla eller annan monteringsyta

Fäst fallskyddsvajern i en punkt nära monteringsytan.

Använd en M5 (3/16 tum) skruv med sexkantshuvud (tillval) och fäst den i ett föremål nära hyllan eller ytan till vilken
takfästet ska fästas.

6
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A: Vajer 
B: Skruv med sexkantshuvud (M5, 3/16 tum)

Passa in skruvhålet 〇 framför enhetens fäste med hålet ◇ i takfästet, och för in enheten och fixera tillfälligt
enhetens fäste i takfästet genom att vrida den medurs.

7
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A:〇 hål
B: ◇ hål

Fäst enhetens fäste och takfästet med de tre medföljande roteringslockskruvarna (M3×8).8
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Nästa, fäst linsen. Se ”Fästa en lins,” ha i åtanke information i ”Säkerhetsföreskrifter när man kopplar/kopplar bort en
lins,” ”Kontrollera linsbrytarna,” och ”Säkerhetsföreskrifter när man använder en zoomlins.”

OBS!

Efter att en lins har fästs ska du kontrollera att linsen sitter säkert.
Linsen inte har inget skydd mot fall. Sony åtar sig inget ansvar för en lins som ramlar av enheten.

Relaterade avsnitt

Säkerhetsföreskrifter när man kopplar/kopplar bort en lins

Kontrollera linsbrytarna

Säkerhetsföreskrifter när man använder en zoomlins

Fästa en lins

Kontrollera monteringsstatus.

Specifikt ska du kontrollera följande artiklar. 

Monteringsskruvarna är korrekt fästa.
Fallskyddsvajern är korrekt fäst och inte tilltrasslad.
Enhet är jämnt monterad (utan lutning eller vingel).
Enheten snurrar inte fritt när den vrids.

9
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Montera i ett tak

Detta ämne beskriver hur man monterar enheten i ett tak med takfästet (CIB-PCM1 (tillval)).

För att montera enheten i ett tak, anlita ett proffs.
När du monterar i ett tak, se då till att monteringsytan och monteringsmaterialet (tillbehör undantaget) klarar av 200
kg eller mer och montera enheten enligt beskrivningen i denna hjälpguide. Om monteringen inte är stadig nog, kan
enheten ramla ned och orsaka allvarlig skada.
Fäst den medföljande fallskyddsvajern i CIB-PCM1 takfäste (tillval) för att undvika att enheten ramlar ned.
När enheten har monterats i ett tak, kontrollera då en gång om året att monteringen inte har lossnat. Förkorta
inspektionsintervallet enligt användningsförhållanden.

Installationsanmärkning
För att skydda linsen och linsens anslutningsblock, ska du behålla linslocket och skyddet på tills linsen är fäst.
För att undvika linshaveri ska du inte hålla i linsdelar när du arbetar.
För att undvika enhetshaveri ska du inte hålla i kamerahuvudet när du arbetar.

Kontrollera tillbehören till takmontering samt monteringsutrymme.

CIB-PCM1 takfästekitt (tillval)
Innan du startar ska du kontrollera att du har följande delar.

Fäste till enheten (1)
Takfäste (1)
Linsfrigöringsknappskydd (1)
Fallskyddsvajer (1)
+PSW M3×8-skruvar (9)
+PSW M4×8 skruvar i rostfritt stål för fallskyddsvajer (1)

OBS!

1
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Fallskyddsvajern är utformad för att stödja enheten när den hängs upp. Tillämpa inte någon belastning på den utöver
enhetens belastning.

Monteringsutrymme
Se följande ritning när du ska fastställa monteringsplats och riktning, och beakta det utrymme som krävs för att vrida
linser och kablaget på enhetens baksida.

A: Kamerahuvudets rörelseräckvidd (t.ex. SEL70200GM2 (med SEL20TC fäst): Ø370)
B: Takfäste (hål på taksidan (Ø150))
C: Hål monteringsinriktning

OBS!

Montera i ett tak (som betong) med tillräcklig bärfasthet.

Om taket saknar tillräcklig bärfasthet, förstärk det då.

Montera på en stabil plats som inte är utsatt för vibration. Platser utsatta för vibration kan orsaka vibration i bilden.

Om enheten måste monteras på en lutad yta, håll den inom ±15° horisontalt, och vidta åtgärder för förhindra enheten från
att falla ned.

Sidan mittemot märket △ på takfästet är filmningsriktning (kamerans framsida).

Skjut pan/tilt-låsspaken till UNLOCK-läget för att låsa upp kamerahuvudets pan/tilt-funktion med 180° i tilt-
riktning.

2

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.3
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Kamerahuvudet vridet 180°

OBS!

Om kamerahuvudets pan/tilt inte låses när låsspaken är i läget LOCK, flytta då kamerahuvudet manuellt tills det låses i
position.

Fäst enhetens fäste i botten av enheten med de sex medföljande skruvarna (M3×8).4
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Använd de medföljande skruvarna. Användning av andra skruvar än de medföljande skruvarna kan skada enhetens
insida.

Fäst tackfästet i en monteringsplatta (tillval) och fäst därefter plattan i taket.5
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A: Takfäste
B: Tak
C: Monteringsplatta
D: △ hål
Fäst fästet enligt takfästets riktning
Observera att när monterat i ett tak sitter kamerans framsida på motsatt sida av takfästet i jämförelse med en
normal upprätt montering. Montera korrekt enligt diagrammet som indikerar monteringsriktningen.

A: Fram för upprätt montering (△ hålets riktning)
B: Fram för takmontering

OBS!

Monteringens ytmaterial ansvarar kunden för.

Fäst fallskyddsvajern i taket.6
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A: Takfäste
B: Skruv med sexkantshuvud (M5, 3/16 tum)
C: Vajer (medföljer)
D: Monteringsplatta
E: Tak

Dra fallskyddsvajern genom hålet i mitten av takfästet och fäst det i enhetens fäste.

Dra fallskyddsvajern genom vajerns metallögla i enhetens fäste och fäst de ordentligt i fästet med den medföljande
skruven i rostfritt stål (M4×8).

A: Vajer som medföljer
B: Phillips-skruv som medföljer (M4×8)
C: Metallögla till vajer

7
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Använd den medföljande skruven. Användning av annan skruv än den medföljande skruven minskar effektiviteten
för vajerns funktion.

OBS!

Det rekommenderas att en person håller enheten så som visas i följande diagram medan en annan person monterar
enheten.

Håll inte i kamerahuvudet eller linsstödet medan du monterar enheten. Det finns en risk för skada om enheten tappas eller
faller ned.

Var försiktig när du drar kablage till elkontakter och kablar så att de inte blir kortslutna av fallskyddsvajern.

Monteringen klarar av en upphängd massa på upp till 8,8 kg (inklusive linsen). För att undvika att enheten ramlar ned,
överskrid inte den maximala massan.

Passa in skruvhålet (A) med enhetens fäste med ◇ hål (B) på takfästet och för in enheten och vrid den cirka
60 grader medurs tills skruvhålet (A) och skruvhålet (C) är inpassade.

8
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A: Skruvhål i enhetens fäste
B: Skruvhålet på takfästet (◇ hole)
C: Skruvhål
D: Tak
E: Monteringsplatta

Fäst enhetens fäste och takfästet med de tre medföljande roteringslockskruvarna (M3×8).9
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Nästa, fäst linsen. Se ”Fästa en lins,” ha i åtanke information i ”Säkerhetsföreskrifter när man kopplar/kopplar bort en
lins,” ”Kontrollera linsbrytarna,” och ”Säkerhetsföreskrifter när man använder en zoomlins.”

OBS!

För att använda pan-tilt korrekt när enheten är monterad i ett tak, ställ in [Pan-Tilt] > [Direction] > [Ceiling] till [On] i web-menyn.

Efter att en lins har fästs ska du kontrollera att linsen sitter säkert.
Linsen inte har inget skydd mot fall. Sony åtar sig inget ansvar för en lins som ramlar av enheten.

Relaterade avsnitt

Säkerhetsföreskrifter när man kopplar/kopplar bort en lins

Kontrollera linsbrytarna

Säkerhetsföreskrifter när man använder en zoomlins

Kontrollera monteringsstatus.

Specifikt ska du kontrollera följande artiklar.

Monteringsskruvarna är korrekt fästa.
Fallskyddsvajern är korrekt fäst och inte tilltrasslad.
Enhet är jämnt monterad (utan lutning eller vingel).
Enheten snurrar inte fritt när den vrids.

10
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Fästa en lins
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Säkerhetsföreskrifter när man kopplar/kopplar bort en lins

Linsen får inte vara bänd mot solen. Direkt solljus kan komma in genom linsen, fokuseras i enheten och orsaka brand.

OBS!

Koppla/koppla bort en lins när enheten är avstängd.

En lins är en precisionskomponent. Placera inte linsen på en yta med linsen vänd nedåt. Fäst den medföljande linsens
monteringslock.

Tips

För information om linser som stöds av enheten, kontakta din Sony-servicerepresentant.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Kontrollera linsbrytarna

Följande kontroller och inställningar krävs beroende på typ av lins.

För en lins med fokusbrytarläge

Ställ in brytaren till AF/MF eller AF.
Om brytaren är inställd på MF eller Full MF, kan fokus endast justeras med linsringen.

OBS!

När man använder en A-monterad lins, är det möjligt att manuell justering från en fjärrkontrollenhet inte är tillgängligt.

För en lins med zoombrytare

Ställ brytaren till SERVO.
Om brytaren är inställd på MANUAL, kan zoomen endast justeras med zoomringen. Zoom-kontroll från enheten har
ingen effekt.

För en lins med Auto Iris-brytare

Ställ brytaren till AUTO.
Om inte inställt till AUTO, kan bländaren endast justeras med linsringen. Detta påverkar inte användning av bländaren
från enheten.

För en lins med bildstabiliseringsbrytare

Ställ brytaren till OFF.
Om brytaren är inställd på ON, kan det uppstå oväntat beteende under pan/tilt-drift.

SELP28135G

A: Flytta fokusringen till forwardposition (AF/MF-läge).
B: Ställ ZOOM-brytaren till läget SERVO.
C: Ställ irisringen på ”A” och IRIS LOCK-omkopplaren till LOCK-läget.
D: Ställ bildstabiliseringsbrytaren till OFF.
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Säkerhetsföreskrifter när man använder en zoomlins

När man använder en zoomlins utöver en power zoom-lins, kan zoompositionen ändras beroende på monteringsmiljö.
Säkra zoomringens position med tejp i enlighet med användningssyfte.

Plastfilmstejp: 471 BLA 50 eller motsvarande

5-041-958-63(1) Copyright 2022 Sony Corporation
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Fästa en lins

Detta ämne beskriver hur man fäster en E-monterad lins eller en A-monterad lins.

OBS!

Transportera inte enheten med linsen fortfarande monterat.

När du använder en A-monterad lins, ställs bländaren in manuellt och fokus ställs in på MF.

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.

OBS!

Om kamerahuvudets pan/tilt inte låses när låsspaken är i läget LOCK, flytta då kamerahuvudet manuellt tills det låses i
position.

1

Vrid på skruven till klämspaken till linsens stödsockel moturs för att lossa på locket. Flytta därefter skruven
till linsens stödsockel till en position där den inte krockar med linsen.

A: Korrekt

2
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B: Inkorrekt

Vrid på kamerahuvudets låsspak i pilriktningen för att låsa upp kamerahuvudet.

OBS!

Tills kamerahuvudet är låst igen, finns det en risk att kamerahuvudet kan förflytta sig under sin egen vikt. Stöd
kamerahuvudet med din hand medan du utför uppgiften.

3

Skjut på kamerahuvudet till positionen längst fram.4

Vrid på kamerahuvudets låsspak i pilriktningen för att låsa kamerahuvudet.5
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OBS!

Se till att kamerahuvudets låsspak inte kommer i kontakt med andra delar för att undvika att störa lutningen.

Ta bort locket och höljet från enheten och linsen.6

Rikta in linsens monteringsmärke (vitt) med enheten och för försiktigt in linsen i kamerahuvudet och vrid
sedan linsen medurs tills du hör ett klickljud när den låses i position.

A: Monteringsmärken (vitt)

OBS!

För att använda en A-monterad lins, fäst en linsmonteringsadapter (tillval) till enheten och fäst den A-monterade linsen.

7

Vrid på kamerahuvudets låsspak i pilriktningen för att låsa upp kamerahuvudet.8
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OBS!

Tills kamerahuvudet är låst igen, finns det en risk att kamerahuvudet kan förflytta sig under sin egen vikt. Stöd
kamerahuvudet med din hand medan du utför uppgiften.

Bevara kamerahuvudets balans framåt och bakåt så att basen förblir horisontal.

Om du använder en eller flera av följande linser då kan du väga enheten och linsen på ett ungefär med vågen på
basen.

9

Vågposition Linsnamn

0,5 SEL70200GM (med SEL20TC fäst)

1,7 SEL70200GM

2,0 SEL70200GM2 (med SEL20TC fäst)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G
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OBS!

Använd vågen på basen som en referens för ungefärligt vikt.

När du fäster linsen se då till att göra lämpliga justeringar på vågen så att enheten inte vickar fram och tillbaka.

Justera vågen på en horisontal yta.

Ta bort linsens stödenhet när du använder SELC1635G.

Vågposition Linsnamn

5,0 eller högre SEL1224GM, SEL1635GM, SELP1635G, SELP18105G, SELP1020G

Vrid på kamerahuvudets låsspak i pilriktningen för att låsa kamerahuvudet.

OBS!

Se till att kamerahuvudets låsspak inte kommer i kontakt med andra delar för att undvika att störa lutningen.
Bekräftelsemetod: Skjut panorerings-/lutningslåset till UNLOCK-läget, vrid kamerablocket så att det är vänt uppåt för hand
och kontrollera visuellt att det inte är i kontakt med andra delar. Om det finns kontakt, vrid kamerahuvudets låsspak igen i
pilriktningen.

10

Vrid linsens stödklämspakar moturs för att lossa på linsens stödenhet.11
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A: Linsens stödklämspak (2 platser)
B: Linsens stödenhet

Flytta linsens stödenhet så att linsstödets sockel är inriktad med dess fästskruv, och vrid därefter skruven
medurs för att säkra linsens stödsockel.

OBS!

Se till att linsens stödsockel är lodrät mot dess fästskruv och dra sedan åt.

12

Vrid på skruven till klämspaken till linsens stödsockel medurs för att låsa den.

A: Skruv till linsens stödsockel
B: Skruvhål
C: Klämspak till linsens stödsockel

Tips

Om en klämspak är i en position där den inte går att vrida, frigör då klämspaken och rotera den till en vinkel som underlättar
driften. När i önskat läge, stäng klämspaken.

13
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Relaterade avsnitt

Kalibrera en E-monterad lins

5-041-958-63(1) Copyright 2022 Sony Corporation

A: Klämspak till linsens stödsockel
B: Linsens stödklämspak

Vrid linsens två stödklämspakar medurs för att säkra linsens stödenhet.14

Kontrollera att båda spakarna är åtdragna och inte sitter lösa, att linsen är ordentligt fäst och att
linsbrytaren sitter korrekt.

Om en spak är lös eller om linsen inte är korrekt fäst, då kan linsen ramla ned och skadas.
När man använder en E-monterad power zoom-lins, då måste även linsen kalibreras separat för att noggrant
återställa zoompositionerna lagrade i kameran som förinställningspositioner. För information, se ”Kalibrera en E-
monterad lins.”

15
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Ta bort en lins

Ta bort en lins genom att göra tvärtom mot när du fäster den.

OBS!

Greppa linsen säkert i din hand för att undvika att den faller ned.

Om ingen annan lins ska fästas omgående, sätt då på locket.

Relaterade avsnitt

Fästa en lins

5-041-958-63(1) Copyright 2022 Sony Corporation

Kontrollera att pan/tilt är låst.1

Vrid på klämhandtaget till linsens stödsockel moturs för att lossa på locket.2

Ta bort skruven till linsens stödsockel på linsstödenheten och flytta den till en position där den inte krockar
med linsen.

3

Lås upp kamerahuvudet och skjut kamerahuvudet till positionen längst fram.

För mer info se stegen 3 till 5 i ”Fästa en lins.”

4

Tryck och håll ned linsens frigöringsknapp och vrid linsen moturs medan du stödjer linsen.5

Med kamerans monteringsmärken (vitt) och linsen inpassad, dra ut linsen framåt.6
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Ansluta kablar

Detta ämne beskriver kabelanslutningar.

5-041-958-63(1) Copyright 2022 Sony Corporation

Anslut nödvändiga kablar till kontakterna på bakpanelen.

För att förhindra att HDMI-kabeln tas bort, skruva bort skruven till HDMI-kabelhållarplattan (M2.6×6, svart) från
anslutningsblocket och fäst den medföljande HDMI-kabelhållarplattan med skruven. Säkra HDMI-kabeln till HDMI-
kabelhållarplattan med ett vanligt buntband.

A: Skruv till HDMI-kabelhållarplatta (M2.6×6, svart)
B: Vanligt buntband
C: HDMI-kabelhållarplatta (medföljer)

1
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Ansluta en enhet till en nätverksenhet via trådbunden anslutning

Detta ämne beskriver hur man ansluter enheten till en nätverksenhet via en trådbunden anslutning.

5-041-958-63(1) Copyright 2022 Sony Corporation

Anslut enheten till nätverksenheten (som en Wi-Fi-åtkomstpunkt eller switchhubb) med en LAN-kabel i
kategori 5e eller högre.

1
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Använda AC-ström

Detta ämne beskriver hur man tillför ström till enheten med AC-ström.

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.1

Anslut AC-adaptern (medföljer) till enhetens DC IN-kontakt och anslut strömsladden (medföljer) till en AC-
strömkälla.

A: DC IN-kontakt
B: Strömsladd
C: AC-adapter

2

Säkra AC-adaptersladden med sladdklämman om du vill förhindra att sladden kopplas ur.

Lås upp klämman och dra sladden genom sladdklämman så som visat nedan samt lås klämman.

3
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OBS!

Använd inte någon AC-adapter eller strömsladd utöver de som medföljde enheten. Om du ansluter en annan adapter eller
strömsladd kan det orsaka brand eller fel.

Anslut och använd inte en AC-adapter i ett slutet utrymme, såsom en vägg eller möbel.

Kortslut inte metalldelar tillhörande kontakten till AC-adaptern. Om du gör det kan det orsaka fel.

Anslut AC-adaptern till närmaste AC-strömkälla. Om ett problem uppstår under användning, koppla då omgående bort
strömsladden från AC-strömkällan.

A: Sladdklämma
B: Lås till sladdklämma
C: AC-adaptersladd

Kontrollera att POWER-lampan på enhetens framsida ändras från blinkar grönt till fast grönt sken och att
uppstarten har slutförts.

När enheten har startat normalt och anslutits till nätverket, tänds NETWORK-lampan i grönt.

När man använder en lins som inte stöder pan/tilt-användning, lås pan/tilt-låsspaken och hoppa över
efterföljande steg. För mer information om linser som stödjer pan/tilt, kontakta din återförsäljare eller Sony-
servicerepresentant.

4

Skjut pan/tilt-låsspaken till UNLOCK-läget för att låsa upp kamerahuvudets pan/tilt-funktion.5

Återställa pan/tilt.

För mer info, se ”Återställa pan/tilt.”

6
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När du kopplar bort AC-adaptern från enheten, greppa kontakten och dra den rakt ut. Att dra i kabeln kan orsaka fel.

Relaterade avsnitt
Återställa pan/tilt

5-041-958-63(1) Copyright 2022 Sony Corporation
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Använda PoE++-strömförsörjning

När enheten är ansluten till en PoE++-kompatibel strömförsörjningsenhet, kommer strömmen till enheten via en vanlig
nätverkskabel tillgänglig i handeln.
Med denna metod är det möjligt att tillföra ström till enheten utan behov av strömkablar där det inte finns något
strömförsörjningsuttag i närheten.

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.1

Anslut enheten och en PoE++-kompatibel strömförsörjningsenhet med en vanlig nätverkskabel tillgänglig i
handeln.

A: Nätverkskabel
B: PoE++-kompatibel strömförsörjningsenhet

2

Kontrollera att POWER-lampan på enhetens framsida ändras från blinkar grönt till fast grönt sken och att
uppstarten har slutförts.

När enheten har startat normalt och anslutits till nätverket, tänds NETWORK-lampan i grönt.

OBS!

3
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OBS!

Enheten överensstämmer med IEEE802.3bt Typ 4 Klass 8. För mer information om verifierade PoE++-kompatibla
strömförsörjningsenheter, kontakta din återförsäljare eller Sony-servicerepresentant.

Enheten är överensstämmande med mjuk autentisering (LLDP), men det kan krävas en konfiguration av nätverksenheter
(IEEE802.3bt-överensstämmande).

Anslut inte en AC-adapter när du använder en PoE++-strömförsörjning med mjuk autentisering (LLDP) aktiverat.

Om en AC-adapter och PoE++-strömförsörjningsenhet ansluts samtidigt kommer strömmen från AC-adaptern.

När man försörjer ström via PoE++, använd en nätverkskabel i kategori 5e eller högre.

Vänta cirka 10 sekunder efter att du slagit på enheten igen när strömmen kommer via PoE++.

När du använder PoE++-strömförsörjning, anslut då jordkontakten till jord.

När du ansluter via PoE++-strömförsörjning, kör inte något utomhuskablage.

Relaterade avsnitt

Återställa pan/tilt

5-041-958-63(1) Copyright 2022 Sony Corporation

När strömmen kommer från PoE++, utförs inledande autentisering under intervallet fram tills uppstarten är klar.

När man använder en lins som inte stöder pan/tilt-användning, lås pan/tilt-låsspaken och hoppa över efterföljande steg. För
mer information om linser som stödjer pan/tilt, kontakta din återförsäljare eller Sony-servicerepresentant.

Skjut pan/tilt-låsspaken till UNLOCK-läget för att låsa upp kamerahuvudets pan/tilt-funktion.4

Återställa pan/tilt.

För mer info, se ”Återställa pan/tilt.”

5
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Återställa pan/tilt

Du kan återställa pan-tilt, när du till exempel ersätter linsen, och det gör du så här.

5-041-958-63(1) Copyright 2022 Sony Corporation

Skjut pan/tilt-låsspaken till UNLOCK-läget för att kontrollera att kamerahuvudets pan/tilt-funktion är upplåst.1

Utför återställningsfunktionen för pan/tilt.

Pan/tilt-återställning kan utföras från den infraröda fjärrkontrollen, Web App eller RM-IP500-fjärrkontrollen (tillval).

Om man använder den infraröda fjärrkontrollen: Tryck då på P/T RESET-knappen.
Om man använder Web App: Tryck då på  (Panorering/lutning återställning)-knappen på fliken 
(Others) på kamerakontrollpanelen på skärmen för livedrift.
Du finner mer information om att använda RM-IP500 i bruksanvisningen för RM-IP500.

OBS!

Utföra pan/tilt-återställning får kamerahuvudet och linsen att vrida sig. Kontrollera att linsen är ren innan du gör detta.

Enheten har en funktion som begränsar pan/tilt-räckvidden, men denna funktion är inaktiverad när enheten är påslagen
eller återställning av pan/tilt utförs.

Tips

När återställning av pan/tilt är slutfört, då återgår enheten till positionen före utförandet.

2
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Gå till Web App från en webbläsare

Genom att ansluta enheten till en surfplatta eller dator kan du använda och konfigurera enheten från en webbläsare.

Kontrollera huruvida din surfplatta eller dator stödjer Web App-användning.

OBS!

Om den miljö som krävs inte uppfylls, eller beroende på användningen av surfplattan/datorn, kan videovisningen i en
webbläsare påverkas negativt.

Web App för denna enhet använder JavaScript. Om du använder antivirus på din surfplatta/dator, kanske webbsidan inte
visas ordentligt.

1

Objekt Krav

Visning
1080×810 pixlar eller högre rekommenderas
Surfplattans visningsstorlek: 10 tum eller större
rekommenderas

Stödda operativsystem och
webbläsare

Windows
OS Windows 10 eller senare

Webbläsare Google Chrome

Mac

OS macOS 10.15 eller senare

Webbläsare
Google Chrome
Safari

iPad

OS iPadOS 15 eller senare

Webbläsare
Google Chrome
Safari

Android
OS Android 12 eller senare

Webbläsare Google Chrome

Kontrollera att enheten, surfplattan eller datorn och kringutrustning är påslagna.2

Kontrollera att enheten och surfplattan eller datorn är anslutna via Wi-Fi eller trådbunden LAN-anslutning.3

Anslut till enheten från din surfplattas webbläsare eller dator.

Ansluta med hjälp av en QR-kod
Skanna QR-koden som finns tryckt på baksidan av medialocket på enheten med hjälp av en kameran i surfplattan.

4
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OBS!

Om HTTP-portnumret ändrades från ett värde på 80, ange ”Enhetens http://IP-adress:Portnummer” i adressfältet.

När du ansluter en QR-kod eller genom att ange URL:en i adressfältet i en webbläsare, använd en enhet som stödjer mDNS*.

Tips

Du kan därefter komma åt enheten snabbt med webbläsarens bokmärkesfunktion.

5-041-958-63(1) Copyright 2022 Sony Corporation

Öppna länken som visas på surfplattan.
Webbläsaren på surfplattan startas och visar enhetens Web App-skärm.

Ansluta genom att föra in en URL i en webbläsares adressfält
Starta en webbläsare på surfplattan eller datorn och ange den URL som finns tryckt på sidan av medialocket på
enheten.
Webbläsaren ska visa enhetens Web App-skärm.

Ansluta genom att föra in enhetens IP-adress i webbläsarens adressfält
Starta en webbläsare på din surfplatta eller dator och ange ”enhetens http://IP-adress” i adressfältet.
Webbläsaren ska visa enhetens Web App-skärm.

mDNS: Ett kommunikationsprotokoll som används för att fastställa IP-adress från ett värdnamn till ett lokalt nätverk.*
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Starta enheten

Se till att konfigurera enheten med följande metod när du använder enheten för första gången.

Tips

Om reservbatteriet laddas ut helt, då måste du konfigurera den inledande konfigurationen igen.

Anslut till enheten från en surfplatta eller dator och starta Web App.

När enheten används för första gången, då blir du uppmanad att ange ett användarnamn och lösenord i
webbläsaren. Ange följande inställningar.

Användarnamn: admin
Lösenord: (lämna tomt)

Följ instruktionerna på skärmen för att konfigurera inledande konfiguration.

1

Ange administratörsanvändarnamnet (Administrator) och lösenordet och tryck på [OK]-knappen.

1: Ange administratörens användarnamn.
2: Ställ in administratörslösenordet.
3: Ange samma lösenord igen för att bekräfta.

OBS!

Följande tecken kan användas i användarnamnet och lösenordet. Lösenordet måste innehålla minst en stor bokstav, en
liten bokstav och en siffra, och vara minst 8 till 64 tecken långt.

Alfanumeriska tecken

2
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Liveskärmen för filmning visas. Fortsätt att konfigurera enhetens grundläggande användning i enlighet med
användningsläge.

Tips

I vissa fall, till exempel när du använder enheten med en surfplatta som ett par, kan det vara enklare att använda en fast IP-
adress för enheten.

Symboler (!$%`*+-./<=>?@[]^_{|}~)

Din webbläsare kommer laddas om och du uppmanas att ange användarnamn och lösenord.

Ange användarnamn och lösenord som konfigurerades i steg 2.

Efter det visas konfigurationsskärmen för språk och klocka.

3

Ange följande objekt och tryck på [OK] -knappen.

[Language]
Välj det språk som ska användas för Web App och kameraskärmvisningen. Att ändra språket ändrar
visningsspråket i Web App.
[Date & Time Format]
Väljer visningsformat för datum och tid från följande alternativ.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
”yyyy” indikerar år, ”mm” indikerar månad, ”dd” indikerar dag, ”hh” indikerar timme, ”mm” indikerar minuter och ”ss”
indikerar sekund.
[12 h/24 h]
Välj [12 h] (12-timmars klocka) eller [24 h] (24-timmars klocka) för tidsvisningen.
[Time Setting]
Välj metod för att ställa in datum/tid.
[Synchronize with PC]: Synkronisera datum/tid med datorn eller surfplattan.
[Manual setting]: Ställ in manuellt. När denna metod väljs, visas inmatningsfält för datum och tid.
[Time Zone]
Välj tidszon.

4
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Om du vill ställa in en fast IP-adress stänger du först av [Network] > [Wired LAN] > [IPv4] > [DHCP] (skjutreglage i vänster läge) i
web-menyn.

Inställningsobjekten för en fast IP-adress visas. Konfigurera objekten och tryck sedan på knappen [OK] på skärmen.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Konfigurera grundläggande användning

Detta ämne beskriver hur man konfigurerar enheten för grundläggande användning.

Ställer in filmningsläge

Du kan välja filmningsläge för enheten för att matcha arbetsflödet.

Custom-läge: Skapa bilder flexibelt under filmning.
Loggfilmningslägen: Spelar in S-Log-innehåll.

Flexible ISO-läge: Exponeringsinställningarna ställs in med ISO-värdejusteringar som matchar motivet som
filmas.
Cine EI-läge/Cine EI Quick-läge: Använd enheten på samma sätt som en filmkamera (inte skapa bilder helt vid
fotografering), med bilder som framkallas i efterproduktion.

I Cine EI Quick-läget väljs automatiskt en baskänslighet som är lämplig för inställningen för exponeringsindex.
Ställ in filmningsläge med hjälp av [Project] > [Base Setting] > [Shooting Mode] i web- eller kameramenyn.

Custom-läge
Du kan välja videostandard.
Ställ in [Project] > [Base Setting]> [Target Display] i web- eller kameramenyn.

[SDR(BT.709)]: Filma med HD-sändningsstandard
[HDR(HLG)]: Filma med nästa generations 4K-sändningsstandard

För detaljer, se ”Översikt för utseende” och andra ämnen i ”Filma med önskat utseende”.

Loggfilmningslägen
(Flexible ISO-läge/Cine EI-läge/Cine EI Quick-läge)
I Loggfilmningslägena väljer du basfärgsomfång för inspelade signaler och utsignaler. Färgomfånget som väljs här är
färgomfånget för videobilden när [LUT On/Off] är inställt på [MLUT Off].
Du kan ändra färgomfånget med [Project] > [Cine EI/Flex.ISO Set] > [Color Gamut] i kameramenyn.

[S-Gamut3.Cine/SLog3]: Enkelt att justera färgomfång för digital cinema (DCI-P3).
[S-Gamut3/SLog3]: Sonys breda färgskala som täcker ITU-R BT.2020-färgomfånget.

För information, se ”Filma med utseendejustering i efterproduktion.”
 
Funktioner som kan användas i varje filmningsläge finns i följande tabell.
●: Stöds, –: Stöds inte

Custom Flexible ISO Cine EI Cine EI Quick

ISO/Gain ● ● – –

AGC ● ● – –

Base Sensitivity ● – – –

Base ISO – ● ● ● (länkad till EI)
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Tips

I Cine EI Quick-läge och Cine EI-läge sker filmning på en grundläggande ISO-känslighetsnivå utan att använda förstärkning för
att maximera prestandan för bildsensorn. Ljusstyrkan justeras med belysning och ND-filter för att justera ljusmängden som når
bildsensorn.

Ställa in systemfrekvensen

Ställ in [Project] > [Rec Format]> [Frequency] i web- eller kameramenyn. Enheten kommer startas om automatiskt efter
byte, beroende på valt värde.

OBS!

Du kan inte byta systemfrekvens under in- eller uppspelning.

Ställa in bildskanningsläge

Du kan ställa in den effektiva bildstorleken och upplösningen för bildsensorn.
Ställ in [Project] > [Rec Format]> [Imager Scan Mode] i web- eller kameramenyn.
[FF]: Helbildsstorlek.
[S35]: Super 35mm storlek.

OBS!

Du kan inte byta bildskanningsläge under in- eller uppspelning.

När den är inställd på S35 är videoformatet begränsat till 1920×1080.

Ställa in codec

Du kan ställa in codec för inspelning.
Ställ in [Project] > [Rec Format]> [Codec] i web- eller kameramenyn.

OBS!

Du kan inte byta codec under in- eller uppspelning.

Ställa in videoformat

Du kan ställa in videoformat för inspelning och videoformat för utgång från kameran.

Växla videoformat för inspelning med hjälp av [Project] > [Rec Format] > [Video Format] i web- eller kameramenyn.
Växla utgångsformat från SDI OUT- och HDMI OUT-kontakterna med [Monitoring] > [Output Format] i web- eller
kameramenyn.

Custom Flexible ISO Cine EI Cine EI Quick

Exposure Index – – ● ●

Auto Shutter ● ● – –

ATW ● ● – –

LUT On/Off – ● ● ●

Scene File ● – – –

Paint/Look
(exkluderar Base Look)

● – – –
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OBS!

Du kan inte växla videoformat under in- eller uppspelning.

Det kan förekomma begränsningar för signalen från SDI OUT- och HDMI OUT-kontakterna beroende på videoformatsinställning.

Relaterade avsnitt

Översikt för utseende

Filma med utseendejustering i efterproduktion

5-041-958-63(1) Copyright 2022 Sony Corporation
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Stödda minneskort

Enheten spelar in ljud och video på CFexpress Type A-minneskort (tillgängliga separat) eller SDXC-minneskort
(tillgängliga separat) insatta i kortöppningarna. Minneskorten används även för proxyinspelning.

CFexpress Type A minneskort

Använd de Sony CFexpress Type A-minneskort* som anges i enhetens ”Rekommenderade inspelningsmedia”.
För information om användning med lagringsmedia från andra tillverkare, se bruksanvisningen för lagringsmediet eller
konsultera tillverkarens information.

SDXC minneskort

Använd de SDXC-minneskort* som anges i enhetens ”Rekommenderade inspelningsmedia”.

Rekommenderade inspelningsmedia

De garanterade driftsförhållandena kommer variera beroende på Rec Format- och Recording-inställningar.

CFexpress Type A
VPG400-överensstämmande
Stöds för alla av enhetens inspelningsformat.

SDXC
Stöds enligt villkoren i följande tabell. ”●” indikerar att åtgärden har verifierats och ”–” indikerar att åtgärden inte är
garanterad.

RAW Out & XAVC-I, 4096×2160 Class 300, Normalt läge

RAW Out & XAVC-I, 3840×2160 Class 300, Normalt läge

Kallas ofta ”CFexpress-kort” i denna hjälpguide.*

Kallas ofta ”SD-kort” i denna hjälpguide.*

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●
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RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (60 fps eller lägre)

RAW Out & XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Verifierade media inte tillgängliga.

XAVC-I, 4096×2160 Class 300, Normalt läge

XAVC-I, 4096×2160 Class 300, S&Q (60 fps eller lägre)

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

24P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

24P – – – – – – ●
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XAVC-I, 3840×2160 Class 300, Normalt läge

XAVC-I, 3840×2160 Class 300, S&Q (60 fps eller lägre)

XAVC-I, 3840×2160 Class 300, S&Q (100 fps, 120 fps)
Verifierade media inte tillgängliga.

XAVC-I, 1920×1080 Class 100, Normalt läge

XAVC-I, 1920×1080 Class 100, S&Q (60 fps eller lägre)

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

115



XAVC-I, 1920×1080 Class 100, S&Q (100 fps, 120 fps)

XAVC-I, 1920×1080 Class 100, S&Q (150 fps, 180 fps)
Verifierade media inte tillgängliga.

XAVC-I, 1920×1080 Class 100, S&Q (200 fps, 240 fps)
Verifierade media inte tillgängliga.

XAVC-L, 3840×2160 420, Normalt läge

XAVC-L, 3840×2160 420, S&Q (60 fps eller lägre)

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

50P – – – – – ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – – ●

50P – – – – – – ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 3840×2160 420, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD50, Normalt läge

XAVC-L, 1920×1080 HD50, S&Q (60 fps eller lägre)

XAVC-L, 1920×1080 HD50, S&Q (100 fps, 120 fps)

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – –

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – ● – ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●
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XAVC-L, 1920×1080 HD50, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD50, S&Q (200 fps, 240 fps)

XAVC-L, 1920×1080 HD35, Normalt läge

XAVC-L, 1920×1080 HD35, S&Q (60 fps eller lägre)

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – – – – ● ●

50P – – – – – ● ●

29.97P – – – – – – ●

25P – – – – – – ●

23.98P – – – – – – ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P ● ● ● ● ● ● ●

25P ● ● ● ● ● ● ●

23.98P ● ● ● ● ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P ● ● ● ● ● ● ●

50P ● ● ● ● ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●
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XAVC-L, 1920×1080 HD35, S&Q (100 fps, 120 fps)

XAVC-L, 1920×1080 HD35, S&Q (150 fps, 180 fps)

XAVC-L, 1920×1080 HD35, S&Q (200 fps, 240 fps)
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Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

23.98P – – ● – ● ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – ● – ● ● ●

25P – – ● – ● ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – ● ●

Systemfrekvens Class 10 U1 U3 VSC V10 VSC V30 VSC V60 VSC V90

59.94P – – ● – ● ● ●

50P – – ● – ● ● ●

29.97P – – – – – ● ●

25P – – – – – ● ●

23.98P – – – – – – ●
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Föra in minneskort

Detta ämne beskriver säkerhetsföreskrifter när man för in minneskort.

Öppna medialocket i kortöppningsdelen.1

För in ett minneskort.

För CFexpress-kort, med etiketten vänd uppåt.

OBS!

På takmonterad enhet, med etiketten vänd nedåt.

För SD-kort, för in med etiketten vänd nedåt.

OBS!

På takmonterad enhet, med etiketten vänd uppåt.

Åtkomstindikatorn tänds i rött och ändras sedan till grönt om kortet kan användas.

2
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OBS!

Minneskortet, minneskortsöppningen och bilddata på minneskortet kan skadas om kortet forceras in i öppningen i felaktig riktning.

När du spelar in till lagringsmedia insatt i både CFexpress Type A/SD kortöppning A och B, sätt då in media i båda öppningarna
som rekommenderas för användning med inspelningsformatet.

5-041-958-63(1) Copyright 2022 Sony Corporation

OBS!

Om åtkomstindikatorn blinkar kontinuerligt rött och inte övergår till grönt, stäng då av enheten tillfälligt och ta bort samt sätt
in minneskortet på nytt.

Stäng medialocket.3
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Mata ut ett minneskort

Öppna medialocket i kortöppningsdelen och tryck lätt på minneskortet för att mata ut det.

OBS!

Om enheten stängs av eller om minneskortet tas ut medan det används, går det inte att garantera dess integritet. Alla data
registrerade på kortet kan försvinna. Se alltid till att åtkomstindikatorn lyser grönt eller är släckt innan du stänger av enheten eller
tar ut minneskortet.

När du tar ut ett minneskort omgående efter att inspelningen är slutförd, kan minneskortet var varmt, men detta indikerar inte ett
problem.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Formatera (initiera) minneskort

Om ett oformaterat minneskort eller ett minneskort som formaterades med en annan specifikation sätts in, visas
meddelandet ”Media Needs to be Formatted” på kamerans bildruta.
Formatera kortet på följande sätt.

OBS!

Om man formaterar ett minneskort raderas alla data, inklusive inspelade videodata och konfigurationsfiler.

Meddelanden kan visas under utförandet beroende på formateringsprocessens varaktighet.

Om formateringen misslyckas
Minneskort som inte stöds av enheten kan inte formateras.
Ett varningsmeddelande visas. Följ instruktionerna för att byta kortet mot ett minneskort som stöds.

Använda ett kort formaterat på enheten i öppningen för en annan enhet
Först ska du göra en reservkopia på kortet och sedan omformatera kortet i enheten som ska användas.

5-041-958-63(1) Copyright 2022 Sony Corporation

Välj [TC/Media] > [Format Media] i kameramenyn.1

Välj Media(A) (slot A) eller Media(B) (slot B), och därefter formateringsmetod (Full Format eller Quick
Format).

Ett bekräftelsemeddelande visas.
[Full Format]: Startar mediet fullständigt, däribland dataregion och datahanteringsinformation.
[Quick Format]: Startar endast mediets datahanteringsinformation.

2

Välj [Execute].

Ett meddelande visas medan formateringen pågår och åtkomstindikatorn tänds i rött.
När formateringen är färdig, visas ett meddelande om att det är klart.

3
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Kontrollera kvarvarande inspelningstid

När du filmar (spelar in/standby), kan du övervaka den kvarvarande kapaciteten i minneskortet i varje öppning med hjälp
av indikatorerna i kamerans bildruta för kvarvarande lagringsmedia i öppning A/B.
Den kvarvarande inspelningstiden beräknas från den kvarvarande kapaciteten för lagringsmediet i varje öppning och det
nuvarande inspelningsformatet (inspelnings bithastighet) och visas i enheten i minuter.

Timing för byte av minneskort
När den totala kvarvarande inspelningstiden på de två minneskorten är mindre än 5 minuter, visas meddelandet ”Media
Near Full” och inspelningslampan börjar blinka för att varna dig.
Byt mot ett lagringsmedia med ledigt utrymme.
Om du fortsätter att spela in tills den totala kvarvarande inspelningstiden når noll, ändras meddelandet till ”Media Full”
och inspelningen stoppas.

OBS!

Upp till cirka 600 videoklipp kan spelas in på ett minneskort.

5-041-958-63(1) Copyright 2022 Sony Corporation

124



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Återställa minneskort

Om av någon anledning ett fel skulle uppstå i minneskortet måste kortet återställas innan användning.
När du laddar ett minneskort som måste återställas, visas ett meddelande på kamerans bildruta som frågar om du vill
återställa det.

Återställa ett kort
Välj [Execute] med hjälp av pilknapparna i GUI-kontrollpanelen och tryck på [Set]-knappen.
Ett meddelande och förloppsstatus (%) visas medan formateringen pågår och åtkomstindikatorn tänds i rött.
När återställningen är färdig, visas ett meddelande om att det är klart.

Om återställningen misslyckas
Minneskort i vilka minnesfel har uppstått kan inte återställas. Ett varningsmeddelande visas. Följ instruktionerna för
att byta ut ett minneskort.
Minneskort i vilka minnesfel har uppstått kan bli oanvändbara om de omformateras.
I vissa fall kan videoklipp återställas men inte i alla. Återställda videoklipp kan vanligtvis spelas upp.

OBS!

För återställning av media inspelat med denna enhet ska du se till att använda denna enhet.

Media inspelat med en annan enhet än denna enhet eller med en enhet av en annan version (även om det är samma modell) kan
inte återställas med denna enhet.

Videoklipp som är kortare än 2 sekunder kan inte återställas.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Starta/stoppa inspelning

Detta ämne beskriver hur man startar/stoppar inspelning.

Fäst de nödvändiga enheterna och kontrollera att det finns strömförsörjning till enheten och
kringutrustning.

1

Sätt i minneskortet(en).2

Kontrollera enhetens strömstatus högst upp till vänster i Web App-skärmen.

När strömförsörjningen är på
När enheten är påslagen, visas [Power ON] på strömbrytaren högst upp på Web App-skärmen.

POWER-lampan tänds på enhetens framsida och kamerabilden visas på skärmen för livedrift på Web App.

OBS!

Om administratörslösenord inte har konfigurerats visas en skärm som uppmanar dig att konfigurera lösenordet. Se ”Starta
enheten.”

När strömförsörjningen är i standby-läge
När enhetens strömförsörjning är i standby-läge, visas [Power Standby] på strömknappen på Web App.

I detta läge, trycker du på brytaren och väljer [Power ON]. Enheten slås på och POWER-lampan tänds i grönt på
enhetens framsida, och kamerabilden visas på skärmen för livedrift på Web App.

Tips

Du kan även starta enheten med strömknappen på den medföljande infraröda fjärrkontrollen.

3
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Växla enhetens strömförsörjning till standby-läge
Tryck på strömknappen i Web App och välj [Power Standby] för att ställa enhetens strömförsörjning till standby-läge.

Tips

Du kan även ställa strömförsörjningen i standby-läge med den medföljande infraröda fjärrkontrollen.

Relaterade avsnitt
Starta enheten

Tryck på knappen START/STOP.

Inspelningen startar och inspelningslampan (2 platser) på enheten tänds.
Under inspelning tänds knappen START/STOP. Även en ikon för målinspelningsmedia samt [●Rec] visas.

4

För att avsluta inspelningen, ska du trycka på knappen START/STOP.

Inspelningen stoppas och inspelningslampan (2 platser) på enheten släcks.
Under standby-läge för inspelning tänds inte START/STOP-knappen för inspelning. Även en ikon för
målinspelningsmedia samt [Stby] visas.

Tips

Du kan även starta/stoppa inspelningen med START/STOP-inspelningsknappen på den medföljande infraröda
fjärrkontrollen.

5
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Växla mellan minneskort

När två minneskort är insatta, kan du trycka på [Slot Select]-knappen på uppspelningskontrollpanelen i Web App för att
växla minneskort.

Tips

Du kan även trycka på knappen SLOT SEL (val av minneskortingång (A)/(B)) på den medföljande infraröda fjärrkontrollen.

Om överföringsinspelning

När inspelning pågår övergår enheten automatiskt till det andra minneskortet precis innan den kvarvarande kapaciteten
på det första kortet reduceras till noll (överföringsinspelning). Du kan fortsätta spela in kontinuerligt när du växlar
minneskort genom att ersätta minneskortet som är fullt med ett nytt minneskort.

OBS!

Du kan inte växla mellan minneskort under uppspelningsläge. Dessutom stöds inte kontinuerlig uppspelning av ett videoklipp med
lagringsmedia i öppning A och B.

Om inspelade data

När du stoppar inspelningen sparas video, ljud och tillhörande data från början till slut av inspelningen som ett enskilt
”videoklipp” på ett minneskort.

Videoklippnamn för inspelade data

Namnet på varje videoklipp som spelas in med enheten tilldelas automatiskt med [TC/Media] > [Clip Name Format] i
kameramenyn.

Maximal längd videoklipp

Upp till 6 timmar per videoklipp.
Den maximala längden för kontinuerlig inspelning är samma som den maximala längden för ett videoklipp. Om
inspelningstiden överskrider den maximala längden för ett videoklipp, skapas ett nytt videoklipp automatiskt och
inspelningen fortsätter. Det nya videoklippet visas som ett separat videoklipp på miniatyrbildskärmen.
Flera videoklipp spelas in i följd under överföringsinspelning, men inspelningen kommer stoppas automatiskt efter 24
timmar.

OBS!

Ta inte ut ett minneskort när inspelning pågår. Vid inspelning ska du endast byta minneskort i öppningar där åtkomstindikatorn är
av.

När återstående kapacitet på minneskortet som används för inspelning är mindre än en minut och ett inspelningsbart minneskort
sätts in i den andra öppningen, kommer meddelandet ”Will Switch Slots Soon” visas. Meddelandet försvinner när minneskorten
har växlats.

Det går inte att använda överföringsinspelning när kvarvarande kapacitet i minneskortet är mindre än en minut. För korrekt
överföringsinspelning, kontrollera att kvarvarande kapacitet på minneskortet är mer än en minut innan du börjar spela in.

Video som skapas med enhetens överföringsinspelningsfunktion kan inte spelas upp sömlöst på enheten.

Du kan kombinera video skapat med enhetens överföringsinspelningsfunktion med programvaran ”Catalyst Browse”.
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Kontrollera ljudet

Ljud går ut från enhetens SDI- och HDMI-kontakter. Välj kombinationen av ljudkanaler som går ut från HDMI-kontakten
med [Audio] > [Audio Output] > [HDMI/Stream Output CH] i kameramenyn.
CH1/CH2: CH1 och CH2 kombination
CH3/CH4: CH3 och CH4 kombination
Vid övervakning av ljudet i Web App, använd då ljudnivåmätaren längst ned till höger på kamerabilden.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Specificera tidsdata

Detta ämne beskriver hur man ställer in tidsdata.

Ställa in tidskoden

Ställ in följande tidskod med [TC/Media] > [Timecode] i kameramenyn.

Ställa in användarbit

Du kan lägga till ett 8-siffrigt hexadecimaltal till den inspelade bilden som användarbit. Du kan även ställa in användarbit
till aktuell tid. Ställ in med [TC/Media] > [Users Bit] i kameramenyn.

Visa tidsdata

Ställ in tidskoden som ska visas med [TC/Media] > [TC Display] > [Display Select] i kameramenyn.
Om du trycker ned en tilldelningsbar knapp med [DURATION/TC/U-BIT] tilldelad kommer displayen växla mellan tidskod,
användarbit och längd i följd.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Granska inspelningen (Rec Review)

Du kan granska det senaste inspelade videoklippet på skärmen (inspelningsgranskning).

OBS!

Rec Review stöds inte om videoformatet ändras efter att ett videoklipp spelas in.

Ställa in Rec Review startposition

Du kan ställa in uppspelningens startposition till en av följande med [Technical] > [Rec Review] i kameramenyn.

Sista 3 sekunderna i videoklippet
Sista 10 sekunderna i videoklippet
Videoklippets start

Tips

Om du vill granska ett specifikt videoklipp efter att ha spelat in flera stycken, tryck då på [Thumbnail]-knappen för att visa
miniatyrbildskärmen och välj videoklipp för att starta uppspelning.

Du kan även trycka på THUMBNAIL-knappen på den medföljande infraröda fjärrkontrollen för att visa miniatyrbildskärmen.

Rec Review-metod

Tilldela Rec Review-funktion till en av de tilldelningsbara knapparna på den grundläggande
konfigurationsjusteringspanelen i förhand.

För information om tilldelning, se ”Tilldelningsbara knappar” i ”Praktiska funktioner.”

Stoppa inspelningen och tryck därefter på en tilldelningsbar knapp tilldelad med Rec Review-funktionen för att starta
uppspelning av det tidigare inspelade videoklippet.
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Videoklippet spelas till sitt slut. Rec Review avslutas och enheten återgår till läget Stby (standby).

Stoppa Rec Review
Tryck på den tilldelningsbara knappen som tilldelats Rec Review eller på knappen [Cancel/Back].
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Tips

Du kan även trycka på [Cancel/Back]-knappen på den medföljande infraröda fjärrkontrollen för att visa Rec Review-funktionen.

Relaterade avsnitt

Tilldelningsbara knappar

5-041-958-63(1) Copyright 2022 Sony Corporation
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Skärm för bildinramningsjustering

Bildinramningen justeras med följande delar av skärmen för livedrift.

OBS!

Beroende på kamerans riktning, linsens fokallängd och zoomposition, kan delar av enheten eller kablar anslutna till
kontaktblocket vara synliga. Innan du filmar ska du kontrollera linsens synfält och fokallängden du använder. Du kan även
kontrollera pan/tilt-räckvidden med hjälp av [Pan-Tilt] > [P/T Range Limit] i web-menyn. När enheten är påslagen eller
återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. För detaljer, se [Pan-Tilt] > [P/T Range
Limit] i web-menyn.

Tips

Du kan även kontrollera bildinramningen med den medföljande infraröda fjärrkontrollen.

5-041-958-63(1) Copyright 2022 Sony Corporation

Kontrollpanelen för förinställningsposition1.

Fliken  (Main) / fliken  (Others)2.

Kontrollpanelen för bildinramningsjustering3.
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Justera filmningsriktning med hjälp av Web App

Att förflytta kameran horisontalt kallas för panorering och vertikalt tilting.
Du kan justera filmningsriktning med pan/tilt-driften.

Tips

Om [Execute Pan-Tilt Reset] visas under joysticken har en inkonsekvens uppstått i pan/tilt-kontrollens ursprungsinformation i
enheten. Utför pan/tilt-återställningsfunktionen för att uppdatera ursprungsinformationen. För mer info, se ”Återställa pan/tilt.”

Vända kamerans baksida till fram
Tryck på knappen  (Panorering/lutning hem) på fliken  (Others) i kamerakontrollpanelen.

OBS!

Beroende på kamerans riktning, linsens fokallängd och zoomposition, kan delar av enheten eller kablar anslutna till
kontaktblocket vara synliga. Innan du filmar ska du kontrollera linsens synfält och fokallängden du använder. Du kan även
kontrollera pan/tilt-räckvidden med hjälp av [Pan-Tilt] > [P/T Range Limit] i web-menyn. När enheten är påslagen eller
återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. För detaljer, se [Pan-Tilt] > [P/T Range
Limit] i web-menyn.

Relaterade avsnitt

Återställa pan/tilt

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på fliken  (Panorering/lutning/zoom) i bildkontrollpanelen för att visa joysticken.1

Dra joystickens mitt i den riktning du vill visa medan du övervakar kamerans bildruta.

Kamerans riktning och hastighet ändras som svar på vart och till vilken nivå du drar.
Du kan justera pan/tilt mer noggrant genom att trycka på joystickens omgivande områden.

2

137



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Ställa in hastigheten för pan/tilt-drift

Du kan ändra hastigheten för zoomdrift med hjälp av skjutreglaget [Pan-Tilt Speed] i kamerans kontrollpanel med
joysticken i bildkontrollpanelen.

OBS!

Om det finns en vägg eller ett annat hinder inom kamerans rörelseintervall, var då försiktig med att inte slå i kameran eller linsen
under pan/tilt-drift.

Pan/tilt-accelerationen styrs av de fysiska egenskaperna, till exempel linsens viktbalans. Du kan ändra accelerationen med [Pan-
Tilt] > [P/T Acceleration] > [Ramp Curve] i web- eller kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på fliken  (Main) i kamerakontrollpanelen.1

Välj skjutreglaget [Pan-Tilt Speed] från listan.

Om skjutreglaget [Pan-Tilt Speed] inte visas, välj då en av de två knapparna för skjutreglagefunktion för att visa
skjutreglaget.

2

Flytta skjutreglaget till vänster eller höger.

När du vrider vredet till vänster minskas drifthastigheten, medan om du vrider det till höger ökas drifthastigheten.

3
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Ställa in acceleration för pan-tilt-användning

Du kan ställa in accelerationen i nio nivåer med [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i web- eller kameramenyn.
Öka värdet för snabbare hastighetsförändringar eller minska värdet för mer stegvisa hastighetsförändringar.
För större svarsförmåga vid pan/tilt-drift ska du välja ett värde mellan 7 och 9.
För större positionsnoggrannhet vid start och slut för en rörelse till en förinställd position, rekommenderas ett värde
mellan 1 och 6.

För information om förinställningsposition, se ”Spara/återställa pan/tilt- och zoomposition.”

OBS!

När ett högt värde är inställt kanske inte funktionen fungerar ordentligt om en tung lins är fäst. Kontrollera åtgärden innan
användning.

Förhållande mellan [Ramp Curve]-inställning och pan/tilt-drift

När pan/tilt används

När en förinställd position återkallas
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Justera filmningsriktning med den medföljande infraröda fjärrkontrollen

Du kan justera filmningsriktningen med pan/tilt-driftknapparna på den medföljande infraröda fjärrkontrollen.

Vända kamerans baksida till fram
Tryck på HOME-knappen.

OBS!

Beroende på kamerans riktning, linsens fokallängd och zoomposition, kan delar av enheten eller kablar anslutna till
kontaktblocket vara synliga. Innan du filmar ska du kontrollera linsens synfält och fokallängden du använder. Du kan även
kontrollera pan/tilt-räckvidden med hjälp av [Pan-Tilt] > [P/T Range Limit] i web-menyn. När enheten är påslagen eller
återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. För detaljer, se [Pan-Tilt] > [P/T Range
Limit] i web-menyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på pilknapparna för att styra pan/tilt.

Tryck på pilknappen i den riktning du vill visa medan du övervakar kamerabilden.
För att förflytta ett kort avstånd, tryck ned pilknappen en kort stund.
För att förflytta ett långt avstånd, tryck och håll ned pilknappen.
För att förflytta diagonalt, tryck och håll ned  (pil uppåt) eller  (pil nedåt) och tryck på  (vänster pil) eller 
(höger pil).

1
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Ställa in zoomtyp

Ställ in typ av zoom med [Technical] > [Zoom] > [Zoom Type] i kameramenyn.
Typen av zoom kommer variera beroende på vilken typ av lins som är fäst.

OBS!

Clear Image Zoom är inte tillgängligt i följande fall.

När [Shooting] > [S&Q Motion] > [Setting] är inställt på On och inställningen för [Frame Rate] i kameramenyn är högre än 60 fps
När [Project] > [Rec Format] > [Codec] i kameramenyn är inställt på [RAW] eller ett alternativ som omfattar RAW

Använda SERVO/MANUAL-väljarspaken för en lins återställer förstoringen för Clear Image Zoom till 1×.

Af-s stöds inte vid Clear Image Zoom.

Clear Image Zoom

Enheten är utrustad med zoomfunktionen som använder bildsignalen kallad Clear Image Zoom. När Clear Image Zoom
är aktiverat, stöds zoomning även för linser med fast fokus. Den kan även användas för att förlänga räckvidden utöver
den optiska räckvidden på en power zoom-lins.
Det maximala zoomförhållandet med Clear Image Zoom varierar beroende på inspelningens upplösning.

För inspelning med QFHD/4K-upplösning: 1,5×
För inspelning med HD-upplösning: 2×

5-041-958-63(1) Copyright 2022 Sony Corporation

Typ av fäst lins
[Zoom Type]-inställning

[Optical Zoom Only] [On(Clear Image Zoom)]

Lins med fast fokus/lins för manuell zoom Zoomdrift stöds inte. Clear Image Zoom stöds.

Power zoom-lins Endast optisk zoom stöds. Optisk zoom och Clear Image Zoom stöds.
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Justera zoomen med hjälp av Web App

Du kan justera enhetens zoom med den optiska zoomen eller Clear Image Zoom. Detta ämne beskriver hur man justerar
zoomen med hjälp av Web App. För information om Clear Image Zoom, se ”Ställa in zoomtyp.”

OBS!

Beroende på kamerans riktning, linsens fokallängd och zoomposition, kan delar av enheten eller kablar anslutna till
kontaktblocket vara synliga. Innan du filmar ska du kontrollera linsens synfält och fokallängden du använder. Du kan även
kontrollera pan/tilt-räckvidden med hjälp av [Pan-Tilt] > [P/T Range Limit] i web-menyn. När enheten är påslagen eller
återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. För detaljer, se [Pan-Tilt] > [P/T Range
Limit] i web-menyn.

Den faktiska zoomhastigheten och precisionen varierar beroende på linsen. Kontrollera åtgärden innan användning.

Tips

Du kan styra zoomen på en manuell zoomlins med hjälp av en linskontroll (tillval) som är kompatibel med den här enheten. För
information, se ”Ansluta en linskontroll” och ”Justera zoomen med hjälp av en linskontroll”.

Relaterade avsnitt

Ställa in zoomtyp

Ansluta en linskontroll

Justera zoomen med hjälp av en linskontroll

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på fliken  (Panorering/lutning/zoom) i bildkontrollpanelen för att visa pan-tilt-kontrollpanelen.1

Skjut [Zoom]-skjutreglaget i [T] (Telephoto)-riktningen eller [W] (Wide)-riktningen för att justera zoomen.

Zoomhastigheten varierar med skjutreglagets rörelse.

2
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Ställa in hastigheten för zoomdrift

Du kan ändra hastigheten för zoomdrift med hjälp av skjutreglaget [Zoom] i kamerans bildkontrollpanel med skjutreglaget
[Zoom Speed] kamerans kontrollpanel.

OBS!

Den faktiska zoomhastigheten och precisionen varierar beroende på linsen. Kontrollera åtgärden innan användning.

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på fliken  (Main) i kamerakontrollpanelen.1

Välj skjutreglaget [Zoom Speed] från listan.

Om skjutreglaget [Zoom Speed] inte visas, välj då en av de två knapparna för skjutreglagefunktion för att visa
skjutreglaget.

 

2

Flytta skjutreglaget [Zoom Speed] till vänster eller höger.

När du vrider vredet till vänster minskas drifthastigheten, medan om du vrider det till höger ökas drifthastigheten.

3
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Justera zoomen med den medföljande infraröda fjärrkontrollen

Du kan justera enhetens zoom med den optiska zoomen eller Clear Image Zoom. Detta ämne beskriver hur man justerar
med den medföljande infraröda fjärrkontrollen. För information om Clear Image Zoom, se ”Ställa in zoomtyp.”

OBS!

Beroende på kamerans riktning, linsens fokallängd och zoomposition, kan delar av enheten eller kablar anslutna till
kontaktblocket vara synliga. Innan du filmar ska du kontrollera linsens synfält och fokallängden du använder. Du kan även
kontrollera pan/tilt-räckvidden med hjälp av [Pan-Tilt] > [P/T Range Limit] i web-menyn. När enheten är påslagen eller
återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. För detaljer, se [Pan-Tilt] > [P/T Range
Limit] i web-menyn.

Tips

Du kan styra zoomen på en manuell zoomlins med hjälp av en linskontroll (tillval) som är kompatibel med den här enheten. För
information, se ”Ansluta en linskontroll” och ”Justera zoomen med hjälp av en linskontroll”.

Relaterade avsnitt

Ställa in zoomtyp

Ansluta en linskontroll

Justera zoomen med hjälp av en linskontroll

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på zoomknappen för att justera zoomen.

Tryck på knappen T (Telephoto) eller W (Wide) medan du övervakar skärmen för att justera zoomen.
För att zooma in trycker du på knappen T.
För att zooma ut trycker du på knappen W.

1
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Kalibrera en E-monterad lins

Kalibrerar skillnaderna i zoom-position på grund av skillnader mellan enskilda linser när man använder en E-monterad
power zoom-lins.
För att noggrant beräkna zoomposition ska du kalibrera din lins korrekt för enskilda skillnader mellan linser med följande
metod.

Kalibreringsdata
Kalibreringsdata för upp till fem linser kan sparas i enheten. De data som är äldst kommer skrivas över när en sjätte
eller efterföljande lins kalibreras.
Du kan kontrollera huruvida kalibreringsdata finns tillgängliga för den fästa linsen genom att trycka på knappen 
(Kamerastatus) i det gemensamma området för Web App-skärmen och väljer [Lens] > [Calibration Data].

5-041-958-63(1) Copyright 2022 Sony Corporation

Om linsen har en SERVO/MANUAL-brytare inställd på SERVO-position.

OBS!

Då kan inte linsen ta emot zoominstruktioner från enheten om brytaren är inställd på MANUAL.

1

Kör kalibreringen med [Technical] > [Lens] > [Lens Calibration] i kameramenyn.

Under kalibrering förflyttas linsen automatiskt och mäts.

2
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Spara/återställa inställningar för pan/tilt, zoomposition och fokusinställningar med
Web App

Du kan spara inställningar för pan/tilt, zoomposition och fokus och återkalla dem när du vill med hjälp av Web App
(förinställd positionsfunktion).

För information om vilka objekt som kan sparas/återställas, se ”Förinställningspositioner för sparade objekt.”

OBS!

Det går inte att spara en förinställningsposition om förhållandet för Clear Image Zoom överskrider 1×.

Om [Pan-Tilt] > [P/T Direction] > [Ceiling]-inställningen i web-menyn ändras raderas alla sparade förinställningspositioner.

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Fastställ den position som du vill spara med pan/tilt- och zoomanvändning.2

Tryck på [+]-knappen i den förinställda positionens kontrollpanel.

Bilden med den sparade positionen visas i den förinställda positionens kontrollpanel.

Tips

Om den förinställda positionens kontrollpanel inte visas, tryck då på knappen  (Öppna) för att visa den.

Positioner sparas i sekvens från [Preset1].

Om det finns förinställningar som inte används inom en sekvens med förinställningar, sparas positioner i förinställningar
utifrån de oanvända förinställningarna. Om till exempel förinställningspositioner sparas i [Preset1] och [Preset3] men inte i
[Preset2], sparas nästa förinställningsposition i [Preset2] och därefter i [Preset4].

3
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För att avbryta funktionen för återställning av förinställningsposition
Tryck på knappen  (Avbryt återställning) som visas på kontrollpanelen för förinställningspositioner under återställning
av förinställningspositioner för att avbryta återställningen. Använd joysticken och [Zoom]-skjutreglaget för att justera
bildinramning.

Upp till 100 förinställningspositioner kan sparas.

Du kan döpa om varje förinställningsposition. För mer information, se ”Döpa om förinställningspositioner med hjälp av Web
App.”

Återställa en sparad position.

Tryck två gånger på en miniatyrbild för positionen du vill återställa i den förinställda positionens kontrollblock för att
återställa motsvarande position.

Tips

Du kan även återställa en position genom att trycka på bilden, och trycka på knappen  (Meny för förinställd position) som
visas och väljer [Recall].

Övergångshastigheten för en sparad position bestäms av inställningen [Pan-Tilt] > [P/T Preset] > [Pan-Tilt] > [Pan-Tilt
Speed for Common] i web-menyn när positionen sparas. Du kan även ändra övergångshastighet efter att du sparat. För
information, se ”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition”.

Graden för ändring i pan/tilt-position när du flyttar en förinställningsposition kan justeras med hjälp av övergångshastigheten
och [Ramp Curve]-inställningar. För mer information, se ”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning
av en förinställningsposition” och ”Ställa in acceleration för pan-tilt-användning”.

Om en annan förinställning hämtas under förinställd uppspelning avbryts driften av den första återkallade förinställningen
och driften av den hämtade förinställningen startar.

OBS!

Om temperaturen i miljön har förändrats avsevärt mellan när en förinställd position sparades och när den spelas upp kan en
avvikelse i inramningen uppstå.

När en förinställningsposition återställs kan du inte utföra några andra åtgärder än att återställa eller avbryta
förinställningspositionen.

4

148



Relaterade avsnitt
Förinställningspositioner för sparade objekt

Döpa om förinställningspositioner med hjälp av Web App

Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition

Ställa in acceleration för pan-tilt-användning

5-041-958-63(1) Copyright 2022 Sony Corporation
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Döpa om förinställningspositioner med hjälp av Web App

Du kan döpa om sparade förinställningspositioner.

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Tryck på förinställningspositionen du vill döpa om.

Knappen  (Meny för förinställd position) visas högst upp till höger på bilden.

2

Tryck på knappen  (Meny för förinställd position) och välj [Rename] från menyn som visas.3

Ange ett nytt förinställningsnamn.4
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Ersätta den sparade förinställda positionen med en ny position med Web App

Du kan ersätta en sparad förinställd position med en ny position.
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Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Fastställ den position som du vill spara med pan/tilt- och zoomanvändning.2

Tryck på positionen du vill ersätta i förinställningens position i kontrollpanelen.

Knappen  (Meny för förinställd position) visas högst upp till höger på bilden.

3

Tryck på knappen  (Meny för förinställd position) och välj [Replace] från menyn som visas.

Den nya positionen ersätter den nuvarande inställningen.

4

151



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Radera en sparad förinställd position med hjälp av Web App

Du kan ta bort sparade förinställningspositioner.

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Tryck på positionen du vill radera i förinställningens position i kontrollpanelen.

Knappen  (Meny för förinställd position) visas högst upp till höger på bilden.

2

Tryck på knappen  (Meny för förinställd position) och välj [Delete] från menyn som visas.

Den sparade positionen raderas.

3
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Synkronisera pan/tilt och zoom/fokus när man återställer en förinställningsposition

Du kan synkronisera pan/tilt och zoom när du återställer en sparad förinställningsposition för jämnare inramning.

Tips

Du kan ange inställningar som används för att registrera en förinställningsposition i förväg. Ställ in[Pan-Tilt] > [P/T Preset] >
[Default] > [Zoom Sync] till [On] i web-menyn.

När [Pan-Tilt] > [P/T Preset] > [Speed Select] är inställt på [Common], kommer alla förinställda positioner återställas till den
hastighet som ställts in med [Pan-Tilt] > [P/T Preset] > [Common Speed].

När zoomrörelsen är klar går kameran till den sparade fokuspositionen.

När rörelsen är klar återgår [AF Transition Speed] till den ursprungliga inställningen.

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Tryck på bilden för förinställningspositionen för vilken du vill ändra övergångshastighet.

Knappen  (Meny för förinställd position) visas högst upp till höger på bilden.

2

Tryck på knappen  (Meny för förinställd position) och välj [Edit…] från menyn som visas.

Inställningsskärmen för den valda förinställningspositionen visas.

3

Skjut reglaget [Zoom Sync] åt höger för att slå på funktionen och tryck på [OK].

Nästa gång en sparad position återställs kommer kameran förflyttas i den konfigurerade hastigheten.

4
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Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en
förinställningsposition

Du kan ändra övergångshastigheten (pan/tilt, zoom, fokus) när du återställer en sparad förinställningsposition.

Tips

När [Pan-Tilt] > [P/T Preset] > [Speed Select] är inställt på [Common], kommer alla positioner återställas till inställd hastighet med
[Pan-Tilt] > [P/T Preset] > [Common Speed].

När zoomrörelsen är klar går kameran till den sparade fokuspositionen.

När rörelsen är klar återgår [AF Transition Speed] till den ursprungliga inställningen.

Ställ in [Pan-Tilt] > [P/T Preset] > [Speed Select] till [Separate] i web-menyn.1

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition.2

Tryck på bilden för förinställningspositionen för vilken du vill ändra övergångshastighet.

Knappen  (Meny för förinställd position) visas högst upp till höger på bilden.

3

Tryck på knappen  (Meny för förinställd position) och välj [Edit…] från menyn som visas.

Inställningsskärmen för den valda förinställningspositionen visas.

4

Ställ in de övergångshastigheter (panorering/lutning/zoom/fokus) som du vill ändra med skjutreglagen eller
ange värden direkt och tryck på knappen [OK].

Nästa gång en sparad position återställs kommer kameran förflyttas i den konfigurerade hastigheten.

5
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Spara/återställa pan/tilt- och zoompositionen med den medföljande infraröda
fjärrkontrollen

Du kan spara pan/tilt- och zoomposition och återkalla dem när så krävs med den medföljande infraröda fjärrkontrollen.

Relaterade avsnitt

Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition

5-041-958-63(1) Copyright 2022 Sony Corporation

Justera kamerans pan/tilt och zoom.1

Ställ in hjälpläget PTZ på [Pos.] i listrutan högst upp på kontrollpanelen för förinställningsposition i Web
App.

2

Tryck och håll ned PRESET-knappen och tryck på en av knapparna 1 till 3.

Positionen är sparad.

3

Återställa en sparad position.

Tryck på en av knapparna 1 till 3 för att återställa den förinställningspositionen.

Tips

Övergångshastigheten vid återställning av en förinställningsposition bestäms av det sparade värdet för [Pan-Tilt] > [P/T
Preset] > [Pan-Tilt Speed] i web-menyn. Du kan ändra övergångshastighet efter att du sparat ett värde. För information, se
”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition”.

4
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Spela in kamerabildinramningar med hjälp av Web App

Du kan spela in kamerabildinramningar med hjälp av Web App.

Justera kamerans startposition.1

Ställ in hjälpläget PTZ på [Trace] i listrutan högst upp på kontrollpanelen för förinställningsposition.2

Tryck på [+]-knappen i den förinställda positionens kontrollpanel.

En miniatyrbild läggs till och kameran växlar till standbyläge för inspelning.

Tips

Du kan trycka på knappen  (Stäng) på miniatyrbilden för att avsluta standbyläget för inspelning och återgå till normal drift.

3
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Tips

Den återstående inspelningstiden visas högst upp på kamerans bildpanel under inspelningen.

OBS!

De inspelade bildinramningarna tas bort om du växlar till takmontering

Om du byter systemfrekvens kan inspelade bildinramningar tas bort.

Zoomfunktionen registreras inte när en linskontroll är ansluten.

Den maximala tiden för inspelning av en enda bildinramningsfunktion är 3 minuter. Inspelningen avbryts automatiskt när
inspelningstiden når 3 minuter.

Det går inte att spela in en bildinramning om förhållandet för Clear Image Zoom är större än 1×.

Om kameran styrs från en annan enhet medan du spelar in en bildinramning spelas även funktionerna från den andra enheten in.
Om du vill ha mer information om hur du spelar in med en fjärrkontroll från tredje part kontaktar du tillverkaren för den.

Inställningarna för fokus och bildkvalitet registreras inte av den här funktionen.

Funktionerna för panorering/lutning/zoom som sparas när man spelar in en bildinramning kan inte återges exakt under
bildvisning.

Om du efter att ha spelat in en bildinramning ställer in pan/tilt-intervallgränsen med [Pan-Tilt] > [P/T Range Limit] i web-menyn
tillämpas inte pan/tilt-intervallgränsen vid bildvisning med inramning. Om du vill använda en bildinramning och pan/tilt-
funktionerna tillsammans ställer du in pan/tilt-intervallgränsen innan du spelar in bildinramningen.

Inspelade bildinramningar kan inte spelas upp när RAW-videoutgång har valts.

Starta bildinramningen med joysticken och [Zoom]-reglaget.

Inspelningen startar från det ögonblick som bildinramningen startar.

4

Tryck på knappen  (Stoppa inspelning) under strömning för att stoppa strömningen.5
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Inspelade bildinramningar kan inte spelas upp när videosignalen inte matas ut från SDI-utgången.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Spela upp kamerabildinramningar med hjälp av Web App

Du kan spela upp en inspelad kamerabildinramning med hjälp av Web App.

Ställ in hjälpläget PTZ på [Trace] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Välj en miniatyrbild med den bildinramning som du vill spela upp.

Knappen  (Förbered) visas på miniatyrbilden.

2

Tryck på knappen  (Förbered).

Kameran flyttas till startpositionen för bildinramningen och växlar till standbyläget för uppspelning.

3

Tryck på knappen  (Spela upp) på miniatyrbilden.4
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Tips

I standbyläget för uppspelning och under uppspelning kan du avbryta uppspelningen och återgå till normal drift genom att göra
något av följande.

Tryck på  (Stopp)-knappen på miniatyrbildskärmen eller i den förinställda positionens kontrollpanel.
Använda joysticken.
Använda [Zoom]-reglaget.

Den återstående uppspelningstiden visas högst upp på kamerans bildpanel under inspelningen.

OBS!

Oväntat beteende kan uppstå om Clear Image Zoom-inställningen skiljer sig mellan inspelning och uppspelning av
bildinramningar.

Uppspelning av zoomfunktioner stöds inte när en linskontroll är ansluten. Om du använder zoomen avbryts uppspelningar av
bildinramning.

Under uppspelning av bildinramning har det ingen effekt att ändra pan/tilt-intervallgräns med hjälp av [Pan-Tilt] > [P/T Range
Limit] på web-menyn. Ställ in pan/tilt-intervallgräns innan du spelar in en bildinramning.

5-041-958-63(1) Copyright 2022 Sony Corporation

Uppspelning för bildinramning startar.
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Radera bildinramningsfunktioner lagrade på kameran med hjälp av Web App

Du kan radera bildinramningsfunktioner lagrade på kameran med hjälp av Web App.
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Ställ in hjälpläget PTZ på [Trace] i listrutan högst upp på kontrollpanelen för förinställningsposition.1

Välj en miniatyrbild med den bildinramning som du vill ta bort.

Knappen  (Spårmeny) visas på miniatyrbilden.

2

Tryck på knappen  (Spårmeny).

Menyn visas.

3

Välj [Delete] från menyn som visas.

Den valda bildinramningen tas bort.

4
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Spara bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen

Du kan även spara bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen.

För information om hur du spelar upp en inspelad kamerabildinramning, se avsnittet ”Spela upp kamerabildinramningar
med den medföljande infraröda fjärrkontrollen”.

OBS!

Den maximala tiden för inspelning av en enda bildinramningsfunktion är 3 minuter. Inspelningen avbryts automatiskt när
inspelningstiden når 3 minuter.

Om kameran styrs från en annan enhet medan du spelar in en bildinramning spelas även funktionerna från den andra enheten in
som en del av bildinramningen.

Om bildkvaliteten justeras vid inspelning av en bildinramning registreras inte ändringen.

Relaterade avsnitt
Spela upp bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen
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Öppna skärmen för live-drift i Web App.1

Ställ in hjälpläget PTZ på [Trace] i listrutan högst upp på kontrollpanelen för förinställningsposition.2

Justera kamerans startposition med hjälp av den infraröda fjärrkontrollen.3

Tryck och håll ned PRESET-knappen och tryck på en av knapparna POSITION1 till 3.

Kameran växlar till standbyläge för inspelning.

4

Utför den bildinramning som du vill spela in.5

Om du vill avsluta inspelningen håller du ned PRESET-knappen och trycker på den POSITION-knapp som
valdes i steg 4.

6
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Spela upp bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen

Du kan spela upp en sparad bildinramningsfunktion med den medföljande infraröda fjärrkontrollen.

OBS!

Om du använder panorering/lutning/zoom i kameran avbryts uppspelningen.

Relaterade avsnitt

Spara bildinramningsfunktioner med den medföljande infraröda fjärrkontrollen
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Öppna skärmen för live-drift i Web App.1

Ställ in hjälpläget PTZ på [Trace] i listrutan högst upp på kontrollpanelen för förinställningsposition.2

Välj och tryck på en av knapparna POSITION1 till 3 som en bildinramning spelades in för.

Kamerans panorering/lutning/zoom flyttas till uppspelningens startposition.

3

När kameran har flyttats till uppspelningens startposition trycker du på samma POSITION-knapp igen.

Uppspelningen startar.

4
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Skärm för fokusjustering

Fokuset justeras med följande delar av skärmen för livedrift.

5-041-958-63(1) Copyright 2022 Sony Corporation

Kamerans bildruta
Du kan justera fokuset genom att vidröra kamerabilden. Du kan inaktivera pekfunktionen i Web App genom att stänga
av [Touch Focus]-brytaren på fliken  (Focus) i kamerakontrollpanelen.

1.

Kamerakontrollpanel – fliken  (Focus)2.

GUI-kontrollpanelen3.
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Justera manuellt med hjälp av Web App

Du kan justera fokuset manuellt, i till exempel följande fall.

Föremål delvis förmörkade med vattendroppar
Föremål med låg kontrast mot bakgrunden
Föremål längre bort än föremål som ligger nära

OBS!

Manuell fokus kan inte styras från Web App medan zoomfunktionen används.

Tips

Du kan även använda autofokus när manuell justering är den huvudsakliga användningsmetoden. För information, se ”Ställa in
fokusmålet manuellt (AF Assist) med hjälp av Web App.”

Relaterade avsnitt

Kontrollera linsbrytarna

Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App
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Om linsen är utrustad med en fokusväljarbrytare, ställ då brytaren till positionen ”AF/MF” eller ”AF”.

OBS!

Om brytaren är inställd på positionen ”Full MF” eller ”MF”, kan linsfokus inte användas med enheten. Se ”För en lins med
fokusbrytarläge” i ”Kontrollera linsbrytarna.”

1

Skjut [Auto Focus]-brytaren till vänster position i kamerakontrollpanelen för att stänga av det.

Manuellt fokusläge är aktiverat.

 (MF)

2

Justera med skjutreglaget längst ned på fliken  (Focus).3
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Justera manuellt med den medföljande infraröda fjärrkontrollen

Du kan justera fokuset manuellt med den medföljande infraröda fjärrkontrollen.

Tips

Du kan även använda autofokus när manuell justering är den huvudsakliga användningsmetoden. För information, se ”Fokusera
manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen.”

Relaterade avsnitt

Fokusera manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen
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Tryck på MF-knappen med den infraröda fjärrkontrollen.1

Justera fokuset manuellt med knappen F (Far) och knappen N (Near).

Tryck på knappen F för att fokusera på ett avlägset motiv.
Tryck på knappen N för att fokusera på ett närbeläget motiv.

2
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Fokusera genom att specificera en fokusposition (punktfokus)

I manuellt fokusläge kan du specificera den position där du vill justera fokus i kamerans bildruta.

OBS!

Punktfokusfunktionen används inte om linsen är inställd på manuellt fokus.

Tips

I punktfokusläge kan du trycka på en tilldelningsbar knapp som tilldelats [Push AF/MF] för att tillfälligt stoppa punktfokus och
aktivera autofokus medan knappen hålls nedtryckt. Fokuset återgår till manuellt fokus när du släpper knappen.
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Ställ in [Shooting] > [Focus] > [Touch Function in MF] till [Spot Focus] i web- eller kameramenyn.1

Skjut [Touch Focus]-brytaren på fliken  (Focus) till höger position för att slå på den.2

Skjut [Auto Focus]-brytaren på fliken  (Focus) till vänster position för att stänga av den.3

Specificera fokuspositionen.

Punktfokusmarkören visas och bilden justeras för att vara i fokus i den positionen.

Exempel på att specificera positionen med pekfunktion

4
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Använda autofokus tillfälligt (push-autofokus (AF))

I manuellt fokusläge kan du justera fokuset tillfälligt med autofokus genom att trycka på [Push AF/MF]-knappen för att
fokusera automatiskt medan knappen är nedtryckt.
Detta är praktiskt när du vill flytta fokuset långsamt från ett föremål till ett annat föremål under manuellt fokus.

OBS!

Push-autofokusfunktionen används inte om linsen är inställd på manuellt fokus.

Tips

Samma användning stöds med en tilldelningsbar knapp tilldelad [Push AF/MF].

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in [Shooting] > [Focus] > [Push AF Mode] till [AF] i kameramenyn.1

Skjut [Auto Focus]-brytaren på fliken  (Focus) till vänster position för att stänga av den.2

Tryck på knappen [Push AF/MF].

Autofokus är aktivt när knappen är nedtryckt.

Push-autofokus återgår till manuellt fokus när du släpper knappen.

3
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Använda autofokus med en bild (push-autofokus (AF-S))

Tryck på knappen [Push AF/MF] i manuellt fokusläge för att fokusera automatiskt i hög hastighet.
Denna funktion kommer väl till hands när du fokuserar på ett motiv innan du filmar.

OBS!

Push-autofokusfunktionen används inte om linsen är inställd på manuellt fokus.

Fokusområdesramen döljs inte när du använder [Display]-knappen.

Under användning av Clear Image Zoom, kan inte rampositionen [Focus Area (AF-S)] ställas in. Under användning av push-
autofokus ges även AF-funktionen prioritet till mittpositionen.

Ställ in [Shooting] > [Focus] > [Push AF Mode] till [Single-shot AF(AF-S)] i web- eller kameramenyn.1

Specificera positionen för vilken du vill justera fokuset under [Shooting] > [Focus] > [Focus Area (AF-S)] i
kameramenyn.

Tips

Du kan ändra position genom att trycka ned en tilldelningsbar knapp tilldelad med [Focus Setting] för att visa en orange ram
runt fokusområdet och välja en position med hjälp av pekfunktionen.

2

Skjut [Auto Focus]-brytaren på fliken  (Focus) till vänster position för att stänga av den.3

Tryck på knappen [Push AF/MF].

Om du frigör knappen innan du slutför fokusering, då stoppas push-autofokus.

Under push-autofokus visas fokusstatusen med fokusindikatorn.
På: Fokus är fixerat vid fokuspositionen.
Blinkar: Fokuserar inte. Eftersom enheten inte fokuserar automatiskt, ändras sammansättnings- och
fokusinställningar för att uppnå fokus.
Fokuset återgår till manuellt fokus när du släpper knappen.

4
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Tips

Samma användning stöds med en tilldelningsbar knapp tilldelad [Push AF/MF].

Du kan även tilldela [Push AF Mode] till en tilldelningsbar knapp.

Du kan även tilldela [Focus Area (AF-S)] till en tilldelningsbar knapp.

Du kan visa/dölja fokusområdesramar med [Monitoring] > [Display On/Off] > [Focus Area Ind.(AF-S)] i kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Justera automatiskt med hjälp av Web App

Enheten använder fasdetektering AF för höghastighetsfokus och kontrast AF för fokus med hög noggrannhet.
Kombinationen av dessa två AF-metoder ger autofokus med såväl hög hastighet som hög noggrannhet.

OBS!

Det krävs en lins som stöder autofokus.

Noggrannheten kanske inte kan uppnås beroende på i vilka förhållanden du filmar.

Fokuset kan inte justeras automatiskt på en A-monterad lins.

Tips

Under autofokusläge kan du justera fokuset med hjälp av Focus-skjutreglaget i kamerakontrollblocket. För information, se ”Ställa
in fokusmålet manuellt (AF Assist) med hjälp av Web App.”

Relaterade avsnitt
Kontrollera linsbrytarna

Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App

5-041-958-63(1) Copyright 2022 Sony Corporation

Om linsen är utrustad med en fokusväljarbrytare, ställ då brytaren till positionen ”AF/MF” eller ”AF”.

OBS!

Om brytaren är inställd på positionen ”Full MF” eller ”MF”, kan linsfokus inte användas med enheten. Se ”För en lins med
fokusbrytarläge” i ”Kontrollera linsbrytarna.”

1

Skjut [Auto Focus]-brytaren till höger position i kamerakontrollpanelen för att slå på den.

Autofokusläge är aktiverat.

 (AF)

2
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Justera automatiskt med den medföljande infraröda fjärrkontrollen

Du kan justera fokuset automatiskt med den medföljande infraröda fjärrkontrollen.

OBS!

Du kan även använda autofokus när manuell justering är den huvudsakliga användningsmetoden. För information, se ”Fokusera
manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen.”

Relaterade avsnitt
Fokusera manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen
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Tryck på AF-knappen med den infraröda fjärrkontrollen.

Fokuset på ett motiv justeras automatiskt.

1
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Ställa in autofokusområde/position (fokusområde)

Du kan ställa in målområdet för autofokus och justera fokus för det området.

Tryck på knappen [Menu] på GUI-kontrollpanelen i kameramenyn.1

Ställ in området för autofokus med [Shooting] > [Focus] > [Focus Area] i kameramenyn.

[Wide]:
Söker efter ett föremål över en vid vinkel för bilden vid fokusering. Ingen ram visas.

[Zone]:
Söker automatiskt efter en fokusposition inom en specifik zon.
Efter val specificerar du positionen med pilknapparna i GUI-kontrollpanelen.

Du kan återgå till mittpositionen genom att trycka och hålla ned [Set]-knappen.
[Flexible Spot]:
Fokuserar på en specificerad position på bilden.
Efter val specificerar du positionen med pilknapparna i GUI-kontrollpanelen.

2
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OBS!

Fokusområdesramen döljs inte när du använder [Display]-knappen på kamerans bildruta.

Under Clear Image Zoom, ställs fokusområdet in på [Wide] (fast).

Tips

Du kan visa/dölja fokusområdesramar med [Monitoring] > [Display On/Off] > [Focus Area Indicator] i kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

Du kan återgå till mittpositionen genom att trycka och hålla ned [Set]-knappen.
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Ändra fokusområdet snabbt (fokusinställning)

Du kan snabbt ändra position och storlek för autofokusområdet under filmning genom att tilldela [Focus Setting] till en
tilldelningsbar knapp.

För information om tilldelningsbara knappar, se ”Tilldelningsbara knappar.”

Användningen varierar beroende på fokusområdesinställning.

När [Shooting] > [Focus] > [Focus Area] är inställt på [Flexible Spot] eller [Zone] i
kameramenyn

Du kan ändra position för fokusområdet genom att trycka på en tilldelningsbar knapp med [Focus Setting] och justera
med pilknapparna i GUI-kontrollpanelen. Du kan återställa positionen för fokusområdet till mitten när du justerar
positionen genom att trycka på [Set]-knappen.
Du kan ändra storlek på fokusområdet genom att trycka och hålla ned en tilldelningsbar knapp med [Focus Setting].
Efter att du ändrat storleken, kan du ändra positionen för fokusområdet genom att trycka ned [Set]-knappen. När du
är färdig, ska du trycka ned den tilldelningsbara knappen med [Focus Setting] för att återgå till den ursprungliga
skärmen.

När [Shooting] > [Focus] > [Focus Area] är inställt på [Wide] i kameramenyn

Du kan endast ändra storlek på fokusområdet genom att trycka och hålla ned en tilldelningsbar knapp med [Focus
Setting]. Positionen kan även ändras genom att först ändra typen av [Flexible Spot] eller [Zone].

Tips

När både [Shooting] > [Focus] > [Push AF Mode] är inställt till [Single-shot AF(AF-S)] i kameramenyn och brytaren [Auto Focus] är
inställd på positionen off (manuellt fokusläge), kan du ändra [Focus Area (AF-S)]-fokusområdespositionen.

Fokusområdesramen visas i orange när positionen för fokusområdet kan ändras.

Relaterade avsnitt

Tilldelningsbara knappar

5-041-958-63(1) Copyright 2022 Sony Corporation
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Flytta fokusområdesramen med pekfunktionen (beröringsfokusområde)

Du kan ändra position för fokusområdet genom att vidröra en tilldelningsbar knapp tilldelad med [Focus Setting] för att
ändra fokusområdesvisningen till orange och sedan flytta fokusområdesramen med pekfunktionen i
kamerakontrollpanelen.
Vidrör skärmen för att flytta fokusområde med fokusområdet centrerat där du vidrört. Dra över skärmen för att flytta
fokusområdet till dit du drar ditt finger.

Tips

Du kan aktivera/inaktivera beröringsfokusområdet på filmningsskärmen med en tilldelningsbar knapp tilldelad med [Focus
Setting].

Vidrör vilken position som helst.

Den vidrörda positionen blir till mitten av fokusområdet.

1

Dra för att flytta fokusområdet till dit du drar din fingerposition.2
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OBS!

Om du vidrör en position eller drar fokusområdet till en position som överskrider inställningsintervallet, ställs fokusområdet till
inställningsintervallets övre/nedre/vänstra/högra kant.

Denna funktion är inte tillgänglig under följande förhållanden.

När [Touch Focus]-brytaren är avstängd i kamerakontrollpanelen
När fokusområdesramen visas i grått eller inte visas alls

5-041-958-63(1) Copyright 2022 Sony Corporation
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Justera autofokusåtgärden (AF-övergångshastighet, känslighet för växling av AF-
föremål)

Du kan justera autofokus genom att ändra övergångshastigheten och känslighet för växling.

Ställa in AF-övergångshastighet

Du kan ställa in hastigheten för fokusets drivenhet för när föremålet ändras med hjälp av knappen [AF Transition Speed] i
kamerakontrollpanelen.

Välj mellan hastigheterna [Speed 1] (Slow) och [Speed 7] (Fast) i ökningar om 1. Tryck på knappen < för att minska
värdet (långsammare) eller knappen > för att öka värdet (snabbare).
När inställt på låg hastighet rör sig fokuset långsamt när föremålet som ska fokuseras ändras, vilket gör det möjligt att
filma med imponerande bilduttryck.
När inställt på hög hastighet, växlar fokuset mellan föremålen snabbt. I exemplet nedan ändras fokuset snabbt från
byggnaden i bakgrunden till personen som går i förgrunden. Föremålet som kommer in i ramen fokuseras omgående,
vilket gör denna inställning perfekt för dokumentärfilmning som kräver snabbt fokus.

Känslighet för växling av AF-föremål

Du kan växla känslighet för att ändra mellan föremål med knappen [AF Subj. Shift Sens.] i kamerakontrollpanelen.
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Välj mellan hastigheterna [Sens 1] (Locked On) till [Sens 5] (Responsive) i ökningar om 1. Tryck på knappen < för att
minska värdet (ändra långsamt) eller knappen > för att öka värdet (ändra snabbt).
När inställt på låg känslighet, växlar inte fokus lätt även om ett annat föremål rör sig framför föremålet i fokus.

När inställt på hög känslighet, växlar fokus för att ge prioritet till föremålet som rör sig framför.

Tips

Om [AF Speed/Sens.] tilldelas en tilldelningsbar knapp, justerar nivåstaplarna för justerade värden som visas i kamerans bildruta i
följande ordning varje gång knappen trycks ned, och gör det möjligt att ändra AF-övergångshastigheten och känslighet för växling
av AF-föremål.
AF-övergångshastighet → känslighet för växling av AF-föremål → Inget visas …

5-041-958-63(1) Copyright 2022 Sony Corporation
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Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App

Efter att man växlat och justerat fokuset manuellt kan man överlåta fokuskontrollen till autofokus för finjusteringar av
fokus.

OBS!

I AF assist-tillståndet är det svårare att flytta fokus, oavsett [Shooting] > [Focus] > [AF Subj. Shift Sens.]-inställning i
kameramenyn.

AF assist-tillståndet avbryts på följande sätt.

När motivet som fokuseras med [Focus]-skjutreglaget inte längre syns
När du byter till manuell fokusering
När realtidsspårning med AF startas

Tips

AF assist-tillståndet kan avbrytas snabbt med en tilldelningsbar knapp som tilldelas med [Push AF/MF].

Realtidsspårning med AF stoppas när skjutreglaget [Focus] används.

Ställ in [Shooting] > [Focus] > [AF Assist] till [On] i kameramenyn.1

Ställ in [Shooting] > [Focus] > [AF Assist Control] till [On] i web-menyn.2

Skjut [Auto Focus]-brytaren till höger position i kamerakontrollpanelen för att slå på den.

Autofokusläge är aktiverat.

3

Ställ in fokusmål med hjälp av skjutreglaget [Focus] i kamerans kontrollblock.

[Near]: Fokus på ett nära motiv.
[Far]: Fokus på ett avlägset motiv.

I AF assist-tillståndet kommer ett motiv vid avstånd inställt med [Focus]-skjutreglaget att fokuseras automatiskt.

4
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I Face/Eye Only AF-läget fokuserar autofokus på ansiktet närmast fokuseringspositionen på [Focus]-skjutreglaget.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Fokusera manuellt under autofokus med hjälp av den medföljande infraröda
fjärrkontrollen

När [Shooting] > [Focus] > [AF Assist] är inställt på [On] i kameramenyn kan du använda knappen F (Far) och N (Near)
på den medföljande infraröda fjärrkontrollen, även under autofokus, för att fokusera på ett motiv.

5-041-958-63(1) Copyright 2022 Sony Corporation

183



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Använda manuellt fokus tillfälligt under autofokus (manuellt fokus med push)

Tryck på knappen [Push AF/MF] i autofokusläge för att fokusera manuellt när knappen är nedtryckt. Fokuset återgår till
autofokus när du släpper knappen.
På detta sätt kan du tillfälligt stoppa autofokus och fokusera manuellt när något som inte är en del av föremålet som
filmas korsar framför föremålet.

Tips

Samma användning stöds med en tilldelningsbar knapp tilldelad [Push AF/MF].

5-041-958-63(1) Copyright 2022 Sony Corporation

184



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fokusering med ansikts- och ögondetektering (Face/Eye Detection AF)

Enheten kan detektera människors ansikten och ögon som ett spårningsmål och sedan justera fokus på ansikten och
ögon inom fokusområdet.
När ansikten detekteras, visas grå ansikts-/ögondetekteringsramar. När det är möjligt med autofokusering ändras
ramarna till vita och spårningen startar. När ögon detekteras och fokuset justeras, visas ansikts-/ögondetekteringsramen
på ögonen. När flera personer detekteras, fastställs huvudföremålet automatiskt.
Denna funktion är endast tillgänglig när fokusläget är i AF-läge eller under push-autofokus.

Tips

När fokusområdet är inställt på [Zone] eller [Flexible Spot] och ansikten eller ögon överlappar inom det specificerade
fokusområdet, ändras ansikts-/ögondetekteringsramarna till vitt och enheten fokuserar på dessa ansikten/ögon.

När push-autofokus (AF-S) används ändras ansikts-/ögondetekteringsramarna för ansikten/ögon i fokus till grönt.

Inställning med knappen [Face/Eye Detection AF] i kamerakontrollpanelen

Tryck på [Face/Eye Detection AF]-knappen och ställ in användning med ansikts-/ögondetektering med AF.

[Face/Eye Only AF]: Kameran detekterar motivs (människors) ansikten/ögon och fokuserar på och spårar endast deras
ansikten/ögon. Om ett ansikte eller öga inte detekteras, stoppas AF tillfälligt, och ikonen (autofokusläget  Face/Eye
Only AF pausas) visas. Detta läge är effektivt när du vill autofokusera på och spåra endast ansikten/ögon.
[Face/Eye Priority AF]: Kameran detekterar motivs (människors) ansikten/ögon och prioriterar fokus/spårning på
ansikten/ögon. När ett ansikte eller öga inte detekteras, är fokus i AF-läge (standardinställning).
[AF]: Ansikts/ögondetekteringsfunktionen AF inaktiveras.

OBS!

Under användning av push-autofokus, aktiveras [Face/Eye Priority AF] även om [Face/Eye Only AF] just då är valt.

När [Auto Focus] -brytaren är inställd på off-position, inaktiveras ansikts-/ögondetektering AF (med undantag för användning av
push-autofokus).

Om du stänger av enheten medan [Face/Eye Only AF] är valt, växlar läget automatiskt till [Face/Eye Priority AF] nästa gång
enheten startas.

Tips
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Du kan ställa in användningen av ansikts-/ögondetektering AF med hjälp av [Shooting] > [Focus] > [Face/Eye Detection AF] i
kameramenyn.

Dölja ansikts-/ögondetekteringsramar
Du kan visa/dölja ansikts-/ögondetekteringsramar med [Monitoring] > [Display On/Off] > [Face/Eye Detection Frame] i
kameramenyn.

OBS!

Gröna ansikts-/ögondetekteringsramar visas för ansikten och ögon som är i fokus med push-autofokus (AF-S), och döljs inte med
[Display]-knappen eller när [Face/Eye Detection Frame] är inställt på [Off].

Växla funktionen ansikts-/ögondetektering AF med en tilldelningsbar knapp
Tilldela [Face/Eye Detection AF] till en tilldelningsknapp. Du kan växla användningen av ansikts-/ögondetektering AF i
följden [Face/Eye Priority AF], [Face/Eye Only AF] och [AF] varje gång du trycker på knappen.

Inställning vid användning av direktmenyn

Du kan även ställa in användningen av ansikts-/ögondetektering AF med hjälp av direktmenyn.

För mer information om direktmenyn, se ”Använda direktmenyn.”

Relaterade avsnitt

Använda direktmenyn
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Spåra ett specificerat motiv (Realtime Tracking AF)

Du kan behålla fokus på ett motiv genom att specificera motivet med pekfunktionen eller genom att välja en
ansiktsdetekteringsram i kamerakontrollpanelen.
När ett motiv har valts visas en vit spårningsram och spårningen startar.

Tips

Spårning sker över hela bildområdet, oavsett fokusområdesinställning.

När [Shooting] > [Focus] > [Touch Function in MF] är inställt på [Tracking AF] i web- eller kameramenyn, stöds AF-spårning i
realtid även när fokusläget är MF-läge.

Beroende på användningslägesinställning för ansikts-/ögondetektering AF uppstår följande för spårningsmålet.

[Face/Eye Only AF] eller [Face/Eye Priority AF]: Fokusering och spårning av ett specifikt motiv.
Om spårningsmålet är en person och ett ansikte/öga detekteras fokuserar kameran på det ansiktet/ögat.
När ett spårat målansikte/-öga detekteras sparas målspårningsansiktet. När det sparas visas en  (ikonen för sparat
spårningsansikte) .

OBS!

När spårnings-AF startas under manuell fokus sparas inte målspårningsansiktet.

[AF]: Används för fokusering och spårning av ett visst motiv. Ansikts-/ögondetektering sker inte, även om spårningsmålet
är en person.

OBS!

Funktionen realtidsspårning med AF används inte om linsen är inställd på manuellt fokus.

Starta realtidsspårning med AF

När ett specifikt ämne anges som spårningsmål startar spårning av det målet.

Specificera med pekfunktionen
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Skjut brytaren [Touch Focus] på fliken  (Focus) i kamerans kontrollblock till höger position för att starta den och vidrör
sedan målmotivet att spåra i något av följande lägen.

Under manuellt fokus eller under manuellt fokus med push och när [Shooting] > [Focus] > [Touch Function in MF] är
inställt till [Tracking AF] i web- eller kameramenyn
Under autofokus eller push-autofokus (AF)

Specificera genom val av ansiktsdetekteringsram
Flytta ansiktets väljarmarkör (orange understreckning) till målmotivet som ska spåras med pilknapparna i GUI-
kontrollpanelen, och tryck på [Set]-knappen.

A: Ansiktsdetekteringsramar (grått)
B: Spårningsram
C: Ansiktsvalsmarkör (orange)

OBS!

Under manuell fokusering kan spårning inte startas genom val av ansiktsdetekteringsram.

Tips

Du kan också ändra målet att spåra under realtidsspårning med AF.

Stoppa realtidsspårning med AF

Tryck på knappen  (stoppa realtidsspårning med AF).

Tips

Realtidsspårning med AF stoppas i följande fall:

När [Auto Focus]-brytaren eller AUTO/MANUAL-kontrollen på linsen växlas
När fokusläget ändrades

188



När AF assist utförs
När fokusområdesinställningen eller ansikts-/ögondetektering ändras
När en tilldelningsbar knapp tilldelad med [Push AF/MF] trycks in
När spårningsmålet inte är inom fotograferingsskärmen eller när motivet är ur fokus i några sekunder

När ett spårningsansikte sparas (när  (ikonen för sparat spårningsansikte) visas), återupptas realtidsspårning med AF när det
sparade spårningsansiktet kommer in i bildområdet. För att rensa spårningsansiktet, stoppa realtidsspårning med AF enligt
beskrivningen ovan.
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189



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Skärm för ljusstyrkejustering

Du kan justera ljusstyrkan genom att justera bländare, förstärkning, slutarhastighet och genom att justera ljusnivån med
hjälp av ND-filter i följande kontrollpaneler på skärmen för livedrift i Web App. Du kan justera ljusstyrkan automatiskt.

OBS!

Förstärkning kan inte justeras när [Shooting Mode] är inställt till [Cine EI Quick] eller [Cine EI]. Dessutom kan inte ljusstyrkan
justeras automatiskt med slutarhastigheten när den är inställd på [Cine EI Quick] eller [Cine EI]. Automatisk justering av ljusstyrka
med bländaren och ND-filter stöds.

Tips

Kamerakontrollpanel – fliken  (Main)1.

Kamerans grundläggande konfigurationspanel
Visar inställningsstatus på knappar för grundläggande funktioner som krävs för filmning. Tryck på en knapp för att
visa motsvarande konfigurationsskärm för varje funktion i kamerans grundläggande justeringspanel nedan.

2.

Kamerans justeringspanel för grundläggande konfiguration
Visar justeringspanelen för konfigurationsobjektet som väljs i kamerans grundläggande konfigurationspanel.

3.
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Cine EI-läge är ett läge för att filma på en grundläggande känslighetsnivå utan att använda förstärkning för att maximera
prestandan för bildsensorn. Ljusstyrkan justeras med belysning och ND-filter för att justera ljusmängden som når bildsensorn. För
information om Exposure Index (EI), se ”Ändra fördelningen av mörka och ljusa områden i inspelad bild.”

Relaterade avsnitt

Ändra fördelningen av mörka och ljusa områden i inspelad bild
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Ställa in grundläggande känslighet

Du kan ställa in den grundläggande känsligheten innan du börjar justera ljusstyrkan.

När [Shooting Mode] är inställt på [Custom]

Tryck på knappen [ISO/Gain] i kamerans grundläggande konfigurationsfält, och ställ in [Base Sensitivity] på ISO/Gain-
justeringspanelen till [High] eller [Low].
Välj [Low] i normala ljusförhållanden och välj [High] i förhållanden med svagt ljus.
Skärm när [AGC] är avstängd

Skärm när [AGC] är påslagen

När [Shooting Mode] är inställt på [Flexible ISO] eller [Cine EI]

Tryck på knappen [Base ISO/Exposure Index] i kamerans grundläggande konfigurationsfält, och ställ in [Base ISO] på
Base ISO/Exposure Index-justeringspanelen till [ISO 12800] eller [ISO 800].
Välj [ISO 800] i normala ljusförhållanden och välj [ISO 12800] i förhållanden med svagt ljus.

Tips
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Du kan även justera detta på fliken  (Main) i kamerakontrollpanelen.

Kan även ställas in med [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] eller [Base ISO] i kameramenyn.

Du kan även tilldela [Base ISO/Sensitivity] till en tilldelningsbar knapp.

I filmningsläget [Cine EI Quick] ställs baskänsligheten in automatiskt enligt inställningen för exponeringsindex.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Ställa in målnivå för automatisk ljusstyrkejustering

Målnivån för automatisk ljusstyrkejustering ställs in med hjälp av [AE Level]-skjutreglaget i kamerakontrollblocket.
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Tryck på fliken  (Main) i kamerakontrollpanelen.

Om [AE Level]-skjutreglaget inte visas, då ska du välja ett av de två skjutreglagen för att välja funktion och välja [AE
Level]-skjutreglaget från listan.

[AE Level]-skjutreglaget visas.

1

Ställ in målnivån med hjälp av skjutreglaget.

Flytta skjutreglaget till vänster för en mörkare bild. Flytta skjutreglaget till höger för en ljusare bild.

Tips

Kan även ställas in med [Shooting] > [Auto Exposure] > [Level] i kameramenyn.

2
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Justera bländaren automatiskt

Du kan justera ljusstyrkan automatiskt enligt föremålet. Det krävs en kompatibel lins.

OBS!

Bländaren kan inte justeras automatiskt på en A-monterad lins.

Tips

Du kan även tilldela [Auto Iris] till en tilldelningsbar knapp.
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Om en lins med Auto Iris är fäst, ställ då brytaren till AUTO.1

Tryck på knappen [Iris] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Iris] ändras till orange.

Iris-justeringspanelen visas.

2

Skjut [Auto]-brytaren till höger position för att slå på den.

Bländaren övergår till automatiskt justeringsläge. Det automatiskt justerade bländarvärdet visas på höger sida av
brytaren.

3
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Justera bländaren manuellt

Du kan justera ljusstyrkan manuellt.

Tillfälligt justera bländaren automatiskt
Du kan även trycka på [Push Auto]-knappen på Iris-justeringspanelen för att justera bländaren automatiskt medan
knappen är nedtryckt.

Om en lins med Auto Iris är fäst, ställ då brytaren till AUTO.

OBS!

När linsens Auto Iris-brytare är inställd på MANUAL, har enhetens funktioner för [Auto Iris] och [Push Auto Iris] ingen
verkan. Inte heller har manuell bländarjustering på enheten någon verkan.

1

Tryck på knappen [Iris] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Iris] ändras till orange.

Iris-justeringspanelen visas.

2

Skjut [Auto]-brytaren till vänster position för att stänga av den.

Bländaren övergår till manuellt justeringsläge.

3

Justera bländaren med skjutreglaget [Iris] eller [Iris]-justeringsknapparna.

Tips

Skjutreglaget och justeringsknappinställningarna är sammankopplade.

Du kan även tilldela bländaren till skjutreglaget på fliken  (Main) i kamerakontrollpanelen.

4
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Tips

Tryck på den tilldelningsbara knappen tilldelad med [Push Auto Iris]-funktionen för att justera bländningen automatiskt medan
knappen är nedtryckt.
Bländaren återgår till manuellt läge när du släpper knappen.
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Justera förstärkningen automatiskt

Du kan justera ljusstyrkan automatiskt med förstärkningsinställningen när [Shooting Mode] är inställt till [Custom] eller
[Flexible ISO].
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Ställ in [Project] > [Shooting Mode] till [Custom] i web- eller kameramenyn.1

Tryck på knappen [ISO/Gain] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [ISO/Gain] ändras till orange.

ISO/Gain-justeringspanelen visas.

2

Skjut [AGC]-brytaren till höger position för att slå på den.

Förstärkningen övergår till automatiskt justeringsläge. Det automatiskt justerade förstärkningsvärdet visas på höger
sida av brytaren.

Tips

Du kan även utföra samma åtgärd genom att ställa in [Shooting] > [Auto Exposure] > [AGC] till [On] i kameramenyn.

Du kan även tilldela [AGC] till en tilldelningsbar knapp.

3
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Justera förstärkningen manuellt

Du kan justera ljusstyrkan manuellt med förstärkningsinställningen när [Shooting Mode] är inställt på [Custom] eller
[Flexible ISO].
Du kan reglera förstärkningen när du vill justera exponeringen medan du använder en fast bländarinställning eller när du
vill förhindra större förstärkning på grund av AGC.

Tillfälligt justera förstärkningen manuellt
Du kan även justera förstärkningen tillfälligt genom att tilldela [ISO/Gain] till ett skjutreglage för att välja funktion på fliken

 (Main) i kamerakontrollpanelen och använda skjutreglaget.
Detta är praktiskt när du vill justera exponeringen med ett steg utan att ändra fältdjup.
Justeringsresultaten återgår till förinställda värden som konfigurerats med [ISO/Gain<L>] efter att du utfört en av följande
åtgärder.

Ställ in [Project] > [Shooting Mode] till [Custom] i web- eller kameramenyn.1

Tryck på knappen [ISO/Gain] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [ISO/Gain] ändras till orange.

ISO/Gain-justeringspanelen visas.

2

Skjut [AGC]-brytaren till vänster position för att stänga av den.

Förstärkningen övergår till manuellt justeringsläge.

3

Justera förstärkningen med skjutreglaget [ISO/Gain] eller [ISO/Gain]-justeringsknapparna.

Tips

Skjutreglaget och justeringsknappinställningarna är sammankopplade.

4
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Ändrar ISO/Gain-justeringsobjekt
Ändrar den grundläggande känsligheten
Ställer AGC-brytaren till läget on
Växla enhetens strömförsörjning till standby

För att tillfälligt justera förstärkningen automatiskt med en tilldelningsbar knapp
Tryck på den tilldelningsbara knappen tilldelad med [Push AGC]-funktionen för att justera förstärkningen automatiskt
medan knappen är nedtryckt.
Förstärkningen återgår till manuellt läge när du släpper knappen.
Justeringsresultaten återgår till förinställda värden som konfigurerats med [ISO/Gain<L>] efter att du utfört en av följande
åtgärder.

Ändrar ISO/Gain-justeringsobjekt
Ändrar den grundläggande känsligheten
Ställer AGC-brytaren till läget on
Växla enhetens strömförsörjning till standby

OBS!

Funktionen kan inte utföras när [Shooting] > [Iris] > [Bokeh Control] är inställt till [On] i kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Justera slutaren automatiskt

Du kan justera slutaren automatiskt som svar på bildens ljusstyrka.
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Tryck på knappen [Shutter] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Shutter] ändras till orange.

Shutter-justeringspanelen visas.

1

Tryck på knappen [Shutter Type] och välj [Auto] från listan.

Tips

Du kan även utföra samma åtgärd genom att ställa in [Shooting] > [Auto Exposure] > [Auto Shutter] till [On] i kameramenyn.

Du kan även tilldela [Auto Shutter] till en tilldelningsbar knapp.

2
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Justera slutaren manuellt

Du kan justera slutaren manuellt.

Tryck på knappen [Shutter] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Shutter] ändras till orange.

Shutter-justeringspanelen visas.

1

Tryck på knappen [Shutter Type] och välj [Speed] från listan.2

Justera slutaren med skjutreglaget [Speed] eller [Speed]-justeringsknapparna.

För att justera exponeringstiden för att matcha bildintervallet, välj [Off] i steg 2. Du kan även ställa in ett fast värde
med [ECS] (frekvens) eller justera det automatiskt med [Auto].
Exempel: Ställ in med [ECS] (frequency)

Tips

Skjutreglaget och justeringsknappinställningarna är sammankopplade.

För att använda [Angle] istället för [Speed] eller [Off], ställ in [Shooting] > [Shutter] > [Mode] till [Angle] i kameramenyn.

3

202



5-041-958-63(1) Copyright 2022 Sony Corporation

203



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Om ND-filtret

När belysningen är för stark kan du ställa in lämplig ljusstyrka genom att ändra ND-filter.
När du filmar ett stark upplyst föremål, kan det bli suddigt om bländaren stängs för mycket vilket producerar en bild som
börjar hamna ur fokus (vanligt förekommande med kameror). Du kan undkomma denna effekt för att få bättre
filmningsresultat med ND-filtret.
Enheten har följande ND-filterlägen.
Förinställt läge

Se ”Justera i förinställt läge.”

Variabelt läge (automatisk justering)

Se ”Justera automatiskt i variabelt läge.”

Variabelt läge (manuell justering)

Se ”Justera manuellt i variabelt läge.”

Relaterade avsnitt

Justera i förinställt läge

Justera automatiskt i variabelt läge

Justera manuellt i variabelt läge
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Justera i förinställt läge

Du kan välja mellan tre sändningsvärden för ND-filter på förhand och snabbt växla mellan dem när du filmar.

Tips

När en tilldelningsbar knapp tilldelas med [ND Filter Position] nedtryckt, ändras ND-filtret i sekvensen [Clear] → [Preset1] →
[Preset2] → [Preset3] → [Clear].
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Ställ in [Shooting] > [ND Filter] > [Mode] till [Preset] i kameramenyn.1

Tryck på knappen [ND Filter] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [ND Filter] ändras till orange.

ND Filter-justeringspanelen visas.

2

Tryck på knappen [ND Filter] och välj en av följande från listan.

[Clear]: Inget ND-filter.
[Preset1]: Sändning inställd med [Shooting] > [ND Filter] > [Preset1] i kameramenyn.
[Preset2]: Sändning inställd med [Shooting] > [ND Filter] > [Preset2] i kameramenyn.
[Preset3]: Sändning inställd med [Shooting] > [ND Filter] > [Preset3] i kameramenyn.

När en av [Preset1] till [Preset3] väljs för ND-filtret, visas sändningsvärdet invid ND-filternamnet.

3
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Justera automatiskt i variabelt läge

Du kan utföra automatisk exponeringsjustering med ND-filtret.

OBS!

När ND-filtret växlas till eller från [Clear] under filmning, visas ND-filterramen på bilden och användningsljudet sänds.

Tips

Du kan även tilldela [Auto ND Filter] till en tilldelningsbar knapp och trycka på knappen för att växla mellan [Auto] och [Manual].
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Ställ in [Shooting] > [ND Filter] > [Mode] till [Variable] i kameramenyn.1

Tryck på knappen [ND Filter] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [ND Filter] ändras till orange.

ND Filter-justeringspanelen visas.

2

Tryck på knappen [ND Filter] och välj [Auto] från listan.

Det automatiskt justerade ND-filtrets sändningsvärde visas invid knappen [ND Filter].

3
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Justera manuellt i variabelt läge

Du kan utföra manuell exponeringsjustering med ND-filtret.

Tillfälligt justera automatiskt
Du kan tilldela [Push Auto ND] till en tilldelningsbar knapp, och tillfälligt ställa in Auto ND-filter till On genom att trycka och
hålla ned knappen. Om du släpper knappen ställs Auto ND-filter tillbaka till Off.
Ställ in ND-filtret till [Manual].

OBS!

När ND-filtret växlas till eller från [Clear] under filmning, visas ND-filterramen på bilden och användningsljudet sänds.

Tips

Ställ in [Shooting] > [ND Filter] > [Mode] till [Variable] i kameramenyn.1

Tryck på knappen [ND Filter] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [ND Filter] ändras till orange.

ND Filter-justeringspanelen visas.

2

Tryck på knappen [ND Filter] och välj [Manual] från listan.3

Justera sändningen av ND-filtret med skjutreglaget[ND Filter] eller [ND Filter]-justeringsknapparna.

Tips

Skjutreglaget och justeringsknappinställningarna är sammankopplade.

Du kan även justera ND-filtret på fliken  (Main) i kamerakontrollpanelen.

4
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Du kan även tilldela [ND Filter Position] till en tilldelningsbar knapp och trycka på knappen för att växla mellan [Manual] och
[Clear].

Du kan även trycka på [Push Auto]-knappen på ND Filter-justeringspanelen för att ställa in Auto ND Filter On medan knappen är
nedtryckt.
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Skärm för justering av vitbalans

Du kan justera vitbalansen med hjälp av skärmen för livedrift på Web App för att erhålla en vitbalans som får bilden att se
mer naturlig ut.
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Kamerans grundläggande konfigurationspanel1.

Kamerans justeringspanel för grundläggande konfiguration
Visar justeringspanelen för konfigurationsobjektet som väljs i kamerans grundläggande konfigurationspanel.

2.
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Justera vitbalansen automatiskt

Du kan närsomhelst erhålla en lämpligt justerad vitbalans med ATW (automatisk vitbalansspårning).
När ATW är aktiverat justeras vitbalansen automatiskt när färgtemperaturen för ljuskällan ändras.

OBS!

ATW kan inte användas när [Shooting Mode] är inställt till [Cine EI] eller [Cine EI Quick].

Det kanske inte är möjligt att justera till lämplig färg med ATW, beroende på förhållandena för belysning och föremål.
Exempel:

När en enskild färg dominerar föremålet, till exempel himmel, hav, mark eller blommor.
När färgtemperaturen är extremt hög eller låg.

Om den lämpliga effekten inte kan erhållas eller den automatiska spårningshastigheten för ATW är långsam, tryck då på [WB
SET]-knappen för att köra automatisk vitbalans.

Tips

Du kan välja svarshastighet i ATW-läge från fem steg (1, 2, 3, 4, 5) med [Shooting] > [White Setting] > [ATW Speed] i
kameramenyn. Ju lägre nummer, desto snabbare svarshastighet.

Du kan frysa den aktuella vitbalansinställningen genom att justera [ATW Hold]-funktionen till en tilldelningsbar knapp, och trycka
ned den tilldelningsbara knappen för att tillfälligt pausa ATW under ATW-läge.

5-041-958-63(1) Copyright 2022 Sony Corporation

Tryck på knappen [White Balance] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [White Balance] ändras till orange.

White Balance-justeringspanelen visas.

1

Tryck på knappen [White Mode] och välj [ATW] från listan.2

210



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justera vitbalansen manuellt

Du kan justera vitbalansen manuellt.

Tryck på knappen [White Balance] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [White Balance] ändras till orange.

White Balance-justeringspanelen visas.

1

Tryck på knappen [White Mode] och välj en av följande från listan.

[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Justera vitbalansen med skjutreglagen eller justeringsknapparna.

Tips

Skjutreglaget och justeringsknappinställningarna är sammankopplade.

Skillnaden mellan [Memory A(T/T)] och [Memory A(R/B)] är att axeln för justeringen skiljer sig, men justeringsresultaten är
sammankopplade.

För [Memory A(T/T)]
Detta läge justerar vitbalansen som sparas i minne A genom att justera färgtemperaturen (Temp) och Tint.
Du kan ställa in färgtemperaturen i ökningar om 20 K mellan 2000 K och 5600 K. Värden över 5600 K kan ställas in
i intervaller motsvarande färgförändringen (mired) från 5580 K till 5600 K.

3

211



5-041-958-63(1) Copyright 2022 Sony Corporation

Om du trycker på knappen [Reset] på höger sida av [Temp] eller [Tint] återställer motsvarande inställning till
standardvärdet.
För [Memory A(R/B)]
Detta läge justerar vitbalansen som sparas i minne A genom att justera färgtemperaturen R Gain och B Gain.
Om du trycker på knappen [Reset] återställs förstärkningsinställningen till standardvärde.
För [Preset]
Detta läge justerar färgtemperaturen till ett förinställt värde.
Du kan ställa in värdet med ökningar om 100 K.
I förinställt läge kan du även tilldela [Preset White Select] till en tilldelningsbar knapp och trycka på knappen för att
ändra till ett förinställt värde.
[Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
[Flexible ISO], [Cine EI], [Cine EI Quick]: 3200 K → 4300 K → 5500 K → 3200 K…

212



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Köra automatisk vitbalans

I läget minne A justeras vitbalansen som ska sparas automatiskt.

Tryck på knappen [White Balance] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [White Balance] ändras till orange.

White Balance-justeringspanelen visas.

1

Tryck på knappen [White Mode] och välj [Memory A(T/T)] eller [Memory A(R/B)] från listan.

[Memory A(T/T)]

[Memory A(R/B)]

2

Placera vitt papper (eller annat föremål) på en plats med samma belysningskälla och förhållanden som
föremålet, och zooma sedan in det på pappret för att visa vitt på skärmen.

3

Justera ljusstyrkan.

Justera bländaren med hjälp av förfarandet i ”Justera bländaren manuellt.”

4

Tryck på [WB SET]-knappen på justeringspanelen för vitbalans.

[Memory A(T/T)]

[Memory A(R/B)]

5
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OBS!

Om justeringen misslyckas visas ett felmeddelande på skärmen i cirka tre sekunder. Om felmeddelandet förblir efter flera försök
att ställa in vitbalansen, då ska du kontakta din Sony-servicerepresentant.

Tips

Du kan även köra det i ATW-läge. Du kan använda detta när du vill snabbt justera vitbalansen under ATW-drift. Efter justering
återgår läget till normal ATW-drift.

Relaterade avsnitt

Justera bländaren manuellt
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Om automatisk vitbalans körs i minnesläge sparas resultatet av autojustering i minnet A.
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Ljudkonfigurationsskärm

Du kan justera ljudnivå som ska spelas in med enheten på skärmen för livedrift med Web App. Konfigurera brytarna på
enhetens anslutningsblock och konfigurera ljudet med kameramenyn eller webbmenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

Kamerakontrollpanel – fliken  (Audio)1.
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Välj ljudingångsenhet

Ställ in följande brytare enligt den enhet som är ansluten till AUDIO IN-kontakten.

OBS!

Inget ljud spelas in i läget Interval Rec eller Slow & Quick Motion.
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När en mikrofon är ansluten, ställ in SETUP-brytare 2 på anslutningsblocket på enhetens baksida.

CH-1 och CH-2 har gemensamma inställningar.

1

Inställning Beskrivning

OFF
(standard)

Välj när du använder en dynamisk mikrofon eller batteridriven mikrofon. Detta stänger av
fantommatningen på +48 V och ställer LINE- eller MIC-ingången till ljudkälla CH-1 och CH-2.

ON
Välj när du använder en mikrofon kompatibel med +48 V fantommatad strömförsörjning. Detta
stänger av fantommatningen på +48 V och ställer in mikrofonen kompatibel med fantommatning
till ljudkälla CH-1 och CH-2.

Ställ in typ av ansluten enhet med [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenyn.2

Ställ in ljudingång med [Audio] > [Audio Input] > [CH1 Input Select] till [CH4 Input Select] i web- eller
kameramenyn.

3

216



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justera ljudinspelningsnivån automatiskt

Ställ in kanalen för vilken du vill justera ljudinspelningsnivån automatiskt till [Auto] på sidan [Audio] i web-menyn eller
använd [Audio] > [Audio Input] > [CH1 Level Control] till [CH4 Level Control] i kameramenyn.
Kanalerna angivna för auto-justering indikeras med en  (Auto)-ikon invid de motsvarande kanalerna på fliken 
(Audio) på skärmen för livedrift.
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217



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Justera ljudinspelningsnivån manuellt

Du kan justera ljudinspelningsnivån manuellt.
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Ställ in kanalen för vilken du vill justera ljudinspelningsnivån manuellt till [Manual] på sidan [Audio] i web-
menyn eller använd [Audio] > [Audio Input] > [CH1 Level Control] till [CH4 Level Control] i kameramenyn.

1

Tryck på fliken  (Audio) i kamerakontrollpanelen.2

På skärmen [Audio] i kamerakontrollpanelen, ställer du in ljudinspelningsnivån med skjutreglaget eller
justeringsknapparna för kanalen vars ljudinspelningsnivå du vill ändra manuellt.

OBS!

Kanalerna för vilka ikonen  (Auto) visas justeras automatiskt. Ändringar av värden med skjutreglaget eller knapparna
tillämpas inte för det inspelade ljudet.

Tips

Skjutreglaget och justeringsknappinställningarna på varje rad är sammankopplade.

Du kan kontrollera ljudingångsnivån i realtid med hjälp av ljudnivåmätarens display på filmningsskärmen.

3
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Använda direktmenyn

Du kan kontrollera enhetens status och inställningar på kamerabilden och välja samt ändra inställningar med GUI-
kontrollknapparna på den infraröda fjärrkontrollen.
Följande objekt kan konfigureras.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
[ND Filter]-värde
[Auto Iris]
[Iris]-värde
[AGC]
[Gain]-värde
[ISO]-värde
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]-värde
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] och [Frame Rate]

Tips

Du kan dessutom utföra samma funktion med den tilldelningsbara knappen och GUI-kontrollblocket i Web App.

Tryck på en tilldelningsbar knapp tilldelad med [Direct Menu] på den infraröda fjärrkontrollen.

Knappen [Direct Menu] tilldelas till tilldelningsbar knapp 1 som fabriksstandard.
Endast objekten på skärmen som kan konfigureras med direktmenyn är valbar med den orange markören.

1

Flytta markören till objektet du vill ställa in med pilknapparna i GUI-kontrollpanelen och tryck på [Set]-
knappen.

En meny visas eller så visas objektet på en vit bakgrund.

2

Välj en inställning med pilknapparna och tryck på [Set]-knappen.

Menyn eller den vita bakgrunden försvinner och den nya inställningen visas med en orange markör.
Tryck på den tilldelningsbara knappen tilldelad med [Direct Menu] eller vänta i 3 sekunder utan utföra någon åtgärd
för att gå ut från direktmenyn.

3
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Tilldelningsbara knappar

Det finns tio tilldelningsbara knappar i enhetens Web App till vilka du kan tilldela funktioner.
De tilldelningsbara knapparna visas på skärmen för livedrift och skärmen för uppspelning.

OBS!

Listan med tilldelningsbara knappar visas inte när konfiguration av inställningarna pågår i kamerans grundläggande
konfigurationsfält i skärmen för livedrift. För att avsluta åtgärden, tryck på knappen [X] högst upp till höger på justeringspanelen.

Följande funktioner är tilldelade till knapparna som fabriksstandard.
Knapp 1: [Direct Menu]
Knapp 2: [Focus Setting]
Knapp 3: [Rec Review]

Knapp 1 till 3 motsvarar samma nummerknappar på den medföljande infraröda fjärrkontrollen.

Knapp 4: [Push Auto ND]
Knapp 5: [Crop Select]
Knapp 6: [Marker]
Knapp 7: [Video Signal Monitor]
Knapp 8: [Clip Flag OK]
Knapp 9: [Color Bars]
Focus Hold-knapp: [Focus Hold]

Focus Hold-knappen motsvarar Focus Hold-knappen på en e-monterad lins.

Ändra en knappfunktion
Använd [Project] > [Assignable Button] i kameramenyn.
När du ändrar en tilldelning, ändras visningen av den tilldelningsbara knapplistan.
För information om tilldelningsbara funktioner, se ”Assignable Button” i ”Kamerameny och detaljerade inställningar.”

Relaterade avsnitt

Assignable Button

5-041-958-63(1) Copyright 2022 Sony Corporation
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Slow & Quick Motion

När inspelningsformatet är inställt till följande värden kan du specificera andra värden för in- och uppspelningens
bildfrekvens.
Följande tabell visar de konfigurerbara bildfrekvenserna.

Systemfrekvens: 59.94/50/29.97/25/23.98, Bildskanningsläge: FF

Systemfrekvens: 59.94/50/29.97/25/23.98, Bildskanningsläge: S35

Systemfrekvens: 24, Bildskanningsläge: FF

OBS!

Slow & Quick Motion kan inte ställas in under inspelning, uppspelning eller när miniatyrbildskärmen visas.

Ljudinspelningen stöds inte i Slow & Quick Motion-läget.

Funktionerna automatisk bländare och automatisk slutare inaktiveras i läget Slow & Quick Motion.

Autofokus har följande begränsningar i Slow & Quick Motion-läget.

Begränsningar på grund av linsmodell, systemfrekvens och uppspelningens bildfrekvens

Codec Videoformat Konfigurerbara bildfrekvenser

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Codec Videoformat Konfigurerbara bildfrekvenser

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Codec Videoformat Konfigurerbara bildfrekvenser

XAVC-I 4096×2160P 1–60
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Autofokusfunktionen avaktiveras tillfälligt om bländaren är inställd på F18 eller högre.

För mer information om RAW-bild, se ”Spela in RAW-video.”

Relaterade avsnitt

Spela in RAW-video
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Sony-lins Systemfrekvens AF-tillgänglighet

Annat än SEL16F28 – 7 fps eller högre stöds

SEL16F28

59.94/29.97/23.98 30, 60, 120, 240 fps stöds

50,00/25,00 25, 50, 100, 200 fps stöds

24,00 Stöds inte
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Spela in video växelvis (Interval Rec)

Med enhetens Interval Rec-funktion är det möjligt för enhetens interna minne att registrera video växlingsvis. Denna
funktion är ett effektivt sätt att filma föremål som rör sig långsamt.
När du börjar spela in registrerar enheten automatiskt ett specificerat antal bilder (Number of Frames) vid en specificerad
intervalltid (Interval Time).

A: Filmningsintervall (Interval Time)
B: Antal bilder i en tagning (Number of Frames)

OBS!

Endast en särskild inspelningsfunktion som Interval Rec-inspelning kan användas en gång i taget.

Om ett annat särskilt inspelningsläge är aktiverat medan Interval Rec används, frigörs Interval Rec automatiskt.

Interval Rec-läget frigörs automatiskt efter att systeminställningarna ändras, till exempel videoformat.

Interval Rec kan inte ändras under inspelning eller uppspelning eller när miniatyrbildskärmen visas.

Begränsningar under inspelning
Ljud spelas inte in.
Granska inspelningen (Rec Review) är inte möjligt.

Om enheten stängs av under inspelning
När enhetens strömförsörjning ställs till läget standby, tillgås lagringsmediet i flera sekunder för att registrera bilder
lagrade i minnet fram till det ögonblicket och sedan övergår enheten till standbyläget automatiskt.
Om DC-strömadaptern är bortkopplad, om strömmen slogs av från AC-adaptern eller om PoE++-strömleveransen
kopplas bort, då kan det som filmats fram till dess gå förlorat (maximalt 10 sekunder). Man bör vara försiktig.

Ställa in antalet bilder och intervall mellan filmning

Ställ in [Project] > [Interval Rec] > [Setting] till [On] i web-menyn och ställ in [Number of Frames] och [Interval Time].
Enheten lämnar läget Interval Rec när den stängs av, men inställningarna [Number of Frames] och [Interval Time] förblir
desamma. Du behöver inte ställa in dem igen nästa gång du filmar i Interval Rec-läge.
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Tips

Kan även ställas in med [Project] > [Interval Rec] i kameramenyn.

Börja filmningen

Tryck på knappen START/STOP-inspelning för att starta inspelning. ”Int●Rec” och ”Int●Stby” visas växlingsvis.

Stoppa filmningen

Stoppa inspelningen.
När filmningen är slut sparas videodata i minnet fram till den punkt det skrivs till lagringsmediet.
För att lämna Interval Rec-lämna Interval Rec-läget, gör en av följande saker.

Växla enhetens strömförsörjning till standby.
I standby-läge för inspelning, ställ in [Project] > [Interval Rec] > [Setting] till [Off].

Dessutom frigörs Interval Rec-läget automatiskt när enheten startas om.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Ta cachade bilder (Picture Cache Rec)

Med funktionen Picture Cache Rec kan du spela in video retroaktivt när du börjar spela in genom att behålla ett internt
cacheminne med en viss varaktighet när du fotograferar.

Ställa in cachestorlek

Ställ in [Project] > [Picture Cache Rec] > [Setting] till [On] i web-menyn och ställ in cachestorlek med [Cache Size].

OBS!

Picture Cache Rec kan inte användas i kombination med Interval Rec, simultan inspelning med 2 öppningar eller proxy-
inspelning. När Picture Cache Rec är inställd på On, tvångsinställs de andra speciella inspelningslägena till Off.

Picture Cache Rec-läget kan inte väljas medan inspelning eller Rec Review pågår.

När Picture Cache Rec är inställd på On, spelas tidskoden in i [Free Run]-läge även om den är inställd på [Regen] eller [Rec
Run].

Inställningen [Output Format] kanske inte går att konfigurera i läget Picture Cache Rec. Om det inträffar ställer du tillfälligt in
Picture Cache Rec till Off, och ändrar sedan inställningen.

Tips

Cachetiden kan vara kortare, beroende på inspelningsformatet. Kontrollera tiden som visas i [Project] > [Picture Cache Rec] >
[Cache Rec Time] i web-menyn.

Kan även ställas in med [Project] > [Picture Cache Rec] i kameramenyn.

Du kan även växla [Picture Cache Rec] mellan On och Off med en tilldelningsbar knapp.

Starta Picture Cache Rec

När [Picture Cache Rec] är inställt på On, visas ”●Cache” (● är grön).
När du trycker på START/STOP-knappen för inspelning startar inspelningen och video skrivs till minneskort med början
från videon som är lagrad i cacheminnet.

OBS!

Om du ändrar inspelningsformatet eller det grundläggande utseendet rensas videon i cacheminnet som lagrats fram till den
punkten och ny video börjar cachelagras. Följaktligen är bildcacheinspelning av bilder innan du byter format inte möjlig, även om
du börjar spela in direkt efter att formatet ändrats.

Om Picture Cache Rec ställs in på On eller Off omedelbart efter att ett minneskort satts i kan det hända att cachedata inte
registreras på kortet.

[Cache Size]-inställning Cachetid (ungefärlig)

[Short] 5 sekunder

[Medium] 10 sekunder

[Long] 20 sekunder

[Max] Maximalt värde för varje inspelningsformat
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Video lagras i cacheminnet när funktionen Picture Cache Rec är inställd på On. Videon som innan funktionen sattes till On
cachelagras inte.

Video lagras inte i cacheminnet medan ett minneskort används, t.ex. under uppspelning, inspelningsgranskning eller visning av
miniatyrbilder. Bildcacheinspelning av video under det intervallet är inte möjlig.

Avbryta Picture Cache Rec

Ställ in [Project] > [Picture Cache Rec] > [Setting] till [Off] i web-menyn eller tryck på en tilldelningsbar knapp tilldelad
med funktionen [Picture Cache Rec].

5-041-958-63(1) Copyright 2022 Sony Corporation
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Inspelning till minneskort A och B samtidigt (2-öppningar Simul Rec)

Du kan spela in på både minneskort A och minneskort B samtidigt genom att ställa in [Project] > [Simul Rec] > [Setting]
till [On] i web- eller kameramenyn.

Spela in separat på minneskort A och minneskort B

Du kan starta/stoppa inspelningen till varje minneskort separat med inspelningsknappen START/STOP eller [2nd Rec
START/STOP]-knappen på fliken  (Others).
Som fabriksinställning är båda knapparna inställda på att starta/stoppa samtidig inspelning på både minneskort A och B.
När knapparna är inställda på att styra inspelning på olika minneskort följer inspelningens start/stoppkontrol för
[SDI/HDMI Rec Control] inspelningsläget för kortplats A.

Ändra inställningen

Ställ in följande med [Project] > [Simul Rec] > [Rec Button Set] i kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

[Rec Button Set]-
inställning Knappar och minneskort

Rec Button:<Slot A>
<Slot B>
2nd Rec Button:<Slot
A> <Slot B>

Startar/stoppar samtidigt inspelning på minneskort A och B med någon av knapparna.

Rec Button:<Slot A>
2nd Rec Button:<Slot
B>

Inspelningsknappen START/STOP startar/stoppar inspelningen till minneskort A och [2nd Rec
START/STOP]-knappen på fliken  (Others) startar/stoppar inspelningen till minneskort B.

Rec Button:<Slot B>
2nd Rec Button:<Slot
A>

Inspelningsknappen START/STOP startar/stoppar inspelningen till minneskort B och [2nd Rec
START/STOP]-knappen på fliken  (Others) startar/stoppar inspelningen till minneskort A.
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Videosignalmonitor

Du kan ställa in vilken typ av videosignal som ska visas kamerans bildruta till vågform, vektorskåp eller histogram med
[Monitoring] > [Video Signal Monitor] > [Setting] i kameramenyn.
Den orange linjen anger de inställda värdena för [Level Marker 1] och [Level Marker 2].
Du kan även tilldela [Video Signal Monitor]-funktionen till en tilldelningsbar knapp.

Övervaka måldisplay
I Log-filmningsläget visas information om färgomfångsinställning eller monitorns LUT-inställning högst upp till höger på
videosignalsmonitorn för att indikera övervakningsmål.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Videoklippflaggor

Du kan lägga till en [OK]-flagga till ett videoklipp genom att trycka på en tilldelningsbar knapp tilldelad med funktionen
[Clip Flag OK] och välja [Add OK].
Du kan radera en [OK]-flagga till ett videoklipp genom att trycka två gånger på knappen och välja [Delete Clip Flag].

Tips

Du kan även lägga till en videoklippflagga med [Thumbnail] > [Set Clip Flag] i kameramenyn.

Miniatyrbildsskärmen kan visas sorterad efter typen av videoklippsflagga (miniatyrskärm för filtrerade videoklipp). För information,
se ”Använda inspelade videoklipp” på ”Miniatyrbildskärmen.”

Relaterade avsnitt

Använda inspelade videoklipp
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Andningskompensation

Du kan ställa in om du ska utföra andningskompensation för linsen med [Technical] > [Lens] > [Breathing Compensation]
i kameramenyn.
Denna funktion korrigerar för fenomenet där förändringar i synvinkeln inträffar när fokuspositionen varierar.
När andningskompensation utförs beskärs en del av bilden elektroniskt för att bibehålla en konstant synvinkel så att
andningsfenomenet inte uppstår.

OBS!

När andningskompensation är aktiverad kan synvinkeln och bildkvaliteten ändras något.

Beroende på linsen är det kanske inte möjligt att korrigera förändringen i synvinkeln när andningskompensation är aktiverad.

Kompensation är inte möjlig när en lins som inte stöder andningskompensation är monterad.

Denna funktion är inställd på Off (fast) i följande fall.

När [Technical] > [Lens] > [Distortion Comp.] är inställt på [Off] i kameramenyn
När [Shooting] > [S&Q Motion] > [Setting] är inställt på [On] i web- eller kameramenyn
När [Project] > [Rec Format] > [Codec] är inställt på [RAW] eller [RAW & XAVC-I] i web- eller kameramenyn

5-041-958-63(1) Copyright 2022 Sony Corporation
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Översikt för proxyinspelning

Med denna funktion kan du simultant spela in lågupplösta proxydata och högupplöst originaldatavideo.

För mer information om minneskort som stöds, formatera minneskort och kontrollera kvarvarande kapacitet, se
”Stödda minneskort” i ”Förbereda minneskort.”

Om den inspelade filen
Filnamnstillägget är ”.mp4”.
Tidskoden registreras också samtidigt.

Lagringsdestination för den inspelade filen
Den inspelade filen lagras i följande katalog.

Om filnamnet
Filnamnet består av videoklippnamnet i minneskortet och ett ”S03”-suffix.
För videoklippnamn, se [TC/Media] > [Clip Name Format] i kameramenyn.

Relaterade avsnitt

Stödda minneskort

5-041-958-63(1) Copyright 2022 Sony Corporation

Inspelningsmedia Mappväg

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub
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Spela in en proxy

Du kan starta inspelningen när proxyinspelning är aktiverat.

Stoppa filmningen
Stoppa inspelningen.

Ställa in ljudkanal för proxyinspelning
Ställ in ljudkanal för proxydatainspelning med [Project] > [Proxy Rec] > [Audio Channel] i kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in [Project] > [Proxy Rec] > [Setting] till [On] i web- eller kameramenyn.1

För in ett minneskort i en CFexpress Type A/SD kortöppning.

För CFexpress-kort, för in med etiketten vänd uppåt.
För SD-kort, för in med etiketten vänd nedåt.

OBS!

Proxy Rec kan inte ställas in på On samtidigt som S&Q Motion eller Interval Rec. När Proxy Rec är inställt på On, ställs
dessa andra inspelningslägen på Off.

2

Tryck på knappen START/STOP.

Proxyinspelning startar.

OBS!

Om enheten stängs av eller om minneskortet tas ut medan det används, går det inte att garantera dess integritet.
Alla data registrerade på minneskortet kan försvinna. Se alltid till att indikatorn för minnekortsåtkomst är släckt innan du
stänger av enheten eller tar ut minneskortet.

Se till att minneskortet inte poppar ut när du för in eller tar ut det.

3
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Översikt för utseende

När enheten är i Custom-läge, kan du lägga till justeringar till den svarta matrisen och andra parametrar för att skapa ett
”utseende” baserat på grundutseende.

Du kan även snabbt välja ett annat utseende genom att spara olika inställningskombinationer i scenfiler.
Enheten kommer med totalt sju förinställda utseenden.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Välja ett utseende

Detta ämne beskriver hur man väljer ett utseende.

Kontrollera att [Project] > [Base Setting] > [Shooting Mode] är inställt på [Custom] i web- eller
kameramenyn.

Tips

I läget [Custom] visas knappen [ISO/Gain] och [Scene File] i kamerans grundläggande konfigurationspanel.

1

Tryck på knappen [Scene File] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Scene File] ändras till orange.

Scene File-justeringspanelen visas.

2

Tryck på knappen [Scene File] på justeringspanelen och välj en scenfil med önskat utseende från listan.

Följande förinställningar är fabriksinställningar.

Tips

Du kan även välja ett utseende med hjälp av [Paint/Look] > [Scene File] > [Recall] i kameramenyn. Du kan även återskapa
ett förinställt utseende med [Scene File] > [Preset Recall].

3

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scene-fil 1 [S-Cinetone] [HLG Live]

Scene-fil 2 [Standard] [HLG Natural]

Scene-fil 3 [Still] (Ej registrerad)

Scene-fil 4 [ITU709] (Ej registrerad)

Scene-fil 5 [709tone] (Ej registrerad)

Scene-filer 6 till 16 (Ej registrerad) (Ej registrerad)
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OBS!

Förinställningen scenfil 5 är inställd på [709tone] med programvaruversion 2.0 eller senare. Det visas när [Maintenance]>
[Reset] > [Factory Default] i web-menyn utförs:
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Importera ett önskat grundutseende

Du kan importera en 3D LUT-fil, skapad på en dator eller annan enhet som ett grundutseende. Upp till 16 filer kan
importeras.
Filformat: CUBE-fil (*.cube) för en 17-punkts eller 33-punkts 3D LUT skapat med Catalyst Browse, RAW Viewer eller
DaVinci Resolve* (av Blackmagic Design Pty. Ltd.).

Ingångsfärgomfång/Gamma: [S-Gamut3.Cine/S-Log3] eller [S-Gamut3/S-Log3]

Justera för underexponering

Verifierat med Resolve V9.0, V10.0 och V11.0.*

Spara 3D LUT-filen på enheten med Web App.1

Öppna [Paint/Look] > [Base Look] i web-menyn.

En lista med registrerade grundutseenden visas.

2

Tryck på knappen [Import] på den rad där du vill importera filen.

Dialogrutan för filval visas.

3

Välj den förberedda 3D LUT-filen.

Den importerade 3D LUT-filen blir till enhetens grundutseende.

4

Välj den importerade 3D LUT-filen med hjälp av [Paint/Look] > [Base Look] > [Select] i kameramenyn.5

Konfigurera [Paint/Look] > [Base Look] > [Input] och [Output] i kameramenyn för att matcha egenskaperna
för den importerade 3D LUT-filen.

6
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Om det finns en tendens till underexponering när autoexponering väljs, när det importerade grundutseendet används,
justera då [Paint/Look] > [Base Look] > [AE Level Offset] i web-menyn.

OBS!

Att endast importera en 3D LUT-fil påverkar inte bilden. Ladda den importerade 3D LUT-filen med hjälp av [Paint/Look] > [Base
Look] > [Select] i kameramenyn.

Om [Input] är korrekt inställt, kommer det korrekta utseendet inte erhållas.

Inställningar för menyobjekten [Input], [Output] och [AE Level Offset] tillämpas för grundutseendet som väljs med [Select]. Om
flera 3D LUT-filer importeras, välj varje 3D LUT-fil med [Select], och konfigurera [Input], [Output] och [AE Level Offset] enskilt för
varje fil.

De konfigurerade inställningarna för [Input], [Output] och [AE Level Offset] sparas för varje 3D LUT-fil.

Grundutseende/LUT-valmöjligheter för importerade 3D LUT-filer är gemensamma för lägena [SDR(BT.709)], [HDR(HLG)] och
Log-filmingslägena, men färgomfångs- och gammakonvertering utförs inte i dessa lägen.

3D LUT-filer raderas inte när [Maintenance] > [Reset] > [All Reset (except for Network Settings)] utförs i web-menyn.

Ett  (3D LUT-filbifogningsfel) som visas framför [Base Look Name]-skärmen anger att 3D LUT-filer inte kan bifogas till
videoklipp som spelats in i Loggfilmningslägen. Importera 3D LUT-filen igen.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Anpassa ett utseende

Du kan anpassa utseendet baserat på grundutseendet med hjälp av skjutreglagen [Master Black], [R Black] och [B Black]
i Scene File-justeringspanelen i kamerans grundläggande justeringsfält och [Paint/Look] > [Matrix] samt andra
konfigurationsobjekt i kameramenyn.
Anslut enheten till en TV eller monitor och justera bildkvaliteten medan du ser bilden på TV:n eller monitorskärmen.

1: [R Black] skjutreglage-/justeringsknappar
2: [B Black] skjutreglage-/justeringsknappar
3: [Master Black] skjutreglage-/justeringsknappar

OBS!

När du importerar en 3D LUT-fil och tillämpar den till bilden, kommer det önskade utseendet i 3D LUT-filen inte erhållas om
[Paint/Look] > [Matrix] och andra inställningar än grundutseendeinställningar i kameramenyn ändras.

Du kan återställa alla anpassade inställningar med hjälp av [Paint/Look] > [Reset Paint Settings] > [Reset without Base Look] i
kameramenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Spara ett utseende

Du kan spara det aktuella utseendet som en scenfil i ett intern minne med [Paint/Look] > [Scene File] > [Store] i
kameramenyn.
Du kan snabbt återkalla ett sparat utseendet med Scene File-justeringspanelen eller genom att använda direktmenyn.

OBS!

Om du väljer ett annat utseende utan att spara det aktuella, då avfärdas det aktuella utseendet.

Tips

Du kan skriva över förinställda scenfiler. För att återställa en förinställd scenfil, ska du ladda utseendet som ska återställas med
[Paint/Look] > [Scene File] > [Preset Recall] i kameramenyn och spara därefter scenfilen med [Scene File] > [Store].

Radera ett sparat utseende
Du kan radera en scenfil sparad i ett intern minne med [Paint/Look] > [Scene File] > [Delete] i kameramenyn.

Tips

När raderad visas den inte längre i Scene File-justeringspanelen eller direktmenyn.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Radera ett grundutseende

Du kan radera importerade 3D LUT-filer enskilt med hjälp av [Paint/Look] > [Base Look] > [Delete] i kameramenyn.
Du kan radera alla importerade 3D LUT-filer med hjälp av [Paint/Look] > [Base Look] > [Delete All] i kameramenyn.

OBS!

Innan du raderar ska du kontrollera att grundutseendet inte används i några scenfiler. Om grundutseendet som används raderas,
kommer utseendet för motsvarande scenfiler vara felaktigt.

Importerade 3D LUT-filer raderas inte när [Maintenance] > [Reset] > [All Reset (except for Network Settings)] utförs i web-menyn.

Ett raderat grundutseende kan inte längre användas i LUT i Log-filmningsläget.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Filma med utseendejustering i efterproduktion

Med hjälp av enheten i Log-filmningslägena*1, och genom att spela in nyanser jämnt från mörka till ljusa områden, kan
du göra finjusteringar som till exempel lokal återställning av nyanser av mörka och ljusa områden, i efterproduktionen.
Men när du visar inspelade bilder på en konventionell monitor, kommer den sammantagna kontrasten framstå som låg
vilket gör det svårt med fokus- och exponeringsjusteringar.
Du kan tillämpa en LUT till enhetens monitormål för att assistera med flera olika justeringar när du filmar. Du kan också
använda den LUT som används när du filmar automatiskt vid uppspelning för att snabbt kontrollera det färdiga resultatet.
LUT:er tillämpas med följande system. Men endast en LUT kan tillämpas.

SDI-utgång
HDMI-utgång och strömning
Proxy-klipp inspelat på inspelningsmedia
High-res (main)-klipp inspelat på inspelningsmedia

5-041-958-63(1) Copyright 2022 Sony Corporation

Generisk term för Flexible ISO-läge/Cine EI-läge/Cine EI Quick-läge*1
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Tillämpa en LUT till HDMI-utgång och strömning

Du kan tillämpa en LUT till HDMI-utgång och strömning.

OBS!

Bilden i kamerans bildruta i Web App är även inkluderad i strömningsbilden.

Tips

Detta kan även ställas in med [Shooting] > [LUT On/Off] > [HDMI/Stream] i kameramenyn.

SDI-utgång kan ställas in på samma sätt.

För video i inspelningsmedia kan du ställa in detta med hjälp av [Shooting] > [LUT On/Off] > [Internal Rec] och [Proxy] i
kameramenyn.

Ett  (3D LUT-filbifogningsfel) som visas framför [Base Look/LUT]-skärmen anger att 3D LUT-filer inte kan bifogas till videoklipp
som spelats in i Loggfilmningslägen. Importera 3D LUT-filen igen.
Den här ikonen visas också när bifogningen inte fungerar på grund av tillfällig överbelastning under bearbetningen.

Kontrollera att [Project] > [Base Setting] > [Shooting Mode] är inställt på [Flexible ISO], [Cine EI] eller [Cine
EI Quick] i web- eller kameramenyn.

Tips

I Loggfilmingslägena visas knappen [Base ISO/Exposure Index] och [Base Look/LUT] i kamerans grundläggande
konfigurationspanel.

1

Tryck på knappen [Base Look/LUT] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Base Look/LUT] ändras till orange.

Base Look/LUT-justeringspanelen visas.

2

Välj [HDMI/Stream] > [MLUT].3
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Ändra en LUT

Du kan ändra den LUT du vill tillämpa.

Tips

Enheten tillhandahåller [s709], [709(800%)] och [S-Log3] som förinställda LUT-filer.

Du kan även importera och tillämpa en 3D LUT-fil. För information, se ”Importera ett önskat grundutseende” och ”Radera ett
grundutseende.”

Detta kan även ställas in med [Paint/Look] > [Base Look] > [Select] i kameramenyn.

Relaterade avsnitt
Importera ett önskat grundutseende

Radera ett grundutseende
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Tryck på knappen [Base Look/LUT] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Base Look/LUT] ändras till orange.

Base Look/LUT-justeringspanelen visas.

1

Tryck på knappen [Base Look/LUT] och välj det grundutseende som du vill tillämpa.2
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Ändra fördelningen av mörka och ljusa områden i inspelad bild

I filmningslägena Cine EI och Cine EI Quick kan du ändra fördelningen av mörka och ljusa områden, om du till exempel
vill prioritera tonen för mörka områden över ljusa områden genom att ändra Exposure Index från den grundläggande
känsligheten.

Tryck på knappen [Base Look/LUT] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Base Look/LUT] ändras till orange.

Base Look/LUT-justeringspanelen visas.

1

Välj [HDMI/Stream] > [MLUT].

En LUT för HDMI-utgång och strömning.

2

Tryck på knappen [Base ISO/Exposure Index] i kamerans grundläggande konfigurationsfält.

Ramen till knappen [Base ISO/Exposure Index] ändras till orange.

Base ISO/Exposure Index-justeringspanelen visas.

3

Justera exponeringsindex enligt önskad fördelning av mörka och ljusa områden med hjälp av skjutreglaget
[Exposure Index] eller justeringsknapparna [Exposure Index].

För [Cine EI]

För [Cine EI Quick]
Baskänsligheten ställs in automatiskt enligt det angivna exponeringsindexet.

4
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Tips

Detta kan även ställas in med [Shooting] > [ISO/Gain/EI] > [Exposure Index] i kameramenyn.

SDI-utgång kan användas på samma sätt.

Inställningens andra numeriska värde indikerar hur många steg av ljusstyrkeinformation som tilldelas för ljusa områden (ljusstyrka
högre än 18% grått). Områden ljusare än dessa är överexponerade.
Exempel: I ”400EI/5.0E,” 5,0 tilldelas stegen på den ljusa sidan.

Du kan även använda denna som en guide för att kontrollera tonen för mörka och ljusa områden när du filmar. Kom ihåg att
återgå till EI-värdet efter att du kontrollerat exponeringen. I Cine EI Quick-läget ska du också vara försiktig så att du inte påverkar
baskänsligheten negativt.

5-041-958-63(1) Copyright 2022 Sony Corporation

Justera belysningen och/eller ND-filter så att kamerans bildutgång från [HDMI/Stream] har lämplig
exponering.

5
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Spela in RAW-video

Du kan spela in med RAW-videons signalutgång från enhetens SDI OUT-kontakt till en kompatibel extern inspelare.
RAW-bildformat som stöds visas nedan.

Systemfrekvens [Codec] [RAW Output Format]

59.94 / 50 / 29.97 / 25 / 23.98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Anslut en extern RAW-inspelningsenhet till enhetens SDI OUT-kontakt.1

Ställ in [Project] > [Base Setting] > [Shooting Mode] till [Cine EI], [Cine EI Quick], eller [Flexible ISO] i web-
eller kameramenyn.

2

Ställ in bildvinkeln (endast FF) med hjälp av [Project] > [Rec Format] > [Imager Scan Mode] i web- eller
kameramenyn.

3

Ställ in [Project] > [Rec Format] > [Codec] till [RAW] i web- eller kameramenyn.

Genom att välja [RAW & XAVC-I] kommer videon spelas in simultant till en extern RAW-inspelare och videon till
videokamerans minneskort.

4

Ställ in upplösningen med hjälp av [Project] > [Rec Format] > [RAW Output Format] i web- eller
kameramenyn.

5

Kontrollera att den externa inspelaren startas och tryck på knappen START/STOP för inspelning på
skärmen för livedrift.

Statusen för RAW-videoinspelning indikeras av en ikon i kamerans bildruta.

6
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OBS!

När inspelningen påbörjas på en extern inspelare är det möjligt att videoklipp inte spelas in korrekt om inte knappen
START/STOP för inspelning på skärmen för livedrift används.

5-041-958-63(1) Copyright 2022 Sony Corporation

OBS!

Inspelningens kontrollsignal går ut från enhetens SDI OUT-kontakt, men det är inte möjligt att erhålla statusen för den
externa inspelaren. Därmed kan enhetens indikera att RAW-videoinspelning pågår när den externa inspelaren faktiskt inte
spelar in. Kontrollera indikatorn på den externa inspelaren för att erhålla korrekt användningsstatus.
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Spela in RAW-video i Slow & Quick Motion-läge

Spela in RAW-video i Slow & Quick Motion-läge.

För information om bildfrekvenser som stöds för att filma, se ”Slow & Quick Motion.”

Relaterade avsnitt

Slow & Quick Motion
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Växlar bokeh control-funktionen till On/Off

Du kan enkelt justera graden av bokeh genom att koppla ND-filtret och förstärkningen till irisanvändningen.

Växlar bokeh control-funktionen till On/Off

Denna funktion kan aktiveras endast när exponeringen justeras manuellt. Ställ in ND-filtret på variabelt läge och ställ
sedan in iris, förstärkning, slutare och ND-filtret på manuell justering.
Växlar bokeh control-funktionen till On/Off med [Shooting] > [Iris] > [Bokeh Control] i kameramenyn.
När bokeh control-funktionen är inställd på On visas en ikon  (B) på ND-filtret och förstärkningsindikatorerna.

OBS!

Denna funktion är endast aktiverad på E-mount-objektiv som kan kommunicera med enheten.

Den maximala effekten av denna funktion kan uppnås med hjälp av ett Sony E-mount-objektiv.

Bokeh-kontrollfunktionen är inställd på Off när någon av följande åtgärder utförs.

När enheten är avstängd
När någon av inställningarna iris, förstärkning, slutare eller ND-filter är inställt på Auto
När filmningsläget växlas
När ND-filtret är inställt på noll eller förinställt läge
När linsen tas bort
När enheten startar om, till exempel efter att frekvensen har ändrats

Tips

Du kan även tilldela [Bokeh Control]-funktionen till en tilldelningsbar knapp och växla bokeh-kontrollfunktionen mellan On och Off
med knappen.
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Justera graden av bokeh

Justera inställningarna i steg 2 till 4 efter behov.

OBS!

Utseendet kan variera beroende på användningshastighet, lins, fotograferingsinställningar och motiv, och även ljusstyrkan kan
ändras. Det rekommenderas starkt att ett kameratest utförs före fotografering.

Ljusstyrkan kan ändras när irisdriftriktningen ändras, till exempel när du öppnar iris efter att du stängt den eller när du stänger iris
efter att den har öppnats. Justera i så fall något mer än vad som krävs i förväg och backa sedan lite, kontrollera ljusstyrkan och
börja sedan fotografera. Om du till exempel vill öppna bländaren till F8 öppningsnivå och göra bakgrunden suddig, stäng först
bländaren förbi F8 och återgå sedan till F8, kontrollera ljusstyrkan och börja fotografera.

Utför bokeh-kontrollåtgärden långsamt. Om du behöver påskynda operationen ska du försöka att göra justeringarna gradvis
medan du kontrollerar ändringarna i bilden.

Tips

När bokeh-kontrollfunktionen är inställd på On, fungerar ND-filtret och förstärkningen tillsammans för att kompensera förändringar
i exponeringen på grund av irisjustering, vilket gör att du kan ändra graden av bokeh.

Bokeh-kontrollen kopplas först till ND-filtret som svar på irisanvändningen. När ND-filtret inte längre kan ändras länkas
förstärkningen.

I MF-läge rekommenderas det att du först öppnar iris och sedan justerar fokus.

Om du använder det automatiska ND-filtret istället för bokeh-kontrollfunktionen följer ND-filtret ändringen av motivets ljusstyrka.

Visas under användning av förstärkningslänk
När bokeh-kontrollfunktionen är inställd på On, kan förstärkningen ändras när iris justeras.
När förstärkningslänken är aktiv och förstärkningen ändras visas ett meddelande högst upp på skärmen och  (B)
ikonen på förstärkningsindikatorn blinkar.

Ställer bokeh-kontrollfunktionen till On.1

Öppna iris helt.2

Ställ in ND-filtret till 1/128.3

Ställ in gain på 0 dB och använd belysning för att få rätt exponering.4

Justera fokuset.5

Justera bländaren.

Graden av bokeh ändras.

6
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Spara och ladda konfigurationsdata Översikt

Du kan spara enhetens inställningar som konfigurationsdata med hjälp av Web App. På detta sätt kan du snabbt hämta
en lämplig uppsättning menyinställningar för den aktuella situationen.
Med denna enhet kan du spara nästan alla inställningar relaterade till kamerafunktionerna, utöver följande notering, som
en ALL-fil (en fil med alla inställningar).

OBS!

Nätverksfunktionsinställningar och autentiseringsinformation sparas inte. För mer information om sparade objekt, se ”Lista på
menyobjekt.”

Relaterade avsnitt

Lista på menyobjekt
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Spara en ALL-fil

Detta ämne beskriver hur man sparar en ALL-fil.

5-041-958-63(1) Copyright 2022 Sony Corporation

Öppna [Project] > [All File] i web-menyn.1

Tryck på knappen [Save All File] > [Save].

Webbläsaren laddar tillfälligt ned en fil kallad all-file.ALL.

2

Specificera en plats och filnamn för den nedladdade all-file.ALL-filen, och spara filen.

Du finner mer information om att filanvändning i enhetens bruksanvisning.

3
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Ladda en ALL-fil

Detta ämne beskriver hur man laddar en ALL-fil.

OBS!

Enheten kommer startas om automatiskt efter att konfigurationsdata laddas. Efter att du startat om, ladda om sidan i
webbläsaren.
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Öppna [Project] > [All File] i web-menyn.1

Tryck på knappen [Load All File] > [Load].

Dialogrutan för öppen fil visas på enheten som kör Web App.

2

Öppna filen du vill ladda.

Du finner mer information om att filanvändning i enhetens bruksanvisning.

3

När laddningsfilnamnets bekräftelseskärm visas, tryck på knappen [OK].4

När skärmen för utföranderesultatet visas, tryck på knappen [OK].5

Vänta tills enheten startas om, och återanslut till Web App.6
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Om filöverföring

Du kan ladda upp en proxyfil eller en ursprungsfil som spelats in på enheten till en server eller internet eller en server på
ett lokalt nätverk.

OBS!

När strömförsörjningen är inställd på standby-läge, placeras filöverföringar på paus även om enheten fortfarande är strömsatt.
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Registrera en filöverföringsdestination

Du kan registrera en överföringsdestinationsserver innan du inleder en filöverföring.

Välj [Network] > [File Transfer] > [Default Upload Server] > [Server Settings1] (eller [Server Settings2],
[Server Settings3]) i web-menyn.

Tips

Namnet på valmöjligheten kommer ändras i enlighet med [Display Name] som konfigureras i nästföljande steg.

1

Konfigurera följande objekt för [Network] > [FTP Server 1] till [FTP Server 3] i web-menyn.

[Display Name]
Ange namnet på servern som ska visas i jobböverföringslistan när du väljer en överföringsdestinationsserver.
[Service]
Visar servertyp.
[FTP]: FTP-server
[Host Name]
Ange serverns adress eller värdnamn.
[Port]
Ange portnummer för servern som ska anslutas.
[User Name]
Ange användarnamn.
[Password]
Ange lösenord.
[Passive Mode]
Ställer passivt läge till på/av.
[Destination Directory]
Ställer in namnet för katalogen i destinationsservern.

OBS!

Om tecknen som är ogiltiga i destinationsservern förs in i [Destination Directory], kommer filerna överföras till användarens
hemkatalog. Ogiltiga tecken kommer variera enligt server.

[Using Secure Protocol]
Ställer in om en säker FTP-överföring ska ske.
[Root Certificate]
Laddar/rensar ett certifikat.
[Load]: Ladda ett CA-certifikat. Laddar PEM-formatcertifikat.
[Clear]: Rensa ett CA-certifikat.
[None]: Ladda eller rensa inte ett certifikat.

OBS!

Ställ in enhetens klocka till rätt tid innan du laddar ett CA-certifikat.

När du spelar in i XAVC-I 4096×2160P/3840×2160P 59.94/50P, kan [Load] inte väljas.

[Root Certificate Status]: Visar laddningsstatus för rotcertifikatet.

2

258



5-041-958-63(1) Copyright 2022 Sony Corporation

[Reset]: Återställer Server Settings till fabriksinställningar.
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Ladda upp en proxyfil i ett minneskort från miniatyrbildskärmen

Du kan ladda upp proxyfiler i ett minneskort enskilt från miniatyrbildskärmen.

OBS!

Upp till 200 överföringsjobb kan registreras.
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Tryck på [Thumbnail]-knappen på skärmen för livedrift i Web App.

Visningen ändras från kamerabilden till miniatyrbildskärmen.

1

Välj [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] i kameramenyn.

För att överföra alla proxy-filer samtidigt, ska du välja [Transfer Clip (Proxy)] > [All Clips].
Videoklipp kan överföras från miniatyrbildskärmen eller miniatyrbildskärmen med filtrerade videoklipp.

2

Välj det videoklipp som du vill överföra med knappen [Set] och tryck på [Menu]-knappen.

En bekräftelseskärm för överföringen visas.

3

Välj [Execute].

Proxy-filen som motsvarar det valda videoklippet registreras som ett överföringsjobb och uppladdningen inleds.
När överföringsjobbet är registrerat, visas skärmen med överföringsresultat.

4

Tryck på knappen [OK].5
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Ladda upp en ursprungsfil i ett minneskort från miniatyrbildskärmen

Du kan ladda upp en ursprungsfil i ett minneskort från miniatyrbildskärmen.

OBS!

Upp till 200 överföringsjobb kan registreras.
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Tryck på [Thumbnail]-knappen på skärmen för livedrift i Web App.

Visningen ändras från kamerabilden till miniatyrbildskärmen.

1

Välj [Thumbnail] > [Transfer Clip] > [Select Clip] i kameramenyn.

För att överföra alla ursprungsfiler samtidigt, ska du välja [Transfer Clip] > [All Clips].
Videoklipp kan överföras från miniatyrbildskärmen eller miniatyrbildskärmen med filtrerade videoklipp.

2

Välj det videoklipp som du vill överföra med knappen [Set] och tryck på [Menu]-knappen.

En bekräftelseskärm för överföringen visas.

3

Välj [Execute].

Ursprungsfilen som motsvarar det valda videoklippet registreras som ett överföringsjobb och uppladdningen inleds.
När överföringsjobbet är registrerat, visas skärmen med överföringsresultat.

4

Tryck på knappen [OK].5
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Kontrollera filöverföringsstatus

Du kan kontrollera statusen för filöverföring genom att välja [Network] > [File Transfer] > [View Job List] i kameramenyn.

OBS!

Upp till 200 överföringsjobb kan registreras.

Överföringsjobben hålls kvar när enheten ställs i standby, men upp till 10 minuter av den senaste förloppsinformation kan gå
förlorad om strömmen kopplas bort med något annat medel.

Om ett fel uppstår under filöverföring, kan överföringen av ett videoklipp med samma namn som det överförda videoklippet inte
återupptas beroende på inställningar och status för överföringens destinationsserver. I detta fall ska du kontrollera
serverinställningar och status.

Tips

Om [Network] > [File Transfer] > [Auto Upload (Proxy)] ställs in till [On] i kameramenyn och om det finns en nätverksanslutning,
då laddas proxyfiler automatiskt upp till servern som specificerats med hjälp av [Default Upload Server] när inspelningen avslutas.
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Ladda upp med Secure FTP

Du kan ladda upp krypterade filer med FTPS i läget Explicit (FTPES) för anslutning med destinationsfilens server.
För säker FTP-överföring, ställ [Using Secure Protocol] till [On] i destinationsfilens server till och ladda ett certifikat.

För information om konfiguration, se ”Registrera en filöverföringsdestination.”

Relaterade avsnitt
Registrera en filöverföringsdestination
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Om strömning

Enheten kan samtidigt strömma video och audio som går ut från HDMI-kontakten.

OBS!

För att använda strömning som huvudvideo, ställ [Monitoring] > [Output Display] > [SDI] till [On] och [HDMI/Stream] till [Off] i web-
menyn, och övervaka kamerastatusen på en SDI-monitor.

Om en monitor ansluten till HDMI-kontakten inte stöder det HDMI-utgångsformat som konfigurerats med [Monitoring]-menyn i
web-menyn eller kameramenyn, då kommer kamerabilden inte att gå ut till Web App. Inte heller kan strömningsvideo fungera som
utgång.

Strömningsupplösningen kan inte ställas högre än den för HDMI-utgångssignalens upplösning.

Under visning av flera användare kan bilden bli förvrängd beroende på codec-inställningar.

Enheten stöder följande strömningsmetoder. Tillgängliga video-codecs för val visas inom parantes.

RTSP (H.264, H.265)
RTMP (H.264)*1

SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Konfigurera inställning för strömningsformat, inställning för video-codec och ljud-codec i den följden.

●: Aktiverad, –: Inaktiverad

Tips

Bilden i kamerans bildruta i Web App är även ett strömningssystem.

Strömningsformat
Codec-inställning

Video Stream 1 Video Stream 2 Video Stream 3 Audio Stream

RTSP
●
video 1

●*2

video 2
– ●

RTMP ● – – ●*1

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

RTMP kan väljas när [Stream] > [Audio Stream] är inställt till [On] i webmenyn.*1

När systemfrekvensen är 59.94 eller 50 och HDMI-utgångsformatet är 3840×2160 eller högre, är video 2-utgång inte tillgänglig.*2
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Ställa in strömningsformat

Ställ in Strömningsformat med [Stream] > [Stream] > [Stream Setting] > [Setting] i web-menyn.

När [Setting] är inställt på [RTSP]

I RTSP-strömning kan bilden från en enskild kamera visas samtidigt av fem användare.
Du kan ställa in upp till två lägen för video-codec.
[Port Number]
Ställer in det portnummer som ska användas för RTSP-strömning. Standardvärde är 554.
Om man ändrar inställningen startar det om RTSP-servern.
[Time Out]
Ställer in timeout för kommandot Keep-Alive för RTSP-strömning. Timeouttiden kan ställas in mellan 0 och 600 sekunder.
Standardvärde är 60 sekunder.
När inställt till 0 sekunder uppstår inte timeout på grund av Keep-Alive-kommando.
[Authentication]
Ställer in huruvida autentisering krävs.
[Video Port Number 1], [Video Port Number 2]
Specificerar portnummer för bilddatakommunikation som ska användas för RTSP-unicastströmning. Standardvärde för
Video Port Number 1 är 51000. Standardvärde för Video Port Number 2 är 53000. Ange ett jämnt tal mellan 1024 och
65534. Numret som ställs in här och det efterföljande udda talet, som erhålls genom att lägga till 1, blir de två portnumren
som används för kommunikation och kontroll av bilddata.
[Video Port Number 1] och [Video Port Number 2] motsvarar [Stream] > [Video Stream] > [Video Stream 1] och [Video
Stream 2].
[Audio Port Number]
Specificerar portnummer för ljuddatakommunikation som används för RTSP-unicastströmning. Standardvärde är 57000.
Ange ett jämnt tal mellan 1024 och 65534. Numret som ställs in här och det efterföljande udda talet, som erhålls genom
att lägga till 1, blir de två portnumren som används för kommunikation och kontroll av ljuddata.

När [Setting] är inställt på [RTMP]

Videocodecläget som kan användas för RTMP är endast H.264. För att använda RTMP måste [Stream] > [Audio Stream]
vara inställt på [On] i web-menyn.
[Server URL]
Ställer in URL för uppladdningsdestination. Ange en teckensträng som börjar med ”rtmp://” eller ”rtmps://”.
[Stream Key]
Ange den strömnyckel som erhålls från den webbplats du använder. Genom att trycka på [Clear]-knappen rensas
inmatningen.

OBS!

Var försiktig när du hanterar strömnyckeln. Om strömnyckeln blir känd av en tredje par, finns det risk för att strömmen spoofas.

[Root Certificate]
Importerar det rotcertifikat som krävs för strömning med RTMPS-protokollet. Om du vill importera rotcertifikatet trycker du
på knappen [Load] och väljer ett rotcertifikat. Tryck på knappen [OK] i dialogrutan för filval för att importera den valda
filen till enheten. Om det finns ett importerat rotcertifikat i enheten uppdateras rotcertifikatet. För att radera ett importerat
rotcertifikat trycker du på knappen [Delete] på inställningsskärmen. Rotcertifikatets status visas i [Root Certificate Status].

OBS!
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Importera rotcertifikatet som krävs av streamingtjänsten.

När [Setting] är inställt på [SRT-Caller] eller [SRT-Listener]

Läget för video-codec är endast H.264.
[Destination]
Visas när strömningsläget är inställt till [SRT-Caller]. Ställer in URL för anslutningsdestination.
[Port Number]
Visas när strömningsläget är inställt till [SRT-Listener]. Ställer in portnumret för lyssning. Standardvärde är 4201.
[Latency]
Ställer in latensen mellan 20 ms och 8000 ms. Standardvärde är 120.
[TTL]
Ställer in TTL-värdet mellan 1 och 255. Standardvärde är 64.
[Encryption]
Väljer krypteringsmetod. Välj, Off, AES128 eller AES256. Standardvärde är Off.
[Passphrase]
Ställer in lösenordsfras som används för kryptering. Genom att trycka på [Clear]-knappen återställs den konfigurerade
lösenordsfrasen.
[ARC]
För att aktivera Adaptive Rate Control-funktionen, ställ till On.
När Adaptive Rate Control-funktionen aktiveras kan störningar i bilden orsakade av stockning i kommunikationslinjen
minskas.

När [Setting] är inställt på [NDI|HX]

Enheten uppfyller NDI|HX version 2 från NewTek.
För att använda NDI|HX, måste man köpa en licensnyckel.
Köpa en licensnyckel
Köp via följande NewTek URL.
https://www.newtek.com/ndihx/products/upgrade/

OBS!

Ladda ned den senaste NDI|HX-drivrutinen och installera den i en NewTek-produkt.

För mer information om NDI|HX-registrering och användning, se bruksanvisningen för NewTek-produkten.

[License]
Visar licensinformationen för en aktiverad licens.
[Source Name]
Visar källnamnet.
[Group]
För att visa NDI-grupperingsfunktionen, ställ in till On.
[Group Name]: Ställer in NDI-gruppnamnet. Flera inställningar kan konfigureras separat med ett komma.
[Discovery Server 1], [Discovery Server 2]
Ställer in NDI identifieringsserver 1 och Ställer in NDI identifieringsserver 2.
[Reliable UDP Mode]
För att aktivera Reliable UDP-läge, ställ till On.
[Multicast Mode]
För att aktivera multicast-strömning, ställ till On.
[Multicast Prefix]: Ställer in det prefix som ska användas för multicast-strömning.
[Multicast Netmask]: Ställer in nätmasken som fastställer intervall för multicast-adress.
[Multicast TTL]: Ställer in TTL-värdet för multicast-strömning mellan 1 och 256. Standardvärde är 3.
[Multi-TCP Mode]
För att aktivera Multi-TCP-läge, ställ till On.
[Unicast UDP Mode]
För att aktivera Unicast UDP-läge, ställ till On.
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Om tredjeparttjänster och programvara
Andra användningsvillkor kan gälla.

Tillhandahållandet av tjänster och programvaruuppdateringar kan störas eller avbrytas utan föregående meddelande.
Beskrivningen av tjänster och programvara är föremål för ändringar utan föregående meddelande.
Separat registrering och prenumeration kan komma att krävas.

Sony kan inte hållas ansvarigt för några krav från användare eller en tredje part på grund av användningen av tjänster
och programvara från andra företag.
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Ställa in video-codec för strömning

Välj video-codec med hjälp av [Stream] > [Video Stream] i web-menyn.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Du kan ställa in upp till tre lägen för bild-codec. Konfigurera följande inställningar separat för varje bildläge.
[Video Stream 3] används för visning av kamerans bildruta i Web App.

OBS!

När [Stream] > [Stream Setting] > [Setting] är inställt på [RTMP], [SRT-Caller] eller [SRT-Listener], har en del av [Video Stream 1],
[Video Stream 2] och [Video Stream 3]-inställningar ([Codec], [Size], [Frame Rate], [Bit Rate Compression Mode])
standardvärden.

[Codec 1], [Codec 2], [Codec 3]
Välj [H.264], [H.265] eller [Off]. Observera att [Codec 1] inte kan ställas in till [Off]. Även [Codec 3] är inställt till [JPEG]
(fast).

OBS!

Följande symtom kan uppstå beroende på kombinationen av olika inställningar, såsom bildstorlek, bildfrekvens och bithastighet
för [Codec 1], [Codec 2] och [Codec 3].

Ökad videolatens.
Hoppar över bilder under videouppspelning.
Växlande ljud.
Långsamt kamerasvar på olika kommandon.
Långsamt kamerasvar på åtgärder från en fjärrkontroll.
Långsam bildskärmsvisning och konfigurationsåtgärder.

Om du upplever dessa symtom, sänk då värdena för bildstorlek, bildfrekvens och bithastighet, eller ändra värdena för andra
inställningsparametrar för att lösa problemet.

När [Stream] > [Stream Setting] > [Setting] är inställt på [RTMP], [SRT-Caller] eller [SRT-Listener], [Codec 1] är inställt på [H.264]
(fast). [Codec 2] är inställt på [Off] (fast).

När bildstorleken eller systemfrekvensen för HDMI-utgången ändras, ställs, [Codec 2] in till [Off].

[Size 1], [Size 2], [Size 3]
Väljer bildstorlek för strömning från kameran.
Tillgängliga bildstorleksval varierar enligt bildstorleken för HDMI-utgången.

OBS!

När bildstorleken eller systemfrekvensen för HDMI-utgången ändras, kommer den maximala bildstorleken väljas.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Ställer in bildfrekvens för bilden.
”fps”-enheter indikerar antalet bilder som strömmas per sekund.
Tillgängliga bildfrekvensval varierar enligt bildstorleken för HDMI-utgången.

OBS!
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När bildstorleken eller systemfrekvensen för HDMI-utgången ändras, kommer den maximala bildfrekvensen väljas.

[I-Picture Mode 1], [I-Picture Mode 2]
Ställer in metoden för att specificera införandeintervall för I-picture för H.264 och H.265 till [Time] eller [Frame].
Kan inte ställas in för [Codec 3].
[Time]: Ställer in införandeintervall för I-picture som tid.
[Frame]: Ställer in införandeintervall för I-picture som antal bilder.
[I-Picture Interval 1], [I-Picture Interval 2]
Ställer in införandeintervall för I-picture i sekunder. Ställer in värdet mellan 1 sekund och 5 sekunder. Standardvärde är 1
sekund.
Kan inte ställas in för [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Ställer in införandeintervall för I-picture för H.264 och H.265 som antal bilder mellan 15 och 300. Standardvärde är 300
bilder.
Kan inte ställas in för [Codec 3].
[Profile 1], [Profile 2]
Ställer in profilen för bild-codec för H.264 eller H.265.
[H.264]: Välj [high], [main] eller [baseline]-profil.
[H.265]: Välj [main] eller [main10]-profil. När två video-codecs är aktiverade är endast [main]-profilen valbar.
Bildkomprimeringseffektiviteten ökar i följden för [high], [main] och [baseline]. Välj profilen som stöds av ditt system.
När [H.265] är inställt till [main10], är driften i [main10] när HDMI-utgången är YCrCb eller i [main] när HDMI-utgången är
RGB.
Kan inte ställas in för [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Välj [CBR] eller [VBR].
För att bevara en konstant bithastighet, välj [CBR]. För att bevara bildkvaliteten välj [VBR].
Kan inte ställas in för [Codec 3].

OBS!

Bildfrekvensen och bithastigheten som faktiskt strömmas kan skilja sig från inställda värden beroende på bildstorlek, scen som
filmas, nätverksmiljö och andra faktorer.

När [Stream] > [Stream Setting] > [Setting] är inställt på [RTMP], [SRT-Caller] eller [SRT-Listener], [Bit Rate Compression Mode 1]
är inställt på [CBR] (fast).

[Bit Rate 1], [Bit Rate 2]
Du ställer in bithastighet per videoström när [Bit Rate Compression Mode] är inställt till [CBR]. Genom att ställa in en
högre bithastighet kan du strömma video med hög bildkvalitet.
Kan inte ställas in för [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Ställer in bildkvaliteten mellan 1 och 10. Värdet 10 ställer in den högsta bildkvaliteten. Standardvärde är 6.
För [Quality 1] och [Quality 2], kan du ställa in H.264-bildkvaliteten genom att ställa in [Bit Rate Compression Mode] till
[VBR] och [Codec] till [H.264]. Du kan ställa in H.265-bildkvaliteten genom att ställa in [Bit Rate Compression Mode] till
[VBR] och [Codec] till [H.265].
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Ställa in ljud-codec för strömning

Välj ljud-codec med hjälp av [Stream] > [Audio Stream] i web-menyn.
[Setting]
För att aktivera ljudströmning, ställ till On.

OBS!

För att välja RTMP, ställ alltid in On i förväg.

[Codec]
Välj typ av codec som ska användas för att strömma ljud.
[AAC (256kbps)]: Välj för att prioritera ljudkvaliteten.
[AAC (128kbps)]: Välj för att prioritera datakapaciteten.
Denna inställning påverkar inte videoklippet som spelats in av enheten eller ljudsignalen som är inbäddad i HDMI/SDI-
signalen.
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Starta/stoppa strömning

För [RTSP], [SRT-Listener] och [NDI|HX]

Enheten väntar på en begäran om strömningsleverans.
Lansera en klientapplikation för att visa strömning och komma åt URL:en som visas i följande tabell.
Anger värdena för användarnamnet och lösenordet som är konfigurerade på enheten.

<camera_address>: Enhetens IP-adress
<Port>: Listener-port konfigurerad med [Port Number]

OBS!

Uppspelning i alla applikationer eller enheter är inte garanterat.

För [RTMP] och [SRT-Caller]

Tryck på knappen [Stream now] på fliken  (Stream) på skärmen för livedrift för att starta strömningen. Knappen ändras
till [Stop stream] och [Stream]-ikonen visas högst upp på kamerans bildruta.
Tryck på knappen [Stop stream] under strömning för att stoppa strömningen. Knappen ändras tillbaka till [Stream now]
och [Stream]-ikonen högst upp på kamerans bildruta försvinner.

OBS!

Uppspelning i alla applikationer eller enheter är inte garanterat.

5-041-958-63(1) Copyright 2022 Sony Corporation

Strömningsformat URL

RTSP
Video Stream 1 rtsp://<camera_address>:<Port>/video1

Video Stream 2 rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX Se bruksanvisning angående NDI|HX kompatibel klientenhet.
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Miniatyrbildskärm

När du trycker på [Thumbnail]-knappen på skärmen för uppspelning eller THUMBNAIL-knappen på den infraröda
fjärrkontrollen, visas videoklipp sparade i minneskortet på kamerans bildruta. Denna visning i kamerans bildruta kallas för
miniatyrbildskärm.
Du kan välja ett videoklipp på miniatyrbildskärmen och starta uppspelning av det videoklippet.
Om du trycker på [Thumbnail]-knappen under visning av miniatyrbildskärmen, stängs den och återgår till
kamerabildsvisning.

OBS!

Endast inspelade videoklipp i det nuvarande valda inspelningsformatet visas på miniatyrbildskärmen. Om ett förväntat inspelat
videoklipp inte visas, kontrollera då inspelningsformat. Var särskilt uppmärksam på detta innan formatering (start av) media.

Skärmlayout

Miniatyrbild av utvalda videoklipp visas mot en orange bakgrund.
Information om det valda videoklippet visas längst ned på skärmen.
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Valt minneskort
En låsikon visas om minneskortet är skrivskyddat.

1.

Videoklippnummer/totalt antal videoklipp2.

Miniatyrbilder (indexbild)
Visar ett videoklipps indexbild. När ett videoklipp spelas in, då ställs den första bilden automatiskt in som indexbild.
Videoklipp/bildinformation visas nedanför miniatyrbilden. Du kan ändra informationen som visas med [Thumbnail] >
[Customize View] > [Thumbnail Caption] i kameramenyn.

3.

Videoklippnamn
Visar namnet på det valda videoklippet.

4.

Inspelningsformat
Visar filformatet för det valda videoklippet.

5.

Särskild inspelningsinformation
Visar endast inspelningsläget om videoklippet spelades in med ett särskilt inspelningsläge.
För videoklipp i Slow & Quick Motion visas bildfrekvensen till höger.

6.

Videoklippets längd7.

Datum för skapande8.
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Spela upp inspelade videoklipp

Du kan spela upp inspelade videoklipp när enheten är i standby-läge (Stby) för inspelning.
Detta ämne beskriver hur man spelar upp inspelade videoklipp med GUI-kontrollpanelen.

Sätt i minneskortet som ska spelas upp.1

Tryck på knappen [Thumbnail].

Videoklippets miniatyrbild visas.

2

Använd pilknapparna i GUI-kontrollpanelen för att flytta markören till miniatyrbilden för videoklippet du vill
visa.

3
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OBS!

Det kan förekomma ett tillfälligt bildavbrott eller att bilden står still när det växlas mellan videoklipp. Du kan inte använda enheten
under denna period.

När du väljer ett videoklipp på miniatyrbildskärmen och påbörjar uppspelning, kan det ske en tillfällig bildstörning i början av
videoklippet. För att visa starten på videoklippet utan störning, ska du ausa uppspelningen, trycka på  (Föregående)-knappen

OBS!

Videoklipp kan inte väljas med pekfunktionen.

Tryck på [Set]-knappen i GUI-kontrollpanelen.

Uppspelning börjar från starten av det valda videoklippet.

4

Använd uppspelningskontrollpanelen enligt behov.

Tips

Du kan även styra åtgärden med GUI-kontrollpanelen.

Spela upp: Tryck på [Set]-knappen.
Pausa uppspelning: Tryck på [Set]-knappen under uppspelning. Tryck igen för att återgå till vanlig uppspelning.
Hoppa till starten av ett videoklipp/början på nästa videoklipp: Tryck på vänster knapp/höger knapp.
Spola fram/tillbaka: Tryck och håll ned den vänstra/högra knappen. Uppspelning återgår till normal hastighet när du
släpper knappen.
Stoppa uppspelning: Tryck på [Cancel/Back]-knappen.

5

Knapp Funktion

 (Spela/Paus)-knapp Spela upp ett videoklipp. Under uppspelning, pausas videoklippet.

 (Framåtspolning)-knappen, 
(Bakåtspolning)-knappen

Spelar upp ett videoklipp i hög hastighet. När knappen är nedtryckt
ändras uppspelningshastigheten i tre steg.

 (Föregående)-knappen, 
(Nästa)-knappen

Hoppar till början av klippet eller föregående/nästa klipp.

 (Stopp)-knappen Stoppar uppspelningen och växlar till fotograferingsskärmen.
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för att återgå till videoklippets start och starta uppspelningen igen.
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Använda inspelade videoklipp

På miniatyrbildskärmen kan du använda videoklippen eller kontrollera videoklippets egenskaper med [Thumbnail]-menyn
i kameramenyn.
Tryck på [Menu]-knappen på skärmen för uppspelning för att visa kameramenyn i kamerans bildruta.
Du kan nu utföra följande åtgärder med hjälp av [Thumbnail]-menyn i kameramenyn.
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Tips

Du kan även trycka på [Menu]-knappen på skärmen för livedrift för att visa kameramenyn.

Åtgärder med [Thumbnail]-menyn i kameramenyn
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Välj en funktion som ska användas med hjälp av pilknapparna i GUI-kontrollpanelen och tryck på [Set]-knappen.
Tryck på [Cancel/Back]-knappen för att återgå till föregående skärm.

OBS!

En del objekt kan väljas beroende på status när menyn visades.

Menyobjekt för att använda videoklipp

[Thumbnail]-menyn i kameramenyn har följande menyobjekt relaterade till användning av videoklipp.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

För mer information om varje menyobjekt, se ”[Thumbnail]-menyn.”

Visar klippets egenskapsskärm
Välj [Thumbnail] > [Display Clip Properties] i kameramenyn för att visa videoklippets egenskapsskärm.
Tryck på  (Föregående)-knappen eller  (Nästa)-knappen för att hoppa till föregående/nästa videoklipp.

Lägga till flaggor till videoklipp
Du kan lägga till flaggor (OK-, NG- eller KP-märken) till videoklippen för att filtrera visning av videoklippen enligt
flaggorna.
Välj miniatyrbilden för videoklippet till vilket du vill lägga till en flagga, och välj sedan klippets flagga med [Thumbnail] >
[Set Clip Flag] i kameramenyn.

Tips

Du kan även använda en tilldelningsbar knapp tilldelad med videoklippets flaggfunktion för att lägga till flaggor till videoklipp.

Visa den filtrerade miniatyrbildskärmen för videoklipp
Välj [Thumbnail] > [Filter Clips] i kameramenyn och välj en flaggtyp för videoklippet som ska visas och endast dessa
videoklipp kommer ha en specificerad flagga.
För att visa alla videoklipp, välj [All].
Du kan även trycka på knappen [Display] för att sortera miniatyrbildsvisningen enligt flaggor.

För att radera videoklipp
Du kan radera videoklipp från minneskorten.
Välj[Thumbnail] > [Delete Clip] > [Select Clip] eller [All Clips] i kameramenyn.
[Select Clip]: Raderar det valda videoklippet. Det går att välja flera videoklipp.
[All Clips]: Raderar alla visade videoklipp.

Ändra informationen som visas på miniatyrbildskärmen

Inställning Tillagd videoklippflagga

[Add OK] OK

[Add NG] NG

[Add KEEP] KP
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Du kan ändra videoklipp/bildinformationen som visas under miniatyrbilden.
Välj [Thumbnail] > [Customize View] > [Thumbnail Caption] i kameramenyn och välj den information som ska visas.
[Date Time]: Visar datum och tid då videoklippet skapades och senast ändrades.
[Time Code]: Visar tidskod.
[Duration]: Visar hur långt videoklippet är.
[Sequential Number]: Visar ett följdnummer för varje miniatyrbild.
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Konfigurera kameramenyn

När knappen [Menu] i GUI-kontrollpanelen eller knappen MENU på den infraröda fjärrkontrollen trycks ned, visas
kameramenyn för att konfigurera de olika inställningarna som behövs för att filma och spela upp på kamerans bildruta.

Menyn består av följande menyer.

Menykonfiguration

[User]-meny
Innehåller menyobjekt konfigurerade av användaren.
Kan redigeras med [Edit User Menu].
[Edit User]-meny
Innehåller menyobjekt för att redigera menyn [User].
[Shooting]-meny
Innehåller inställningar för att filma.
[Project]-meny
Innehåller grundläggande projektinställningar.
[Paint/Look]-meny
Innehåller inställningar för bildkvalitet.
[Pan-Tilt]-meny
Innehåller inställningar för pan/tilt.
[TC/Media]-meny
Innehåller inställningar för tidskoder och inspelningsmedia.
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[Monitoring]-meny
Innehåller inställningar för videoutgång och skärmdisplayen.
[Audio]-meny
Innehåller inställningar för ljud.
[Thumbnail]-meny
Innehåller inställningar för miniatyrbildsvisning.
[Technical]-meny
Innehåller inställningar för tekniska objekt.
[Network]-meny
Innehåller inställningar för nätverk.
[Maintenance]-meny
Innehåller enhetsinställningar, till exempel klocka och språk.

Konfiguration av kamerameny och hierarki

Nivå 1 Nivå 2

User
(fabriksinställningar)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Nivå 1 Nivå 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project

Base Setting

Rec Format

Cine EI/Flex.ISO Set

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix
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Nivå 1 Nivå 2

Pan-Tilt P/T Acceleration

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output

Thumbnail

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR
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Nivå 1 Nivå 2

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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Använda kameramenyn

När knappen [Menu] i GUI-kontrollpanelen eller knappen MENU på den infraröda fjärrkontrollen trycks ned, visas
kameramenyn för att konfigurera de olika inställningarna som behövs för att filma och spela upp på kamerans bildruta.
Menyn används med knapparna i GUI-kontrollpanelen.

[Menu]-knappen: Tryck på den för att visa kameramenyn. Tryck på nytt medan kameramenyn visas för att dölja menyn.
Pilknappar: Tryck på pilknapparna för att flytta markören upp/ned/vänster/höger i kameramenyn och för att välja
menyobjekt eller inställningar.
[Set]-knappen: Tryck för att tillämpa valt objekt.
[Cancel/Back]-knappen: Tryck för att återgå till föregående meny. En ofullständig ändring avbryts.

OBS!

En del objekt kan väljas beroende på status när menyn visades.

Objekt på inställningsmeny

Flytta markören till objektet du vill ställa in med pilknapparna i GUI-kontrollpanelen och tryck på [Set]-knappen för att
tillämpa inställningen.

Menyobjektets väljarområde visar upp till åtta rader. Om tillgängliga alternativ för ett objekt inte kan visas samtidigt,
bläddra då på displayen genom att föra markören upp/ned.
För delobjekt med ett stort inställningsintervall (till exempel, −99 till +99), visas inte inställningsområdet. Den aktuella
inställningen markeras för att indikera att värdet kan ändras.
Om du väljer [Execute] för en funktion kommer det utföra denna funktion.
Om du väljer ett objekt som kräver bekräftelse för utförande kommer menyn att döljas tillfälligt före utförande och ett
bekräftelsemeddelande visas. Kontrollera meddelandet och välj sedan om funktionen ska utföras eller avbrytas.
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Ange en teckensträng

När du väljer ett objekt, till exempel ett filnamn, för vilket tecken måste anges, då visas skärmen för detta.
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Tryck på knappilarna i GUI-kontrollpanelen för att välja teckentyp och tillämpa inställningen.

[ABC]: Stora alfabetiska bokstäver
[abc]: Små alfabetiska bokstäver
[123]: Numeriska tecken
[!#$]: Specialtecken

1

Välj ett tecken och tryck på knappen [Set] för att tillämpa inställningen.

Markören flyttas till nästa fält.
[Space]: För in mellanslag vid markörens position.
[←] [→]: Flyttar markörens position.
[BS]: Raderar tecknet till vänster om markören (backspace).

2

När du är klar, tryck på knappen [Done] för att tillämpa inställningen.

Teckensträngen är bekräftad och skärmen för att skriva in tecken försvinner.

3
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User

Detta ämne beskriver funktionen och inställningarna för varje menyobjekt.

OBS!

Du kan lägga till och ta bort menyobjekt i menyn [User] med menyn [Edit User]. Upp till 20 objekt kan konfigureras.
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Objekt Beskrivning

Base Setting Project > Base Setting-objekt

Focus Shooting > Focus-objekt

S&Q Motion Shooting > S&Q Motion-objekt

LUT On/Off Shooting > LUT On/Off-objekt

Simul Rec Project > Simul Rec-objekt

Proxy Rec Project > Proxy Rec-objekt

Interval Rec Project > Interval Rec-objekt

Picture Cache Rec Project > Picture Cache Rec-objekt

Assignable Button Project > Assignable Button-objekt

Scene File Project > Scene File-objekt

Base Look Paint/Look > Base Look-objekt

P/T Acceleration Pan-Tilt > P/T Acceleration-objekt

Clip Name Format TC/Media > Clip Name Format-objekt

Format Media TC/Media > Format Media-objekt

Video Signal Monitor Monitoring > Video Signal Monitor-objekt

Marker Monitoring > Marker-objekt

Zoom Technical > Zoom-objekt

Lens Technical > Lens-objekt

Edit User Menu Visar menyn Edit User.
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Edit User

Menyn [Edit User] visas högst upp när menyn [Edit User Menu] väljs i menyn [User].
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Add Item
Lägg till ett objekt till
menyn [User]

– –
Lägger till ett menyobjekt på nivå 2 till menyn
[User].

Customize Reset
Återställer objekten i
menyn [User]

– –
Återställer menyobjekt registrerade i menyn
[User] till fabriksinställningar.

Menyobjekt på nivå 2 som
väljs under redigering

Delete –
Raderar det registrerade menyobjektet på nivå 2
från menyn [User].

Move –
Flyttar på det registrerade menyobjektet på
menyn [User].

Edit Sub Item –
Redigerar (registrera/radera) det registrerade
meny-underobjektet på nivå 3 i menyn [User].
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ISO/Gain/EI

Ställer in förstärkningsinställningar.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Mode ISO/dB dB
Väljer läge för
förstärkningsinställning.

ISO/Gain<L>

För information om
inställningar, se ”ISO/Gain-
inställningar och
standardvärden.”

–
Ställer in <L> förinställt
förstärkningsvärde.

Exposure
Index<L>

När Base ISO är inställt på ISO
800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
När Base ISO är inställt på ISO
12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

När Base ISO är inställt
på ISO 800: 800EI / 6.0E
När Base ISO är inställt
på ISO 12800: 12800EI /
6.0E

Ställer in värdet Exposure
Index<L>.

Shockless
Gain

On / Off Off
Ställer in stötfri
förstärkningsfunktion på/av.

Base
Sensitivity

High / Low Low
Ställer in grundläggande
känslighet för Custom-läget.
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Relaterade avsnitt
ISO/Gain-inställningar och standardvärden
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Base ISO ISO 12800 / ISO 800 ISO 800
Ställer in grundläggande ISO-
känslighet för Cine EI/Flexible
ISO-läget.
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ND Filter

Ställer in förinställda värden för ND-filter.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Mode Preset / Variable Variable Väljer ND-filterläge.

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/4 Ställer in förinställt värde 1 för ND-filter.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/16 Ställer in förinställt värde 2 för ND-filter.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 1/64 Ställer in förinställt värde 3 för ND-filter.
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Shutter

Ställer in driften för den elektroniska slutaren.
Används för att filma föremål som rör sig snabbt tydligt.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Mode Speed / Angle Speed
Väljer läget för att ställa in
slutarhastighet i sekunder (Speed)
eller som slutarvinkel (Angle).

Shutter
Speed
On/Off

On / Off Off

Ställer in huruvida
exponeringstiden när Speed-läge
är valt följer [Shutter Speed]-
värdet eller ställs in för full
exponering.

Shutter
Speed

64F till 1/8000
De tillgängliga inställningarna varierar
beroende på bildfrekvens för valt videoformat.
59.94P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 / 1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 / 1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F / 16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
25P: 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 / 1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
24P/23.98P: 64F / 32F / 16F / 8F / 7F / 6F /
5F / 4F / 3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 /
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000 / 1/4000 / 1/8000

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Ställer in slutarhastighet när
Speed-läget är inställt på Speed.

Shutter
Angle

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300.0° / 270.0° / 240.0° / 216.0° /
210.0° / 180.0° / 172.8° / 150.0° / 144.0° /
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 30.0° /
22.5° / 11.25° / 5.6°

180.0°
Ställer in slutarvinkel när Angle-
läget är inställt på Speed.

ECS On/Off On / Off Off
Ställer in stötfri Extended Clear
Scan-funktionen till på/av.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

ECS
Frequency

23.99 till 8000
De tillgängliga inställningarna varierar
beroende på bildfrekvens för valt videoformat.

59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Ställer in ECS-frekvensen när
Mode är inställt på ECS.
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Iris

Ställer in bländarinställningar.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Bokeh Control On / Off Off Ställer bokeh-kontrollfunktionen till på/av.
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Auto Exposure

Ställer in inställningar för automatisk exponering.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Level

+3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75
/ +1.5 / +1.25 / +1.0 / +0.75 / +0.5 /
+0.25 / ±0 / −0.25 / −0.5 / −0.75 / −1.0 /
−1.25 / −1.5 / −1.75 / −2.0 / −2.25 / −2.5
/ −2.75 / −3.0

±0
Ställer in ljusstyrka för automatiskt
detekterad exponering.

Mode Backlight / Standard / Spotlight Standard

Ställer in driftläge för automatisk
exponeringsjustering.
Backlight: Bakgrundsbelysningsläge
(läge för reducerad förmörkning av ett
föremål när det är bakgrundsbelyst)
Standard: Standardläge
Spotlight: Strålkastarläge (läge för
reducerat vitt när föremålet belyses med
strålkastare)

Speed −99 till +99 ±0 Ställer in justeringsläge för automatisk
exponeringsjustering.

AGC On / Off Off
Ställer in funktionen AGC (automatisk
förstärkningskontroll) till på/av.

AGC Limit

För information om inställningar, se
”AGC Limit-inställningar och
standardvärden.”

– Ställer in maximal förstärkning för AGC-
funktion.

AGC Point F2.8 / F4 / F5.6 F2.8
Ställer in F-stoppvärdet för bländaren när
AGC-funktionen startar när AGC-
funktionen är i läget On.

Auto
Shutter

On / Off Off
Ställer in automatisk slutarfunktion till
på/av.

A.SHT
Limit

1/100 / 1/150 / 1/200 / 1/250 / 1/2000 1/2000
Ställer in snabbaste slutarhastighet för
den automatiska slutarfunktionen.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Ställer in F-stoppvärdet för bländaren när
funktionen automatisk slutare startar.

Clip High
light On / Off Off

Startar funktionen som ignorerar de
ljusaste områdena för att ge ett mattare
svar vid på/av för högluminans.
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AGC Limit-inställningar och standardvärden
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom 1

Ställer in ljusmätningsintervall
automatiskt för att justera exponering
enligt föremålets ljusstyrka. (Ej tillgängligt
när exponering justeras manuellt)

Detect
Window
Indication

On / Off Off
Ställer indikation för ljusmätningsintervall
till på/av.

Custom
Width

40 till 999 500 Ställer in bredden på
ljusmätningsintervallet.

Custom
Height

70 till 999 500
Ställer in höjden på
ljusmätningsintervallet.

Custom H
Position

−479 till +479 ±0
Ställer in horisontal position på
ljusmätningsintervallet.

Custom V
Position

−464 till +464 ±0
Ställer in vertikal position på
ljusmätningsintervallet.
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White

Ställer in inställningar för vitbalans.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Preset
White

2000K till
15000K

3200K Ställer in förinställt värde för vitbalans.

Color
Temp <A>

2000K till
15000K

3200K

Ställer in färgtemperatur för vitbalans sparat i minne A.

OBS!

Eftersom Color Temp klipps vid 2000K och 15000K under R
Gain/B Gain-användning, är det möjligt att det inte går att visa rätt
Color Temp för R Gain/B Gain-värdet.

Tint<A> −99 till +99 ±0

Ställer in tonvärde för vitbalans sparat i minne A.

OBS!

Eftersom Tint klipps vid ±99 under användning av R Gain/B Gain,
är det möjligt att det inte går att visa rätt Tint-värde för R Gain/B
Gain-värdet.

R Gain
<A>

−99.0 till +99.0 ±0.0 Ställer in R-förstärkningsvärde för vitbalans sparat i minne A.

B Gain
<A>

−99.0 till +99.0 ±0.0 Ställer in B-förstärkningsvärde för vitbalans sparat i minne A.
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White Setting

Justerar inställningar för vitbalans.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Shockless
White

Off / 1 / 2 / 3 2

Ställer in svarshastighet för vitbalans vid växling med
balansläge.
Off: Växlar omgående.
1 till 3: Ju högre nummer, desto långsamt växlas det.

ATW Speed 1 / 2 / 3 / 4 / 5 3
Ställer in svarshastighet till ATW-läge.
Den snabbaste svarshastigheten är 1 och den
långsammaste svarshastigheten är 5.
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Offset White

Ställer in förskjutningsinställningar för vitbalans.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Offset White <A> On / Off Off
Väljer om ett förskjutningsvärde ska läggas till (On) eller
inte ska läggas till (Off) vitbalansminnet A.

Offset Color
Temp<A>

−99 till +99 ±0
Ställer in förskjutning för färgtemperatur som ska läggas
till vitbalansen i minnet A när [Offset White <A>] är inställt
på On.

Offset Tint<A> −99 till +99 ±0
Ställer in förskjutning för Tint-värde som ska läggas till
vitbalansen i minnet A när [Offset White <A>] är inställt på
On.

Offset
White<ATW>

On / Off On
Väljer om ett förskjutningsvärde ska läggas till (On) eller
inte ska läggas till (Off) ATW-vitbalans.

Offset Color
Temp<ATW>

−99 till +99 ±0
Ställer in förskjutning för färgtemperatur som ska läggas
till ATW-vitbalansen när [Offset White<ATW>] är inställt
på On.

Offset Tint<ATW> −99 till +99 ±0
Ställer in förskjutning för Tint-värde som ska läggas till
ATW-vitbalansen när [Offset White<ATW>] är inställt på
On.
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Focus

Ställer in fokusinställningar.

Relaterade avsnitt

Ställa in autofokusområde/position (fokusområde)

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

AF
Transition
Speed

1(Slow) / 2 / 3 / 4 /
5 / 6 / 7(Fast)

5
Ställer in hastigheten för fokusdrivenheten när föremålet
ändras under autofokus.

AF Subj.
Shift Sens.

1(Locked On) / 2 / 3
/ 4 / 5(Responsive)

5(Responsive)
Ställer in känsligheten för att ändra föremål under
autofokus.

Focus Area
Wide / Zone /
Flexible Spot Wide

Ställer in målområde för autofokus och push-autofokus
(AF).

Se ”Justera fokus automatiskt (autofokus)” och ”Ställa in
autofokusområde/position (fokusområde).”

Wide: Söker efter ett föremål över en vid vinkel för bilden
vid fokusering.
Zone: Söker automatiskt efter en fokuspunkt inom en
specifik zon.
Flexible Spot: Fokuserar på en specificerad position på
bilden.

Focus Area
(AF-S)

Flexible Spot Flexible Spot Ställer in målområde för push-autofokus (AF-S).

Face/Eye
Detection
AF

Face/Eye Only AF /
Face/Eye Priority
AF / Off

Face/Eye Priority
AF

Aktiverar/inaktiverar ansiktsdetektering AF.

Se ”Fokusering med ansikts- och ögondetektering
(Face/Eye Detection AF).”

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Ställer in läget push-autofokus.

Touch
Function in
MF

Tracking AF / Spot
Focus Tracking AF

Ställer in driften när du trycker på kamerabilden på live-
skärmen i Web App i MF-läge.

AF Assist On / Off On

När inställt på On, kan du tillfälligt åsidosätta autofokus och
ställa in fokus manuellt.

Se ”Ställa in fokusmålet manuellt (AF Assist) med hjälp
av Web App” och ”Fokusera manuellt under autofokus
med hjälp av den medföljande infraröda fjärrkontrollen.”
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Fokusering med ansikts- och ögondetektering (Face/Eye Detection AF)

Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App

Fokusera manuellt under autofokus med hjälp av den medföljande infraröda fjärrkontrollen
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S&Q Motion

Ställer in inställningar för Slow & Quick Motion-läge (se ”Slow & Quick Motion”).

Relaterade avsnitt

Slow & Quick Motion
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer Slow & Quick Motion-läge till på/av.

Frame
Rate

1fps till 60fps / 100fps / 120fps /
150fps / 180fps / 200fps / 240fps

–

Ställer in bildfrekvens vid filmning i Slow & Quick
Motion.

OBS!

De tillgängliga inställningarna varierar beroende
på systemfrekvens, codec och videoformat.
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LUT On/Off

Ställer in LUT-inställningar.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

SDI MLUT On / MLUT Off MLUT Off
Väljer om Monitor LUT ska tillämpas för SDI-
utgångsvideo.

HDMI/Stream MLUT On / MLUT Off MLUT Off
Väljer om Monitor LUT ska tillämpas för HDMI-
och Stream-utgångsvideo.

Proxy MLUT On / MLUT Off MLUT Off
Välj om Monitor LUT ska tillämpas för proxy-
videoinspelning.

Internal Rec MLUT On / MLUT Off MLUT Off Välj om Monitor LUT ska tillämpas för
huvudvideoinspelning.

LUT On/Off
Button Target

SDI / HDMI/Stream / SDI
& HDMI/Stream

HDMI/Stream
Ställer in målutgång kontrollerad med en
tilldelningsbar knapp tilldelad med LUT On/Off.
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Noise Suppression

Ställer in brusreduceringsinställningar.

Tips

[Setting(Custom)] och [Level(Custom)] återspeglas i [Target Display]-inställningen.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting(Custom) On / Off On
Ställer brusreduceringsfunktionen till on/off i läget
Custom.

Level(Custom) Low / Mid / High Mid Ställer in brusreduceringsnivån i läget Custom.

Setting (Cine EI/Flex.
ISO)

On / Off Off
Ställer brusreduceringsfunktionen till på/av i Log-
filmningsläget.

Level (Cine EI/Flex.
ISO) Low / Mid / High Mid

Ställer in brusreduceringsnivån i Log-
filmningsläget.
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Flicker Reduce

Ställer in inställningar för flimmerkorrigering.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Mode Auto / On / Off Off Ställer in flimmerkorrigeringsläget.

Frequency 50Hz / 60Hz 60Hz
Ställer in frekvensen för strömförsörjningskällan som försörjer
belysningen som orsakar flimret.
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SteadyShot

Ställer in inställningar för bildstabilisering.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting
Active / Standard /
Off

Off

Ställer in bildstabiliseringsfunktionen.

OBS!

Aktiverat när en kompatibel lins är fäst.

När inställt till Active eller Standard, kan det uppstå oväntat
beteende under pan/tilt-drift.
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Base Setting

Ställer in grundinställningar.

Relaterade avsnitt

Konfigurera grundläggande användning
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Ställer in filmningsläge.

Se ”Ställer in filmningsläge” i ”Konfigurera
grundläggande användning.”

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Ställer in färgomfång för inspelning/bilder i läget
Custom.
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Rec Format

Ställer in inställningar för inspelningsformat.

Inställningarna [RAW Output Format]

Standardvärden visas i fetstilt.
Förhållanden under vilka [RAW Output Format] inte kan ställas in, har hoppats över.

Inställningarna [Video Format]

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94 Väljer systemfrekvens.

Imager
Scan Mode

FF / S35 FF Väljer bildstorleken.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L

XAVC-I

Ställer in videoklippets
inspelnings/uppspelningscodec.

OBS!

När [Imager Scan Mode] är inställt till [S35],
kan [RAW] och [RAW & XAVC-I] inte väljas.

RAW
Output
Format

Tillgängliga inställningar kan
variera beroende på [Frequency]-
inställningar.

Se inställningarna ”[RAW
Output Format]” nedan.

–

Ställer in storleken på RAW-bild till utmatning
till en extern RAW-inspelare.

OBS!

När [Codec] är inställt på [RAW & XAVC-I],
växlar inställningen [Video Format] i länken
till inställningen [RAW Output Format].

Video
Format

Tillgängliga inställningar kan
variera beroende på
inställningarna för [Frequency],
[Imager Scan Mode] och [Codec].

Se inställningarna ”[Video
Format]” nedan.

– Ställer in bildstorleken och bithastigheten.

Frequency Imager Scan Mode Codec Inställning

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Standardvärden visas i fetstilt.
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Frequency Imager Scan Mode Codec Inställning

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I/XAVC-I 4096×2160P
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Cine EI/Flex.ISO Set

Ställer in inställningar i Log-filmningsläge (Se ”Ställer in filmningsläge” i ”Konfigurera grundläggande användning”).

Relaterade avsnitt

Konfigurera grundläggande användning
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-
Gamut3.Cine/SLog3

Ställer in färgomfånget för Loggfilmningslägena
([Flexible ISO], [Cine EI Quick], [Cine EI]).

Embed
LUT File

On / Off On
Slår på/av metadatainspelning av 3D LUT-fil
(CUBE-fil).
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Simul Rec

Ställer in inspelning samtidigt till 2-öppningar (se ”Inspelning till minneskort A och B samtidigt (2-öppningar Simul Rec)”).
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer läget inspelningsläge med
2 öppningar till on/off.

Rec
Button
Set

Rec Button:<Slot A> <Slot B> 2nd Rec
Button:<Slot A> <Slot B> / Rec Button:
<Slot A> 2nd Rec Button:<Slot B> / Rec
Button:<Slot B> 2nd Rec Button:<Slot A>

Rec Button:<Slot A> <Slot
B> 2nd Rec Button:<Slot
A> <Slot B>

Tilldelar inspelningsknapparna
som används för att styra varje
inspelningsmedia.
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Proxy Rec

Ställer in inställningar i läget proxy-inspelning (se ”Proxyinspelning”).
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer läget proxy-inspelning till på/av.

Audio Channel CH1/CH2 / CH3/CH4 CH1/CH2 Väljer ljudkanal för att spela in proxy-data.
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Interval Rec

Ställer in inställningar i läget inspelningsintervaller (se ”Spela in video växelvis (Interval Rec)”).
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer läget inspelningsintervaller till
på/av. (Om du ställer detta läge till On
ställs alla andra speciallägen till Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (timme)

1

Ställer in intervallen mellan
inspelningar i inspelningsläget Interval
Rec (när Interval Rec är inställt till
On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tillgängliga inställningarna
varierar beroende på bildfrekvens
för valt videoformat.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Ställer in antalet bilder per inspelning i
inspelningsläget Interval Rec (när
Interval Rec är inställt till On).
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Picture Cache Rec

Ställer in inställningar i läget picture cache-inspelning (se ”Ta cachade bilder (Picture Cache Rec)”).

Relaterade avsnitt

Ta cachade bilder (Picture Cache Rec)
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer picture cache-funktionen till on/off.

Cache Size
Short / Medium /
Long / Max

Max
Ställer in tiden för ackumulering av bilder i bildcacheminnet
(inspelningstid för bildcache).

Cache Rec
Time

– –
Visar tiden för ackumulering av bilder i bildcacheminnet
(inspelningstid för bildcache).
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SDI/HDMI Rec Control

Ställer in inställningar för SDI/HDMI-inspelningskontroll.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting
Off / SDI/HDMI
Remote I/F / Parallel
Rec

Off

Ställer in inspelningens start/stoppkontroll för en externt ansluten
enhet via SDI/HDMI-utgångssignalen.
Off: Använd inte fjärrkontrollen.
SDI/HDMI Remote I/F: Start/stoppkontroll för inspelning på en
externt ansluten enhet när inget media sitter i enheten. Inte
synkroniserat med bildnoggrannhet till enhetens media.
Parallel Rec: Start/stoppkontroll för inspelning på en externt
ansluten enhet när ett media sitter i videokameran. Synkroniserat
med bildnoggrannhet till enhetens media.

OBS!

För kontroll med hjälp av HDMI-utgångssignalen, ställ [TC/Media]
> [HDMI TC Out] > [Setting] till [On] i kameramenyn.
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Assignable Button

Ställer in funktionstilldelningar till tilldelningsbara knappar (<1> till <9>) och [Focus Hold Button].
Följande funktioner kan tilldelas.
[Off]: Ingen funktionstilldelning.
[Base ISO/Sensitivity]: Växlar bildsensorns grundkänslighet.
[AGC]: Ställer in AGC-funktionen till on/off.
[Push AGC]: Aktiverar AGC-funktionen medan knappen är nedtryckt.
[ND Filter]

I variabelt läge: Justerar ND-filtersändningen. Tryck och håll ned brytaren mellan Clear/Manual/Auto.
I förinställt läge: Tryck och håll ned brytarens förinställningar.

[ND Filter Position]: Växlar ND-filter.
[Auto ND Filter]: Ställer in automatisk ND-filterfunktion till on/off.
[Push Auto ND]: Aktiverar automatisk ND-filterfunktion medan knappen är nedtryckt.
[Auto Iris]: Ställer in bländarfunktionen till on/off.
[Push Auto Iris]: Aktiverar den automatiska bländarfunktionen medan knappen är nedtryckt.
[Bokeh Control]: Ställer läget bokeh-kontroll till on/off.
[Auto Shutter]: Ställer in automatisk slutarfunktion till on/off.
[AE Level/Mode]: Justerar AE-nivå. Tryck och håll ned för att växla till AE-läge.
[Backlight]: Växlar mellan Backlight och Standard.
[Spotlight]: Växlar mellan Spotlight och Standard.
[Preset White Select]: Växlar vitbalansens förinställda värde.
[ATW]: Ställer in ATW-funktionen till on/off.
[ATW Hold]: Pausar ATW-funktionen.
[AF Speed/Sens.]: Växlar inställning för AF-övergångshastighet och känslighetsinställningar för växling av föremål för
AF.
[Focus Setting]: Ställer in fokusområde.
[Face/Eye Detection AF]: Växlar inställningar för ansiktsdetektering AF.
[Push AF Mode]: Växlar inställningar för Push AF-läge.
[Push AF/MF]: I MF-fokusläge, aktiveras AF när knappen trycks ned. I AF-fokusläge, aktiverar MF när knappen trycks
ned.
[Focus Hold]: I AF-fokusläge, fixeras fokus när knappen trycks ned.
[S&Q Motion]: Ställer Slow & Quick Motion-läge till on/off. Ställer in filmningens bildfrekvens om den är nedtryckt.
[LUT On/Off]: Ställer LUT-funktionen till on/off. Växlingsmål ställs in med [Shooting] > [LUT On/Off] > [LUT On/Off Button
Target].
[SteadyShot]: Växlar mellan Active, Standard och Off.
[Crop Select]: Brytare Imager Scan Mode. Växling aktiverat inom intervallet utan att ändra inspelningsformat.
[Rec]: Starta/stoppa inspelning.
[Picture Cache Rec]: Ställer läget bildcachesinspelning till on/off.
[Rec Review]: Ställer funktionen för inspelningsgranskning till on/off.
[Clip Flag OK]: Utför Add OK. Tryck två gånger för att utföra Delete Clip Flag.
[Clip Flag NG]: Utför Add NG. Tryck två gånger för att utföra Delete Clip Flag.
[Clip Flag Keep]: Utför Add KEEP. Tryck två gånger för att utföra Delete Clip Flag.
[Slot Select]: Växlar minneskortet (A) och (B).
[Color Bars]: Ställer färgstaplarna till on/off.
[DURATION/TC/U-BIT]: Växlar mellan Time Code, Users Bit och Duration.
[Display]: Ställer skärmindikatorerna till on/off.
[Lens Info]: Växlar indikatorn för fältdjup.
[Video Signal Monitor]: Växlar videosignalmonitor (till exempel en vågformsmonitor).
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[Marker]: Ställer markörfunktionen till on/off.
[Thumbnail]: Visar/går ut från miniatyrbildsskärmen.
[Auto Upload (Proxy)]: Ställer funktionen automatisk proxy-filöverföring till on/off.
[Direct Menu]: Visar/går ut från direktmenyn.
[User Menu]: Visar/går ut från menyn User.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Scene File

Ställer in inställningar relaterade till scenfiler (se ”Filma med önskat utseende”).
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Recall – –
Laddar en scenfil lagrad i ett internt minne
och tillämpar inställningarna som aktuella
bildkvalitetsinställningar.

Store – –
Sparar aktuell bildkvalitetsstatus som en
scenfil i ett internt minne.

Delete – –
Tar bort en scenfil lagrad i ett internt
minne.

Preset
Recall

När Shooting Mode är inställt på
Custom och Target Display är inställt
på SDR(BT.709): S-Cinetone / Standard /
Still / ITU709/ 709tone
När Shooting Mode är inställt på
Custom och Target Display är inställt
på HDR(HLG): HLG Live / HLG Natural

–
Tillämpar förinställda
bildkvalitetsinställningar (skrivskyddade)
som aktuella bildkvalitetsinställningar.
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Base Look

Ställer in inställningar relaterade till grundutseende.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Select

När Shooting Mode är inställt på
Custom och Target Display är
inställt på SDR(BT.709): S-Cinetone
/ Standard / Still / ITU709 / 709tone /
User1 till User16
När Shooting Mode är inställt på
Custom och Target Display är
inställt på HDR(HLG): HLG Live /
HLG Natural / User1 till User16
När Shooting Mode är inställt på
Log-filmningslägena: s709 /
709(800) / S-Log3 / User1 till User16

När Shooting Mode är
inställt på Custom och
Target Display är inställt på
SDR(BT.709): S-Cinetone
När Shooting Mode är
inställt på Custom och
Target Display är inställt på
HDR(HLG): HLG Live
När Shooting Mode är
inställt på Log-
filmningslägena: s709

Väljer ett grundutseende.

Delete – – Raderar valt grundutseende.

Delete
All

– – Raderar alla grundutseenden.

Input
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Ställer in ingångsomfång för valt
grundutseende med hjälp av
[Select].

Output BT.709 / HLG BT.709
Ställer in utgångsfärgomfång för
valt grundutseende med hjälp av
[Select].

AE
Level
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /
5/3EV / 2EV

0EV

Ställer in
exponeringsreferensvärde för
valt grundutseende med hjälp av
[Select].
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Reset Paint Settings

Återställer inställningar för menyn [Paint/Look], med grundutseende undantaget.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Reset without
Base Look

Execute / Cancel –
Återställer inställningar för menyn [Paint/Look], med
grundutseende undantaget.
Execute: Utför funktionen.
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Black

Ställer in svartinställningar.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Master Black −99.0 till +99.0 ±0.0 Ställer in masternivå för svart.

R Black −99.0 till +99.0 ±0.0 Ställer in R-nivå för svart.

B Black −99.0 till +99.0 ±0.0 Ställer in B-nivå för svart.
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Knee

Ställer in inställningar för knee-korrigering.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting

När Target Display är
inställt på SDR(BT.709):
On / Off / ---
När Target Display är
inställt på HDR(HLG): On
/ Off / ---

När Target Display är
inställt på
SDR(BT.709): Off
När Target Display är
inställt på HDR(HLG): Off

Ställer in knee-korrigeringsfunktionen till på/av.

OBS!

Aktiverad endast när [Base Look] > [Select] är
inställd på [Standard], [ITU709], [709tone],
[HLG Live], eller [HLG Natural].

Auto
Knee

När Target Display är
inställt på SDR(BT.709):
On / Off / ---
När Target Display är
inställt på HDR(HLG): On
/ Off / ---

När Target Display är
inställt på
SDR(BT.709): On
När Target Display är
inställt på HDR(HLG): Off

Ställer in automatisk knee-funktion till på/av.

OBS!

Aktiverad endast när [Base Look] > [Select] är
inställd på [Standard], [ITU709] eller
[709tone].

Point 75% till 109% 90% Ställer in knee-punkt.

Slope −99 till +99 ±0 Ställer in knee-lutning.
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Detail

Ställer in detaljerade justeringsinställningar.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off On Ställer detaljfunktionen till på/av.

Level −7 till +7 ±0 Ställer in detaljnivån.

Manual
Setting

On / Off / --- Off Ställer funktionen för manuella detaljjusteringar till på/av.

H/V Ratio −2 till +2 ±0

Ställer in balansen mellan horisontell (H) och vertikal (V)
detalj för manuell detaljjustering.

OBS!

Detta varierar beroende på programvaruversion.*1

B/W
Balance

Type1 / Type2 /
Type3 / Type4 /
Type5

Type3
Ställer in balansen mellan svart (B) detalj för områden med
lågluminans och vit (W) detalj för områden med hög luminans
för manuell justering av detaljer.

Limit 0 till 7 7 Ställer in detaljens gränsnivå för manuell justering av detaljer.

Crispening 0 till 7 0
Ställer in detaljens krispighetsnivån för manuell justering av
detaljer.

High Light
Detail

0 till 4 0
Ställer in detaljnivån för högluminans för manuell justering av
detaljer.

I programvaruversion 1.00 är menyalternativet [V/H Balance]. I programvaruversion 1.10 eller senare är menyalternativet [H/V Ratio].
Inställningsområdet är oförändrat från −2 till 0 till +2, men effekten på bildkvaliteten skiljer sig.
Programvaruversion 1.00: Ju högre inställt värde, desto högre horisontell (H) detalj.
Programvaruversion 1.10 eller senare: Ju högre inställt värde, desto högre vertikal (V) detalj.
Efter uppdatering från programvaruversion 1.00 till 1.10 eller senare ärvs [All File], [Scene File] och andra inställningar men med inverterad
polaritet (bildkvaliteten bibehålls).
Om du har registrerat menyalternativet [V/H Balance] i menyn [User] kommer det automatiskt att ersättas med [H/V Ratio] i menyn [User] efter
uppdatering av programvaran.

*1
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Matrix

Ställer in inställningar för matriskorrigering.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

User Matrix On / Off Off
Ställer in användarmatriskorrigeringsfunktionen till
på/av.

User Matrix
Level

−99 till +99 ±0 Justerar färgmättnad för hela bilden.

User Matrix
Phase

−99 till +99 ±0 Justerar färgton (fas) för hela bilden.

User Matrix R-G −99 till +99 ±0 Ställer in en användardefinierad R-G-användarmatris.

User Matrix R-B −99 till +99 ±0 Ställer in en användardefinierad R-B-användarmatris.

User Matrix G-R −99 till +99 ±0 Ställer in en användardefinierad G-R-användarmatris.

User Matrix G-B −99 till +99 ±0 Ställer in en användardefinierad G-B-användarmatris.

User Matrix B-R −99 till +99 ±0 Ställer in en användardefinierad B-R-användarmatris.

User Matrix B-G −99 till +99 ±0 Ställer in en användardefinierad B-G-användarmatris.
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Multi Matrix

Ställer in inställningar för multi-matris.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer in multi-matriskorrigeringsfunktionen
till på/av.

Reset Execute / Cancel –
Ställer in nyans och mättnad för varje
axelfärg till standardvärden.

Axis
B / B+ / MG− / MG / MG+ / R / R+ / YL−
/ YL / YL+ / G− / G / G+ / CY / CY+ / B−

B Väljer axel.

Hue −99 till +99 ±0 Ställer in färgnyans för multi-
matriskorrigering.

Saturation −99 till +99 ±0
Ställer in färgmättnad för multi-
matriskorrigering.
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P/T Acceleration

Ställer in inställningarna relaterade till acceleration av pan/tilt-drift.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Ramp
Curve

1 till 9 8
Väljer acceleration/retardation för pan/tilt-drift. Ju högre siffra,
desto högre acceleration.
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Timecode

Ställer in tidkodsinställningar.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Mode Preset / Regen / Clock Preset

Ställer in tidskodens körningsläge.
Preset: Börjar köra från ett förinställt värde.
Regen: Börjar köra från tidskoden från slutet av föregående
videoklipp.
Clock: Använder en intern klocka som tidskod.

Run Rec Run / Free Run Rec Run
Rec Run: Körs endast vid inspelning.
Free Run: Körs alltid, oavsett funktion som används för
videokameran.

Setting – –
Ställer in tidskoden till ett slumpmässigt värde.
Set: Ställ in värdet.

Reset Execute / Cancel –
Återställer tidskoden till 00:00:00:00.
Execute: Utför funktionen.

TC
Format DF / NDF DF

Ställer in tidkodsformat.
DF: Hoppa över bilder
NDF: Hoppa inte över bilder
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TC Display

Ställer in visningsinställningar för tidsdata.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Display Select Timecode / Users Bit / Duration Timecode Växlar visningen av tidsdata.
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Users Bit

Ställer in inställningar relaterade till användarbits.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Mode Fix / Time Fix

Ställer in användarbitsläge.
Fix: Använder ett slumpmässig fixerat värde i användarbits.
Time: Använder aktuell timma, minut och sekund i
användarbits.

Setting – – Ställer in användarbits till ett slumpmässigt värde.
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HDMI TC Out

Ställer in inställningar relaterade till tidskodutgång när HDMI används.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer huruvida tidskoden ska gå till enheter i andra syften,
med HDMI.
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Clip Name Format

Ställer in inställningar relaterade till videoklippets namn och borttagning.
När [Auto Naming] är inställt på [Cam ID + Reel#] bestäms de första fyra tecknen med videoklippnamn för varje
inspelningsmedia. När nytt inspelningsmedium sätts i eller när det sista klippet på inspelningsmediet inte
överensstämmer med inställningarna för [Camera ID] eller [Reel Number] blinkar videoklippnamnet för att meddela dig.
När [Auto Naming] är inställt på [Title] kan du använda en godtycklig teckensträng som första del av videoklippnamn.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Auto
Naming Cam ID + Reel# / Title

Väljer namnformatet för videoklipp.
Cam ID + Reel#: Kamera-ID + Rullnummer +
Bildnummer + Datum + Slumpmässig sträng
Title: Godtycklig sträng som anges av [Title Prefix] +
videoklippnummer

Camera ID A till Z A

Ställer in det kamera-ID som används vid generering av
videoklippnamn.

OBS!

Kan endast konfigureras när [Auto Naming] är inställt på
[Cam ID + Reel#].

Reel
Number

001 till 999 001

Ställer in den del av rullnumret som används vid
generering av videoklippnamn.

OBS!

Kan endast konfigureras när [Auto Naming] är inställt på
[Cam ID + Reel#].

Camera
Position

C / L / R C

Ställer in den första teckendelen av det bildnummer som
används vid generering av videoklippnamn.

OBS!

Kan endast konfigureras när [Auto Naming] är inställt på
[Cam ID + Reel#].

Title Prefix
nnn_(nnn är de sista 3
siffrorna i serienumret)
(Max. 7-siffrig visning)

nnn

Delar upp titeln (4 till 46 tecken) för videoklippets namn.
Öppnar en skärm för att ange tecken.

För information om att ställa in titlar och skärmen för
teckeninföring, se ”Ställa in titeln” nedan och ”Ange
en teckensträng”.

OBS!

Kan endast konfigureras när [Auto Naming] är inställt på
[Title].
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Ställa in [Title Prefix]

Relaterade avsnitt

Ange en teckensträng
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Number
Set

0001 till 9999 0001

Ställer in videoklippet namn med ett 4-siffrigt suffix.

OBS!

Kan endast konfigureras när [Auto Naming] är inställt på
[Title].

Välj tecken att föra in vid markörens position i området [Title Prefix] från området där man väljer tecken
med hjälp av pilknapparna i GUI kontrollblocket (tecknen är markerade), och tryck på knappen [Set] i GUI-
kontrollblocket.

Det valda tecknet förs in och markören flyttas till höger.

1

Upprepa steg 1 för att ställa in titeln.

Använd [BS] enligt behov.

2

Efter att titeln ställts in, tryck på knappen [Done] för att stänga skärmen för teckeninföring.

För information om att använda skärmen för teckeninföring, se ”Ange en teckensträng.”

Följande tecken kan väljas.
!#$%()+,-.;=@[ ]^_~ mellanslag
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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Update Media

Uppdaterar hanteringsfilen i minneskorten (se ”Återställa minneskort”).

Relaterade avsnitt

Återställa minneskort
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Media(A) Execute / Cancel –
Uppdaterar hanteringsfilen i minneskortet i öppning A.
Execute: Utför funktionen.

Media(B) Execute / Cancel –
Uppdaterar hanteringsfilen i minneskort i öppning B.
Execute: Utför funktionen.
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Format Media

Formaterar (initiera) minneskort (se ”Formatera (initiera) minneskort”).

Relaterade avsnitt
Formatera (initiera) minneskort
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Media(A) Full Format / Quick Format / Cancel – Formaterar minneskortet i öppning A.

Media(B) Full Format / Quick Format / Cancel – Formaterar minneskortet i öppning B.
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Media Life

Visar kvarvarande liv för minneskorten.

OBS!

Kräver minneskort som stöder kvarvarande medialivsvisning.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Media(A) – – Visar kvarvarande liv i minneskortet i öppning A.

Media(B) – – Visar kvarvarande liv för minneskortet i öppning B.
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Output Format

Ställer in inställningar för utgångsformat.

Relaterade avsnitt
Utgångsformat och begränsningar
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

SDI För information om inställningar, se ”Utgångsformat
och begränsningar.”

– Ställer in upplösning för SDI- och
HDMI-utgång.HDMI –

338



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Display On/Off

Ställer in objektinställningar.
För att visa ett visat objekt, välj On. För att dölja ett visat objekt, välj Off.

Objekt Inställning underobjekt Fabriksstandard

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On
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Objekt Inställning underobjekt Fabriksstandard

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On
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Video Signal Monitor

Ställer in inställningar för videosignalmonitor.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting Off / Waveform / Vector / Histogram Off Ställer in typen av videosignalmonitor.

Level Marker 1 0% till 109% 70% Ställer in luminansnivån för nivåmarkör 1.

Level Marker 2 0% till 109% 100% Ställer in luminansnivån för nivåmarkör 2.
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Marker

Ställer in inställningar för markören.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off On Ställer displayen för alla markörer till på/av.

Color
White / Yellow / Cyan / Green /
Magenta / Red / Blue

White Väljer markörens signalfärg.

Center
Marker

1 / 2 / 3 / 4 / Off Off Väljer central markör.

Safety
Zone

On / Off Off Ställer markören för säkerhetszon till på/av.

Safety Area 80% / 90% / 92.5% / 95% 90%
Väljer storlek på markören för
säkerhetsområdet (som en procentandel av
den totala skärmstorleken).

Aspect
Marker

Line / Mask / Off Off Väljer typ av aspektmarkör.

Aspect
Mask

0 till 15 12
Ställer in nivån på videosignalen utanför
markören.

Aspect
Safety
Zone

On / Off Off
Ställer aspektmarkören för säkerhetszon till
på/av.

Aspect
Safety Area

80% / 90% / 92.5% / 95% 90%
Väljer storlek på aspektmarkören för
säkerhetsområdet (som en procentandel av
den totala skärmstorleken).

Aspect
Select

1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 / 1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1 Ställer in läget när aspektmarkören visas.

Custom
Aspect
Ratio

Ange vilket värde som helst. 01.00:01.00

Ställer in aspektförhållande till ett
slumpmässigt värde.

OBS!

Aktiveras när [Aspect Select] ställs in till
[Custom].

Guide
Frame

On / Off Off Ställer styrbilddisplayen till på/av.

100%
Marker On / Off Off Ställer 100% markören till på/av.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

User Box On / Off Off Ställer markören för användarruta till på/av.

User Box
Width

3 till 479 240
Ställer markören för bredd på användarruta
(avstånd från mitt till vänster och höger till
kanter).

User Box
Height

3 till 269 135
Ställer markören för höjd på användarruta
(avstånd från mitt till högst upp och
bottenkanter).

User Box H
Position

−476 till +476 0 Ställer in horisontalt läge för mitten på
markören för användarrutan.

User Box V
Position

−266 till +266 0
Ställer in vertikalt läge för mitten på markören
för användarrutan.
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Audio Input

Ställer in ljudingångsinställningar.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

AUDIO IN
Select

MIC / LINE MIC
Väljer typen av enhet som är ansluten till AUDIO IN-
kontakten.

Phantom
Power +48V

On / Off Off Visar statusen för fantommatningen på +48 V.

CH1 Input
Select

AUDIO IN CH1 AUDIO IN CH1 Visar ingångskälla för inspelning på kanal 1.

CH2 Input
Select

AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Växlar ingångskälla för inspelning på kanal 2.

CH3 Input
Select

Off / AUDIO IN CH1 AUDIO IN CH1 Växlar ingångskälla för inspelning på kanal 3.

CH4 Input
Select

Off / AUDIO IN CH1 /
AUDIO IN CH2

AUDIO IN CH2 Växlar ingångskälla för inspelning på kanal 4.

AUDIO IN
CH1 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Ställer in referensinspelningsnivå för XLR-
mikrofoningången från AUDIO IN CH1.

AUDIO IN
CH2 MIC Ref.

−80dB / −70dB /
−60dB / −50dB /
−40dB / −30dB

−50dB
Ställer in referensinspelningsnivå för XLR-
mikrofoningången från AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB / −3dB /
EBUL

+4dB
Väljer referensingångsnivå när [AUDIO IN Select] är
inställt på LINE.

Reference
Level

−20dB / −18dB /
−16dB / −12dB /
EBUL

−20dB Väljer inspelningsnivå för 1 kHz referenstonsignal.

CH1 Wind
Filter

On / Off Off
Aktiverar/inaktiverar vindreduceringsfiltret för inspelning
med kanal 1.

CH2 Wind
Filter

On / Off Off
Aktiverar/inaktiverar vindreduceringsfiltret för inspelning
med kanal 2.

CH3 Wind
Filter

On / Off Off
Aktiverar/inaktiverar vindreduceringsfiltret för inspelning
med kanal 3.

CH4 Wind
Filter

On / Off Off Aktiverar/inaktiverar vindreduceringsfiltret för inspelning
med kanal 4.

CH1 Level
Control

Auto / Manual Auto
Väljer automatisk eller manuell justering av
ljudingångsnivå för inspelningskanal 1.

344



5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
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CH2 Level
Control

Auto / Manual Auto
Väljer automatisk eller manuell justering av
ljudingångsnivå för inspelningskanal 2.

CH3 Level
Control

Auto / Manual Auto
Väljer automatisk eller manuell justering av
ljudingångsnivå för inspelningskanal 3.

CH4 Level
Control

Auto / Manual Auto
Väljer automatisk eller manuell justering av
ljudingångsnivå för inspelningskanal 4.

CH1 Input
Level

0 till 99 49 Ställer in ingångskälla för inspelning på kanal 1.

CH2 Input
Level

0 till 99 49 Ställer in ingångskälla för inspelning på kanal 2.

CH3 Input
Level

0 till 99 49 Ställer in ingångsnivå för inspelning på kanal 3.

CH4 Input
Level

0 till 99 49 Ställer in ingångskälla för inspelning på kanal 4.

Master Input
Level

0 till 99 99 Ställer in master-ljudingångsnivå.

Limiter Mode
Off / −6dB / −9dB /
−12dB / −15dB /
−17dB

Off
Väljer teckenbegränsning för stora ingångssignaler när
ljudets ingångsnivå justeras manuellt.

CH1&2 AGC
Mode

Mono / Stereo Stereo
Ställer in läget automatisk ljudjusteringsnivå för kanal 1
och kanal 2. När inställt till Stereo, kopplas AGC mellan
kanaler.

CH3&4 AGC
Mode

Mono / Stereo Stereo
Ställer in läget automatisk ljudjusteringsnivå för kanal 3
och kanal 4. När inställt till Stereo, kopplas AGC mellan
kanaler.

AGC Spec
−6dB / −9dB / −12dB
/ −15dB / −17dB

−6dB Väljer AGC-egenskapen.

1kHz Tone on
Color Bars

On / Off Off

Ställer 1 kHz referenstonsignalen till på/av när färgstaplar
visas.

OBS!

När inställt på [On], är 1 kHz referenstonssignalen
inställd på inspelning på kanal 3 och kanal 4, även om
[CH3 Input Select] och [CH4 Input Select] är inställt på
[Off].
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Audio Output

Ställer in ljudutgångsinställningar.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Ställer in kombinationen av ljudkanaler på
HDMI-/strömningsutgången.
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Display Clip Properties

Visar klippets egenskapsskärm.
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Display Clip Properties – – Visar klippets egenskapsskärm.
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Set Clip Flag

Ställer in inställningar för klippflagga.
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Add OK – – Lägger till en OK-flagga.

Add NG – – Lägger till en NG-flagga.

Add KEEP – – Lägger till en KEEP-flagga.

Delete Clip Flag – – Tar bort alla flaggor.
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Lock/Unlock Clip

Ställer in inställningar för videoklippskydd.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Select Clip – – Väljer och låser/låser upp ett videoklipp.

Lock All Clips – – Låser alla videoklipp.

Unlock All Clips – – Låser upp alla videoklipp.

349



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Delete Clip

Raderar videoklipp.
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Select Clip – – Raderar det valda videoklippet.

All Clips – – Raderar alla videoklipp.
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Transfer Clip

Överför videoklipp.
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Select Clip – – Överför alla valda videoklipp.

All Clips – –

Överför alla videoklipp.

OBS!

Upp till 200 överföringsjobb kan registreras.
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Transfer Clip (Proxy)

Överför proxyklipp.
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Select Clip – – Överför proxyklipp som motsvarar de valda videoklippen.

All Clips – –

Överför proxyklipp som motsvarar alla videoklippen.

OBS!

Upp till 200 överföringsjobb kan registreras.
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Filter Clips

Ställer in inställningar för videoklipp som ska visas.
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OK – – Visar endast videoklipp med en OK-flagga.

NG – – Visar endast videoklipp med en NG-flagga.

KEEP – – Visar endast videoklipp med en KEEP-flagga.

None – – Visar endast videoklipp utan flagga.

All – – Visar alla videoklipp, oavsett om det finns några flaggor.
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Customize View

Växlar vyn för miniatyrbildsskärm.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Thumbnail
Caption

Date Time / Time Code / Duration /
Sequential Number

Time Code
Växlar informationen som visas under
miniatyrbilder.
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Color Bars

Ställer in inställningar för färgstaplar.
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Setting On / Off Off Ställer funktionen färgstapel till på/av.

Type ARIB / 100% / 75% / SMPTE ARIB Väljer typ av färgstapel.
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Genlock

Konfigurerar genlock-statusvisning (se ”Synkronisera videosignalens fas (Genlock)).”

Relaterade avsnitt
Synkronisera videosignalens fas (Genlock)
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Reference Internal / External(HD) / External(SD) – Visar typen av genlock-referenssignal.
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Tally

Ställer in inställningar för inspelningslampan (se ”Ansluta en tally-signal”).

Relaterade avsnitt

Ansluta en tally-signal
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Tally Lamp
Brightness

High / Low / Off High Ställer in ljusstyrkan för inspelningslampan.

G Tally Lamp Enable / Disable Enable Aktiverar/inaktiverar G-tallylampan.

Tally Control External / Internal Internal

Väljer målet för att acceptera kontrollinformation om
enhetens inspelningslampa.
External: Tally-kontroll utifrån kameran.
Internal: Kontroll via kamerans inspelningsfunktion.
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Rec Review

Ställer in inställningar för inspelningsgranskning (se ”Granska inspelningen (Rec Review)”).

Relaterade avsnitt

Granska inspelningen (Rec Review)
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting 3s / 10s / Clip 3s
Ställer in tid för uppspelning av videoklipp som precis spelats in
för inspelningsgranskning.
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Zoom

Ställer in zoominställningar (”Justera Zoomen”).
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Zoom Type Optical Zoom Only / On(Clear Image Zoom) Optical Zoom Only Ställer in typ av zoom.
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Lens

Ställer in inställningar relaterade till linser.

Relaterade avsnitt
Andningskompensation
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Lens Calibration Execute / Cancel –
Utför funktionen som korrigerar skillnaderna i zoom-
position på grund av skillnader mellan enskilda linser
när man använder en power zoom-lins.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Left(W)/Right(T)

Ställer in riktning för användning av zoomring.

OBS!

Aktiveras endast när en E-monterad lins används som
stöder zoomringens byten av riktning.

Shading
Compensation

Auto / Off Auto Ställer in automatisk skuggkompensation.

Chroma
Aberration
Comp.

Auto / Off Auto
Ställer in automatisk kompensation av kromatisk
aberration.

Distortion Comp. Auto / Off Auto Ställer in automatisk störningskompensation.

Breathing
Compensation

Auto / Off Off
Ställer in linsens andningskompensation.

Se ”Andningskompensation.”

Distance Display Meter / Feet Meter
Ställer in visningsenheter för linsinformation och
fokusposition.

Zoom Position
Display

Focal Length /
Number / Bar

Focal Length Ställer in visningsformat för zoomningsposition.
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APR

Executes APR.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

APR Execute / Cancel –

Kör APR (Automatic Pixel Restoration) för bildsensorns
automatiska justering.
Execute: Utför funktionen.

OBS!

Sätt alltid på linslocket innan du kör APR.
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Wired LAN

Ställer in inställningar relaterade till trådbundna LAN-anslutningar.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

HTTP Port – 80 Visar HTTP-åtkomstporten.

Detail
Settings

– – Visar egenskaperna för trådbunden LAN-anslutning.

DHCP
On / Off

On Visar om DHCP är (On) eller inaktiverat (Off).

IP Address –
Visar videokamerans IP-adress när [DHCP] är inställt på
[Off].

Subnet Mask –
Visar videokamerans nätmask när [DHCP] är inställt på
[Off].

Gateway – Visar default gateway när [DHCP] är inställd på [Off].

DNS Auto
On / Off

On Visar inställning för DNS autoförvärv.
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File Transfer

Ställer in inställningar relaterade till filöverföringar (se ”Om filöverföring”).

Relaterade avsnitt

Om filöverföring
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Auto Upload
(Proxy)

On / Off Off Ställer funktionen automatisk överföring till on/off.

Default
Upload
Server

Server Settings1
till 3 > Display
Name

–

Väljer uppladdningsserver för filer. Den valda servern här blir
destination för automatisk uppladdning för proxy-filer och
uppladdningsdestination för filer från miniatyrskärmen.
Visar [Display Name] inställningarna för menyn [Server
Settings1 till 3].

Clear
Completed
Jobs

Execute / Cancel –
Rensar slutförda överföringsjobb från listan.
Execute: Utför funktionen.

Clear All
Jobs

Execute / Cancel –
Rensar alla överföringsjobb från listan.
Execute: Utför funktionen.

View Job List – – Visar listan med överföringsjobb.
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Language

Ställer in visningsspråk.
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Select – –
Ställer in visningsspråk.
Set: Ställ in värdet.
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Clock Set

Ställer in interna klockinställningar.

OBS!

När denna inställning ändras från kameramenyn, stäng av strömförsörjningen till enheten och starta om enheten. Oväntat
beteende kan inträffa om standbyläge för ström initieras med den infraröda fjärrkontrollen eller Web App.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Time Zone UTC − 12:00 till UTC + 14:00 –
Ställer in tidsskillnaden från UTC i 30-minuters
enheter.

Date
Mode

YYMMDD / MMDDYY /
DDMMYY YYMMDD

Väljer visningsformat för datum.
YYMMDD: År, månad, dag
MMDDYY: Månad, dag, år
DDMMYY: Dag, månad, år

12H/24H 12H / 24H 24H
Väljer klockans visningsformat.
12H: 12-timmarsläge
24H: 24-timmarsläge

Date – –
Ställer in aktuellt datum.
Set: Ställ in värdet.

Time – –
Ställer in aktuell tid.
Set: Ställ in värdet.
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Hours Meter

Visar den ackumulerade körtiden.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Hours(System) – –
Visar det ackumulerade antalet användningstimmar (kan
inte återställas).

Hours(Reset) – –
Visar det ackumulerade antalet användningstimmar (kan
återställas).

Reset Execute / Cancel –
Återställer den ackumulerade körtiden till 0.
Execute: Utför funktionen.
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ISO/Gain-inställningar och standardvärden

Intervallet för inställningar och standardvärden för [ISO/Gain<L>] varierar beroende på inställningarna för [Mode], [Base
Look] > [Select] och [Base Sensitivity].
Standardvärden i tabellerna visas i fetstilt.

När [Mode] är inställt på [ISO]

När [Base Look] > [Select] är inställt på [S-Cinetone], [Standard], [ITU709], [709tone] eller [Still]

When [Base Look] > [Select] är inställt på [HLG Live] eller [HLG Natural]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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När [Base Look] > [Select] är inställt på [User1] till [User16]

När [Mode] är inställt på [dB]

Ett värde i intervallet −3dB till +30dB med ökningar på 1dB kan konfigureras.
Standardvärde är 0dB.
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När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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AGC Limit-inställningar och standardvärden

Intervallet för inställningar och standardvärden för menyn [AGC Limit] varierar beroende på inställningarna för [Mode],
[Base Look] > [Select] och [Base Sensitivity].
Standardvärden i tabellerna visas i fetstilt.

När [Mode] är inställt på [ISO]

När [Base Look] > [Select] är inställt på [S-Cinetone], [Standard], [ITU709], [709tone] eller [Still]

When [Base Look] > [Select] är inställt på [HLG Live] eller [HLG Natural]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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När [Base Look] > [Select] är inställt på [User1] till [User16]

När [Mode] är inställt på [dB]

Välj från 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Standardvärde är 15dB.
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När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[Low]

När [ISO/Gain/EI] > [Base Sensitivity] är inställt på
[High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600
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Bildkvalitetsinställningar som sparas för varje filmningsläge

Den aktuella statusen för konfigurationsobjekt relaterade till bildkvalitet sparas för vart och ett av följande
fotograferingslägen. När du ändrar fotograferingsläget tillämpas motsvarande inställningar som sparats för
fotograferingsläget.

Custom läget SDR(BT.709)-mål visas
Custom läget HDR(HLG)-mål visas
Log-filmning (Cine EI, Cine EI Quick, Flexible ISO)

De konfigurationsobjekt relaterade till bildkvaliteten som sparas för varje fotograferingsläge visas i följande tabeller.
”Ja” indikerar en inställning som sparas och ”Nej” indikerar en inställning som inte sparades. ”Ja” över flera kolumner
indikerar gemensamma inställningar.

Objekt

Filmningsläge

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Shooting-
meny

ISO/Gain/EI

ISO/Gain Ja1) Ja Nej

Exposure Index Nej Nej Ja Ja

Base Sensitivity Ja Nej

Base ISO Nej Ja4) Nej3) Ja4)

White
Preset White Ja Ja

Annat än ovan Ja

White Setting Ja

Offset White Ja Nej

LUT On/Off Nej Ja

Noise
Suppression

Setting(Custom) Ja Ja Nej

Level(Custom) Ja Ja Nej

Setting (Cine EI/Flex.
ISO) Nej Ja

Level (Cine EI/Flex.
ISO)

Nej Ja
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Objekt

Filmningsläge

Custom Flexible
ISO

Cine EI
Quick

Cine
EISDR(BT.709) HDR(HLG)

Paint/Look-
meny

Base Look

Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE-nivåförskjutning2) Ja

Black Ja Ja Nej

Knee
Auto Knee Ja Nej Nej

Annat än ovan Ja Ja Nej

Detail Ja Ja Nej

Matrix Ja Ja Nej

Multi Matrix Ja Ja Nej

Separata ISO-känslighetsinställningar sparas för både läget Custom SDR(BT.709) och HDR(HLG).1)

Inställningar sparas för varje Grundutseende och beror inte på filmningsläget.2)

Den grundläggande ISO-känsligheten ändras i samband med exponeringsindexet.3)

Gemensamt inställningsvärde för filmningslägena Flexible ISO och Cine EI.4)
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Konfigurera web-menyn

Tryck på användningsskärmen [Settings] för att visa inställningsskärmen.
Använd inställningsskärmen för att konfigurera enhetens olika konfigurationsobjekt, bland annat de inledande
inställningarna, nätverksinställningar, inspelnings-/uppspelningsinställningar med hjälp av web-menyn.

Menyn består av följande menyer.

Konfiguration av meny och hierarki

Nivå 1 Nivå 1 beskrivning Nivå 2

Shooting Innehåller inställningar för att filma. Focus
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Nivå 1 Nivå 1 beskrivning Nivå 2

Project Innehåller grundläggande projektinställningar.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Innehåller inställningar för bildkvalitet. Base Look

Pan-Tilt Innehåller inställningar för pan/tilt.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring Innehåller inställningar för videoutgång och skärmdisplayen.
Output Format

Output Display

Audio Innehåller inställningar för ljud. Audio

Technical Innehåller inställningar för tekniska objekt.

Tracking Data Output

Tally

IR Remote

RCP/MSU

Lens Controller

Network Innehåller inställningar för nätverk.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack Protection
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OBS!

[Accessibility] är endast tillgänglig för modeller i Nordamerika.
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Nivå 1 Nivå 1 beskrivning Nivå 2

Stream Innehåller inställningar för strömning.

Stream

Video Stream

Audio Stream

Maintenance Innehåller enhetsinställningar, till exempel klocka och språk.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software
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Använda web-menyn

Tryck på växlingsfliken [Settings] på användningsskärmen för att visa inställningsskärmen för att konfigurera enhetens
olika konfigurationsobjekt, bland annat de inledande inställningarna, nätverksinställningar,
inspelnings-/uppspelningsinställningar med hjälp av web-menyn.
Konfigurera inställningarna i web-menyn på en surfplatta med hjälp av pekfunktionen eller på en dator med
musfunktionen.
Tryck på menyn för objekten om du vill konfigurera så att konfigurationsobjekten och deras inställningar visas i den
menyn.

Konfigurationsmetod

Värdeurval

Meny (nivå 1)1.

Meny (nivå 2)2.

Inställningar3.
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Tryck på radioknappen för ett objekt. Radioknappen för ett valt objekt visas i orange.

Objekt On/Off

Tryck på brytaren för att ställa objektet till On/Off. Brytaren är orange när objektet är aktiverat och vitt när det är
inaktiverat.

Värdesval från en lista

Tryck på den nedrullningsbara knappen och välj ett objekt från listan.

Numeriskt värdeurval

Tryck på < eller > för att ändra numeriskt värde. Om det numeriska värdet är understruket, kan du även ange ett
numeriskt värde direkt.

Tecken/nummerinmatning

Konfiguration på separat skärm
Tryck på knappen för att utföra konfigurationsåtgärder på en separat skärm.

Vägledningsmeddelande

Information som kan hjälpa dig att konfigurera en del inställningar, och meddelanden som uppmärksammar användaren,
visas.

Spara en inställning

När du har konfigurerat en inställning, tryck på knappen [OK] för att spara inställningen.
Tryck på knappen [Cancel] för att avfärda en inställning och återgå till den tidigare inställningen.
Tryck på knappen [Reload] för att uppdatera skärmdisplayen.
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OBS!

Om du trycker på knappen [Reload] innan du sparar en inställning, då avfärdas ändringarna för den inställningen.

Om du går till en annan sida innan du sparar en inställning, då avfärdas ändringar för den inställningen.
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Focus

Ställer in fokusinställningar.

Relaterade avsnitt

Ställa in fokusmålet manuellt (AF Assist) med hjälp av Web App
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Ställer in läget push-autofokus.

Touch
Function in
MF

Tracking AF / Spot
Focus

Tracking AF Ställer in driften när kamerans bildskärm vidrörs i MF-läge.

AF Assist
Control

On / Off On

När inställt till [On], kan du använda fokusskjutreglaget i
Web App under autofokus för att justera fokusposition.

För information, se ”Ställa in fokusmålet manuellt (AF
Assist) med hjälp av Web App.”

OBS!

Detta objekt aktiveras endast när [AF Assist] är inställt till
[On] i kameramenyn.
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Base Setting

Ställer in grundinställningar.

Relaterade avsnitt

Konfigurera grundläggande användning
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Shooting
Mode

Custom / Flexible ISO / Cine EI
Quick / Cine EI

Custom

Ställer in filmningsläge.

Se ”Filmningsläge” i ”Konfigurera
grundläggande användning.”

Target
Display

SDR(BT.709) / HDR(HLG) SDR(BT.709)
Ställer in färgomfång för inspelning/bilder i
läget Custom.

380



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Rec Format

Ställer in inställningar för inspelningsformat.

Inställningarna [RAW Output Format]

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 59.94

Väljer systemfrekvens.

OBS!

Om frekvensen ändras, då startas kameran
om. Efter att du startat om, ladda om sidan i
webbläsaren.

Imager
Scan Mode

FF / S35 FF Väljer bildstorleken.

Codec
RAW / RAW & XAVC-I / XAVC-I /
XAVC-L XAVC-I

Ställer in videoklippets
inspelnings/uppspelningscodec.

OBS!

När [Imager Scan Mode] är inställt till [S35],
kan [RAW] och [RAW & XAVC-I] inte väljas.

RAW
Output
Format

Tillgängliga inställningar kan
variera beroende på [Frequency]-
inställningar.

Se inställningarna ”[RAW
Output Format]” nedan.

–

Ställer in storleken på RAW-bild till utmatning
till en extern RAW-inspelare.

OBS!

När [Codec] är inställt på [RAW & XAVC-I],
växlar inställningen [Video Format] i länken
till inställningen [RAW Output Format].

Video
Format

Tillgängliga inställningar kan
variera beroende på
inställningarna för [Frequency],
[Imager Scan Mode] och [Codec].

Se inställningarna ”[Video
Format]” nedan.

– Ställer in bildstorleken.

Frequency Imager Scan Mode Codec Inställning

59.94 / 50 / 29.97 / 25 / 23.98 FF RAW / RAW & XAVC-I
4096×2160
3840×2160

24 FF RAW / RAW & XAVC-I 4096×2160
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Standardvärden visas i fetstilt.
Förhållanden under vilka [RAW Output Format] inte kan ställas in, har hoppats över.

Inställningarna [Video Format]

Standardvärden visas i fetstilt.
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Frequency Imager Scan Mode Codec Inställning

59.94 / 50 / 29.97 / 25 / 23.98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L
3840×2160P
1920×1080P 50
1920×1080P 35

S35

XAVC-I 1920×1080P

XAVC-L
1920×1080P 50
1920×1080P 35

24 FF
RAW –

RAW & XAVC-I/XAVC-I 4096×2160P
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Simul Rec

Ställer in inspelning samtidigt till 2-öppningar (se ”Inspelning till minneskort A och B samtidigt (2-öppningar Simul Rec)”).

Relaterade avsnitt

Inspelning till minneskort A och B samtidigt (2-öppningar Simul Rec)
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer den simultana inspelningsfunktionen till på/av och
ställer in inspelningens destinationsmedia.

Rec Button
Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B Visar tilldelning av inspelningsknapp för varje
inspelningsmedia.
Ställ in [Project] > [Simul Rec] > [Rec Button Set] i
kameramenyn.

2nd Rec
Button

Slot A / Slot B / Slot
A/Slot B

Slot A/Slot B
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Proxy Rec

Ställer in inställningar i läget proxy-inspelning (se ”Proxyinspelning”).
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer läget proxy-inspelning till på/av.
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Interval Rec

Ställer in inställningar i läget inspelningsintervaller (se ”Spela in video växelvis (Interval Rec)”).

Relaterade avsnitt
Spela in video växelvis (Interval Rec)
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off
Ställer läget inspelningsintervaller till
på/av. (Om du ställer detta läge till On
ställs alla andra speciallägen till Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (sec)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15
/ 20 / 30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (timme)

1

Ställer in intervallen mellan
inspelningar i inspelningsläget Interval
Rec (när Interval Rec är inställt till
On).

Number
of
Frames

1frame / 2frames / 3frames /
6frames / 9frames / 12frames
De tillgängliga inställningarna
varierar beroende på bildfrekvens
för valt videoformat.
59.94P/50P: 2frames / 6frames /
12frames
29.97P/25P/24P/23.98P: 1frame /
3frames / 6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Ställer in antalet bilder per inspelning i
inspelningsläget Interval Rec (när
Interval Rec är inställt till On).
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Picture Cache Rec

Ställer in inställningar i läget picture cache-inspelning (se ”Ta cachade bilder (Picture Cache Rec)”).

Relaterade avsnitt

Ta cachade bilder (Picture Cache Rec)
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer picture cache-funktionen till on/off.

Cache Size
Short / Medium /
Long / Max

Max
Ställer in tiden för ackumulering av bilder i bildcacheminnet
(inspelningstid för bildcache).

Cache Rec
Time

– –
Visar tiden för ackumulering av bilder i bildcacheminnet
(inspelningstid för bildcache).
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All File

Utför ALL-fil-användning (se ”Spara och ladda konfigurationsdata”).
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Load All
File

– –

Ladda en ALL-fil till enheten från enheten som kör Web App.

OBS!

När en ALL-fil laddas i enheten, då kommer enheten att startas
om. Efter att du startat om, ladda om sidan i webbläsaren.

Save All
File

– –
Spara enhetens inställningar och kör enheten som kör Web App
som en ALL-fil.
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Base Look

Du kan ladda ett grundutseende i enheten.
En lista med tillgängliga grundutseenden visas på skärmen. Det grundutseende som tillämpas indikeras med märkningen
● till vänster om grundutseendenummer.

[No.]: Grundutseendenummer
[Base Look Name]: Grundutseendenamn
[Input]: Ingångssignal grundutseende
[Output]: Utgångssignal grundutseende
[AE Level Offset]: Förskjutningsvärde för exponeringsreferensens grundutseende

Lägga till ett grundutseende
Tryck på knappen [Import] för att importera ett nytt grundutseende. Följ instruktionerna på skärmen.
Efter import ställer du in lämpliga värden för [Input], [Output] och [AE Level Offset]. För information, se ”Importera ett
önskat grundutseende.”

Relaterade avsnitt
Importera ett önskat grundutseende
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P/T Speed

Inställningarna relaterade till pan/tilt-hastighet.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Speed
Step

Normal /
Extended

Extended

Ställer in antalet hastighetssteg för pan/tilt-driften.
Normal: Hastigheten kan specificeras med hjälp av 24-
stegsräckvidd. Använd denna inställning för kompabilitet med
befintliga fjärrkameror från Sony.
Extended: Hastigheten kan specificeras med hjälp av 50-
stegsräckvidd.

Speed
Mode

Normal / Slow Normal

Ställer in hastighetsläget för pan/tilt-driften.
Aktiveras endast när [Speed Step] är inställt på [Normal].
Normal: Drivs i normal hastighetsintervall (minimum till maximum
(60 grader/sekund)).
Slow: Drivs i låg hastighetsintervall (minimum till maximum (40
grader/sekund)).
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P/T Acceleration

Inställningarna relaterade till pan/tilt-hastighet.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Acceleration 1 till 9 8
Väljer acceleration/retardation för pan/tilt-drift. Ju högre
siffra, desto högre acceleration.
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P/T Range Limit

Inställningarna relaterade till att begränsa räckvidd för pan/tilt-drift.
Ställ in gränser för räckvidd för pan/tilt-drift med följande skärm.

OBS!

När enheten är påslagen eller återställning av pan/tilt används, då ignoreras denna inställning för räckviddsbegränsning. Denna
funktion kan inte användas för att undvika hinder nära enheten.

Ställ brytaren [Setting] till läget On.

Funktion för räckviddsbegränsning av pan-tilt-funktionen aktiveras.

1

Kontrollera bilden med kamerans pan/tilt-kontroller.2

För att ställa in positionerna vid vilken driften begränsas, trycker du på knapparna [Left], [Right], [Up],
[Down] > [Set Current Value] i dessa positioner.

[Left]: Vänster sida av kameran
[Right]: Höger sida av kameran
[Up]: Kamerans översida

3
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OBS!

Kamerapositionerna utanför gränspositionerna kan inte sparas som en förinställning.

Om inställningen [Pan-Tilt] > [P/T Direction] > [Ceiling] ändras, återgår den konfigurerade inställningen för gränsposition till
fabriksstandard.

Inställningen kan inte ändras under uppspelning, under miniatyrbildsvisning, när ett pan/tilt-fel uppstår, när pan/tilt inte inleds och
när pan/tilt är låst.
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[Down]: Kamerans undersida

Gränspositionerna ställs in och visas som numeriska värden (vinkel).
För att avbryta en gräns, trycker du på knappen [Reset] för de enskilda positionerna.

Tryck på knappen [OK].

Pan/tilt-driften är begränsad till att stanna inom de konfigurerade gränspositionerna.

4
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P/T Direction

Inställningarna relaterade till pan/tilt-riktning.

OBS!

När en ändrad inställning för [Ceiling] tillämpas, raderas förändras förinställningspositioner eftersom pan/tilt-koordinaterna skulle
vändas om.

Pan/tilt-driftens räckvidd ändras enligt vad som visas i följande diagram beroende på inställningen för [Ceiling].

A: När [Ceiling] ställs in till [Off]
B: När [Ceiling] ställs in till [On]
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Ceiling On / Off Off
När enheten är monterad på ett skrivbord, ställ in på [Off]. När
enheten är monterad i ett tak, ställ in på [On]. När [Ceiling] är
inställt på [On], ställs [Pan Direction] automatiskt in på [Opposite].

Pan
Direction

Normal /
Opposite

Normal
Ställer in pan-driftsriktningen. När inställningen ändras, återställs
driftriktningen.

Tilt
Direction

Normal /
Opposite

Normal Ställer in tilt-driftsriktningen. När inställningen ändras, återställs
driftriktningen.
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P/T Preset

Ställer in inställningar relaterade till kamerans förinställningar.

Pan-Tilt
Ställer in hastigheten för förinställningar.

Default
Ställer in de standardvärden som konfigureras när en förinställningsposition sparas.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Pan-Tilt Speed
Setting Way

Separate /
Common

Separate
Ställer in huruvida förinställda hastigheter ska konfigureras
separat eller använda en gemensam inställning.

Pan-Tilt Speed
for Common

1 till 50 50

Ställer in gemensam hastighet för förinställningar.

OBS!

En maximal drifthastighet om 24 används om ett värde på
25 eller högre ställs in när [Pan-Tilt] > [P/T Speed] > [Speed
Step] ställs in till [Normal].

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Pan-Tilt Speed
for Separate

1 till 50 50
Ställer in hastigheten för förinställningar när metoden för
val av förinställningshastighet är inställd på [Separate].

Zoom Sync On / Off On
Anger om pan/tilt och zoom ska synkroniseras när en
förinställningsposition återställs.

Zoom Speed 0 till 32767 32767 Ställer in zoomhastighet.

Focus Recall On / Off On Ställer in ifall fokusinställningarna ska återställas.

MF Speed 0 till 32767 32767 Ställer in fokushastighet för manuell fokus.
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Output Format

Ställer in inställningar för utgångsformat.

Relaterade avsnitt
Utgångsformat och begränsningar
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

SDI För information om inställningar, se ”Utgångsformat
och begränsningar.”

– Ställer in upplösning för SDI- och
HDMI-utgång.HDMI –
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Output Display

Ställer in inställningar relaterade till utgångssignaler.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

SDI On / Off Off
Ställer in huruvida menyn och status är inbäddad i SDI-
utgångssignalen.

HDMI/Stream On / Off On

Ställer in huruvida menyn och status är inbäddad i HDMI-
utgångssignalen.

OBS!

Denna inställning tillämpas även för HDMI-
utgångsbildsignalen, strömningsutgångsbilden och bilden i
kamerans bildruta i Web App.
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Audio Input

Ställer in inställningar relaterade till ljudingången CH1 till CH4.

Ställer in master-ljudingångsnivå. Masterljudingångsnivån används för alla kanaler 1 till 4.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Level
Control

Auto / Manual Auto
Väljer automatisk eller manuell justering av
ljudingångsnivå.

Level 0 till 99 49 Ställer in ingångsnivå.

Input
Select

AUDIO IN CH1 / AUDIO IN
CH2 / Off

CH1 och CH3: AUDIO IN
CH1
CH2 och CH4: AUDIO IN
CH2

Ställer in ljudingångsnivå.

OBS!

CH1 är inställt på [AUDIO IN CH1] (fast).

Wind Filter On / Off Off
Stänger av filtret för vindbrusreducering till
on/off.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Master 0 till 99 99 Ställer in master-ingångsnivå.
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Audio Output

Ställer in inställningar relaterade till ljudutgång.

OBS!

Denna inställning tillämpas även för strömningsutgångsljud.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Ställer in kombinationen av ljudkanaler på
HDMI-/strömningsutgången.
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Tracking Data Output

Ställer in inställningar som är relaterade till spårningsinformation (free-d-protokoll-kompatibel).
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Transfer Mode
Off / Always / On
Demand

Off Väljer utmatningsmetod för spårningsinformation.

Camera ID 0 till 255 255 Ställer in enhetens ID.

Destination
Address

IPv4-adress –
När [Transfer Mode] är inställt på [Always] ställer du in
destinations-IP-adressen för spårningsinformation.

Destination
Port

1024 till 65534 40000 När [Transfer Mode] är inställt på [Always] ställer du in
numret för destinationsporten för spårningsinformation.

Listen Port 1024 till 65534 40000
När [Transfer Mode] är inställt på [On Demand] ställer du in
portnumret på enheten för att lyssna på begäran från
klienter.
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Tally

Ställer in inställningar för inspelningslampan (se ”Ansluta en tally-signal”).

Relaterade avsnitt

Ansluta en tally-signal

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Tally Lamp
Brightness

High / Low / Off High Ställer in ljusstyrkan för inspelningslampan.

G Tally Lamp Enable / Disable Enable Aktiverar/inaktiverar G-tallylampan.

Tally Control External / Internal Internal
Väljer målet för att acceptera kontrollinformation om
enhetens inspelningslampa.
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IR Remote

Ställer in inställningar relaterade till infraröd fjärrkontroll.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off On
Aktiverar/inaktiverar enhetens drift från den infraröda
fjärrkontrollen.
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RCP/MSU

Konfigurerar inställning när en RCP/MSU (tillval) är ansluten.
För detaljer, se ”Ansluta en RCP/MSU (tillval)”.

OBS!

Konfigurera inställningarna på RCP/MSU efter behov.

En MSU krävs för ett multikamerasystem.

När du använder flera MSU-enheter, ställ in en MSU-enhet som master och ställ in alla andra MSU-enheter som klienter.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

CNS Mode
Off / Bridge / MCS /
PC Control

Off Ställer in anslutningsläget för RCP/MSU.

Master IP
Address

IPv4-adress 0.0.0.0
Ställer in IP-adressen för huvudenheten när du bygger ett
LAN-baserat multikamerasystem.

Camera No. Camera No. (1 till 96) 1 Ställer in ett unikt kameranummer i systemet när man
bygger ett LAN-baserat multikamerasystem.
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Lens Controller

Ställer in inställningar för en ansluten linskontroll (tillval).
För information, se ”Ansluta en linskontroll.”

OBS!

När [Setting] ändras, startas enheten om. Ladda om sidan i webbläsaren.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer in om linskontrollen ska användas (tillval).

Mode 0 till 15 0

Ställer in driftläget för linskontrollen (tillval).
Värden i intervallet 0 till 15 finns tillgängliga, men de faktiska
värdena som kan väljas varierar beroende på linskontrollen (tillval).
Du finner mer information i linskontrollens bruksanvisning.

Reverse On / Off Off Vänder linskontrollens rotationsriktning (tillval).

Initialize – – Initierar linskontrollen (tillval).
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Camera Name

Ställer in inställningar relaterade till kameranamnet (enhetsnamnet).

Upp till åtta (0 till 8) av följande tecken kan anges för Camera Name.
Alfanumeriska tecken
Symboler (mellanslag !#$`*+-./;<=>?@[\]^_`{|})
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Camera Name – FR7 Ställer in kameranamnet.
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User

Ställer in inställningar relaterade till användaråtkomsten till enheten.

Inställningar relaterade till administratörsanvändare (Administrator) (krävs)

Inställningar relaterade till allmänna användare (User 1 till User 9) (valfritt)
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

User Name – admin Ställer in användarnamnet.

Current Password – –
När du ändrar lösenordet, ange då nuvarande
lösenord.

New Password – – Ange det nya lösenordet.

Re-Type
Password

– – Ange det nya lösenordet igen för att bekräfta.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

User Name – – Ställer in användarnamnet.

Current Password – –
När du ändrar lösenordet, ange då nuvarande
lösenord.

New Password – – Ange det nya lösenordet.

Re-Type
Password – – Ange det nya lösenordet igen för att bekräfta.
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Wired LAN

Status
Visar nätverksstatusen.

IPv4
Ställer in inställningar relaterade till IPv4-nätverket.

IPv6
Ställer in inställningar relaterade till IPv6-nätverket.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Host Name – – Visar värdnamnet.

MAC Address – – Visar enhetens MAC-adress.

Ethernet Status – – Visar aktuell kommunikationshastighet.

IP Address – – Visar enhetens IP-adress.

Subnet Mask – – Visar enhetens nätmask.

Gateway – – Visar enhetens standard IPv4 gateway.

Primary DNS Server – – Visar enhetens primära DNS-server.

Secondary DNS Server – – Visar enhetens sekundära DNS-server.

IPv6 Address 1 – – Visar enhetens IPv6-adress 1.

IPv6 Address 2 – – Visar enhetens IPv6-adress 2.

IPv6 Gateway – – Visar enhetens standard IPv6 gateway.

Link-local IPv6 Address – – Visar enhetens IPv6 länklokal-adress.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

DHCP On / Off On Ställer funktionen [DHCP] till on/off.

IP Address – – Ställer in IPv4-adressen när [DHCP] är inställd till Off.

Subnet
Mask

– – Ställer in undernätmask när [DHCP] är inställd till Off.

Gateway – –
Ställer in IPv4 default gateway när [DHCP] är inställd till
Off.
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Common
Ställer in gemensamma inställningar för IPv4/IPv6-nätverket.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Obtain an IP Address
Automatically

On / Off On Ställer in förvärv av IPv6-adress till on/off.

IP Address – –
Ställer in IPv6-adressen när [Obtain an IP Address
Automatically] är inställd till Off.

Prefix Length – –
Ställer in prefixet när [Obtain an IP Address
Automatically] är inställd till Off.

Gateway – – Ställer in IPv6 default gateway när [Obtain an IP
Address Automatically] är inställd till Off.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

HTTP Port 80, 1024 till 65534 80 Ställer in HTTP-portnummer.

DNS Auto On / Off On
Ställer in huruvida DNS-adresserna ska erhållas
från DHCP-servern.

Primary DNS
Server

IPv4/IPv6-adress –
Anger primär DNS-server när [DNS Auto] är inställd
till Off.

Secondary DNS
Server

IPv4/IPv6-adress –
Ställer in sekundär DNS-server när [DNS Auto] är
inställd till Off.
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File Transfer

Ställer in inställningar relaterade till filöverföringar.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Auto
Upload
(Proxy)

On / Off Off Ställer funktionen automatisk överföring till on/off.

Default
Upload
Server

Server Settings1
till 3 > Display
Name

Server Settings1

Väljer uppladdningsserver för filer. Den valda servern här blir
destination för automatisk uppladdning för proxy-filer och
uppladdningsdestination för filer från miniatyrskärmen.
Visar [Display Name] inställningarna för menyn [Server
Settings1 till 3].
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FTP Server 1 till 3

Ställer in inställningar relaterade till FTP-filöverföringar.
Inställningarna är gemensamma för FTP Server 1 till 3.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Display Name – –
Ställer in visningsnamnet som visas i
konfigurationsmenyn för överföringsdestination.

Service – – Visar servertyp.

Host Name – – Ställer in värdnamn för servern för överföringsdestination.

Port 21, 990, 1024 till
65534

21 Ställer in portnummer för servern för
överföringsdestination.

User Name – –
Ställer in användarnamn för autentisering av anslutning
till servern för överföringsdestination.

Password – –
Ställer in autentiseringslösenord för anslutning till servern
för överföringsdestination.

Passive Mode On / Off Off Ställer passivt läge till on/off.

Destination
Directory

– – Ställer in namnet för servern för överföringsdestination.

Using Secure
Protocol

On / Off Off
Ställer in om säker FTP-överföring ska (On) eller inte
(Off) ska användas.

Root Certificate – –

Laddar rotcertifikatet för säker FTP-överföring.
Tryck på knappen [Load] och välj ett rotcertifikat på
skärmen som visas.
Tryck på knappen [Delete] för att radera det laddade
rotcertifikatet.

Root Certificate
Status

– – Visar laddningsstatus för rotcertifikatet.

Reset – – Återställer [Server Settings] till fabriksinställningar.
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SSL

Ställer in inställningar relaterade till SSL.

SSL
Aktiverar/inaktiverar SSL-funktionen.

SSL Server Authentication
Ställer in inställningar relaterade till SSL-serverautentisering.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Function
Disable / Enable / Enable (Allow HTTP connection
for some clients)

Disable
Aktiverar/inaktiverar SSL-
funktionen.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Certificate
Options

Use a self-signed
certificate (For test use) /
Use an external certificate

–
Ställer in installationsmetod för SSL-
servercertifikat.

Status – –
Visar giltigheten för SSL-serverns certifikat när
[Certificate Options] är inställt till [Use a self-
signed certificate (For test use)].

Issuer DN – –
Visar det specifika namnet för föremålet för SSL-
servercertifikat när [Certificate Options] är inställt
på [Use a self-signed certificate (For test use)].

Subject DN – –
Visar det specifika namnet för föremålet för SSL-
servercertifikat när [Certificate Options] är inställt
till [Use a self-signed certificate (For test use)].

Available Period – –
Visar giltighetsperioden för SSL-serverns
certifikat när [Certificate Options] är inställt till
[Use a self-signed certificate (For test use)].

Extended Key
Usage

– –
Visar metoden för förbättrad nyckelanvändning
när [Certificate Options] är inställt till [Use a self-
signed certificate (For test use)].

Delete – –
Denna knapp visas när [Certificate Options] ställs
in till [Use a self-signed certificate (For test use)].
Raderar det installerade SSL-servercertifikatet.

Import – –
Installerar ett externt SSL-servercertifikat från en
lista när [Certificate Options] är inställt till [Use an
external certificate].
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Private Key
Password

– –

Ställer in lösenordet för information om den
privata nyckeln till SSL-servercertifikatet när
[Certificate Options] är inställt till [Use an external
certificate].

Reset – –
Denna knapp rensar visningen av lösenordet för
den privata nyckeln för att ange ett nytt lösenord.

Self-Signed
Certificate
Generation

– –

Tryck på [Generate] för att generera ett
självsignerat certifikat när [Certificate Options] är
inställt till [Use a self-signed certificate (For test
use)].
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Referer Check

Ställer in inställningar relaterade till Referer-kontroller.

Exception List
Ställer in inställningar relaterade till undantagslistan för Referer-kontroller.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off On Aktiverar/inaktiverar Referer-kontrollfunktionen.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

No. 1 till 10 – Ställer in undantagsnummer från listan.

Host
Name

– – Ställer in värdnamn för undantaget.

Port
Number

– – Ställer in portnumret för undantaget.

Set – – Tryck för att registrera konfigurerat undantag i undantagslistan.

Delete – –
Välj ett undantag som du vill ta bort och tryck på knappen för att
radera det registrerade undantaget från undantagslistan.
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Brute Force Attack Protection

Ställer in inställningar relaterade till förebyggande av brute force attack.

När en angripare detekteras, visas angriparens listinformation.
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Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Setting On / Off On Ställer funktionen [Brute Force Attack Protection] till on/off.

Count 3 till 100 8
Ställer in antalet försök som ska betraktas som en attack.
Aktiveras när [Setting] ställs in till On.

Release
Mode Always / Timer Timer

Ställer in frigöringsvillkor.
Aktiveras när [Setting] ställs in till On.
Always: Radera inte från listan med angripare.
Timer: Radera från listan med angripare efter frigöringstiden
när [Release Time] har gått ut.

Release
Time

30 till 86400 s 60

Ställer in frigöringstid.
Aktiveras när [Setting] ställs in till On.
När Release Mode är inställt på [Timer], raderas poster från
angriparlistan efter att frigöringstiden har gått ut.
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Stream

Ställer in strömningsinställningar (se ”Om strömning”).

Stream Setting
Ställer in inställningar relaterade till strömningsprotokoll.

OBS!

Om du vill använda RTMP ställer du in [Stream] > [Audio Stream] > [Setting] till [On] i förväg.

RTSP
Följande objekt visas när [Stream Setting] är inställt till [RTSP].
Ställer in inställningar relaterade till RTSP-strömning.

RTMP
Följande objekt visas när [Stream Setting] är inställt till [RTMP].
Ställer in inställningar relaterade till RTMP-strömning.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting RTSP / RTMP / SRT-Caller / SRT-Listener / NDI|HX / Off RTSP Väljer strömningsprotokoll.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Port Number 554, 1024 till 65534 554 Ställer in RTSP-portnummer.

Time Out 0 till 600 60
Ställer in timeout för kommandot Keep Alive för RTSP-
strömning.

Authentication On / Off On Ställer RTSP autentiseringsfunktionen till on/off.

Video Port
Number 1

1024 till 65534 51000 Ställer in portnummer för att sända video 1 för RTSP
unicast-strömning.

Video Port
Number 2

1024 till 65534 53000
Ställer in portnummer för att sända video 2 för RTSP
unicast-strömning.

Audio Port
Number

1024 till 65534 57000
Ställer in portnummer för att sända ljud för RTSP
unicast-strömning.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Server URL – –
Ställer in URL för anslutningsdestination för RTMP eller
RTMPS.
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SRT
Följande objekt visas när [Stream Setting] är inställt till [SRT-Caller] eller [SRT-Listener].
Ställer in inställningar relaterade till SRT-strömning.

NDI|HX
Följande objekt visas när [Stream Setting] är inställt till [NDI|HX].
Ställer in inställningar relaterade till NDI|HX.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Stream Key – –
Ställer in den strömnyckel som erhålls från RTMP-
serversidan.

Root
Certificate

– –

Läser in det rotcertifikat som krävs för anslutning till
RTMP-servern.
Tryck på knappen [Load] och välj ett rotcertifikat på
skärmen som visas.
Tryck på knappen [Delete] för att radera det laddade
rotcertifikatet.
Status visas i [Root Certificate Status].

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Destination – –
Ställer in URL för anslutningsdestination när enheten
körs som en anropare.

Port
Number

1024 till 65534 4201
Ställer in portnummer för lyssning när enheten körs
som en lyssnare.

Latency 20 till 8000 ms 120 Ställer in latensen.

TTL 1 till 255 64 Ställer in TTL-värdet.

Encryption Off / AES128 / AES256 Off
Aktiverar/inaktiverar kryptering och ställer in
krypteringsmetod.

Passphrase
0 eller sträng med 10 till
79 tecken

0
Ställer in lösenordsfras som används för kryptering.
Tryck på Reset för att rensa lösenordsfrasen.

ARC On / Off On Ställer in funtionen Adaptive Rate Control till on/off.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

License – – Visar installationsstatus för NDI-licensnyckeln.

Source Name – – Visar NDI-källnamn.

Group On / Off Off Ställer NDI-grupperingsfunktionen till on/off.

Group Name – –
Visar när NDI-grupperingsfunktionen är inställd till On.
Ställer in gruppnamnet.

Discovery
Server 1

– – Ställer in NDI identifieringsserver 1.
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Relaterade avsnitt

Om strömning

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Discovery
Server 2

– – Ställer in NDI identifieringsserver 2.

Multicast Mode On / Off Off Ställer multicast-strömning till on/off.

Multicast Prefix 239.255.0.0 239.255.0.0
Visas när [Multicast Mode] ställs in till On.
Ställer in det prefix som ska användas för multicast-
strömning.

Multicast
Netmask

255.255.0.0 255.255.0.0
Visas när [Multicast Mode] ställs in till On.
Ställer in nätmasken som fastställer intervall för
multicast-adress.

Multicast TTL 1 till 256 3
Visas när [Multicast Mode] ställs in till On.
Ställer in TTL-värdet för multicast-strömning.

Multi-TCP Mode On / Off Off Ställer Multi-TCP-läget till on/off.

Unicast UDP
Mode

On / Off On Ställer Unicast UDP-läget till on/off.

417



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Video Stream

Ställer in inställningar relaterade till video-codec.

Video Stream 1
Ställer in inställningar relaterade till video-codec 1.

Video Stream 2
Ställer in inställningar relaterade till video-codec 2.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Codec 1 H.264 / H.265 H.264 Ställer in codec för bild 1.

Size 1
4096×2160 / 3840×2160 / 2048×1080
/ 1920×1080 / 1280×720 / 640×360

1920×1080 Ställer in bildstorlek för bild 1.

Frame Rate 1

För information om bildfrekvenser
som stöds, se ”Ställa in video-
codec för strömning.”

– Ställer in bildfrekvens för bild 1.

I-Picture Mode 1 Time / Frame Time
Ställer in IDR-Frame för bild 1 som tid
eller antal bilder.

I-Picture Interval
1

1 / 2 / 3 / 4 / 5 s 1

Visas när [I-Picture Mode 1] ställs in
till Time.
Ställer in IDR-Frame införandeintervall
för H.264 och H.265 som tid.

I-Picture Ratio 1 15 till 300 bilder 30

Visas när [I-Picture Mode 1] ställs in
till Frame.
Ställer in IDR-Frame införandeintervall
för H.264 och H.265 som antal bilder.

Profile 1
H.264: high / main / baseline
H.265: main / main10

H.264: high Ställer in profil för H.264 eller H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Ställer in bithastighetkomprimering för
bild 1.

Bit Rate 1

512 / 768 / 1000 / 2000 / 3000 / 4000
/ 5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 /
80000 kbps

16000

Visas när [Bit Rate Compression
Mode 1] ställs in till On.
Ställer in målvärdet för bithastighet när
läget för bithastighetkomprimering är
inställt till CBR.

Quality 1 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Ställer in kvalitet för H.264 eller H.265.
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Video Stream 3
Ställer in inställningar relaterade till video-codec 3.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Codec 2 H.264 / H.265 / Off Off Ställer in codec för bild 2.

Size 2
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 / 1280×720
/ 640×360 / 512×270

1920×1080 Ställer in bildstorlek för bild 2.

Frame Rate 2

För information om bildfrekvenser
som stöds, se ”Ställa in video-
codec för strömning.”

–
Visas när [Codec 2] inte är inställt på
Off.
Ställer in bildfrekvens för bild 2.

I-Picture Mode
2

Time / Frame Time

Visas när [Codec 2] inte är inställt på
Off.
Ställer in IDR-Frame för bild 2 som tid
eller antal bilder.

I-Picture Interval
2

1 / 2 / 3 / 4 / 5 s 1

Visas när både [Codec 2] inte är inställt
på Off och [I-Picture Mode 2] är inställt
till [Time].
Ställer in IDR-Frame införandeintervall
för H.264 och H.265 som tid.

I-Picture Ratio 2 15 till 300 bilder 30

Visas när både [Codec 2] inte är inställt
på Off och [I-Picture Mode 2] är inställt
till [Frame].
Ställer in IDR-Frame införandeintervall
för H.264 och H.265 som antal bilder.

Profile 2
H.264: high / main / baseline
H.265: main

– Ställer in profil för H.264 eller H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Visas när [Codec 2] inte är inställt på
Off.
Ställer in bithastighetkomprimering för
bild 2.

Bit Rate 2

512 / 768 / 1000 / 2000 / 3000 / 4000
/ 5000 / 6000 / 7000 / 8000 / 16000 /
24000 / 32000 / 50000 / 64000 /
80000 kbps

8000

Visas när både [Codec 2] inte är inställt
på Off och [Bit Rate Compression
Mode 2] är inställt till [On].
Ställer in målvärdet för bithastighet när
läget för bithastighetkomprimering är
inställt till CBR.

Quality 2 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6

Visas när både [Codec 2] är inställt till
H.264 och [Bit Rate Compression
Mode 2] är inställt till Off.
Ställer in kvalitet för H.264 eller H.265.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Codec 3 JPEG JPEG
Ställer in codec för bild
3.
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Relaterade avsnitt

Ställa in video-codec för strömning
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Ställer in bildstorlek för
bild 3.

Frame
Rate 3

För information om bildfrekvenser som stöds, se ”Ställa
in video-codec för strömning.” –

Ställer in bildfrekvens
för bild 3.

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6 Ställer in kvaliteten.
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Audio Stream

Ställer in inställningar relaterade till ljud-codec.
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Objekt Inställning underobjekt Fabriksstandard Beskrivning

Setting On / Off Off Ställer ljudströmningsutgång till på/av.

Codec AAC (128kbps) / AAC (256kbps) AAC (128kbps)
Visas när [Setting] ställs in till On.
Ställer in ljud-codec för strömning.
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Language

Ställer in visningsspråk.

OBS!

Tillgängliga språk kan variera beroende på land eller region.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Language – – Ställer in visningsspråk.
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Accessibility

Ställer in inställningar relaterade till ljudavläsning (text till tal).

OBS!

Denna funktion är endast tillgänglig för modeller som säljs i Nordamerika. Skärmläsarfunktionen kan endast användas när
språket är inställt på engelska (per publiceringsdatum).

Aktiverar skärmläsarfunktionen i webbläsaren på enheten med Web App.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Screen
Reader

On / Off Off 
Ställer kamerabildrutans skärmläsarfunktion i
Web App till on/off.

Speech
Rate

Slow2 / Slow1 / Normal / Fast1 /
Fast2 / Fast3 / Fast4

Normal

Ställer in hastigheten för
skärmläsarfunktionen.
Ett testutdrag läses upp högt i den
konfigurerade hastigheten.

Speech
Volume

1 till 15 7

Ställer in volymen för skärmläsarfunktionen i
Web App.
Ett testutdrag läses upp högt i den
konfigurerade volymen.
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Clock Set

Ställer in interna klockinställningar.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Current Date
& Time

– –
Visar den aktuella tiden som är konfigurerad
på enheten.

PC Clock – –
Visar den aktuella tiden på surfplattan eller
datorn som används för konfiguration.

Date & Time
Format

yyyy-mm-dd hh:mm:ss / mm-dd-
yyyy hh:mm:ss / dd-mm-yyyy
hh:mm:ss

yyyy-mm-dd Väljer visningsformat för datum och tid.

12 h / 24 h 12 h / 24 h 24 h
Ställer in tiden till visningsformatet 12/24
timmar.

Time Setting
Keep current setting / Synchronize
with PC / Manual setting /
Synchronize with NTP

– Väljer konfigurationsmetod för datum och tid.

yy-mm-dd
hh:mm:ss

yy: 19 till 37
mm: 01 till 12
dd: 01 till 31
hh: 00 till 23
mm: 00 till 59
ss: 00 till 59 (sekunder)

–
Visas när [Time Setting] ställs in till Manual
setting.
Ställer in datum och tid manuellt.

NTP Auto On / Off Off

Visas när [Time Setting] ställs in till
Synchronize with NTP.
Ställer in huruvida NTP serverns IP-adress
ska erhållas från DHCP-servern.

NTP Server IPv4/IPv6-adress eller värdnamn –

Visas när både [Time Setting] är inställt till
[Synchronize with NTP] och [NTP Auto] är
inställt till Off.
Specificerar NTP-servern som används för
tidssynkronisering.

Time Zone UTC − 12:00 till UTC + 14:00 – Välj tidszon.
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Reset

Startar enheten.

Reboot
Startar om enheten.

Reset
Återställer enhetens inställningar.

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Reboot Execute –

Startar om enheten.
Execute: Utför funktionen.

OBS!

Efter att du startat om, ladda om sidan i webbläsaren.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

All Reset (except for
Network Settings)

Execute –

Återställer enhetens inställningar (exklusive
nätverksinställningar).
Execute: Utför funktionen.

OBS!

Importerade grundutseenden och LUT-filer raderas
inte.

Network Reset Execute –

Återställer enhetens nätverksinställningar.
Execute: Utför funktionen.

OBS!

Efter Network Reset, startas enheten om. Efter att
du startat om, ladda om sidan i webbläsaren.

Factory Default Execute –

Återställer enhetens inställningar till fabriksläge.
Execute: Utför funktionen.

OBS!

Efter Factory Default, startas enheten om. Efter att
du startat om, ladda om sidan i webbläsaren.
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Information

Visar kamera- och linsinformation. Används även till att uppdatera programvara.

Camera
Visar kamerainformation och uppdaterar programvara.

Lens
Visar linsinformation och uppdaterar programvara.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Model
Name

– – Visar kamerans modellnamn.

Serial
Number

– – Visar kamerans serienummer.

Version
Number – – Visar kamerans programvaruversion.

Version Up – –

Tryck på knappen [Choose File] och följ instruktionerna på
skärmen för att uppdatera kamerans programvara.

OBS!

Efter uppdatering startas enheten om. Efter att du startat om,
ladda om sidan i webbläsaren.

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Model
Name

– – Visar linsens modellnamn.

Serial
Number

– – Visar linsens serienummer.

Version
Number

– – Visar linsens programvaruversion.
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Relaterade avsnitt

Uppdatera programvara för E-monterad lins

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

Version Up – –

Tryck på knappen [Choose File] och följ instruktionerna på
skärmen för att uppdatera linsens programvara.

För information, se ”Uppdatera programvara för E-
monterad lins.”

OBS!

Efter uppdatering av linsen startas enheten om. Efter att du
startat om, ladda om sidan i webbläsaren.
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System Log

Ställer in inställningar relaterade till System Log.

Den förvärvade loggen visas så som nedan.

Relaterade avsnitt

Uppdatera programvara för E-monterad lins

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Ställer in nivån för att lägga till en inspelning till
systemloggen.

Log Size 200 till 1024 1024
Ställer in storleken på loggen som ska sparas i
systemloggen.

Download
as File

– –
Tryck på knappen [Download] och spara
systemloggen till en surfplatta eller dator från den
visade skärmen.
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HTTP Access Log

Ställer in inställningar relaterade till HTTP Access Log.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning underobjekt Fabriksstandard Beskrivning

Log Level
Critical, Warning & Info /
Critical & Warning / Critical

Critical, Warning &
Info

Ställer in nivån för att lägga till en inspelning till
HTTP-åtkomstloggen.

Log Size 200 till 1024 1024
Ställer in storleken på loggen som ska sparas i
HTTP-åtkomstloggen.

Download
as File

– –
Tryck på knappen [Download] och spara HTTP-
åtkomstloggen till en surfplatta eller dator från den
visade skärmen.
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Service

Erhåll enhetsinformation om enheten. Använd när du kontaktar din Sony-servicerepresentant.

5-041-958-63(1) Copyright 2022 Sony Corporation

Objekt Inställning
underobjekt Fabriksstandard Beskrivning

I agree to download
device information.

– –

Markera här för att samtycka till att erhålla
enhetsinformation och tryck på knappen [OK].
Tryck på knappen[Download] som visas. Webbläsaren
laddar tillfälligt ned en fil kallad deviceinformation.dat.

OBS!

Efter nedladdning startas enheten om. Starta om
manuellt om enheten inte startar om automatiskt. Efter
att du startat om, ladda om sidan i webbläsaren.

431



Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

EULA

Visar licensavtal för slutanvändare (EULA).

5-041-958-63(1) Copyright 2022 Sony Corporation
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Software

Visa programvarulicens.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Ansluta externa monitorer och inspelningsenheter

För att visa inspelade eller spela upp bilder på en extern monitor ska du ställa in videoutgångstyp för den externa
monitorn och använda en lämplig kabel för att ansluta monitorn.
Du kan även ansluta en extern inspelningsenhet och spela in utsignalen från enheten.
Du kan visa samma information som är synlig i kamerans bildruta, som statusinformation och menyer, på en extern
monitor. Ställ in systemtyp för skärmen till On med hjälp av [Monitoring] > [Output Display] i web-menyn.

OBS!

Om en monitor ansluten till HDMI-kontakten inte stöder det HDMI-utgångsformat som konfigurerats med [Monitoring]-menyn i
web-menyn eller kameramenyn, då kommer kamerabilden inte att gå ut till Web App. Inte heller kan strömningsvideo fungera som
utgång.

Du kan ställa in både [Output Display] > [SDI] och [HDMI/Stream] till [Off], men det kommer förhindra användning av
kameramenyn och funktionerna som beror på skärmen. Därtill kommer enhetens felmeddelanden begränsas till enhetens lampor
(tänd eller blinkar) och visningen av notifieringsmärket högst upp till höger på Web App. För att se den detaljerade statusen, ställ
in [Output Display] till [On].

Tips

[Output Display] > [SDI] ställs in till [Off] och [HDMI/Stream] ställs in som [On] som fabriksstandard. För att använda strömning
som huvudvideo, ställ in [SDI] till [On] och [HDMI/Stream] till [Off], och övervaka kamerastatusen på en SDI-monitor.

SDI OUT-kontakt (BNC-typ)

Ställ in utgångsformatet med hjälp av [Monitoring] i web- eller kameramenyn.
Använd en vanlig 75 Ω koaxialkabel för anslutningen.

OBS!

Kontrollera att anslutningen mellan enheten och den externa enheten är jordad innan du startar enheten.

Det rekommenderas att enheten och den externa enheten startas efter anslutning av 75 Ω koaxialkabeln.
Om den externa enheten måste anslutas till enheten medan den är på, anslut då 75 Ω koaxialkabeln till den externa
enheten först och därefter ansluter du den till enheten.

Starta inspelning på enheten och den externa enheten samtidigt
Med SDI-utsignal aktiverat, ställer du in [Project] > [SDI/HDMI Rec Control] > [Setting] till [SDI/HDMI Remote I/F] eller
[Parallel Rec] i kameramenyn för att göra det möjligt med en utgående REC-triggersignal till den externa enheten
ansluten till SDI OUT-kontakten. Detta kommer att synkronisera inspelningen på den externa enheten med enheten.

OBS!

Om en ansluten extern enhet inte stöder en REC-triggersignal går det inte att använda enheten.

När [Project] > [SDI/HDMI Rec Control] > [Setting] är inställt in [SDI/HDMI Remote I/F] i kameramenyn, endast REC-
utlösningssignal går ut när det inte finns något inspelningsmedia insatt och START/STOP-inspelningsknappen används.

HDMI OUT-kontakt (Type A-kontakt)

Ställ in utgången On/Off-inställning och utgångsformat i [Monitoring]-menyn i kameramenyn.
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Starta inspelning på enheten och den externa enheten samtidigt
Med HDMI-utsignal aktiverat, ställer du in [TC/Media] > [HDMI TC Out] > [Setting] till [On] och [Project] > [SDI/HDMI Rec
Control] > [Setting] till [SDI/HDMI Remote I/F] eller [Parallel Rec] i kameramenyn för att göra det möjligt med en utgående
REC-triggersignal till den externa enheten ansluten till HDMI OUT-kontakten. Detta kommer att synkronisera
inspelningen på den externa enheten med enheten.

OBS!

Om en ansluten extern enhet inte stöder en REC-triggersignal går det inte att använda enheten.

När [Project] > [SDI/HDMI Rec Control] > [Setting] är inställt in [SDI/HDMI Remote I/F] i kameramenyn, endast REC-
utlösningssignal går ut när det inte finns något inspelningsmedia insatt och START/STOP-inspelningsknappen används.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Ansluta med en RCP/MSU

Vissa av enhetens funktioner kan fjärrstyras genom att ansluta en fjärrkontrollpanel (RCP) som RCP-3500/3501 eller en
huvudinställningsenhet (MSU) som MSU-3500 till enheten via en LAN-kabel.
Anslutningsmetoden kommer att variera beroende på konfigurationen av relaterade enheter och applikationen.

För detaljer om en en-till-en-anslutning mellan enheten och en RCP, se ”En-till-en-anslutning mellan enheten och en
RCP”.
För mer information om hur du ansluter flera kameror med en MSU eller programvara för kamerakontroll, se
”Använda enheten i en multikameramiljö med en MSU/kamerans fjärrkontrollprogramvara”.

Relaterade avsnitt

En-till-en-anslutning mellan enheten och en RCP

Använda enheten i en multikameramiljö med en MSU/kamerans fjärrkontrollprogramvara

5-041-958-63(1) Copyright 2022 Sony Corporation
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En-till-en-anslutning mellan enheten och en RCP

OBS!

Se ”Lista över funktioner som stöds” och konfigurera enheten så att den uppfyller driftsvillkoren för de funktioner du vill använda,
aktivera sedan anslutningen med en RCP med hjälp av följande procedur.

Relaterade avsnitt
Lista över funktioner som stöds
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Slå på varje enhet.1

Ställ in [Technical] > [RCP/MSU] > [CNS Mode] till [Bridge] i web- meny till kameran.2

Konfigurera följande inställningar på RCP.

Du finner mer information om konfiguration i bruksanvisningen för RCP.

3

Ställ in anslutningsläget till Bridge-läge.1.
Registrera kamerans IP-adress.2.
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Använda enheten i en multikameramiljö med en MSU/kamerans
fjärrkontrollprogramvara

Du kan ansluta flera kameror med en MSU eller programvara för kamerafjärrkontroll.

OBS!

Se ”Lista över funktioner som stöds” och konfigurera enheten så att den uppfyller driftsvillkoren för de funktioner du vill använda,
aktivera sedan anslutningen med en MSU eller kamerans fjärrkontrollprogramvara med hjälp av följande procedur.

Relaterade avsnitt
Lista över funktioner som stöds
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Slå på varje enhet.1

Konfigurera systemets nätverksinställningar med hjälp av MSU eller kamerans fjärrkontrollprogramvara.

För detaljer om konfiguration, se bruksanvisningen för MSU eller kamerans fjärrkontrollprogramvara.

2

Konfigurera följande inställningar med [Technical] > [RCP/MSU] i web-menyn till kameran.3

Om du använder en MSU, ställ in [CNS Mode] till [MCS]. Om du använder programvara för kamerafjärrkontroll,
ställ in [CNS Mode] till [PC Control].

1.

Ställ in IP-adressen för master-MSU eller programvara för kamerafjärrkontroll i [Master IP Address].2.
Ställ in det kameranummer som kameran ska registreras för i [Camera No.].3.
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Lista över funktioner som stöds

Följande tabell visar funktioner som stöds och deras motsvarande driftsförhållanden.

Driftspanel Enhetens funktioner Driftsförhållanden

IRIS Justera bländaren manuellt –

AUTO IRIS Växla Auto Iris på/av –

ND
Växla ND-filtrets förinställda position (Clear/Preset1
till Preset3)

Funktionen aktiveras när [Shooting] > [ND
Filter] > [Mode] är inställt till [Preset] i
kameramenyn.

MASTER
GAIN

Justera gain manuellt (3 dB enheter)
Aktiverad när filmningsläget är ställt på läget
Custom och [Shooting] > [ISO/Gain/EI] >
[Mode] är inställt till [dB] i kameramenyn.

WHITE (R/B) Justera vitbalansen (R Gain/B Gain) manuellt

Aktiveras när [White Mode] ställs in till [Memory
A(R/B)] eller [Memory A(T/T)].WHITE

(Color Temp)

Justera vitbalansen (färgtemperatur/ton) manuellt

RCP – [Color Temp]: Färgtemperatur för
vitbalans
RCP – [Balance]: Tonvärde för vitbalans

ATW Ställer funktionen ATW (Automatisk spårning av
vitbalans) till på/av

Aktiverad när fotograferingsläget är ställt på
läget Custom.

BLACK R/B Justera svartbalansen
Aktiverad när fotograferingsläget är ställt på
läget Custom.
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OBS!

Konfigurera enheten så att den uppfyller driftsvillkoren för de funktioner du vill använda och aktivera sedan anslutningen med en
RCP/MSU. Om driftsförhållandena justeras efter att anslutningen har aktiverats kan oavsiktligt beteende inträffa.
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Driftspanel Enhetens funktioner Driftsförhållanden

MASTER
BLACK

Justera in masternivå för svart

Aktiverad när fotograferingsläget är ställt på
läget Custom.
H/V Ratio och Crispening är aktiverat när
[Paint/Look] > [Detail] > [Manual Setting] är
inställt på [On] i kameramenyn.

DETAIL

Växla detaljfunktionen till på/av
Ställa in detaljnivån
Ställa in H/V Ratio
Ställa in Crispening

User Matrix

Växla användarmatriskorrigeringsfunktionen till
på/av
Ställa in korrigeringsvärden för matrisen (R-G/R-
B/G-R/G-B/B-R/B-G)

Multi Matrix

Växla multi-matriskorrigeringsfunktionen till
på/av
Ställa in färgnyans och mättnad för multi-
matriskorrigering

Knee
Slå på/av knee-korrigeringsfunktionen
Slå på/av den automatiska knee-funktionen
Ställa in knee-punkten och knee-lutningen

BARS Växla funktionen färgstapel till på/av

SHUTTER

Växla slutarfunktionen till på/av
Ställa in värdet för slutarhastighet
(Slå på/av automatisk slutare, ställa in
slutarvinkel, ställa in lång slutare, ställa in ECS
stöds inte.)

OBS!

RCP-slutarinställningarna kanske inte visas
beroende på det konfigurerade
slutarhastighetsvärdet.

Inställningarna för RCP-slutaren kanske inte
visas korrekt om slutaren inte kan styras från
RCP.

När automatiska slutare är på fortsätter den
automatiska slutaren att fungera även om du
slår på/av slutaren eller ändrar värdet för
slutarhastighet från RCP.
När slutaren är inställd på [Angle] kan du inte
slå på/av slutaren eller ändra inställningen för
slutarhastighet från RCP.
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Om användning med en RM-IP500-fjärrkontroll (tillval)

Du kan använda enheten med en programvaruversion 2.2 eller senare för Sony RM-IP500-fjärrkontrollen. Enheterna
kommunicerar med hjälp av VISCA over IP (LAN).
Beroende på målobjekt kanske du behöver visa enhetens skärm. Förbered en monitor som kan användas för att
kontrollera skärmen.
Följande åtgärder stöds från en RM-IP500-fjärrkontroll.

Välj målkameran
Justera bildinramningen (pan, tilt, zoom)
Justera fokuset (exkluderar pekfunktionen)
Registrera och återkalla förinställningspositioner
Använda enhetens meny (exkluderar webbmenyn)
Justera ljusstyrkan
Justera vitbalansen
Justera svartbalansen
Justera ljudingångsnivån
Starta/stoppa inspelning
Utföra enhetens tilldelningsbara knappfunktioner

Du finner mer information om att använda RM-IP500 i bruksanvisningen för RM-IP500.

Tips

När du använder en RM-IP500, använd då panelen för den enhet som medföljer RM-IP500.

RM-IP500 (använda panelen för denna enhet)
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Ansluta en RM-IP500-fjärrkontroll

Du finner mer information om att tilldela funktioner i bruksanvisningen för RM-IP500.
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Ställ enhetens SETUP-brytare 3 till läget ON för att aktivera VISCA over IP-kommunikation.

OBS!

Brytarinställningen tillämpas när nästa enhet slås på.

1

Anslut RM-IP500 till samma nätverk som enheten.2

Följ processen i bruksanvisningen till RM-IP500 för att konfigurera VISCA over IP (LAN) anslutningen till
RM-IP500.

Tilldela denna enhet med hjälp av RM-meny > AUTO IP SETUP > ASSIGN CAM.

3

Tilldela denna enhets funktioner till knappar och vred, enligt behov, med hjälp av följande RM menyobjekt i
RM-IP500.

SW ASSIGN
AE CONFIG2
WB MODE

4
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Om att synkronisera med en extern enhet

När man filmar med flera olika enheter kan enheterna synkroniseras till en specifik referenssignal eller tidskod via
enheternas GENLOCK-kontakt.

För information om genlock, se ”Synkronisera videosignalens fas (Genlock).”
För information om tidskoder, se ”Låsa tidskoden till andra enheter.”

Relaterade avsnitt
Synkronisera videosignalens fas (Genlock)

Låsa tidskoden till andra enheter
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Synkronisera videosignalens fas (Genlock)

Du kan mata in en referenssignal till GENLOCK-kontakten för att aktivera genlock.
Ingångsreferenssignalerna som kan användas varierar beroende på systemfrekvens för valt inspelningsformat.

Du kan kontrollera den externa synkroniseringsstatusen med hjälp av [Technical] > [Genlock] > [Reference] i
kameramenyn.

OBS!

Om referenssignalen inte är stabil, kan inte genlock uppnås.

Bärvågen synkroniseras inte.
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Systemfrekvens för inspelningsformat Ingångsreferenssignaler som stöds

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P
1920×1080 24PsF
1920×1080 24P

23.98P
1920×1080 23,98PsF
1920×1080 23,98P

59.94i
1920×1080 59.94i
720×486 59.94i

50i
1920×1080 50i
720×576 50i
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Låsa tidskoden till andra enheter

Ställ in enheten som står för tidskoden till ett läge i vilken tidskoden som går ut fortsätter köras (till exempel Free Run
eller Clock).

OBS!

Kontrollera att den inmatade referenstidskoden och referensvideosignalen har en fasrelation som efterlever tidskodstandarden
SMPTE.

Vid användning med det externa låset, låses tidskoden omgående med den externa tidskoden och det externa tidskodsvärdet
visas i tidsdatavisningsområdet. Men börja inte spela in omgående. Vänta några sekunder tills tidskodsgeneratorn stabiliseras
före inspelning.

Om frekvensen för referensvideosignalen och bildfrekvensen i enheten inte är samma, då går det inte att låsa och enheten
kommer inte fungera som den ska. Om detta inträffar kommer tidskoden inte låsas ordentligt med den externa tidskoden.

Om den externa tidskodskällan kopplas bort, då kan tidskoden växla från en bild per timme avseende referenstidskoden.

Frigöra externt lås
Ändra inställningen [TC/Media] > [Timecode] i kameramenyn.
Extern synkronisering sker också om systemfrekvensen förändras och när du startar inspelningen i ett
specialinspelningsläge (Slow & Quick Motion eller Interval Rec).

5-041-958-63(1) Copyright 2022 Sony Corporation

Ställ in följande i [TC/Media] > [Timecode] i kameramenyn.

Ställ [Mode] till [Preset].
Ställ [Run] till [Free Run].

1

Tryck på den tilldelningsbara knappen tilldelad med funktionen [DURATION/TC/U-BIT] för att visa tidskoden
på skärmen.

2

Mata in en HD- eller SD-referensvideosignal till GENLOCK-kontakten och referenstidskoden till TC IN-
kontakten.

Enhetens tidskodsskapare låser referenstidskoden och ”EXT-LK” visas på skärmen.
När cirka tio sekunder har gått efter tidskodens lås, behålls den externa låsstatusen även om den externa
referenstidskodskällan kopplas bort.

3
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Ansluta en extern mikrofon eller extern ljudenhet

Du kan mata in signalen från en extern mikrofon eller extern enhet och bädda in ljudet i enhetens inspelade video eller
utgångsvideo.

Ansluta en extern mikrofon eller extern ljudenhet med hjälp av en XLR-kabel.

När ljudet är inställt på [LINE] med hjälp av [Audio] > [Audio Input] > [AUDIO IN Select] i kameramenyn, fungerar
AUDIO IN-kontakten som AUDIO IN CH-1-kontakten och AUDIO IN CH-2-kontakten.

1

Stiftnr. Funktion

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Stäng av enheten och anslut XLR-kabeln till AUDIO IN-kontakten.2

Konfigurera SETUP-brytare 2 för att aktivera fantommatning enligt behov.

Slå på strömförsörjningen på +48 V (fantommatning) enligt beskrivningen nedan.
Brytare 2
Ställer in huruvida +48 V strömförsörjningen (fantommatningen) är på eller av när en ljudingångsenhet ansluts.

3

Inställning Beskrivning

OFF
(standard)

Detta stänger av fantommatningen på +48 V och ställer LINE- eller MIC-ingången till ljudkälla
CH-1 och CH-2.
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OBS!

Om man ställer denna brytare på ON och ansluter en mikrofon som inte är kompatibel med en källa på +48 V kan det skada
den anslutna enheten. Kontrollera inställningen innan du ansluter enheten.

Inställning Beskrivning

ON
Detta stänger av fantommatningen på +48 V och ställer in mikrofonen kompatibel med
fantommatning till ljudkälla CH-1 och CH-2.

Slå på enheten och ställ in typen av ansluten enheten med hjälp av [Audio] > [Audio Input] > [AUDIO IN
Select] i kameramenyn.

4
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Hantera/redigera videoklipp med en dator

Du kan hantera/redigera klipp med hjälp av en dator.

Importera klipp med en kortläsare (tillval)

Anslut en CFexpress Type A-kortläsare eller SD-kortläsare till din dator och använd programvara som stöder denna
enhets inspelningsformat, till exempel Catalyst Browse, för att importera videoklipp.

Använda icke-linjära redigeringssystem

I ett icke-linjärt redigeringssystem, krävs det ett redigeringsprogram (tillval) som stöder de format som enheten spelar in.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Utgång för en optisk fibersignal

Du kan mata ut en SDI-signal konverterad till en optisk signal genom att ansluta en SFP+-modul (tillval) till enhetens
OPTICAL-kontakt. Använd en SFP+-modul som matchar signalbandet för varje format.
Signalband

4K (59.94p, 50p): 12G
4K (annat än 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (annat än 59.94p, 50p): 1.5G

OBS!

Använd en modul som efterlever följande standarder.

SFF-standarder
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

SDI-standarder
ST297/ST292/ST424/ST425/ST2081/ST2082

Samma signal som SDI-utgångskontakten matas ut till SFP+-modulen.

Enheten stöder inte optisk fibersignalinmatning.

Använd en SFP+-modul för optisk fibersignalingång. För mer information om verifierade SFP+-moduler, kontakta din
återförsäljare eller Sony-servicerepresentant.

5-041-958-63(1) Copyright 2022 Sony Corporation

* Power Level I (1,0 W)
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Ansluta en tally-signal

Detta ämne beskriver tally-signalkontroll.

Tända tally-lampan med en signal från en fjärrkontroll

Du kan tända tally-lampan med hjälp av ett VISCA over IP-kommando från en extern enhet såsom RM-IP500.
Ställ in [Technical] > [Tally] > [Tally Control] till [External] i web- eller kameramenyn.

Tänd tally-lampan från en extern enhet

Du kan tända enhetens tally-lampa i rött eller grönt från en extern enhet såsom RM-IP500 eller en brytare. Du kan
kontrollera tallyn med kommandon som sänds över nätverket eller med en tally-signalingång på enhetens OPTION-
kontakt.
Ställ in [Technical] > [Tally] > [Tally Control] till [External] i web- eller kameramenyn.
När du matar in en tally-signal i OPTION-kontakten, kortslutningsstift 7 till GND (antingen stift 4 eller 5) för att tally-
lampan ska lysa grönt eller stift 8 till GND (antingen stift 4 eller 5) för att tally-lampan ska lysa rött.

OBS!

När [Tally Control] är inställt till [External], indikeras inte enhetens inspelningsstatus av tally-lampan.

När en röd tally och grön tally matas in samtidigt tänds enhetens tally-lampa i rött.

Specifikationer OPTION-kontaktstift

Stiftnr. Signalriktning Signalspecifikationer

1 – RS-232C TX-signal (för linskontroll)

2 – RS-232C RX-signal (för linskontroll)

3 OUT

Utgång grön Tally-lampa
Lågnivåutgång när grön Tally-lampan är tänd.
Lågnivåutgång (open-drain-utgång) när grön Tally-lampan inte är tänd.

4 – GND (jord)

5 – GND (jord)
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Tända en extern enhets tally-lampa med en signal från enheten

Du kan tända en extern enhets tally-lampa med en signal från enheten genom att ansluta stift 3 och stift 6 till OPTION-
kontakten så som visat nedan.
OPTION-kontaktstiften 3 och 6 till exempel

OBS!

Applicera inte spänning på stiften 7 och 8.

Anslut inte en extern enhet som kan applicera spänning på OPTION-kontakten.

Om en tillströmning eller backspänning som överskrider märkspänning tillämpas på stift 3 eller 6, kan det orsaka fel, rök eller
brand.

Ställ in utgångssignalen med hjälp av [Technical] > [Tally] > [Tally Control] i web- eller kameramenyn.
[Internal]: Enhetens pågående inspelningsstatus
[External]: Logisk OCH för röda/gröna tally-signaler som enheten tar emot via IN-signalen och fjärrkontrollerna.

5-041-958-63(1) Copyright 2022 Sony Corporation

Stiftnr. Signalriktning Signalspecifikationer

6 OUT

Utgång röd Tally-lampa
Lågnivåutgång när röd Tally-lampan är tänd.
Hi-Z (open-drain-utgång) när röd Tally-lampan inte är tänd.

7 IN
Grön Tally extern kontrollingång
Kortslutning till jord (stift 4 eller 5) får enhetens tally-lampa att tändas i grönt.

8 IN
Röd Tally extern kontrollingång
Kortslutning till jord (stift 4 eller 5) får enhetens tally-lampa att tändas i rött.
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Mata ut spårningsdata (free-d)

Enheten kan mata ut panorering/lutning/zoominformation, fokus- och bländarspårningsinformation synkroniserad med en
synkroniseringssignal.
Datautmatningen överensstämmer med free-d-protokollet, en branschstandard. Du kan välja utmatningsmetod mellan
konstant utmatning och utmatning på begäran från klienter. Välj utmatningsmetod enligt ditt VR/AR-system.

Datautmatningsformat

Tips

Tekniska detaljer finns i ”Integrationshandbok för free-d.” Kontakta en Sony-återförsäljare.

Spårningsdata som matas ut av enheten omfattar följande data enligt det format som anges i Type D0/D1 i free-d-
protokollet.
Type D0 – poll/command

Kontrollera att enheten är påslagen.1

Ställ in utmatningsmetod för spårningsdata.

För konstant utmaning

För utmatning på begäran från klienter

2

Ställ in [Technical] > [Tracking Data Output] > [Transfer Mode] till [Always] i web-menyn.1.
Ställ in enhetens ID i [Camera ID].2.
Ange IP-adressen för utmatningsdestinationen i [Destination Address].3.
Ange portnumret för utmatningsdestinationen i [Destination Port].4.
Tryck på knappen [OK].5.

Ställ in [Technical] > [Tracking Data Output] > [Transfer Mode] till [On Demand] i web-menyn.1.
Ställ in enhetens ID i [Camera ID].2.
Ange portnumret för att lyssna på begäran från klienter i [Listen Port].3.
Tryck på knappen [OK].4.

Symbol Innehåll Beskrivning

<D0> Message type

<CA> Camera ID

<CD> command

Stöder följande kommandon:

00 Stop stream mode
01 Start stream mode

<CK> Checksum
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Type D1 – camera position/orientation data

OBS!

Spårningsdata kan fördröjas eller värden kanske inte uppdateras i följande situationer:

När du matar ut RAW-video
När S&Q Motion är på
När kameramenyn visas
När miniatyrbildskärmen visas
När du spelar upp inspelade videoklipp
När web-menyn visas

5-041-958-63(1) Copyright 2022 Sony Corporation

Symbol Innehåll Beskrivning

<D1> Message type

<CA> Camera ID

<PH><PM><PL> Camera Pan Angle Pan-vinkel (−170° till +170°)

<TH><TM><TL> Camera Tilt Angle Tiltvinkel (−30° till +195°)

<RH><RM><TL> Camera Roll Angle Stöds inte (alltid 0)

<XH><XM><XL> Camera X-Position Stöds inte (alltid 0)

<YH><YM><YL> Camera Y-Position Stöds inte (alltid 0)

<HH><HM><HL> Camera Height Stöds inte (alltid 0)

<ZH><ZM><ZL> Camera Zoom Fokallängd

<FH><FM><FL> Camera Focus Fokusavstånd

<SH><SL> Spare/User Defined Bländarposition

<CK> Checksum
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Ansluta en linskontroll

Du kan använda zoomen på en manuell zoomlins från Web App, RM-IP500 (tillval) eller den infraröda fjärrkontrollen
genom att ansluta en kommersiellt tillgänglig linskontroll (tillval) som är kompatibel med den här enheten.
Du finner mer information om att ansluta en linskontroll i bruksanvisningen för linskontrollen.
För information om att justera zoomen med hjälp av en linskontroll, se ”Justera zoomen med hjälp av en linskontroll”.

OBS!

Innan du använder en linskontroll ska du läsa bruksanvisningen för linskontrollen noggrant och se till att du förstår hur den
används. Sony kan inte hållas ansvarig för någon typ av anspråk som härrör från användningen av en linskontroll.

Clear Image Zoom är inte tillgänglig när en linskontroll är aktiverad. Vi rekommenderar att du ställer in förhållandet för Clear
Image Zoom på 1.0× eller inaktiverar Clear Image Zoom.

När linskontrollen är aktiverad kan kamerabildinramningar inte spelas in eller spelas upp.

Relaterade avsnitt
Justera zoomen med hjälp av en linskontroll

5-041-958-63(1) Copyright 2022 Sony Corporation
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Justera zoomen med hjälp av en linskontroll

Använd följande procedur för att fästa en linskontroll (tillval) och justera zoomen.

Kontrollera linskontrollens status
Tryck på knappen  (Kamerastatus) i det gemensamma området på Web App-skärmen för att visa kamerans
statusskärm.

Anslut en linskontroll till OPTION-kontakten på enhetens kontaktblock.

Du finner mer information om fäste i bruksanvisningen för linskontrollen.

1

Ställ in linskontrollen för zoomlinsen.

Du finner mer information i linskontrollens bruksanvisning.

2

Lås enhetens pan/tilt och fäst zoomlinsen.

För information, se ”Fästa en lins.”

3

Justera linskontrollen så att den kan använda zoomlinsen.4

Bevara kamerahuvudets balans framåt och bakåt så att basen förblir horisontal.

Du finner mer information i linskontrollens bruksanvisning och under ”Fästa en lins”.

5

Ställ in [Technical] > [Lens Controller] > [Setting] på [On] i web-menyn och tryck på knappen [OK].

Enheten startas om. Vänta tills återställningen av pan/tilt har slutförts.

6

Tryck då på knappen  (Initiera linskontroll) på fliken  (Others) på kamerakontrollpanelen på
skärmen för livedrift i Web App.

Linskontrollen rör sig för att upptäcka zoomintervallet. Du finner mer information i linskontrollens bruksanvisning.
När indikatorn  (Linskontrollfel) ändras till  (Linskontroll klar) längst upp till vänster på kamerans bildpanel är
förberedelsen klar.

OBS!

Notera linsen driftsområde när linskontrollen initieras.

7

Justera zoomen med hjälp av [Zoom]-reglaget i Web App eller zoomkontrollknapparna på den infraröda
fjärrkontrollen.

8
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Du kan kontrollera linskontrollens status på den här skärmen.

OBS!

När du byter lins, initera linskontrollen.

Clear Image Zoom är inte tillgänglig när en linskontroll är aktiverad. Vi rekommenderar att du ställer in förhållandet för Clear
Image Zoom på 1.0× eller inaktiverar Clear Image Zoom.

5-041-958-63(1) Copyright 2022 Sony Corporation

Status Beskrivning

Off Använd power zoom i E-monterad lins.

Communication
Error

Ett kommunikationsfel uppstod mellan enheten och linskontrollen.
Kontrollera anslutningen mellan enheten och linskontrollen, se sedan bruksanvisningen till
linskontrollen och initiera linskontrollen.

Uninitialized Utför initiering.

Initializing Vänta tills initieringen är klar.

Initialization Failed
Kontrollera anslutningen mellan enheten och linskontrollen, se sedan bruksanvisningen till
linskontrollen och initiera linskontrollen.

Working Styr zoomen med hjälp av linskontrollen.

Rotation Error
Det lagrade zoomintervallet och linsens rörelseområde kanske inte stämmer överens. Initiera
linskontrollen.

System Error Kontrollera anslutningen mellan enheten och linskontrollen, se bruksanvisningen till linskontrollen
och initiera linskontrollen eller starta om enheten och linskontrollen.Unknown Error
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Försiktighetsåtgärder vid användning

Försiktighetsåtgärder vid transport och packning
Vid transport eller packning av enheten ska följande förhållanden bibehållas och den ska inte utsättas för kraftiga
vibrationer eller stötar.

Ta bort linsen och sätt fast locket.
När du har flyttat kamerahuvudet (A) framåt vrider du kamerans låsspak (B) i pilriktningen för att låsa kamerahuvudet.

Rikta kamerahuvudet så att det är vänt framåt och lås med hjälp av pan/tilt-låsspaken.

Ta bort anslutningskablarna.

Kondensation
Om enheten flyttas direkt från en kall plats till en varm plats, eller om omgivningstemperaturen plötsligt höjs, kan fukt
bildas på den utvändiga ytan och/eller inuti enheten. Detta kallas kondens. Om kondens har bildats ska enheten stängas
av och inte användas förrän kondensen har avdunstat. Enheten kan skadas om den används när kondens finns på eller i
den.

Kamerans CMOS-bildsensorfenomen

OBS!

Följande fenomen som kan förekomma på bilder är specifika för bildsensorer. De indikerar inte ett fel.

Vita fläckar
Även om bildsensorerna är tillverkade med högprecisionsteknologi kan små, vita fläckar bildas på skärmen i sällsynta
fall, orsakade av kosmiska strålar etc.
Det hänger ihop med principen för bildsensorer och är inte ett fel. Utför APR regelbundet.
De vita fläckarna tenderar särskilt att ses i följande fall:
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Vid drift vid hög omgivningstemperatur
När du har höjt gain (känslighet)

Flimmer
Om du filmar i belysning som produceras av lysrör, natriumlampor, kvicksilverånglampor eller lysdioder kan skärmen
flimra eller färgerna variera.

Linser och pan/tilt-driftenheter
Om driftmekanismen för lins och pan/tilt inte används under en längre period, kan viskositeten för smörjmedlet inuti öka
och förhindra mekanismens rörelse. Kör lins- och pan/tilt-mekanismen regelbundet.

Om förbrukningsdelar
Fläkten och det inbyggda batteriet är förbrukningsartiklar som regelbundet måste bytas.
När den används i rumstemperatur är ett normalt bytesintervall omkring 5 år. Denna bytescykel är endast en generell
riktlinje och garanterar inte att dessa delar har en sådan livslängd.
Kontakta återförsäljaren för mer information om byte av delar.

Livslängden på nätadaptern och elektrolytkondensatorn är ungefär 5 år vid normal driftstemperatur och normal
användning (8 timmar per dag, 25 dagar per månad). Om normal användningsfrekvens enligt ovan överskrids kan det
hända att livslängden minskar i motsvarande grad.

Periodiska inspektioner rekommenderas för att hålla enheten fungerande och förlänga dess livslängd. Kontakta en Sony
servicerepresentant för mer information om inspektioner.

Om det inbyggda uppladdningsbara batteriet
Enheten har ett inbyggt uppladdningsbart batteri för att lagra datum, tid och andra inställningar även om enheten är
avstängd. Det inbyggda uppladdningsbara batteriet blir laddat efter att 24 timmar har gått om enheten är ansluten till ett
eluttag med AC-adaptern eller får ström via PoE++, oavsett om videokameran är på eller av. Det uppladdningsbara
batteriet urladdas helt på cirka 2 månader om AC-adaptern inte är ansluten till ett strömuttag. Använd enheten när du har
laddat batteriet. Men även om det uppladdningsbara batteriet inte är laddat påverkas inte enhetens funktion så länge du
inte behöver lagra datumet.

Användnings- och förvaringsplatser
Förvaras på en jämn, välventilerad plats.
Undvik att använda eller förvara enheten på följande platser.

Platser utsatta för regn eller vatten (inklusive under takfötter)
Utomhus och platser som överskrider 40 °C
Kom ihåg att på sommaren kan temperaturen inuti en bil med stängda fönster lätt överstiga 50 °C.
Platser som är kallare än 0 °C.
På fuktiga eller dammiga platser. Platser där enheten kan utsättas för regn
Platser som är föremål för vibrationer eller stötar
Platser där strålning, röntgenstrålar och starka magnetfält genereras.
Nära radio- eller TV-sändare som producerar starka elektromagnetiska fält
I direkt solljus eller nära element under längre perioder

Anmärkning om laserstrålar
Laserstrålar kan skada CMOS-bildsensorn. Om du fotograferar en scen som innehåller en laserstråle, var försiktig så att
du inte låter laserstrålen riktas in i kamerans CMOS-bildsensor. Specifikt kan högeffektiva laserstrålar från medicinsk
utrustning eller andra enheter orsaka skador på grund av reflekterat ljus och spritt ljus.

För att förhindra elektromagnetisk störning från bärbara kommunikationsenheter
Användningen av bärbara telefoner och andra kommunikationsenheter nära den här enheten kan leda till funktionsfel och
störningar i ljud- och videosignaler. Vi rekommenderar att de bärbara kommunikationsenheterna nära enheten stängs av.

Placera inte denna produkt i närheten av medicinsk utrustning
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Denna produkt (inklusive tillbehör) innehåller en eller flera magneter som kan påverka pacemakers, programmerbara
shuntventiler för vattenskallebehandling, eller annan medicinsk utrustning. Placera inte denna produkt i närheten av
personer som använder sådan medicinsk utrustning. Rådfråga en läkare innan du använder denna produkt om du själv
använder sådan medicinsk utrustning.

Säkerhetsåtgärder
SONY KOMMER INTE ATT ANSVARA FÖR SKADOR AV NÅGOT SLAG TILL FÖLJD AV UNDERLÅTENHET ATT
UPPRÄTTA LÄMPLIGA SÄKERHETSÅTGÄRDER PÅ ÖVERFÖRINGSENHETER, OUNDVIKLIGA DATALÄCKAGE
PÅ GRUND AV ÖVERFÖRINGSSPECIFIKATIONER, ELLER SÄKERHETSPROBLEM AV NÅGOT SLAG.
Beroende på användningsförhållandena kan obehöriga tredje parter på nätverket eventuellt få tillgång till apparaten.
När apparaten ansluts till nätverket ska det bekräftas att nätverket är skyddat på rätt sätt.
Ur säkerhetssynpunkt rekommenderas det starkt att du öppnar kontrollfönstret via en webbläsare och ändrar de
fabriksinställda åtkomstinställningarna när du använder enheten ansluten via nätverket. Det rekommenderas också
att du ställer in ett lösenord med en tillräckligt lång rad tecken för att det ska vara svårt för andra att gissa, och att du
lagrar det på ett säkert sätt.
När du ansluter den här produkten till ett nätverk, anslut den via ett system som ger en skyddsfunktion, som en router
eller brandvägg. Om den ansluts utan sådant skydd kan säkerhetsproblem uppstå.

Strömförsörjning
Enheten är inte utrustad med en strömbrytare. För att stänga av enheten, kontrollera att alla åtgärder har avslutats
och att enheten är i standbyläge för ström, och koppla därefter bort AC-adaptern. När du använder PoE++-
strömförsörjning, koppla då bort LAN-kabeln.
När så möjligt använd en strömkälla från en plats där det är lätt att koppla in och ta bort stickkontakten.
Om du använder ett uttag på en dammig plats, rengör då området runtomkring uttaget regelbundet för att förhindra
spårning.
Koppla bort strömförsörjningen när den inte används.

Säkerhetsföreskrifter för rörliga delar
Se till att främmande ämnen inte kommer in mellan rörliga delar.
Applicera inte en för stor belastning när du rör delarna för hand. Om du gör det kan det orsaka fel.
Stör inte driften för rörliga delar när de är i rörelse. Om du gör det kan det orsaka skada eller fel.
Rörliga delar kanske inte fungerar normalt om enheten inte används under en längre period. Kör enhetens pan/tilt-
funktioner regelbundet.

Försiktighetsåtgärder vid kontinuerlig drift
Enheten kan drivas 24 timmar per dag, 365 dagar per år (standbyläge).
Utför alltid ett filmningstest och kontrollera att enheten fungerar som den ska.

Det går inte att filma kontinuerligt under perioder som överstiger 24 timmar.
Om du filmar i mer än 24 timmar ska du ställa enheten i standbyläge och sedan starta om enheten.

Observera att Sony inte ansvarar för ersättning av något slag för innehållet i bilder om du inte kan ta dem på grund av
något fel när du använder den här enheten.
Kontrollera alltid att enheten fungerar som den ska före användning. SONY KAN INTE HÅLLAS ANSVARIG FÖR
SKADOR AV NÅGOT SOM HELST SLAG, INKLUSIVE, MEN INTE BEGRÄNSAT TILL, ERSÄTTNING ELLER
ÅTERBETALNING PÅ GRUND AV FÖRLUST AV AKTUELL ELLER FRAMTIDA VINST PÅ GRUND AV FEL I DENNA
ENHET, ANTINGEN UNDER GARANTIPERIODEN ELLER EFTER ATT GARANTIN HAR GÅTT UT, ELLER AV
VILKA SOM HELST ANDRA ANLEDNINGAR.
SONY KAN INTE HÅLLAS ANSVARIG FÖR NÅGON TYP AV ANSPRÅK AV ANVÄNDARE AV ENHETEN ELLER
TREDJE MAN.
SONY KAN INTE HÅLLAS ANSVARIG FÖR UPPHÖRANDE ELLER AVBROTT AV NÅGON TJÄNST I ANSLUTNING
TILL DENNA ENHET, OAVSETT ORSAK.

Försiktighetsåtgärder för inspelningsfunktionen
Gör alltid en provinspelning och kontrollera att inspelningen lyckades. SONY KAN INTE HÅLLAS ANSVARIG FÖR
SKADOR AV NÅGOT SOM HELST SLAG, INKLUSIVE, MEN INTE BEGRÄNSAT TILL, ERSÄTTNING ELLER
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ÅTERBETALNING PÅ GRUND AV FEL I DENNA ENHET ELLER DESS INSPELNINGSMEDIA ELLER NÅGRA
ANDRA MEDIA ELLER LAGRINGSSYSTEM FÖR ATT SPELA IN NÅGOT SOM HELST TYP AV INNEHÅLL.
Kontrollera alltid att enheten fungerar som den ska före användning. SONY KAN INTE HÅLLAS ANSVARIG FÖR
SKADOR AV NÅGOT SOM HELST SLAG, INKLUSIVE, MEN INTE BEGRÄNSAT TILL, ERSÄTTNING ELLER
ÅTERBETALNING PÅ GRUND AV FÖRLUST AV AKTUELL ELLER FRAMTIDA VINST PÅ GRUND AV FEL I DENNA
ENHET, ANTINGEN UNDER GARANTIPERIODEN ELLER EFTER ATT GARANTIN HAR GÅTT UT, ELLER AV
VILKA SOM HELST ANDRA ANLEDNINGAR.
SONY KAN INTE HÅLLAS ANSVARIG FÖR NÅGON TYP AV ANSPRÅK AV ANVÄNDARE AV ENHETEN ELLER
TREDJE MAN.
SONY KAN INTE HÅLLAS ANSVARIG FÖR NÅGON FÖRLUST, REPARATION, ELLER REPRODUCERING AV
NÅGON DATA SOM ÄR SPARAD I INTERNMINNET, INSPELNINGSAPPARAT ELLER NÅGON ANNAN APPARAT
ELLER MINNESSYSTEM.
SONY KAN INTE HÅLLAS ANSVARIG FÖR UPPHÖRANDE ELLER AVBROTT AV NÅGON TJÄNST I ANSLUTNING
TILL DENNA ENHET, OAVSETT ORSAK.

5-041-958-63(1) Copyright 2022 Sony Corporation
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Utgångsformat och begränsningar

Detta ämne beskriver utgångsformat och begränsningar.

OBS!

Bildformatets upplösning begränsas av inställningarna för [Project] > [Rec Format] > [Frequency], [Codec] och [Video Format] i
web- eller kameramenyn.

Bildformatets upplösning begränsas även av kombinationen med S&Q-bildfrekvensen. Förutom tabellen över SDI OUT/HDMI
OUT-utgångsformat nedan ändras HDMI-utgången till Full HD eller lägre när alla följande villkor är uppfyllda.

[Shooting] > [S&Q Motion] > [Setting] är inställt på [On]
[Shooting] > [S&Q Motion] > [Frame Rate] är högre än 60fps

När förhållandena ovan inträffar gråmarkeras valalternativen HDMI-utgång 4096×2160P och 3840×2160P för [Monitoring] >
[Output Format] > [SDI/HDMI] och kan inte väljas.

Bilden spelas inte upp om en högre upplösning än videoutgångsupplösningen konfigureras.

Utgångsformat SDI OUT/HDMI OUT-kontakt

När systemfrekvensen är 50/59.94 Hz

Inställning Valbart utgångsformat

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(standard)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(standard)
1920×1080i
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När systemfrekvensen är 25/29.97 Hz

Inställning Valbart utgångsformat

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)1)
4096×2160P
1920×1080P
1920×1080i

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (Level A)
(standard)

1920×1080P
(standard)
1920×1080i

1920×1080P (Level B)
1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Utgång stoppad)
720×480P2)

720×576P3)

Skärmen kan inte överläggas.1)

När systemfrekvensen är 59.942)

När systemfrekvensen är 503)
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När systemfrekvensen är 23.98 Hz

Inställning Output Format (utgångsupplösning)

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(standard)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(standard)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(standard)

1920×1080i
(standard)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(standard)

1920×1080i
(standard)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Inställning Output Format (utgångsupplösning)

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(standard)

3840×2160
(RAW)

(3840×2160 RAW)
3840×2160P
1920×1080P
(standard)
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När systemfrekvensen är 24 Hz

5-041-958-63(1) Copyright 2022 Sony Corporation

Inställning Output Format (utgångsupplösning)

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(standard)

1920×1080P
(standard)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P
(standard)

1920×1080P
(standard)

1920×1080
1920×1080P
(standard)

1920×1080P
(standard)

Inställning Output Format (utgångsupplösning)

Inspelnings-/uppspelningsläge
RAW-utgångsupplösning/

Intern
inspelningsupplösning

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)
4096×2160P
1920×1080P
(standard)

XAVC-I 4096×2160
4096×2160 (2SI)
1920×1080P
(standard)

4096×2160P
1920×1080P
(standard)
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Felsökning

Strömförsörjning

Bildutgång

Symtom Orsak Lösning

Enheten
startar inte.

AC-adaptern är inte ordentligt ansluten till DC IN-
kontakten.

Sätt in strömsladden ordentligt och så långt det
går.

AC-strömsladden är inte ordentligt insatt i AC-
adaptern eller AC-uttaget.

Sätt in strömsladden ordentligt och så långt det
går.

LAN-kabeln är inte ordentligt ansluten mellan PoE++
strömförsörjningsenheten och enheten.

Kontrollera att kabeln är insatt tills den låses på
plats.

LAN-kabeln är ansluten till OPTION-kontakten men
inte till LAN-kontakten.

Anslut LAN-kabeln till LAN-kontakten korrekt.

Enheten är ansluten till en strömförsörjningsenhet
som inte stöder PoE++ (IEEE802.3bt Typ 4 Klass 8-
efterlevande).

Anslut till en strömförsörjningsenhet som stöder
PoE++ (IEEE802.3bt Typ 4 Klass 8-
efterlevande).

Den totala strömförbrukningen överskrider den
maximala märkningen för PoE++
strömförsörjningsenheten.

Se bruksanvisning angående PoE++
strömförsörjningsenheten.

En nätverkskabel med kategorimärkning som inte
stöder PoE++ strömförsörjning är ansluten.

Använd en nätverkskabel i kategori 5e eller
högre för anslutning till LAN-kontakten.

Kameran, PoE++ strömförsörjningsenheten samt
kringutrustning är inte anslutna till jord.

Anslut kameran, PoE++
strömförsörjningsenheten samt kringutrustning
till jord.

Symtom Orsak Lösning

Ingen bildutgång.

Anslutna enheter är inte korrekt anslutna.
Anslut de anslutna enheterna
korrekt.

Inledande konfiguration slutfördes inte.
Slutför den inledande
konfigurationen med hjälp av Web
App.

Ingen bildutgång från
HDMI-kontakten.

En signal konfigureras som inte stöds av
destinationsenheten för HDMI-utgången.

Ändra formatinställning för HDMI-
utgången eller använd en enhet
som stödjer utgångssignalen.

En kabel används som inte stödjer standard för HDMI-
utgång.

Använd en kabel som stödjer den
standard som gäller för HDMI-
utgång.
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Fjärrkontroll

Infraröd fjärrkontroll

Symtom Orsak Lösning

Ingen bildutgång från
SDI-kontakten.

En kabel används som inte stödjer standard för SDI-
utgången.

Använd en kabel som stödjer den
standard som gäller för SDI-
utgången.

Monitorn ansluten till SDI-kontakten stödjer inte
utgångssignalen.

Använd en monitor som stödjer
standarden för SDI-utgången.

Inspelningsformatet är inställt till RAW-utgången.
Ändra inspelningsformatet till en
annan inställning än RAW-utgång.

HDMI-utgången är inställd till SD-upplösning. Ställ in HDMI-utgången till en
annan upplösning än SD.

Ingen bildutgång från
den optiska
fiberkabeln eller
bilden är förvrängd.

Modulen som används efterlever inte standarderna
SFF eller SMPTE eller uppfyller inte Power Level I (1,0
W).

Se ”Utgång för en optisk
fibersignal.”

Ingen bildutgång eller
förvrängd bild med
extern synkronisering.

En extern synkroniseringssignal lämplig för det
konfigurerade videosignalformatet kommer inte in.

Använd som ingång en extern
synkroniseringssignal lämplig för
det konfigurerade
videosignalformatet.

Det är brus i ljudet.

Kameran, PoE++ strömförsörjningsenheten samt
kringutrustning är inte anslutna till jord.

Anslut enheten, PoE++
strömförsörjningsenheten samt
kringutrustning till jord.

Enheten används i en miljö med enheter som genererar
starka elektrisk och magnetisk fält (såsom
Tv-/radioantenner, amatörradiosändare,
luftkonditioneringsmotorer,
strömförsörjningstransformatorer).

Håll på avstånd från enheter som
genererar starka elektriska och
magnetiska fält.

Linsen, linsstödet och drivenheten är i kontakt med
enheten eller ett föremål i den omgivande miljön och ett
avvikande brus sänds.

Fäst linsen korrekt.

Kontrollera om det finns några
hinder nära kameran.

Symtom Orsak Lösning

Den infraröda fjärrkontrollen
fungerar inte när den trycks
ned.

Funktionen för den infraröda
fjärrkontrollen är inaktiverad.

Ställ in [Technical] > [IR Remote] > [Setting]
till [On] i web-menyn.

Batteriet har laddats ut eller
batteriets polaritet är felaktig.

Använd den infraröda fjärrkontrollen nära
enhetens IR-sensor. Om ström-LED:en
blinkar, byt då ut batteriet.

Inledande konfiguration slutfördes
inte.

Slutför den inledande konfigurationen med
hjälp av Web App.

Pan/tilt-driftshastigheten är
långsam.

Pan/tilt-hastigheten från den
infraröda fjärrkontrollen är inställd
på normalt läge.

Ställ in SETUP-brytare 4 till läget ON på
enhetens kontaktblock.
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RM-IP500

Web App

Symtom Orsak Lösning

Åtgärden hade en annan
kamera än den avsedda som
mål.

Den infraröda signalen togs emot
av en annan kamera än den
avsedda.

Ställ in [Technical] > [IR Remote] > [Setting]
till [Off] i web-menyn till kameran du inte vill
styra.

Symtom Orsak Lösning

Kameran kan inte användas från
fjärrkontrollen RM-IP500.

Kamerans strömförsörjning
är inte ansluten.

Kontrollera att enhetens POWER-lampa tänds i
grönt eller orange.

Kameran eller fjärrkontrollen
är inte ansluten till nätverket.

Kontrollera anslutningar för enheten och
fjärrkontrollen.

Inledande konfiguration av
kameran slutfördes inte.

Slutför den inledande konfigurationen med hjälp
av Web App.

VISCA over IP-
kommunikation är inte
aktiverat.

Ställ in SETUP-brytare 3 till läget ON på
enhetens kontaktpanel och starta om enheten.

Kamerans IP-adress
ändrades.

Kontrollera kamerans IP-adress med [Network]
> [Wired LAN] i web- eller kameramenyn.

Kamerans IP-adress ändrades
med AUTO IP SETUP på
fjärrkontrollen RM-IP500.

Minst 20 minuter har gått
sedan kameran startades.

Starta om enheten. IP-adressen kan ändras
med AUTO IP SETUP inom de första 20
minuterna efter enheten startades.
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Symtom Orsak Lösning

Kan inte ansluta med en
webbläsare.

En LAN-kabel i kategori 5e eller
högre är inte ansluten.

Anslut en LAN-kabel i kategori 5e eller högre.

Inte ansluten till LAN korrekt eller
det anslutna nätverket fungerar
inte normalt.

Kontroller att Link LED för LAN-kontakten är
tänd. Om Link LED är inte tänd, kontakta din
nätverksadministratör.

Kamerans strömförsörjning är
inte ansluten.

Se avsnittet ”Strömförsörjning” ovan.

Ingen giltig IP-adress är
konfigurerad för enheten.

Utför en nätverksåterställning.

Den konfigurerade IP-adressen
används för en annan enhet.

Kontrollera att IP-adresser till kringutrustning är
unika.

Den konfigurerade nätmasken
motsvarar inte använt nätverk.

Utför en nätverksåterställning.

Enheten koms åt från samma
lokala nätverk via en
proxyserver.

Ändra konfigurationen så att proxyservern inte
används.

Den konfigurerade standard-
gatewayen för enheten är
felaktig.

Utför en nätverksåterställning.

Angiven URL är felaktig. Ange korrekt URL och försök på nytt.

HTTP-porten är felaktig.

Visa kameramenyn på en extern monitor och
kontrollera inställningen för [Network] > [Wired
LAN] > [HTTP Port]. Om ett annat värde än 80
är konfigurerat lägg då till HTTP-portnumret till
värdenamnet eller den IP-adress som angivits i
webbläsaren.
Exempel: Om HTTP-porten är inställd till 8080,
ange http://<IP Address>:8080

Enhetens HTTP-portnumret
filtreras eller blockeras.

Ändra enhetens HTTP-portnummer till en port
som inte filtreras eller blockeras.

Webbläsarens gamla cache har
en negativ effekt.

Ta bort cache från webbläsaren.

Kan inte ansluta till Web App
med 2D-koden (QR-kod).

Enheten som används stödjer
inte mDNS.

Använd en enhet som stödjer mDNS.
Om du använder en enhet som inte stödjer
mDNS, ange då IP-adressen direkt i
webbläsaren.

Surfplattan eller datorn är
ansluten till ett annat nätverk än
kameran.

Anslut surfplattan eller datorn till samma lokala
nätverk som enheten.

Kan inte ansluta till Web App
genom att ange URL:en
manuellt.

Enheten som används stödjer
inte mDNS.

Använd en enhet som stödjer mDNS.

Surfplattan eller datorn är
ansluten till ett annat nätverk än
kameran.

Anslut surfplattan eller datorn till samma lokala
nätverk som enheten.

469



Symtom Orsak Lösning

Autentiseringsskärmen visas
kontinuerligt.

Angivet användarnamn eller
lösenord är inte korrekt.

Ange registrerat användarnamn och lösenord.
Om du har glömt den registrerade
användarinformationen, se ”RESET-brytare” i
”Anslutningsblock” för att starta
användarinformation för nätverksanslutning.

Användarnamnet och lösenordet
kan ha ändrats av en användare
som är inloggad med hjälp av en
annan webbläsare.

Kontrollera korrekt användarnamn och
lösenord med enhetsadministratören.

Kamerabilden visas inte i Web
App.

Kamerans HDMI-utgång är
inställd på 720×480 eller
720×576.

Ändra upplösning för enhetens HDMI-utgång.

En HDMI-monitor som inte
stöder kamerans HDMI-
utgångssignal är ansluten.

Ta bort HDMI-monitorn eller använd en HDMI-
monitor som stöder HDMI-
utgångsinställningarna.

Enheten startades om och
sessionen kopplades bort.

Vänta minst en minut och ladda om
webbläsaren.

Webbläsarens gamla cache har
en negativ effekt.

Ta bort cache från webbläsaren.

Kamerabildens upplösning som
visas i Web App är låg.

Upplösningen för videostream 3
som används av Web App är för
lågt inställd.

Öka värdet med [Stream] > [Video Stream] >
[Size 3] i web-menyn.

Kameramenyn visas inte när du
trycker på knappen [Menu].

Kameramenyn är konfigurerad
så att den inte är inbäddad i
HDMI-utgångssignalen.

Ställ in [Monitoring] > [Output Display] >
[HDMI/Stream] till [On] i web-menyn.

Värdet för en inställning på
inställningsskärmen
uppdateras/visas inte ordentligt.

Inställningsskärmen för Web App
återger inte automatiskt
inställningarna som ändrades i
en annan Web App.

Tryck på knappen [Reload] längst ned på
inställningsskärmen för Web App. Värdena för
inställningarna på den visade
konfigurationsskärmen laddas om och
uppdateras.

Inställningarna för tillfälliga
internetfiler har en påverkan.

Ta bort cache från webbläsaren.

Kan inte ladda ned
konfigurationsfilen eller loggen.

Webbläsarens
filnedladdningsfunktion är
inaktiverad.

Aktivera webbläsarens filnedladdningsfunktion.

Inställningsskärmen för Web
App kan kommas åt, men inte
utföra åtgärder på skärmen för
livedrift och uppspelning.

Användningsskärmen för Web
App är låst.

Ställ in brytaren för användningslås högst upp
till höger i Web App till -läget (Drift
upplåst).

Web App-skärmen tar lite tid att
visas.

Enhetens strömningsbild visas
av flera användare samtidigt.

Minska antalet användare som kan komma åt
Web App samtidigt.
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Filmning

Kamera

Pan/tilt

Symtom Orsak Lösning

Bilden förvrängs eller är ryckig.

Videoinformationen sänds inte
ordentligt på grund av anhopning
i kommunikationsvägen.

Minska bithastigheten för strömningen eller
ställ in [Video Stream 3] > [Size] till det minsta
alternativet eller minska hastigheten för att
skapa marginal i kommunikationsbandet.

Flera webbläsare körs på
surfplattan och upptar minne.

Stäng alla webbläsare som körs i bakgrunden.

För många flikar i webbläsaren
är öppna, vilket saktar ner
driften.

Stäng alla flikar som inte används.

Överdriven ackumulering av
webbläsarens cache och
webbhistorik saktar ner driften.

Ta bort cache från webbläsaren.

Symtom Orsak Lösning

Bilden ser förvrängd ut vid början
och slut av pan/tilt-drift.

Bilden kan bli förvrängd om linsens
stabiliseringsfunktion är påslagen.

Stäng av linsens
stabiliseringsfunktion.

Synvinkel ändras utan
användaråtgärd.

Linsandning inträffade. Se ”Andningskompensation.”

Kan inte använda fokus, zoom eller
iris.

Linsernas brytarinställningar kan vara
felaktiga.

Se ”Kontrollera linsbrytarna.”

Symtom Orsak Lösning

Kan inte återställa pan/tilt. Pan/tilt-låsspaken är i LOCK-läget. Skjut pan/tilt-låsspaken till UNLOCK-läget.

Kameran stannar inte i
förväntat läge.

Kamerablocket är inte i balans.
Flytta kamerablocket framåt/bakåt till ett lämpligt
läge såsom beskrivet i ”Fästa en lins,” och stäng
sedan av enheten igen.

Linsen stöder inte pan/tilt.
Se informationen om linskompabilitet och sätt på
en lins som stödjer pan/tilt och starta sedan
enheten igen.

Kan inte utföra återställning av
pan/tilt.

Utför en återställning av pan/tilt enligt
beskrivningen i ”Återställa pan/tilt.”En oförväntad kraft applicerades

på kamerahuvudet, vilket orsakade
ett pan/tilt-kontrollfel.

Kameran återgår inte till
fronten när knappen

 (Panorering/lutning
hem) är nedtryckt.

Takmonteringsläge har aktiverats.

Ställ in [Pan-Tilt] > [P/T Direction] > [Ceiling] i
web-menyn enligt nuvarande installation och
starta sedan enheten igen. När monterat i taket
sitter kontaktblocket framför kameran.
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Symtom Orsak Lösning

Pan/tilt-driften är begränsad.

Pan/tilt-intervallgräns konfigureras.
Rensa inställningarna för pan/tilt-intervallgräns,
enligt behov, så som beskrivet i ”P/T Range
Limit.”

En oförväntad kraft applicerades
på kamerahuvudet, vilket orsakade
ett pan/tilt-fel.

Utför en återställning av pan/tilt enligt
beskrivningen i ”Återställa pan/tilt.”

Pan/tilt-driften förflyttades i
motsatt riktning.

Inställningen för
takmonteringsläget skiljer sig från
nuvarande monteringsstatus.

Ställ in [Pan-Tilt] > [P/T Direction] > [Ceiling] i
web-menyn i enlighet med nuvarande
installation.

Inställningarna relaterade till
pan/tilt-riktning ändrades.

Kontrollera inställningarna för [Pan-Tilt] > [P/T
Direction] i web-menyn.

Bilden förflyttar sig inte
smidigt vid början och slut
av pan/tilt-drift.

Inställningen för
acceleration/retardation för pan/tilt-
drift är för hög.

Minska inställningen acceleration/retardation för
pan/tilt-drift för att göra rörelsen vid början och
slut av pan/tilt-driften smidigare med hjälp av
[Pan-Tilt] > [P/T Acceleration] > [Ramp Curve] i
web- eller kameramenyn. Obs! Detta innebär att
linsen tar längre tid på sig att nå högsta
hastighet.

Pan/tilt-driften har stoppats.

Kamerablocket är inte i balans.
Flytta kamerablocket framåt/bakåt till ett lämpligt
läge såsom beskrivet i ”Fästa en lins,” och stäng
sedan av enheten igen.

Inställningen för rampkurvan
(acceleration/retardation) är för hög
för linsen.

Om en stor lins är påkopplad, minska då värdet
för [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]
i web- eller kameramenyn.

En stor lins används. Kontakta din Sony-supportrepresentant.

Enheten störs när pan/tilt
används.

Skruven till klämspaken till linsen
stödsockel slår i kameran.

Vrid på skruven till klämspaken till linsen
stödsockel så att den är riktat uppåt.

Linsens stödklämspak slår i
kameran.

Vrid på stödklämspaken så att den är riktad
uppåt.

Kamerahuvudets låsspak slår i
kameran.

Kontrollera att kamerahuvudets låsspak är helt i
LOCK-läget.

Ovanligt brus uppstår under
pan/tilt-drift.

Kameran är inte i balans. Flytta kamerahuvudet framåt/bakåt till en lämplig
position så att skjutbotten är horisontal.

Inställningen för rampkurvan
(acceleration/retardation) är för hög
för linsen.

Om en stor lins är påkopplad, minska då värdet
för [Pan-Tilt] > [P/T Acceleration] > [Ramp Curve]
i web- eller kameramenyn.

Kamerahuvudet är inte fixerat i
läget och det förekommer ett
rörelseljud under drift.

Ställ kamerahuvudets låsspak i LOCK-läget.

Det går inte att spara en
förinställningsposition.

En förinställning kan inte sparas
om Clear Image Zoom används.

Ställ tillbaka förhållandet för Clear Image Zoom
till 1×. (status där förhållandet inte visas till höger
om  (Zoomförhållande))
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In-/uppspelning

Symtom Orsak Lösning

Inramningen förskjuts när en
förinställningsposition spelas
upp.

Temperaturen i miljön kan ha
förändrats avsevärt mellan när en
förinställningsposition sparades
och när den spelas upp.

Spara förinställningspositionen igen.

Linskalibrering utförs inte.
Kör kalibreringen med [Technical] > [Lens] >
[Lens Calibration] i kameramenyn.

En annan lins monterat än den lins
som användes när förinställningen
sparades. Eller så är zoomläget för
manuell zoom annorlunda.

Spara förinställningspositionen igen.

Bildkontrollpanelen i Web
App är gråmarkerad och kan
inte användas.

Pan/tilt-driften är inte tillgänglig
medan miniatyrbildskärm visas och
under uppspelning.

Visa uppspelningsskärmen och avsluta visningen
av miniatyrbilden eller stoppa uppspelningen.

Pan/tilt-driften är inte tillgänglig när
kamerabilden inte kan visas i Web
App.

Se ”Web App” i ”Felsökning.”

Pan/tilt-låsspaken är i LOCK-läget. Skjut pan/tilt-låsspaken till UNLOCK-läget.

”Execute Pan-Tilt Reset”
visas under
bildkontrollpanelen i Web
App.

En oförväntad kraft applicerades
på kamerahuvudet, vilket orsakade
ett pan/tilt-fel.

Utför en återställning av pan/tilt enligt
beskrivningen i ”Återställa pan/tilt.”

Symtom Orsak Lösning

Inspelning påbörjas inte när du
trycker på inspelningsknappen
START/STOP.

Minneskortet är fullt.
Byt ut minneskortet med ett med ledigt
utrymme.

Minneskortet måste återställas.
Återställ minneskortet enligt beskrivningen i
”Återställa minneskort.”

Inspelningslampan är konfigurerad
som en tally-lampa och därmed kan
inte lampan fastställa
inspelningsstatus.

Konfigurera inspelningslampan så att den
fungerar som en inspelningslampa enligt
beskrivningen i ”Ansluta en tally-signal.”

Det går inte att spela in ljud.

En mikrofon är inte ansluten.
Anslut en mikrofon eller ljudenhet till AUDIO
IN-kontakten i kontaktblocket.

Inställningen [Master Input Level] är
på minimivärde.

Justera [Master Input Level].

Inspelat ljud är förvrängt.
Inställningen för ljudingångsnivån är
för hög.

Justera [CH1 Input Level] till [CH4 Input
Level] och [Master Input Level].

När du använder en mikrofon i en ljudlig
miljö, t.ex. med livemusik, justerar du först
[AUDIO IN CH1 MIC Ref.] och [AUDIO IN
CH2 MIC Ref.].
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Filöverföring

IP-strömning

Symtom Orsak Lösning

Det inspelade ljudet brusar
mycket.

Inställningen för ljudingångsnivån är
för låg.

Justera inställningarna [Audio Input Level]
och [Audio] > [Audio] > [Audio Input] >
[AUDIO IN CH1 MIC Ref.] eller [AUDIO IN
CH2 MIC Ref.].

Videoklipp kan inte spelas upp.

Videoklippet redigeras.

Videoklipp kan inte spelas upp om du har
modifierat filnamn eller mappar eller om
videoklippet används på en dator. Detta är
inte ett fel.

Videoklippet spelades in med en
annan kamera än denna enhet.

Videoklipp inspelade på andra kameror än
denna enhet kanske inte kan spelas upp
eller visas med felaktig storlek. Detta är inte
ett fel.

Symtom Orsak Lösning

Filuppladdning
misslyckades.

Serverns användarnamn och
lösenord är felaktiga.

Serverns användarnamn och lösenord kan vara
felaktigt. Ange korrekta uppgifter.

Symtom Orsak Lösning

Strömning är inte
tillgängligt.

Det användarnamn eller lösenord
som angavs i klientens applikation
för att visa strömning från enheten
är felaktigt.

Om enhetens strömningsformat är inställt på
[RTSP], [SRT-Listener] eller [NDI|HX], då måste
man ange användarnamn och lösenord som ställts
in för denna enhet i klientapplikationen. Ange
korrekt användarnamn och lösenord.

Strömningsprotokollet är inte inställt.
Välj målprotokoll med hjälp av [Stream] > [Stream
Setting] i web-menyn.

Sex eller fler RTSP-sessioner har
ställts in.

Ställ in antalet sessioner till fem eller färre.

UDP-portnumret är inte korrekt
inställt.

Ställ in portnummer och andra inställningar för
målprotokollet med hjälp av [Stream] > [Stream] >
[Stream Setting] i web-menyn.

UDP-kommunikation är blockerad. Kontrollera inställningar för säkerhetsprogramvara.

Ljud strömmas inte.
Ljudutgångsströmning är inställd på
[Off].

Ställ in [Stream] > [Audio Stream] > [Setting] till
[On] i web-menyn.

Strömning kopplades
bort.

Protokollinställning eller
strömningens codec-inställningar
ändrades under strömningen.

Ställ in protokollinställning och strömningens
codec-inställningar innan du börjar strömma.

Bildstorlek för [Video
Stream 1] kan inte ställas
in till 4096×2160 eller
3840×2160.

Bildstorleken är 1920×1080 när
[Output Format] är inställt till HDMI.

Bildstorleken för strömning kan inte ställas in högre
än HDMI-bildstorleken. Ändra HDMI-bildstorleken
med hjälp av [Monitoring] > [Output Format] i web-
menyn.
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Anslutning till externa enheter

Extern synkronisering

Tally

Symtom Orsak Lösning

Bildfrekvensen för [Video
Stream 1] kan inte ställas
in till 60 FPS eller 50
FPS.

Strömningens bildfrekvens är
inställd till 29.97 eller lägre.

Bildfrekvensen som används för strömning
begränsas av systemfrekvensen. Ändra
systemfrekvensen med hjälp av [Rec Format] >
[Frequency] i web-menyn.

Streamen [Video Stream
3] kan inte nås.

[Video Stream 3] stödjer inte
RTSP/SRT/NDI.

Använd [Video Stream 1] eller [Video Stream 2].

RTSP/SRT-skärmen
uppdateras/visas inte
ordentligt.

Portnumret som används för RTSP
eller SRT filtreras eller blockeras.

Ändra RTSP- eller SRT-portnumret till en port som
inte filtreras eller blockeras av enheter som tar
emot streamen. Eller ändra portnumret som
används för RTSP- eller SRT på enheten.

Bilden förvrängs eller är
ryckig.

Videoinformationen sänds inte
ordentligt på grund av anhopning i
kommunikationsvägen.

Minska bithastigheten för strömningen eller ställ in
[Video Stream 2] codec ([Codec 2]) till [Off] för att
skapa marginal i kommunikationsbandet.

Beställningen av videopaket har
ändrats inom
kommunikationskanalen.

Använd samma internettjänsteleverantör på både
enhetssidan och mottagarsidan.

Inte upptäckt som NDI-
enhet.

Strömningsprotokollet är inte inställt
till NDI|HX.

Strömningsprotokollet måste ställas in till NDI|HX
för att upptäcka en enhet som en NDI-enhet. Ställ
in [Stream] > [Stream Setting] till [NDI|HX] i web-
menyn.

Kan inte ställas in som
en NDI-enhet.

Ingen NDI|HX-licens är installerad.

Installera en NDI|HX-licens. Du kan kontrollera om
det finns en NDI|HX-licens med hjälp av [Stream] >
[Stream] > [Stream Setting] > [NDI|HX] > [License]
i web-menyn.

Symtom Orsak Lösning

Kan inte
synkronisera till
extern källa.

En extern synkroniseringssignal lämplig för
det konfigurerade videosignalformatet
kommer inte in.

Använd som ingång en extern
synkroniseringssignal lämplig för det
konfigurerade videosignalformatet.

Enheten är dubbelavslutad.
Enheten har en inbyggd 75 Ω avslutare. Anslut
direkt till en signalkälla (en-för-en) eller använd
en fördelardosa.
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Linskontroll

Relaterade avsnitt

Utgång för en optisk fibersignal

Anslutningsblock

Andningskompensation

Kontrollera linsbrytarna

Fästa en lins

Återställa pan/tilt

P/T Range Limit

Återställa minneskort

Ansluta en tally-signal

5-041-958-63(1) Copyright 2022 Sony Corporation

Symtom Orsak Lösning

Tally-lampan
tänds inte.

Ljusstyrkan för tally-lampan är inställd på
Off.

Ställ in lämplig ljusstyrka med [Technical] > [Tally] >
[Tally Lamp Brightness] i web-menyn.

Inspelnings/tally-lampan är konfigurerad
som en inspelningslampa.

Konfigurera inspelnings/tally-lampan så att den fungerar
som en tally-lampa enligt beskrivningen i ”Ansluta en
tally-signal.”

RM-IP500 är ansluten och VISCA over IP
är inaktiverat.

Ställ in SETUP-brytare 3 till läget ON på enhetens
kontaktblock.

OPTION-kontaktens anslutning är felaktig
eller så är målstiftet inte kortslutet till GND.

Kortslut stift 7 eller stift 8 till OPTION-kontakten till GND
så som beskrivet i ”Ansluta en tally-signal.”

Symtom Orsak Lösning

[Communication Error]
visas i 
(Kamerastatus).

Kameran kan inte
kommunicera med
linskontrollen.

Kontrollera anslutningen mellan enheten och linskontrollen,
starta sedan om enheten och linskontrollen.

[Rotation Error] visas i 
(Kamerastatus).

Ett roteringsfel inträffade
i linskontrollen.

Det lagrade zoomintervallet och linsens rörelseområde
kanske inte stämmer överens. Initiera linskontrollen.
Om problemet kvarstår kontaktar du tillverkaren av
linskontrollen.

[System Error] visas i 
(Kamerastatus).

Ett systemfel inträffade i
linskontrollen.

Kontrollera anslutningen mellan enheten och linskontrollen,
se bruksanvisningen till linskontrollen och initiera
linskontrollen eller starta om enheten och linskontrollen.
Om problemet kvarstår kontaktar du tillverkaren av
linskontrollen.

[Unknown Error] visas i
 (Kamerastatus).

Ett okänt fel inträffade i
linskontrollen.

Kontrollera anslutningen mellan enheten och linskontrollen,
se bruksanvisningen till linskontrollen och initiera
linskontrollen eller starta om enheten och linskontrollen.
Om problemet kvarstår kontaktar du tillverkaren av
linskontrollen.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Fel-/varningsmeddelanden

Om det uppstår en situation som ger en varning, försiktighet eller driftsförhållande på enheten, visas ett meddelande på
kamerans bildruta och POWER-lampan samt NETWORK-lampan på frampanelen och inspelningslampan börjar blinka.

OBS!

Inspelningslampans blinkning aktiveras endast när både [Technical] > [Tally] > [Tally Control] ställs in på [Internal] och [Tally Lamp
Brightness] inte är inställt på [Off] i web- eller kameramenyn.

Felmeddelanden

Om POWER-lampan och NETWORK-lampan blinkar enligt nedan, vidta då följande åtgärder.

Enheten kommer stoppas om följande visas.

Varningsmeddelanden

Följ instruktionerna som medföljer om följande visas.

POWER-
lampa

NETWORK-
lampa Orsak och lösning

Blinkar
långsamt i
orange

Blinkar
långsamt i
grönt

Enheten kan inte användas normalt. För detaljer, se [Maintenance] > [System Log] i
web-menyn. Om problemet kvarstår även efter att du satt enheten i standby-läge
eller stängt av strömmen och sedan slagit på den igen, kontakta då din Sony-
servicerepresentant.

Blinkar
snabbt i
orange

Blinkar snabbt
i grönt

Ett fel uppstod med enheten. Kontakta din Sony-servicerepresentant.

Meddelande
som visas Inspelningslampa Orsak och lösning

E + felkod Snabbt blinkande

Indikerar fel i enheten. Inspelningen stannas även om ●REC visas i kamerans
bildruta.
Stäng av enheten och kontrollera om det finns några problem med anslutna
enheter, kablar eller media. Om problemet kvarstår när enheten slås på igen,
kontakta då din Sony-servicerepresentant. Det kan hända att ett fel inte visas
eller att ett varningsljud inte ljuder beroende på enhetens status.

Meddelande som
visas Inspelningslampa Orsak och lösning

Temperature High Blinkar
Den invändiga temperaturen är hög.
Stäng av videokameran och låt den svalna innan du startar den på nytt.

Media Temperature
High

Blinkar
Tempteraturen på CFexpress-kortet är hög.
Byt ut videokameran eller låt den svalna innan du använder den på nytt.
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Försiktighets- och driftsmeddelanden

Följande försiktighets- och driftsmeddelande kan visas mitt på skärmen. Följ instruktionerna och lös problemet.

Meddelande som
visas Inspelningslampa Orsak och lösning

Voltage Low Blinkar DC IN-spänningen är låg (nivå 1). Kontrollera strömkällan.

Insufficient Voltage Snabbt blinkande
DC IN-spänningen är för låg (nivå 2). Inspelning inaktiveras.
Anslut till en annan strömkälla.

Media Near Full Blinkar
Minneskortets kvarvarande kapacitet börjar bli låg.
Byt ut så snart som möjligt.

Media Full Snabbt blinkande
Videoklipp kunde inte spelas in eller kopieras på grund av att det inte
finns något utrymme kvar i minneskort.
Byt ut omgående.

Clips Near Full Blinkar
Det kvarvarande utrymmet för videoklipp som kan spelas in på ett
minneskort börjar bli litet.
Byt ut så snart som möjligt.

Clips Full Snabbt blinkande
Det kvarvarande utrymmet för videoklipp som kan spelas in på
minneskortet är slut.
Det går inte att spela in eller kopiera fler videoklipp. Byt ut omgående.

Last Clip Recording Blinkar
Klippet som just nu spelas in är det sista som kan spelas in, då maximalt
antal videoklipp har uppnåtts.
Förbered ett nytt minneskort.

Media(A) Life Near
End1) Blinkar

Minneskortet är på väg att nå slutet på sin livslängd. Byt ut så snart som
möjligt.

Media(A) Life End1) Snabbt blinkande Minneskortet har nått slutet på sin livslängd. Byt ut omgående.

Media(A) Near Full1) Blinkar När du använder Simul Rec-funktionen

Media(A) Full1) Snabbt blinkande När du använder Simul Rec-funktionen

Media(A) Clips Near
Full1) Blinkar När du använder Simul Rec-funktionen

Media(A) Clips Full1) Snabbt blinkande När du använder Simul Rec-funktionen

Media(A) Last Clip
Rec1) Blinkar När du använder Simul Rec-funktionen

(Inget visas) Blinkar
Ett okänt fel inträffade i linskontrollen.
Kontrollera status i kamerastatus i Web App.
Mer information finns i systemloggen i Web App.

”(B)” visas för kortet i öppning B.1)

Visa meddelande Orsak och lösning

Backup Battery End
Please Change

Reservbatteriets kvarvarande kapacitet är för liten.
Anslut enheten till en strömkälla i minst 24 timmar för att ladda
reservbatteriet.
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Information om RTMP-strömningsfel

Följande felinformation kan visas på enheten. Utför följande åtgärder efter behov.

Visa meddelande Orsak och lösning

Unknown Media(A)1)

Please Change

Ett minneskort som har delats upp eller ett minneskort med fler
videoklipp än vad enheten kan hantera har satts i.
Kortet kan inte användas i enheten och måste bytas ut.

Cannot Use Media(A)1)

Unsupported File System

Ett kort använder ett annat filsystem eller ett oformaterat kort sattes in.
Kortet kan inte användas i enheten och måste bytas ut eller formateras
med enheten.

Media Error
Media(A) Needs to be Restored1)

Ett fel uppstod i minneskortet och kortet måste återställas.
Återställ minneskortet.

Media Error
Cannot Record to Media(A)1)

Minneskortet kan vara skadat och kan inte längre användas för
inspelning.
Det går inte att spela upp, så gör en kopia och det rekommenderas att
byta minneskortet.

Media Error
Cannot Use Media(A)1)

Minneskortet kan vara skadat och kan inte längre användas för
inspelning eller uppspelning.
Kortet kan inte användas i enheten och måste bytas ut.

Media(A) Error1)

Recording Halted
Playback Halted

Inspelning och uppspelning stoppades på grund av att ett fel uppstod
när minneskortet användes.
Om problemet kvarstår byt då minneskortet.

Media Reached Rewriting Limit
Change Media(A)1)

Minneskortet har nått slutet på sin livslängd.
Gör en reservkopia och byt kortet omgående. Om du fortsätter använda
kortet är det möjligt att det inte går att spela in eller upp.
Du finner mer information i minneskortets bruksanvisning.

The specified address is invalid.
Specificerad adress ogiltig.
Kontrollera att inställningen är korrekt.

Cannot Use Specified Port Number
Specificerat portnummer är ogiltigt.
Kontrollera att inställningen är korrekt.

Lens I/F Error(xx:xx)

Ett linsfel upptäcktes i linsens I/F-kommunikation när en E-monterad
lins monterades.
Kontrollera status för anslutningen med E-monterad lins.
Om problemet kvarstår kontakta din Sony-servicerepresentant med
felkoden (fem tecken inom parantes).

Cannot add auto upload job of Proxy file
because maximum number of upload jobs
was reached.

Maximalt antal överförda jobb har nåtts.
Rensa alla oönskade jobb. Inställningen för destination för automatisk
uppladdning för proxyfiler kan också vara felaktig. Kontrollera att
inställningen är korrekt.

Fan Stopped

Fläktarna har stannat.
Kontrollera att det inte finns något damm eller främmande ämnen.
Om problemet kvarstår efter eventuellt damm eller främmande ämnen
tagits bort, kontakta då din Sony-servicerepresentant.

”(B)” visas för kortet i öppning B.1)
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Information om SRT-strömningsfel

Följande felinformation kan visas på enheten. Utför följande åtgärder efter behov.

Felkod
Beskrivning Lösning

RTMP RTMPS

1002
1004

2002
2004

Kan inte ansluta till RTMP-server.
Kontrollera att serverns URL-inställning är korrekt.
Kontrollera nätverksinställningen.

1003 2003
Det går inte att lösa
domännamnet.

Kontrollera att serverns URL-inställning är korrekt.
Kontrollera DNS-serveranslutningen.

–
2005
2008

CRL-fel
Kontrollera att serverns URL-inställning är korrekt.
Kontrollera att anslutningens destination är en betrodd plats.

2006 CA-certifikatfel Kontrollera att klockinställningen är korrekt.
Kontrollera att CA-certifikatet är korrekt.

– 2007
Inget CA-certifikat är installerat.
Autentiseringsfel för
servercertifikat.

Installera ett CA-certifikat.
Kontrollera att anslutningens destination är en betrodd plats.

4002 RTMP-sessionen kopplades bort.
Enheten kan ha blivit bortkopplad på RTMP-serverns sida.
Kontrollera att inställningarna överensstämmer med tjänstens
rekommenderade codec-parameter.

4003 Nätverksanslutningskvaliteten är
låg.

Kontrollera nätverksinställningen.

Annat Andra fel.

Felkod

Beskrivning LösningSRT-
Caller

1001 Oväntat fel
Enheten kanske inte fungerar som den ska. Starta om
enheten.

1002
Kommunikation bortkopplad på grund av
ändrade inställningar

Kommunikationen kopplades bort på grund av att
inställningarna ändrades.
Återupprätta anslutningen.

5001 Oväntat fel
Enheten kanske inte fungerar som den ska. Starta om
enheten.

5005 Anslutningsfel
Kontrollera att anslutningens destinationsinställning är
korrekt.

5006 Krypteringsfel Kontrollera att krypteringsinställningen är korrekt.

5007 Oväntat fel Enheten kanske inte fungerar som den ska. Starta om
enheten.5008 Oväntat fel

5009 Överföringsfel
Enheten kopplades bort under kommunikation.
Kontrollera nätverksinställningen.
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Lista på menyobjekt

I följande tabeller framgår enhetens menyobjekt.

Förklaring
”Kamerameny” och ”web-meny”
●: Tillgängligt
▲: En del objekt tillgängliga
–: Ej tillgängligt

”All File” och ”Scene File”
Ja: Objekt sparat i ALL File eller Scene File
Nej: Objekt sparas inte

”All Reset (except for Network Settings)”
När [Reset]> [Reset] > [All Reset (except for Network Settings)] i web-menyn utförs:
Ja: Startat objekt (exkluderar nätverksinställningar)
Nej: Ej tillämpligt

”Network Reset”
När [Reset]> [Reset] > [Network Reset] i web-menyn utförs:
Ja: Startat objekt (nätverksinställningar)
Nej: Ej tillämpligt

”Factory Default”
Ja: Objekt återställt till fabriksstandard
Nej: Ej tillämpligt

Shooting

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Ja Ja Ja Ja Ja

ND Filter ● – Ja Ja*1 Ja Nej Ja

Shutter ● – Ja Ja Ja Nej Ja

Iris ● – Ja Ja Ja Nej Ja

Auto Exposure ● – Ja Ja*2 Ja Nej Ja

White ● – Ja Ja*3 Ja Nej Ja

White Setting ● – Ja Nej Ja Nej Ja

Offset White ● – Ja Nej Ja Nej Ja

Focus ● ▲ Ja Nej Ja Nej Ja

S&Q Motion ● – Ja Nej Ja Nej Ja
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Project

Paint/Look

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

LUT On/Off ● – Ja Nej Ja Nej Ja

Noise
Suppression

● – Ja Ja Ja Nej Ja

Flicker Reduce ● – Ja Nej Ja Nej Ja

SteadyShot ● – Ja Nej Ja Nej Ja

[Mode] ej tillämpligt*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V Position] ej tillämpligt*2

[Preset White] ej tillämpligt*3

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Base Setting ● ● Ja Nej Ja Nej Ja

Rec Format ● ● Ja Nej Ja*1 Nej Ja

Cine
EI/Flex.ISO Set

● – Ja Nej Ja Nej Ja

Simul Rec ● ● Ja Nej Ja Nej Ja

Proxy Rec ● ▲ Ja Nej Ja Nej Ja

Interval Rec ● ● Ja*2 Nej Ja Nej Ja

Picture Cache
Rec

● ● Ja*2 Nej Ja Nej Ja

SDI/HDMI Rec
Control

● – Ja Nej Ja Nej Ja

Assignable
Button

● – Ja Nej Ja Nej Ja

All File – ● Nej Nej Nej Nej Nej

[Frequency] ej tillämpligt*1

[Setting] ej tillämpligt*2

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Scene File ● – Nej Nej Nej Nej Nej

Base Look ● ▲ Ja*1 Nej Ja*1 Nej Ja*1

Reset Paint
Settings

● – Nej Nej Nej Nej Nej
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Pan-Tilt

TC/Media

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Black ● – Ja Ja Ja Nej Ja

Knee ● – Ja Ja Ja Nej Ja

Detail ● – Ja Nej Ja Nej Ja

Matrix ● – Ja Ja Ja Nej Ja

Multi Matrix ● – Ja*2 Ja*2 Ja Nej Ja

LUT-data importerade som grundutseende är ej tillämpligt*1

[Axis] ej tillämpligt*2

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

P/T Speed – ● Nej Nej Ja Nej Nej

P/T
Acceleration

● ● Nej Nej Ja Nej Nej

P/T Range
Limit

– ● Nej Nej Ja Nej Nej

P/T Direction – ● Nej Nej Ja Nej Nej

P/T Preset – ● Nej Nej Ja Nej Nej

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Timecode ● – Ja*1 Nej Ja Nej Ja

TC Display ● – Ja Nej Ja Nej Ja

Users Bit ● – Ja*1 Nej Ja Nej Ja

HDMI TC Out ● – Ja Nej Ja Nej Ja

Clip Name
Format

● – *2 Nej Ja Nej Ja

Update
Media

● – Nej Nej Nej Nej Nej

Format
Media

● – Nej Nej Nej Nej Nej

Media Life ● – Nej Nej Nej Nej Nej

[Setting] ej tillämpligt*1

[Auto Naming] tillämpligt, [Camera ID] ej tillämpligt*2
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Monitoring

Audio

Thumbnail

Technical

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Output
Format

● ● Ja Nej Ja Nej Ja

Output
Display

– ● Ja Nej Ja Nej Ja

Display
On/Off ● – Ja Nej Ja Nej Ja

Video Signal
Monitor

● – Ja Nej Ja Nej Ja

Marker ● – Ja Nej Ja Nej Ja

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Ja Nej Ja Nej Ja

Audio
Output

● ▲ Ja Nej Ja Nej Ja

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Nej Nej Nej Nej Nej

Set Clip Flag ● – Nej Nej Nej Nej Nej

Lock/Unlock
Clip

● – Nej Nej Nej Nej Nej

Delete Clip ● – Nej Nej Nej Nej Nej

Transfer Clip ● – Nej Nej Nej Nej Nej

Transfer Clip
(Proxy)

● – Nej Nej Nej Nej Nej

Filter Clips ● – Nej Nej Nej Nej Nej

Customize View ● – Ja Nej Ja Nej Ja
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Network

Stream

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Nej *1 Nej Ja

Genlock ● – Nej Nej Nej Nej Nej

Tally ● ● Ja Nej Ja Nej Ja

Rec
Review

● – Ja Nej Ja Nej Ja

Zoom ● – Ja Nej Ja Nej Ja

IR
Remote

– ● Nej Nej Ja Nej Ja

Lens ● – Ja Nej Ja Nej Ja

APR ● – Nej Nej Nej Nej Nej

[Type] tillämpligt, [Setting] ej tillämpligt*1

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Camera Name – ● Nej Nej Nej Nej Ja

User – ● Nej Nej Nej Ja Ja

Wired LAN*1 ▲ ● Nej Nej Nej Ja Nej

File Transfer ● ▲ Ja Nej Ja Ja Ja

FTP Server 1 – ● Nej Nej Ja Nej Ja

FTP Server 2 – ● Nej Nej Ja Nej Ja

FTP Server 3 – ● Nej Nej Ja Nej Ja

SSL – ● Nej Nej Nej Ja Ja

Referer Check – ● Nej Nej Nej Ja Ja

Brute Force
Attack Protection

– ● Nej Nej Nej Ja Ja

Kan inte konfigureras med kameramenyn (visas endast)*1

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Nej Nej Ja*1 Nej Ja*1
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Maintenance
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Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Video
Stream

– ● Ja Nej Ja Nej Ja

Audio
Stream

– ● Ja Nej Ja Nej Ja

[NDI|HX] > [License] ej tillämpligt*1

Objekt
(nivå 2) Kameramenyn Web-

menyn
All
File

Scene
File

All Reset (except for
Network Settings)

Network
Reset

Factory
Default

Language ● ● Ja Nej Ja Nej Ja

Accessibility – ● Ja Nej Nej Nej Ja

Clock Set ● ● Ja*1 Nej Ja*2 Nej Ja

Reset – ● Nej Nej Nej Nej Nej

Hours Meter ● – Nej Nej Nej Nej Nej

Information – ● Nej Nej Nej Nej Nej

System Log – ● Nej Nej Nej Nej Ja

HTTP Access
Log

– ● Nej Nej Nej Nej Ja

Service – ● Nej Nej Nej Nej Nej

EULA – ● Nej Nej Nej Nej Nej

Software – ● Nej Nej Nej Nej Nej

Datum och tidsinformation ej tillämpligt*1

[Time Zone], datum och tidsinformation ej tillämpligt*2
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Förinställningspositioner för sparade objekt

”Ja” indikerar en inställning som sparas för den förinställda positionen och ”Nej” indikerar en inställning som inte
sparades.

Pan/tilt-objekt

Zoom-objekt

Fokus-objekt

Visningsplats Objekt Spara motiv

Bildkontrollpanel för skärmen för livedrift
Pan/tilt-position Ja

[Pan-Tilt Speed] Nej

[Pan-Tilt] i web-menyn

[P/T Speed] Nej

[P/T Acceleration] Nej

[P/T Range Limit] Nej

[P/T Direction] Nej

[P/T Preset] > [Pan-Tilt] Nej

[P/T Preset] > [Default] > [Pan-Tilt Speed] Ja1)

Värdena för inställningar när du sparar en förinställningsposition sparas som värdena för den förinställningspositionen. När värdena har sparats
kan värdena ändras för varje förinställningsposition. För information, se ”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) för
förinställningspositioner med hjälp av Web App”.

1)

Visningsplats Objekt Spara motiv

Bildkontrollpanel för skärmen för livedrift
Zoom-position (fokusavstånd) Ja

[Zoom Speed] Nej

[Pan-Tilt] > [P/T Preset] > [Default] i web-menyn
[Zoom Sync] Ja1)

[Zoom Speed] Ja1)

[Technical] > [Zoom] i kameramenyn [Zoom Type] Nej

Värdena för inställningar när du sparar en förinställningsposition sparas som värdena för den förinställningspositionen. När värdena har sparats
kan värdena ändras för varje förinställningsposition. För information, se ”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) för
förinställningspositioner med hjälp av Web App”.

1)
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Relaterade avsnitt

Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en förinställningsposition

5-041-958-63(1) Copyright 2022 Sony Corporation

Visningsplats Objekt Spara
motiv

Kamerans bildruta på skärmen för
livedrift

Spåra ett motiv specificerat för realtidsspårning AF Nej

Specificerade koordinater för punktfokus Nej

 (Focus) flik på skärmen för livedrift

[Touch Focus]-brytare Nej

[Auto Focus]-brytare Ja

[Focus Hold]-knappläge Nej

[Push AF/MF]-knappläge Nej

[Face/Eye Detection AF] Ja

[AF Subj. Shift Sens.] Ja

[AF Transition Speed] Ja

Fokusposition Ja1)

[Shooting] > [Focus] i web-menyn

[Push AF Mode] (inkluderar inställningar med
tilldelningsbara knappar)

Nej

[Touch Function in MF] Nej

[AF Assist Control] Nej

[Pan-Tilt] > [P/T Preset] > [Default] i web-
menyn

[Focus Recall] Ja2)

[MF Speed] Ja2)

[Shooting] > [Focus] i kameramenyn

Fokusområdets storlek och position ställs in med [Focus
Area]

Ja

Fokusområdets position ställs in med [Focus Area (AF-S)] Ja

Återställs inte när brytaren [Auto Focus] är inställd på On. Återställs när inställt på Off.1)

Värdena för inställningar när du sparar en förinställningsposition sparas som värdena för den förinställningspositionen. När värdena har sparats
kan värdena ändras för varje förinställningsposition. För information, se ”Ändra övergångshastighet (Pan-Tilt/Zoom/Focus) vid återställning av en
förinställningsposition”.

2)
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Blockdiagram

Audio Input

Audio Output

5-041-958-63(1) Copyright 2022 Sony Corporation
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Uppdatera programvara för E-monterad lins

Du kan uppdatera programvaran i en E-monterad lins med hjälp av enheten.
Se webbplatsen för linser som kan uppdateras och motsvarande programvara.
Programvaran uppdateras med hjälp av web-menyn.

OBS!

Utför inte följande åtgärder förrän uppdateringen har slutförts.

Koppla bort nätverket
Ta bort en lins
Stänga av strömmen

Om ett meddelande indikerar att uppdateringen misslyckats, kontrollera då den beskrivning som visas och försök uppdatera på
nytt.

5-041-958-63(1) Copyright 2022 Sony Corporation

Fäst en E-monterad lins på enheten.1

Kontrollera [Maintenance] > [Information] > [Lens] > [Model Name] och [Version Number] i web-menyn.

Programvaruversionens nummer för den E-monterade linsen visas på sidan.
Kontrollera programvarans versionsnummer och uppdatera programvaran enligt behov.

2

Ladda ned uppdateringsfilen för linsens programvara för Windows (.exe extension) till enheten som kör
Web App.

3

I [Maintenance] > [Information] > [Lens] > [Version Up], trycker du på knappen [Choose File] och därefter
väljer du den nedladdade uppdateringsfilen.

4

Följ instruktionerna på skärmen.5
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Fästa locket till linsfrigöringsknappen

Du kan förhindra att linser tas bort oavsiktligt genom att fästa locket till linsfrigöringsknappen som medföljer CIB-PCM1
takfäste (tillval) till linsfrigöringsknappen.

OBS!

Detta förhindrar inte helt och hållet att linsen kan tas bort.

Relaterade avsnitt

Fästa en lins

5-041-958-63(1) Copyright 2022 Sony Corporation

Fästa en lins.

Du finner mer info om att fästa en lins, i ”Fästa en lins.”

1

Skjut pan/tilt-låsspaken till LOCK-läget för att låsa kamerahuvudets pan/tilt-funktion.2

Flytta kamerablocket till en position så att linsutmatningslocket kan fästas.3

Fäst linsutmatningslocket så att det täcker linsfrigöringsknappen.4

Säkra linsutmatningslocket med dess skruv.5
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Licenser

Patentportföljlicens för MPEG-4 AVC

DENNA PRODUKT ÄR LICENSIERAD MED AVC-PATENTPORTFÖLJENS LICENS FÖR EN KONSUMENTS
PERSONLIGA ANVÄNDNING ELLER ANDRA ANVÄNDNINGSFORMER DÄR MAN INTE ERHÅLLER ERSÄTTNING
FÖR DET
(i) AVKODA VIDEO I ÖVERENSSTÄMMELSE MED AVC-STANDARDEN (”AVC-VIDEO”) OCH/ELLER
(ii) AVKODA AVC-VIDEO SOM KODATS AV EN KONSUMENT ENGAGERAD I EN PERSONLIG AKTIVITET
OCH/ELLER ERHÅLITS FRÅN EN VIDEOLEVERANTÖR LICENSIERAD LA FÖR ATT TILLHANDAHÅLLA AVC-VIDEO.
INGEN LICENS BEVILJAS ELLER SKA UNDERFÖRSTÅS FÖR NÅGON ANNAN ANVÄNDNING. YTTERLIGARE
INFORMATION KAN ERHÅLLAS FRÅN MPEG LA, L.L.C. SE HTTP://WWW.MPEGLA.COM

Erhålla programvara med GPL/LGPL-licensen

Denna produkt använder programvara för vilken GPL/LGPL gäller. Detta informerar dig om att du har rätt till tillgång,
modifiera och vidaredistribuera källkoden för dessa programvaror enligt villkoren för GPL/LGPL.
Källkoden finns på internet. Använd följande URL och följ nedladdningsinstruktionerna.
https://oss.sony.net/Products/Linux/
Vi skulle föredra att du inte kontaktar oss om innehållet i källkoden.

μT-Kernel-källkod

Denna produkt använder källkoden μT-Kernel under T-licens 2.1 beviljad av TRON Forum (www.tron.org).

5-041-958-63(1) Copyright 2022 Sony Corporation
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Specifikationer

Allmänt

Massa
Cirka 4,6 kg (endast huset)
Cirka 6,0 kg (inklusive linsen SELP28135G)

Mått
Se ”Yttre dimensioner.”

Strömförsörjning
19,5 V DC
PoE++ (IEEE802.3bt, Typ 4, Klass 8-efterlevande)

Strömförbrukning
19,5 V DC: 80,0 W (max)
PoE++: 71,3 W (max) 

Driftstemperatur
0 °C till 40 °C

Lagringstemperatur
−20 °C till +60 °C

Inspelningsformat (video)
XAVC Intra
XAVC-I 4K/QFHD-läge: VBR, 600 Mbps (max) bithastighet, MPEG-4 AVC/H.264
XAVC-I HD-läge: CBG, 223 Mbps (max,) MPEG-4 AVC/H.264

XAVC Long
XAVC-L QFHD-läge: VBR, 150 Mbps (max) bithastighet, MPEG-4 H.264/AVC
XAVC-L HD 50-läge: VBR, 50 Mbps (max), MPEG-4 H.264/AVC
XAVC-L HD 35-läge: VBR, 35 Mbps (max), MPEG-4 H.264/AVC

Inspelningsformat (ljud)
LPCM 24-bit, 48 kHz, 4-kanal

Bildfrekvens inspelning

XAVC Intra
XAVC-I 4K-läge: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
XAVC-I QFHD-läge: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-I HD-läge: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
XAVC-L QFHD-läge: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
XAVC-L HD 50-läge: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
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XAVC-L HD 35-läge: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Inspelnings-/uppspelningstid
XAVC Intra
XAVC-I QFHD-läge: 59.94P, cirka 30 minuter (med CEA-G160T)
XAVC-I HD-läge: 59.94P, cirka 78 minuter (med CEA-G160T)

XAVC Long
XAVC-L QFHD-läge: 59.94P, cirka 115 minuter (med CEA-G160T)
XAVC-L HD 50-läge: 59.94P, cirka 155 minuter (med CEA-G80T)
XAVC-L HD 35-läge: 59.94P, cirka 210 minuter (med CEA-G80T)

OBS!

Inspelnings-/uppspelningstiden kan variera på grund av användningsförhållanden och minnesegenskaper. Inspelnings- och
uppspelningstider gäller för kontinuerlig inspelning som ett enskilt videoklipp. De faktiska tiderna kan vara kortare, beroende på
antalet videoklipp som spelas in.

Avsnitt om pan/tilt-drift

Minsta pan-hastighet: 0,02 grad./s
Minsta tilt-hastighet: 0,02 grad./s
Maximal pan-hastighet: 60 grad./s
Maximal tilt-hastighet: 60 grad./s
Pan-räckvidd: −170 grad. till +170 grad.
Tilt-räckvidd: −30 grad. till +195 grad.
Bruskriteriemärkning: NC35 eller lägre
Förinställningspositioner: 100

Kameraavsnitt

Bildenhet
35 mm full bild (35,6 × 23,8 mm), Exmor R CMOS-sensor

Antal pixlar
Cirka 12,9 megapixel (totalt pixlar)
Cirka 10,3 megapixel (faktiska pixlar)

Autofokus
Detekteringsmetod: Fasdetektering/kontrastdetektering

Interna ND-filter
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Linjär variabel ND: 1/4ND till 1/128ND

ISO-känslighet
ISO 800/12800 (Cine EI-läge, D55 ljuskälla)

Linsmontering
E-montering

Latitud
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15+ stopp

Slutarhastighet
64F till 1/8000 sek. (23.98P)

Slutarvinkel
5,6° till 360°, 2 till 64 bilder

Slow & Quick Motion
XAVC QFHD: 1 fps till 120 fps
XAVC HD: 1 fps till 240 fps
XAVC 4K: 1 fps till 60 fps
XAVC HD (S35): 1 fps till 120 fps

Vitbalans
2000 K till 15000 K

Förstärkning
−3 dB till +30 dB (1 dB ökningar)

Grundutseende
S-Cinetone, Standard, Still, ITU709, 709tone, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Ljudavsnitt

Samplingsfrekvens
48 kHz

Kvantisering
24-bit

Frekvenssvar
XLR in MIC-läge: 20 Hz till 20 kHz (± 3 dB eller mindre)
XLR in LINE-läge: 20 Hz till 20 kHz (± 3 dB eller mindre)

Dynamisk intervall
XLR in MIC-läge: 80 dB (Typical)
XLR in LINE-läge: 90 dB (Typical)

Störning
XLR in MIC-läge: 0,08% eller lägre (−40 dBu in-nivå)
XLR in LINE-läge: 0,08% eller lägre (+14 dBu in-nivå)

Ingångs-/utgångsavsnitt

Ingångar
DC IN

EIAJ-efterlevande, 19,5 V DC

AUDIO IN

XLR-typ, 5-stifts, hona
LINE / MIC / MIC+48V växlingsbar
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MIC: Referens −30 dBu till −80 dBu

GENLOCK IN

BNC-kontakt, 1.0 Vp-p, 75 Ω

TC IN

BNC-kontakt

Utgångar
SDI OUT

BNC-kontakt, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), HD-SDI

HDMI

Typ-A-kontakt

OPTICAL utmatningskontakt

SFP+-efterlevande
* Enheten stöder inte optisk signalinmatning.

Ingång/utgång
LAN-kontakt

RJ-45, 1000BASE-T

OPTION-kontakt

RJ-45 in-/utgångskontakt för inspelningslampa

Avsnitt öppning för media

CFexpress Type A/SD-kortöppning (2)

Medföljande tillbehör

AC-adapter (1)
Strömsladd (1)
Infraröd fjärrkontroll (1)
Lock (1) (fäst på enheten)
HDMI-kabelhållarplatta (1)
Innan du använder den här enheten (1)
Garantihäfte (1)

Yttermått

Måtten är ungefärliga värden.
Enhet: mm

Kamerahus
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Takfäste

498



Specifikationer och design kan ändras utan föregående meddelande.
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Hjälpguide

Interchangeable Lens Digital Camera
ILME-FR7 / ILME-FR7K

Varumärken

 är ett varumärke tillhörande Sony Group Corporation.
XAVC och  är registrerade varumärken tillhörande Sony Group Corporation.
Benämningarna HDMI och HDMI High-Definition Multimedia Interface och HDMI-logotypen är varumärken eller
registrerade varumärken som tillhör HDMI Licensing Administrator, Inc. i USA och andra länder.
Microsoft och Windows är varumärken eller registrerade varumärken tillhörande Microsoft Corporation USA och/eller
andra länder.
Mac och macOS är registrerade varumärken tillhörande Apple Inc. i USA och andra länder.
Loggan ”Catalyst Browse” är ett varumärke eller registrerat varumärke tillhörande Sony Group Corporation.
IOS är ett varumärke eller registrerat varumärke tillhörande Cisco i USA och andra länder och används med licens.
iPadOS, Safari och iPad är varumärken tillhörande Apple Inc., registrerade i USA och andra länder och regioner.
Android och Google Chrome är varumärken eller registrerade varumärken tillhörande Google LLC.
Wi-Fi är ett registrerat varumärke tillhörande Wi-Fi Alliance.
SDXC-loggan är ett varumärke tillhörande SD-3C, LLC.
Logotyperna CFexpress och CFexpress Type A är varumärken som tillhör CompactFlash Association.
NewTek™ och NDI® är varumärken eller registrerade varumärken tillhörande NewTek, Inc.
JavaScript är ett registrerat varumärke tillhörande Oracle och/eller dess närstående företag.
Intel, Intel-loggan och Intel Core är varumärken tillhörande Intel Corporation eller dess dotterbolag.
QR Code är ett varumärke som tillhör Denso Wave Inc.
Alla andra företagsnamn och produktnamn är registrerade varumärken eller varumärken tillhörande sina respektive
ägare. I detta dokument är varumärken inte indikerade med symbolen ™ eller ®.
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